To ensure that you are using the documentation that corresponds to the software you are licensed to use, compare this version number with the software version shown in “About MicroStrategy...” in the Help menu of your software.

Document number: 09520940
Copyright © 2013 by MicroStrategy Incorporated. All rights reserved.

If you have not executed a written or electronic agreement with MicroStrategy or any authorized MicroStrategy distributor, the following terms apply:

This Software and Documentation are provided "AS IS" and without express or implied warranty of any kind by either MicroStrategy Incorporated or anyone who has been involved in the creation, production, or distribution of the Software or Documentation. Including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose, good title and noninfringement. Quality or accuracy. The entire risk as to the quality and performance of the Software and Documentation is with you. Should the Software or Documentation prove defective. You (and not MicroStrategy, Inc. or anyone else who has been involved with the creation, production, or distribution of the Software or Documentation) assume the entire cost of all necessary servicing or repair. Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

In no event will MicroStrategy, Inc. or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In addition, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose, good title and noninfringement. Quality or accuracy. The entire risk as to the quality and performance of the Software and Documentation is with you. Should the Software or Documentation prove defective, You (and not MicroStrategy, Inc. or anyone else who has been involved with the creation, production, or distribution of the Software or Documentation) assume the entire cost of all necessary servicing or repair. Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify anyone or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc. are prohibited. U.S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at FAR 52.227-19, as applicable. Contractor is MicroStrategy, Inc., 1850 Towers Crescent Plaza, Tysons Corner, VA 22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.


All other company and product names may be trademarks of the respective companies with which they are associated. Specifications subject to change without notice. MicroStrategy is not responsible for errors or omissions. MicroStrategy makes no warranties or commitments concerning the availability of future products or versions that may be planned or under development.

Patent Information

This product is patented. One or more of the following patents may apply to the product sold herein: U.S. Patent Nos. 6,154,766, 6,173,310, 6,260,050, 6,263,051, 6,269,393, 6,279,033, 6,567,796, 6,587,547, 6,606,596, 6,658,093, 6,658,432, 6,682,195, 6,671,715, 6,691,100, 6,694,316, 6,697,808, 6,704,723, 6,741,980, 6,765,997, 6,768,788, 6,772,137, 6,788,788, 6,798,867, 6,801,910, 6,820,073, 6,829,334, 6,836,537, 6,850,603, 6,859,798, 6,873,693, 6,885,734, 6,940,953, 6,964,012, 6,977,992, 6,996,588, 6,996,569, 7,003,512, 7,010,518, 7,016,480, 7,020,251, 7,039,165, 7,062,422, 7,113,993, 7,127,403, 7,174,349, 7,181,417, 7,194,457, 7,197,481, 7,228,303, 7,260,577, 7,266,181, 7,272,212, 7,302,639, 7,324,942, 7,330,847, 7,330,947, 7,340,400, 7,356,758, 7,356,840, 7,415,438, 7,428,302, 7,430,562, 7,440,886, 7,468,780, 7,509,671, 7,516,181, 7,559,048, 7,574,376, 7,617,201, 7,725,811, 7,801,967, 7,836,178, 7,861,161, 7,861,253, 7,881,443, 7,925,616, 7,945,584, 7,970,782, 8,005,870, 8,051,168, 8,051,369, 8,094,786, 8,130,918, 8,236,297, 8,331,411, and 8,482,755. Other patent applications are pending.

Various MicroStrategy products contain the copyrighted technology of third parties. This product may contain one or more of the following copyrighted technologies:

Graph Generation Engine Copyright © 1998-2013. Three D Graphics, Inc. All rights reserved.
Actuate® Formula One. Copyright © 1993-2013 Actuate Corporation. All rights reserved.
XML parser Copyright © 2003-2013 Microsoft Corporation. All rights reserved.
Xalan XSLT processor. Copyright © 1999-2013. The Apache Software Foundation. All rights reserved.
Xeroxe XML parser. Copyright © 1999-2013. The Apache Software Foundation. All rights reserved.
FOP XSLT formatting objects. Copyright © 2004-2013. The Apache Software Foundation. All rights reserved.
Portions of Intelligence Server memory management Copyright © 1991-2013 Compuware Corporation. All rights reserved.
ASHTHPT Request library. Copyright © 2007-2013. All-Seeing Interactive. All rights reserved.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)
CONTENTS

Book Overview and Additional Resources

Description of this guide........................................................... xv
About this book ............................................................................ xvi
    Additional formats ..................................................................... xvii
    How to find business scenarios and examples ....................... xvii
    What’s new in this guide ....................................................... xvii
    Prerequisites ........................................................................... xx
    Who should use this guide...................................................... xx
Resources.................................................................................... xxi
    Documentation ........................................................................ xxi
    Education .............................................................................. xxx
    Consulting ............................................................................. xxx
    International support ........................................................... xxxi
    Technical Support .................................................................. xxxi
Feedback .................................................................................... xxxvi

1. Designing and Creating Documents

Introduction .................................................................................. 1
Before you begin .......................................................................... 2
    Display modes in MicroStrategy Web ...................................... 2
    Document views in Desktop .................................................. 4
Designing and creating documents: An overview ....................... 6
Best practices for designing effective documents ....................... 10
    Best practices: Designing documents for Excel .................... 15
    Best practices: Designing documents for Kindle and Nook ... 16
Creating documents ..................................................................... 17
    Creating a document from scratch ....................................... 18
    Creating a document using another document as a
## Contents Report Services  Document Creation Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>template</td>
<td>20</td>
</tr>
<tr>
<td>Creating a document from a report</td>
<td>25</td>
</tr>
<tr>
<td>Understanding and working with document sections</td>
<td>28</td>
</tr>
<tr>
<td>Displaying, hiding, and resizing document sections</td>
<td>37</td>
</tr>
<tr>
<td>Adding sections in documents</td>
<td>39</td>
</tr>
<tr>
<td><strong>2. Adding Text and Data to Documents</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>45</td>
</tr>
<tr>
<td>Using datasets in documents</td>
<td>45</td>
</tr>
<tr>
<td>Importing data from different data sources</td>
<td>47</td>
</tr>
<tr>
<td>Adding, changing, or removing a dataset</td>
<td>48</td>
</tr>
<tr>
<td>Changing the grouping and sorting dataset for a document</td>
<td>51</td>
</tr>
<tr>
<td>Working with multiple dataset reports</td>
<td>51</td>
</tr>
<tr>
<td>Determining whether Grid/Graphs can use multiple datasets</td>
<td>58</td>
</tr>
<tr>
<td>Defining a dataset as primary or secondary</td>
<td>60</td>
</tr>
<tr>
<td>Joining multiple datasets: Examples</td>
<td>65</td>
</tr>
<tr>
<td>Using Intelligent Cubes as datasets</td>
<td>74</td>
</tr>
<tr>
<td>Using a view report or base report as a dataset</td>
<td>74</td>
</tr>
<tr>
<td>Displaying grouping elements that contain null values</td>
<td>75</td>
</tr>
<tr>
<td>Removing sections that do not have metric data</td>
<td>79</td>
</tr>
<tr>
<td>Adding text and data to a document: Text fields</td>
<td>81</td>
</tr>
<tr>
<td>Adding a static text label to a document</td>
<td>82</td>
</tr>
<tr>
<td>Adding dynamic data to a document</td>
<td>83</td>
</tr>
<tr>
<td>Combining different types of text fields in a document</td>
<td>86</td>
</tr>
<tr>
<td>Editing the text in a text field</td>
<td>87</td>
</tr>
<tr>
<td>Displaying document and dataset report information: Auto text codes</td>
<td>88</td>
</tr>
<tr>
<td>Auto text codes for document information</td>
<td>90</td>
</tr>
<tr>
<td>Auto text codes for dataset report information</td>
<td>91</td>
</tr>
<tr>
<td>Configuring auto text codes</td>
<td>94</td>
</tr>
<tr>
<td>Working with metrics in documents</td>
<td>114</td>
</tr>
<tr>
<td>Metric calculation in document sections</td>
<td>114</td>
</tr>
<tr>
<td>Creating metrics in documents</td>
<td>128</td>
</tr>
<tr>
<td>Displaying real-time web and other HTML content: HTML containers</td>
<td>142</td>
</tr>
<tr>
<td>Displaying text formatted by HTML in an HTML container</td>
<td>144</td>
</tr>
<tr>
<td>Displaying a website using a URL (iFrame)</td>
<td>146</td>
</tr>
<tr>
<td>Adding shapes and lines to a document</td>
<td>149</td>
</tr>
<tr>
<td>Inserting images in a document</td>
<td>151</td>
</tr>
</tbody>
</table>
3. Displaying Reports in Documents: Grid/Graphs

Introduction .................................................................................................................. 167

Arranging controls on a document ............................................................................. 156

Adding a Grid/Graph to a document ....................................................................... 170
Adding a Grid/Graph and a new dataset simultaneously ................................... 175
Adding an empty Grid/Graph ..................................................................................... 176
Adding a Grid/Graph that uses multiple datasets ............................................... 178
Adding a Grid/Graph as a shortcut ......................................................................... 191
Changing datasets in Grid/Graphs ......................................................................... 195

Selecting and viewing a Grid/Graph ........................................................................ 196

Editing data in a Grid/Graph ................................................................................... 201
Adding objects to a Grid/Graph .............................................................................. 202
Editing data in a Grid/Graph displayed as a grid ................................................. 203
Editing data in a Grid/Graph displayed as a graph .............................................. 205
Editing data in a Grid/Graph displayed as a grid and a graph ............................... 207

Formatting Grid/Graph containers .......................................................................... 207
Formatting suggestions for a Grid/Graph container .............................................. 207
Formatting the background of selected items in Grid/Graphs used as selectors .......... 208

Adding title bars to Grid/Graphs ............................................................................ 211
Allowing the background of the Grid/Graph to show through a transparent title bar .......................................................... 214

Quick switch for Grid/Graphs .................................................................................. 215
Quick switch in MicroStrategy Web ....................................................................... 215
Quick switch in Desktop ............................................................................................ 216
Enabling quick switch .............................................................................................. 216

Using view filters on Grid/Graphs .......................................................................... 217
Multiple qualifications in view filters ...................................................................... 219
View filters in documents with multiple datasets ................................................. 219
Metrics in rows and columns ................................................................................... 224
Creating, editing, and deleting view filters .............................................................. 225

Linking a Grid/Graph to its underlying report ......................................................... 229

Merging column and row headers in a grid ............................................................ 232
Displaying attribute and attribute form headers in a grid .................................... 233
Drilling in Grid/Graphs ............................................................................................. 238
Inheriting subtotals and defining join type ............................................................... 241

Determining how null and zero metric values are displayed .................................. 243
Enabling interactive Grid/Graphs for MicroStrategy Web ..................................... 244
4. Formatting Documents

Introduction .......................................................................................... 251

Formatting suggestions ........................................................................ 252

Methods for formatting a control ....................................................... 253
  Copying and pasting formatting ....................................................... 254

Defining default formatting for control types: control defaults ........ 255
  Formatting using predefined formats (Autostyles) ......................... 258

Using a transparent or opaque backstyle ......................................... 261

Applying a 3D effect ........................................................................... 263

Applying a drop shadow .................................................................... 265

Using gradient colors ......................................................................... 267

Creating and using custom colors ..................................................... 269

Creating a pop-up tooltip .................................................................. 270

Hiding a control ................................................................................ 272

Formatting text fields ......................................................................... 273
  Formatting text field options ......................................................... 274
  Displaying scroll bars in text fields ................................................. 276
  Formatting numbers ........................................................................ 277

Formatting text position in a text field ............................................ 278

Formatting HTML containers ............................................................ 281

Formatting lines and rectangles ...................................................... 284
  Controlling the display of rounded corners in Flash Mode ....... 285

Formatting images ............................................................................. 287

Formatting document sections ........................................................ 288
  Hiding or displaying sections for a finished document ............... 289

Formatting the background color of document sections ............. 293

Displaying sections horizontally ....................................................... 293

Changing the size of a section .......................................................... 296

Repeating information horizontally ............................................... 302

Repeating information on each page .............................................. 303

Keeping the contents of a section together ................................... 306

Formatting conditional data in documents ..................................... 307
  Derived metrics, summary metrics, and attributes in conditional formatting ........................................................................ 310
Conditional formatting on selector totals.............................. 312
Conditional formatting on a document with multiple datasets ............................................................................... 313
Creating a conditional format or threshold based on a single metric......................................................................... 316
Creating a conditional format or threshold based on multiple metrics or attributes................................................ 319
Displaying or hiding conditional formatting .......................... 323
Deleting a threshold or its conditions ................................... 324
Formatting the border or background of a document or layout ......................................................................................... 325
Adding watermarks to documents ............................................. 326
Project watermarks vs. document watermarks .................... 328
Creating a project watermark............................................... 330
Hiding a project watermark for a specific document ............ 332
Creating document watermarks .......................................... 333
Disabling document watermarks for all documents in the project ............................................................................ 336
Disabling all watermarks...................................................... 336
Determining display for end users ............................................. 337
Letting users switch between grid and graph: Quick Switch .................................................................................. 338
Hiding the floating grid toolbars in Flash Mode ................. 339
Allowing a document to be refreshed automatically in Express Mode .............................................................. 340
Embedding fonts for Flash Mode ............................................... 341
Formatting a document for exporting or printing................. 342
Adding page breaks and numbering pages ......................... 343
Modifying page setup options .............................................. 346
Controlling horizontal overflow ............................................. 350
Embedding fonts in PDFs .................................................... 353
Changing graph resolution in PDFs ................................. 355
Including or hiding bookmarks in PDFs ............................ 356
Including interactive tables of contents in PDFs .......... 358
Formatting a document for export........................................ 363

5. Grouping and Sorting Records in a Document

Introduction.............................................................................. 373
Grouping records in a document ............................................. 374
Determining grouping order ................................................. 376
Changing the grouping order in a document........................ 377
Deleting a grouping field in a document ............................... 378
Displaying forms in a group .................................................. 379
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Showing totals for a group</td>
<td>380</td>
</tr>
<tr>
<td>Displaying a group horizontally</td>
<td>389</td>
</tr>
<tr>
<td>Hiding Group Header and Group Footer sections</td>
<td>395</td>
</tr>
<tr>
<td>Adding a page break for a group</td>
<td>396</td>
</tr>
<tr>
<td>Resetting page numbers for each group</td>
<td>397</td>
</tr>
<tr>
<td>Repeating a Group Header section on another page</td>
<td>398</td>
</tr>
<tr>
<td>Keeping the data in a group together on a page</td>
<td>398</td>
</tr>
<tr>
<td>Applying grouping selections to the current layout or all layouts</td>
<td>399</td>
</tr>
<tr>
<td>Specifying that groups are exported to separate Excel worksheets</td>
<td>401</td>
</tr>
<tr>
<td>Using page-by on a document</td>
<td>403</td>
</tr>
<tr>
<td>Page-by on a document with multiple datasets</td>
<td>406</td>
</tr>
<tr>
<td>Enabling page-by</td>
<td>407</td>
</tr>
<tr>
<td>Disabling page-by</td>
<td>408</td>
</tr>
<tr>
<td>Sorting records in a document</td>
<td>409</td>
</tr>
<tr>
<td>6. Linking from Documents</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>411</td>
</tr>
<tr>
<td>Creating links in a document</td>
<td>412</td>
</tr>
<tr>
<td>Linking to a web page</td>
<td>415</td>
</tr>
<tr>
<td>Linking to other documents and to reports</td>
<td>418</td>
</tr>
<tr>
<td>Linking from a text field</td>
<td>419</td>
</tr>
<tr>
<td>Linking from a button</td>
<td>421</td>
</tr>
<tr>
<td>Linking from an attribute in a Grid/Graph</td>
<td>422</td>
</tr>
<tr>
<td>Linking from an attribute in a widget</td>
<td>423</td>
</tr>
<tr>
<td>Adding a link to a document</td>
<td>424</td>
</tr>
<tr>
<td>Specifying how prompts are answered in the target</td>
<td>427</td>
</tr>
<tr>
<td>Specifying prompt answers for any other prompts not listed</td>
<td>435</td>
</tr>
<tr>
<td>Passing selector values from the source to the target</td>
<td>438</td>
</tr>
<tr>
<td>Defining hyperlinks in documents</td>
<td>439</td>
</tr>
<tr>
<td>Emailing, exporting, and subscribing to documents and reports via links</td>
<td>440</td>
</tr>
<tr>
<td>Specifying prompt information parameters in manually created link URLs</td>
<td>443</td>
</tr>
<tr>
<td>How links, drilling, and selectors work together</td>
<td>446</td>
</tr>
<tr>
<td>7. Transaction-enabled Documents</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>449</td>
</tr>
<tr>
<td>Creating a transaction-enabled document</td>
<td>450</td>
</tr>
</tbody>
</table>
Input object controls that support transactions .......................... 457  
  Formatting a Barcode Scanner control .................................. 458  
  Formatting a Calendar control ......................................... 459  
  Formatting a Likert Scale control .................................... 460  
  Formatting a List control .............................................. 461  
  Formatting a Radio List control ...................................... 463  
  Formatting a Signature Capture control ......................... 464  
  Formatting a Slider control ....................................... 464  
  Formatting a Star Rating Control ................................... 466  
  Formatting a Stepper control ..................................... 467  
  Formatting a Switch control .................................. 467  
  Formatting a Text Area control .................................. 468  
  Formatting a Text Field control .................................. 469  
  Formatting a Time Picker control ................................. 472  
  Formatting a Toggle control ................................... 472

8. Advanced Documents  

Introduction .............................................................................. 475  
Creating multi-layout documents ........................................ 476  
  Creating a multi-layout document .................................. 476  
  Exporting multi-layout documents .................................. 486  
Using prompts in documents ........................................... 488  
  Specifying whether a document uses default prompt answers when the document is run ..................................... 489  
  Prompt order in documents .......................................... 491  
Specifying the delivery options available to users subscribing to a document ................................................. 493  
Improving document execution performance ...................... 494  
  Automatic resizing of documents ................................ 494  
  Limiting shrinking, growing, and empty sections .......... 495  
  Incremental fetch ................................................................. 496  
  Incremental fetch on Grid/Graphs .................................. 499  
Caching documents .............................................................. 502  
  Caching and page-by, selectors, and widgets ................. 503  
Portable documents: Reusing documents across projects .... 505  
  How the document reconciliation process works .......... 506  
  Copying documents between projects ......................... 507

A. Document Interfaces in MicroStrategy  

Introduction .............................................................................. 513  
Document Editor layout .......................................................... 513  
  Controls toolbar ................................................................. 515
B. Document Tutorial

Introduction ...................................................................................... 525

Create a sample invoice document .................................................. 525
Creating the report to use as the dataset ........................................... 529
Creating the new document and selecting the dataset ...................... 530
Grouping the document by customer .................................................. 531
Adding the logo image to the document ............................................ 532
Resizing the image ............................................................................ 533
Adding static text to the document .................................................... 533
Formatting, aligning, and sizing the text field .................................. 534
Adding a rectangle to the document .................................................. 534
Switching to PDF View .................................................................... 535
Adding an attribute to the Customer Header section ........................ 536
Combining text fields ....................................................................... 538
Adding and formatting additional text fields in the Customer Header section .............................................................. 539
Adding a line to the Customer Header section .................................... 541
Creating the column headers in the Detail Header section .................. 542
Ordering the controls ....................................................................... 543
Creating the item detail in the Detail section .................................... 545
Formatting a text field as currency .................................................... 546
Adding summary information to the Detail Footer section .............. 547
Adding totals to a document ............................................................. 549
Saving the document ...................................................................... 550
Creating the final PDF ..................................................................... 551

C. Troubleshooting Documents

Introduction ...................................................................................... 553

Troubleshooting during document creation ..................................... 553
Troubleshooting Grid/Graphs ............................................................. 553
Miscellaneous document creation troubleshooting ................................ 555
Troubleshooting during document execution .................................... 557
Troubleshooting common Flash Mode issues ................................. 559
Description of this guide

This guide is the primary resource for you to use to learn about designing and creating MicroStrategy Report Services documents using Desktop. It builds on the basic concepts about documents presented in the *Document and Dashboard Analysis Guide*, which helps document designers understand how end users will use documents for data analysis. The chapters, which are described below, are organized to help guide you through creating a new document, from creating the document itself, to adding objects to the new document, and formatting the document and its objects:

- *Chapter 1, Designing and Creating Documents* begins with a brief review of basic concepts, such as executing and printing documents, that are covered in the *Document and Dashboard Analysis Guide*. The chapter is focused on creating new documents, so it includes procedures and best practices to create and design documents.

- *Chapter 2, Adding Text and Data to Documents* discusses how datasets provide the data for the document and how multiple datasets are joined in the document. The chapter includes procedures to work with datasets, to import data, and to create many of the objects that make up documents, such as text fields, images, and shapes.
- Chapter 3, Displaying Reports in Documents: Grid/Graphs describes Grid/Graphs, which display reports in a document. The chapter provides instructions to create and format Grid/Graphs.

- Chapter 4, Formatting Documents describes how to format the document and its objects.

- Chapter 5, Grouping and Sorting Records in a Document explains how to group and sort documents. Grouping defines the document’s hierarchy and therefore its sort order. Page-by interactively displays groups on separate pages in PDF View.

- Chapter 6, Linking from Documents explains how to connect a document with a report, a web page, or another document, passing parameters to answer any prompts that are in the target. Use links as a tool to present investigative workflows, such as navigating from data at one level to different levels of aggregation.

- Chapter 8, Advanced Documents provides information about advanced concepts such as multi-layout documents, document caches, and portable documents.

Most of the tasks in this guide are performed in MicroStrategy Web. Some are performed in MicroStrategy Desktop, and are clearly labeled. You can also design and create documents using MicroStrategy Desktop. The concepts are the same, but the procedures differ slightly. For steps, see the Desktop Help.

About this book

This book is divided into chapters that begin with a brief overview of the chapter’s content.

The following sections provide the location of additional examples, list prerequisites for using this book, and describe the user roles the information in this book was designed for.

HTML Documents in the MicroStrategy platform, formerly called documents, are HTML shells into which you can place MicroStrategy reports and other graphics, and control the formatting and appearance with style sheets. In this guide, the term “document” means a Report Services document.
Additional formats

This book is also available as an electronic publication in the Apple iBookstore, and can be read on an iPhone or iPad with the iBooks app installed. To download this book, search for the book’s title in the iBookstore search bar, or scan the QR code below using your device’s camera.

How to find business scenarios and examples

Within this guide, many of the concepts discussed are accompanied by business scenarios or other descriptive examples. For examples of basic Report Services documents and dashboards, see the Document and Dashboard Analysis Guide.

For examples of reporting functionality, see the MicroStrategy Tutorial, which is MicroStrategy’s sample warehouse and project. Information about the MicroStrategy Tutorial, which is included as part of the MicroStrategy Analytics Modules, can be found in the Basic Reporting Guide. Detailed examples of advanced reporting functionality can be found in the Advanced Reporting Guide.

Other examples in this book use the Analytics Modules projects, which include a set of precreated sample reports and documents, each from a different business area. Sample reports and documents present data for analysis in such business areas as financial reporting, human resources, and customer analysis.

What’s new in this guide

MicroStrategy 9.4

- You can import data from different data sources directly into a document. The data source can include an Excel file, a table in a database, the results of a Freeform SQL query, or a Salesforce.com report. Your imported data is saved and can be used immediately in the document. For background
information on using imported data as a dataset, see *Importing data from different data sources, page 47.*

- A document can use multiple Intelligent Cubes as datasets, or a mix of Intelligent Cubes and reports. For background information on using Intelligent Cubes as datasets, see *Using Intelligent Cubes as datasets, page 74.*

- If you remove or replace a dataset, controls on the document that contain data that is no longer available from the dataset will be updated and will no longer contain data from the replaced or removed dataset. You can change this behavior to instead display the missing objects in the Grid/Graph. For a more detailed explanation, including examples, and a procedure, see *Removing or keeping missing objects in a Grid/Graph when datasets are removed or replaced, page 54.*

- When a document contains multiple datasets, a threshold or a view filter on a Grid/Graph can include any objects from any of the datasets, regardless of whether the Grid/Graph uses that dataset. For examples, see *Conditional formatting on a document with multiple datasets, page 313* and *View filters in documents with multiple datasets, page 219.*

- When a document contains multiple datasets, the elements available in the grouping fields are the elements available in the target (what is being grouped). If the target is filtered, the grouping elements are also filtered. For examples, see *Page-by on a document with multiple datasets, page 406.*

- By default, objects in a Grid/Graph must come from a single dataset. You can allow a single Grid/Graph to contain objects from multiple datasets. For steps, see *Determining whether Grid/Graphs can use multiple datasets, page 58* and *Adding a Grid/Graph that uses multiple datasets, page 178.* For details on how the datasets are joined and metrics are resolved in the Grid/Graph, see *Adding a Grid/Graph that uses multiple datasets, page 178.*

- You can allow a document to be refreshed automatically, and select the length of time between refreshes. When document refresh is enabled, a user can pause and resume automatic document refreshing in Express Mode. For steps to enable document refresh, see *Allowing a document to be refreshed automatically in Express Mode, page 340.*

**MicroStrategy 9.3.1**

- When you create a link, you can allow the link to automatically pass values chosen in a selector in the source to a selector in the target. For an example, see *Passing selector values from the source to the target, page 438.*
• You can create a button that links to a web page, report, or another document. For an example, see *Linking from a button, page 421*.

**MicroStrategy 9.3**

• A user can drill on one grid or graph (the source) in a document to simultaneously drill on one or more target grids or graphs. For example, a grid containing profit data across several product categories targets a graph displaying inventory data. If you drill to Subcategory in the source grid, the target graph will automatically be updated to display inventory data drilled to the Subcategory level.

• If a user changes the grouping in one layout of a document and then switches to a different layout that contains the same grouping field, the grouping may be applied to the new layout, if you enabled the Apply grouping selection to all layouts option. For steps to enable this option, see *Applying grouping selections to the current layout or all layouts, page 399*.

• You can specify formatting options for the table of contents included in documents exported as PDF files, including font size and color, the style in which to display the border around the table of contents, and where in the document to display the table of contents. For steps to format the table of contents, see *Including interactive tables of contents in PDFs, page 358*.

• When you create a document, you can specify whether or not the contents of the selected document section are repeated on each page of the PDF. To create repeated sections with controls that do not display on the last page, you can use this option with the Show only in repeated sections option, which is defined for individual controls, not document sections. You can use these options to display text such as "Continued on next page" on every page except the last page. For steps to use these options, see *Repeating information on each page, page 303*.

• When a user views a grouped document, drop-down lists are displayed to allow the user to select which elements, or subsets of data, to display. You can select which attribute forms are displayed in the list, and the order of the forms. For steps to specify the forms in grouping, see *Displaying forms in a group, page 379*.
Prerequisites

Before working with this manual, you should be familiar with the information in the *Document and Dashboard Analysis Guide, Basic Reporting Guide*, and *Advanced Reporting Guide*.

To work with Report Services documents, you must have purchased a license for Report Services and installed it on your machine. You must also have the proper privileges assigned to your user login. These privileges are described below:

- **Execute document**, to execute documents in Desktop
  
  To execute a document in Desktop, you must connect to the project in three-tier (server) mode.

- **Use document editor**, to create and edit documents using the Document Editor in Desktop

- **Web execute document**, to browse and execute documents in MicroStrategy Web

- **Web document design**, to create and edit documents in Web

- **Web manage document datasets**, to add and remove datasets from a document in Web

- **Execute Report that Uses Multiple Data Sources**, to view Grid/Graphs that use objects from multiple datasets

- **Import Table from Multiple Data Sources**, to create Grid/Graphs that use objects from multiple datasets

  If you do not have Report Services, contact your MicroStrategy sales representative for more information.

Who should use this guide

This guide is designed for all users who need to design and create documents.

Document design is the process of building documents that are used widely by other users on the business intelligence platform and throughout the enterprise. To design documents you use the Document Editor in either MicroStrategy Desktop or Web. The Document Editor allows you to create document objects (called controls) such as text fields, auto text codes, Grid/
Graphs, HTML containers, images, and so on. You can also create a special type of document called Report Services (RS) dashboards, which are interactive, visually intuitive displays of data that summarize key business indicators for a status check. RS dashboards provide interactive features that let users change how they view the RS dashboard’s data. The interaction is provided by these types of controls: panels, selectors, and widgets.

For examples of RS dashboards and the objects that they contain, including instructions to create RS dashboards, see the *Dashboards and Widgets Creation Guide*.

In general, the role of document designer is made available only to a group of advanced users who can design documents. The Desktop Designer and Web Professional user roles in MicroStrategy include the set of privileges required to create documents and controls, for each respective product.

For an introduction to documents, you should review the *Document and Dashboard Analysis Guide*, which provides a basic understanding of how to manipulate the data in a document to analyze business information.

**Resources**

**Documentation**

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

- **Manuals**: In general, MicroStrategy manuals provide:
  - Introductory information and concepts
  - Examples and images
  - Checklists and high-level procedures to get started

The steps to access the manuals are described in *Accessing manuals and other documentation sources, page xxviii*.

Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy Account Executive with a purchase order number.
• **Help:** In general, MicroStrategy help provides:
  - Detailed steps to perform procedures
  - Descriptions of each option on every software screen

**Translations**

For the most up-to-date translations of MicroStrategy documentation, refer to the MicroStrategy Knowledge Base. Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual.

**Finding information**

You can search all MicroStrategy books and Help for a word or phrase, with a simple Google™ search at [www.google.com](http://www.google.com). For example, type “MicroStrategy derived metric” or “MicroStrategy logical table” into a Google search. As described above, books typically describe general concepts and examples; Help typically provides detailed steps and screen options. To limit your search to MicroStrategy books, on Google’s main page you can click More, then select Books.

**Manuals for MicroStrategy overview and evaluation**

• *Introduction to MicroStrategy: Evaluation Guide*

  Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide also includes a detailed, step-by-step evaluation process of MicroStrategy features, where you perform reporting with the MicroStrategy Tutorial project and its sample business data.

• *MicroStrategy Evaluation Edition Quick Start Guide*

  Overview of the installation and evaluation process, and additional resources.

• *MicroStrategy Suite: Quick Start Guide*

  Evaluate MicroStrategy as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Suite.
Resources for Identity and Loyalty

- *Alert Commerce Management System (CMS) Guide and Alert API Reference*

  Content resources providing steps to deliver and manage marketing and commerce content through the Alert mobile applications.

- *Usher Administration Guide*

  Steps to perform mobile identity validation using the Usher mobile identity network to issue electronic badges for identifying users.

Manuals for query, reporting, and analysis

- *MicroStrategy Installation and Configuration Guide*

  Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, as well as basic maintenance guidelines.

- *MicroStrategy Upgrade Guide*

  Instructions to upgrade existing MicroStrategy products.

- *MicroStrategy Project Design Guide*

  Information to create and modify MicroStrategy projects, and understand facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.

- *MicroStrategy Basic Reporting Guide*

  Instructions to get started with MicroStrategy Desktop and MicroStrategy Web, and how to analyze data in a report. Includes the basics for creating reports, metrics, filters, and prompts.

- *MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application*

  Instructions for advanced topics in the MicroStrategy system, building on information in the Basic Reporting Guide. Topics include reports, Freeform SQL reports, Query Builder reports, filters, metrics, Data Mining Services, custom groups, consolidations, and prompts.

- *Document and Dashboard Analysis Guide*

  Instructions for a business analyst to execute and analyze a document in MicroStrategy Desktop and MicroStrategy Web, building on basic
concepts about projects and reports presented in the MicroStrategy Basic Reporting Guide.

- **MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents**

  Instructions to design and create Report Services documents, building on information in the Document and Dashboard Analysis Guide. It is organized to help guide you through creating a new document, from creating the document itself, to adding objects to the new document, and formatting the document and its objects.

- **MicroStrategy Dashboards and Widgets Creation Guide: Creating Interactive Dashboards for your Data**

  Instructions for designing and creating MicroStrategy Report Services dashboards, a type of document that is optimized for viewing online and for user interactivity. It builds on the basic concepts about documents presented in the MicroStrategy Report Services Document Creation Guide.

- **MicroStrategy OLAP Services Guide**

  Information on MicroStrategy OLAP Services, which is an extension of MicroStrategy Intelligence Server. OLAP Services features include Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.

- **MicroStrategy Office User Guide**

  Instructions for using MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, and Word, to analyze, format, and distribute business data.

- **MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile**

  Information and instructions for using MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.

- **MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence**

  Information and instructions to install and configure MicroStrategy Mobile, as well as instructions for a designer working in MicroStrategy Desktop or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.
• **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting your MicroStrategy Business Intelligence System**

  Concepts and high-level steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.

• **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

  Information and instructions for MicroStrategy administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

• **MicroStrategy Functions Reference**

  Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.

• **MicroStrategy MDX Cube Reporting Guide**

  Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.

**Manuals for Analytics Modules**

• **Analytics Modules Installation and Porting Guide**

• **Customer Analysis Module Reference**

• **Sales Force Analysis Module Reference**

• **Financial Reporting Analysis Module Reference**

• **Sales and Distribution Analysis Module Reference**

• **Human Resources Analysis Module Reference**

**Manuals for Narrowcast Services products**

• **MicroStrategy Narrowcast Server Getting Started Guide**

  Instructions to work with the tutorial to learn Narrowcast Server interfaces and features.
• MicroStrategy Narrowcast Server Installation and Configuration Guide
  Information to install and configure Narrowcast Server.

• MicroStrategy Narrowcast Server Application Designer Guide
  Fundamentals of designing Narrowcast Server applications.

• MicroStrategy Narrowcast Server System Administrator Guide
  Concepts and high-level steps to implement, maintain, tune, and troubleshoot Narrowcast Server.

• MicroStrategy Narrowcast Server Upgrade Guide
  Instructions to upgrade an existing Narrowcast Server.

Software Development Kits

• MicroStrategy Developer Library (MSDL)
  Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.

• MicroStrategy Web SDK
  The Web SDK is available in the MicroStrategy Developer Library, which is part of the MicroStrategy SDK.

• Narrowcast Server SDK Guide
  Instructions to customize Narrowcast Server functionality, integrate Narrowcast Server with other systems, and embed Narrowcast Server functionality within other applications. Documents the Narrowcast Server Delivery Engine and Subscription Portal APIs, and the Narrowcast Server SPI.

Documentation for MicroStrategy Portlets

• Enterprise Portal Integration Help
  Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.
This resource can be accessed from the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page xxviii.*

**Documentation for MicroStrategy GIS Connectors**

- *GIS Integration Help*

  Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with various third-party mapping services.

  This resource can be accessed from the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page xxviii.*

**Help**

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

- **Help button:** Use the Help button or ? (question mark) icon on most software windows to see help for that window.

- **Help menu:** From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.

- **F1 key:** Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

  For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.
Accessing manuals and other documentation sources

The manuals are available from http://www.microstrategy.com/producthelp, as well as from your MicroStrategy disk or the machine where MicroStrategy was installed.

Adobe Acrobat Reader is required to view these manuals. If you do not have Acrobat Reader installed on your computer, you can download it from http://get.adobe.com/reader/.

The best place for all users to begin is with the MicroStrategy Basic Reporting Guide.

To access the installed manuals and other documentation sources, see the following procedures:

• To access documentation resources from any location, page xxviii
• To access documentation resources on Windows, page xxviii
• To access documentation resources on UNIX and Linux, page xxix

To access documentation resources from any location

1 Visit http://www.microstrategy.com/producthelp.

To access documentation resources on Windows

1 From the Windows Start menu, choose Programs (or All Programs), MicroStrategy Documentation, then Product Manuals. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

2 Click the link for the desired manual or other documentation source.

3 If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be downloaded. Select Open this file from its current location, and click OK.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Acrobat Reader.
To access documentation resources on UNIX and Linux

1 Within your UNIX or Linux machine, navigate to the directory where you installed MicroStrategy. The default location is /opt/MicroStrategy, or $HOME/MicroStrategy/install if you do not have write access to /opt/MicroStrategy.

2 From the MicroStrategy installation directory, open the Help folder.

3 Open the Product_Manuals.htm file in a web browser. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

4 Click the link for the desired manual or other documentation source.

5 If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be downloaded. Select Open this file from its current location, and click OK.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Acrobat Reader.

Documentation standards

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

These standards may differ depending on the language of this manual; some languages have rules that supersede the table below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| bold    | • Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions  
Example: Click Select Warehouse. |
| italic  | • Names of other product manuals and documentation resources  
• When part of a command syntax, indicates variable information to be replaced by the user  
Example: The aggregation level is the level of calculation for the metric.  
Example: Type copy c:\filename d:\foldername\filename |
Education

MicroStrategy Education Services provides a comprehensive curriculum and highly skilled education consultants. Many customers and partners from over 800 different organizations have benefited from MicroStrategy instruction.

Courses that can help you prepare for using this manual or that address some of the information in this manual include:

- MicroStrategy Report Services: Dynamic Dashboards

For the most up-to-date and detailed description of education offerings and course curricula, visit [http://www.microstrategy.com/Education](http://www.microstrategy.com/Education).

Consulting

MicroStrategy Consulting Services provides proven methods for delivering leading-edge technology solutions. Offerings include complex security architecture designs, performance and tuning, project and testing strategies and recommendations, strategic planning, and more. For a detailed description of consulting offerings, visit [http://www.microstrategy.com/Services](http://www.microstrategy.com/Services).
International support

MicroStrategy supports several locales. Support for a locale typically includes native database and operating system support, support for date formats, numeric formats, currency symbols, and availability of translated interfaces and certain documentation.

MicroStrategy is certified in homogeneous configurations (where all the components lie in the same locale) in the following languages—English (US), French, German, Italian, Japanese, Korean, Portuguese (Brazilian), Spanish, Chinese (Simplified), Chinese (Traditional), Danish, and Swedish. A translated user interface is available in each of the above languages. For information on specific languages supported by individual MicroStrategy system components, see the MicroStrategy readme.

MicroStrategy also provides limited support for heterogeneous configurations (where some of the components may lie in different locales). Please contact MicroStrategy Technical Support for more details.

Technical Support

If you have questions about a specific MicroStrategy product, you should:

1 Consult the product guides, Help, and readme files. Locations to access each are described above.

2 Consult the MicroStrategy Knowledge Base online at https://resource.microstrategy.com/support.

   A technical administrator in your organization may be able to help you resolve your issues immediately.

3 If the resources listed in the steps above do not provide a solution, contact MicroStrategy Technical Support directly. To ensure the most productive relationship with MicroStrategy Technical Support, review the Policies and Procedures document in your language, posted at http://www.microstrategy.com/Support/Policies. Refer to the terms of your purchase agreement to determine the type of support available to you.

MicroStrategy Technical Support can be contacted by your company’s Support Liaison. A Support Liaison is a person whom your company has designated as a point-of-contact with MicroStrategy’s support personnel. All customer inquiries and case communications must come through these named individuals. Your company may designate two employees to serve as
their Support Liaisons, and can request to change their Support Liaisons two times per year with prior written notice to MicroStrategy Technical Support.

It is recommended that you designate Support Liaisons who have MicroStrategy Administrator privileges. This can eliminate security conflicts and improve case resolution time. When troubleshooting and researching issues, MicroStrategy Technical Support personnel may make recommendations that require administrative privileges within MicroStrategy, or that assume that the designated Support Liaison has a security level that permits them to fully manipulate the MicroStrategy projects and has access to potentially sensitive project data such as security filter definitions.

**Ensure issues are resolved quickly**

Before logging a case with MicroStrategy Technical Support, the Support Liaison may follow the steps below to ensure that issues are resolved quickly:

1. Verify that the issue is with MicroStrategy software and not a third party software.
3. Attempt to reproduce the issue and determine whether it occurs consistently.
4. Minimize the complexity of the system or project object definition to isolate the cause.
5. Determine whether the issue occurs on a local machine or on multiple machines in the customer environment.
6. Discuss the issue with other users by posting a question about the issue on the MicroStrategy Customer Forum at [https://resource.microstrategy.com/forum/](https://resource.microstrategy.com/forum/).

The following table shows where, when, and how to contact MicroStrategy Technical Support. If your Support Liaison is unable to reach MicroStrategy Technical Support by phone during the hours of operation, they can leave a voicemail message, send email or fax, or log a case using the Online Support
Interface. The individual Technical Support Centers are closed on certain public holidays.

<table>
<thead>
<tr>
<th>Region</th>
<th>Email</th>
<th>Web</th>
<th>Fax</th>
<th>Phone</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td><a href="mailto:support@microstrategy.com">support@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>(703) 842–8709</td>
<td>(703) 848–8700</td>
<td>9:00 A.M.–7:00 P.M. Eastern Time, Monday–Friday except holidays</td>
</tr>
<tr>
<td>EMEA: Europe</td>
<td><a href="mailto:eurosupp@microstrategy.com">eurosupp@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>+44 (0) 208 711 2525</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Middle East</td>
<td>The European Technical Support Centre is closed on national public holidays in each country.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Africa</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asia Pacific</td>
<td><a href="mailto:apsupport@microstrategy.com">apsupport@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Latam America</td>
<td><a href="mailto:latamsupport@microstrategy.com">latamsupport@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Support Liaisons should contact the Technical Support Center from which they obtained their MicroStrategy software licenses or the Technical Support Center to which they have been designated.

**Required information when calling**

When contacting MicroStrategy Technical Support, please provide the following information:

- **Personal information:**
  - Name (first and last)
  - Company and customer site (if different from company)
  - Contact information (phone and fax numbers, e-mail addresses)

- **Case details:**
  - Configuration information, including MicroStrategy software product(s) and versions
  - Full description of the case including symptoms, error messages(s), and steps taken to troubleshoot the case thus far

- **Business/system impact**

If this is the Support Liaison’s first call, they should also be prepared to provide the following:

- Street address
- Phone number
- Fax number
- Email address

To help the Technical Support representative resolve the problem promptly and effectively, be prepared to provide the following additional information:

- **Case number:** Please keep a record of the number assigned to each case logged with MicroStrategy Technical Support, and be ready to provide it when inquiring about an existing case

- **Software version and product registration numbers of the MicroStrategy software products you are using**
• Case description:
  ▪ What causes the condition to occur?
  ▪ Does the condition occur sporadically or each time a certain action is performed?
  ▪ Does the condition occur on all machines or just on one?
  ▪ When did the condition first occur?
  ▪ What events took place immediately prior to the first occurrence of the condition (for example, a major database load, a database move, or a software upgrade)?
  ▪ If there was an error message, what was its exact wording?
  ▪ What steps have you taken to isolate and resolve the issue? What were the results?

• System configuration (the information needed depends on the nature of the problem; not all items listed below may be necessary):
  ▪ Computer hardware specifications (processor speed, RAM, disk space, and so on)
  ▪ Network protocol used
  ▪ ODBC driver manufacturer and version
  ▪ Database gateway software version
  ▪ (For MicroStrategy Web-related problems) browser manufacturer and version
  ▪ (For MicroStrategy Web-related problems) Web server manufacturer and version

If the issue requires additional investigation or testing, the Support Liaison and the MicroStrategy Technical Support representative should agree on certain action items to be performed. The Support Liaison should perform any agreed-upon actions before contacting MicroStrategy Technical Support again regarding the issue. If the Technical Support representative is responsible for an action item, the Support Liaison may call MicroStrategy Technical Support at any time to inquire about the status of the issue.
Feedback

Please send any comments or suggestions about user documentation for MicroStrategy products to:

documentationfeedback@microstrategy.com

Send suggestions for product enhancements to:
support@microstrategy.com

When you provide feedback to us, please include the name and version of the products you are currently using. Your feedback is important to us as we prepare for future releases.
Introduction

A MicroStrategy Report Services document contains objects representing data coming from one or more MicroStrategy reports, as well as images and shapes. Documents can appear in almost as many ways as you can imagine and are generally formatted to suit your business needs, in a single display of presentation quality.

This chapter describes the ways in which you can design and create a MicroStrategy Report Services document. If you are new to designing documents, see Best practices for designing effective documents, page 10 before you begin a new document.

Note the following:

- While you can connect an older Desktop client to a newer Intelligence Server (such as an 8.1.x Desktop client and a 9.x Intelligence Server), none of the newer 9.x functionality for Report Services documents is supported.

- If some fonts are not available on an Intelligence Server installed on the UNIX operating system, copy True Type fonts into the Intelligence Server installation directory. Copy these fonts, which
Before you begin creating a document, you should understand how end users will use documents for data analysis. For examples of manipulating data in documents and steps to perform analysis, see the Document and Dashboard Analysis Guide.

This section describes how to display a document during the design process so that you can achieve your design goals. It also describes all display modes so you can determine which display modes to make available to end users.

Display modes in MicroStrategy Web

In MicroStrategy Web, you can view and work with a document using several display modes. For example, you might use Interactive Mode to analyze data in grid and graph reports, or you can use Flash Mode to work with Flash-only features like MicroStrategy widgets, which are a common feature of Report Services (RS) dashboards.

When a document is created, it is saved in a default display mode by the document’s designer. If the designer enabled other display modes to make them available, users can view the document in another display mode by switching display modes. (To enable or disable display modes for end users, see Determining display for end users, page 337.)

To change display modes

1. Click the name of a document to open it.

2. From the Home menu, select Design Mode, Express Mode, Editable Mode, Interactive Mode, or Flash Mode. The options available depend on your user privileges and the display modes enabled for the document.
The following summary table of display modes is a useful reference.

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>What You Can Do In It</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Mode</strong></td>
<td>• Requires document designer privileges&lt;br&gt;• Displays document structure and placeholders for document components, without associated contents&lt;br&gt;• Quicker performance, since document results are not displayed&lt;br&gt;• Create a new document&lt;br&gt;• Edit an existing document&lt;br&gt;• Add and remove dataset objects&lt;br&gt;• Insert controls such as Grid/Graph containers, text fields, lines, shapes, and panel stacks&lt;br&gt;• Edit and format controls&lt;br&gt;• Format Grid/Graph containers&lt;br&gt;• Pivot report objects on grid reports&lt;br&gt;• Use group-by</td>
<td>• Must switch modes to view the results of a document&lt;br&gt;• Cannot format all aspects of grid or graph reports, including metric values and attribute headers&lt;br&gt;• Cannot format widget Flash settings&lt;br&gt;• Cannot use selectors to flip through panels in a panel stack or display attribute elements or metrics in a grid or graph report&lt;br&gt;• Cannot use page-by to group data&lt;br&gt;• Cannot sort grid reports&lt;br&gt;• Cannot use the Fit to contents/window feature&lt;br&gt;• Cannot show or hide rulers</td>
</tr>
<tr>
<td><strong>Editable Mode</strong></td>
<td>• Requires document designer privileges&lt;br&gt;• Quickly see the affect of changes to the document&lt;br&gt;• Create a new document&lt;br&gt;• Edit an existing document&lt;br&gt;• View the results of a document&lt;br&gt;• Add and remove dataset objects&lt;br&gt;• Insert controls such as Grid/Graph containers, text fields, lines, shapes, and panel stacks&lt;br&gt;• Edit and format controls&lt;br&gt;• Format grid and graph reports, including metric values and attribute headers&lt;br&gt;• Use selectors to flip through panels in a panel stack or display attribute elements or metrics in a grid or graph report&lt;br&gt;• Use page-by and group-by to group data&lt;br&gt;• Use the Fit to contents/window feature&lt;br&gt;• Sort grid reports and pivot report objects&lt;br&gt;• Show or hide rulers</td>
<td>• Performance reflects the fact that you can see all document results as you work&lt;br&gt;• Cannot format widget Flash settings</td>
</tr>
<tr>
<td>Display Mode</td>
<td>What You Can Do In It</td>
<td>Limitations</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Interactive Mode | • Intended for document analysts  
• Optimized for RS dashboard viewing  
• Edit an existing document  
• View the results of the document  
• Use selectors to flip through panels in a panel stack or display attribute elements or metrics in a grid or graph report  
• Format grid and graph reports  
• Sort grid reports and pivot report objects  
• Add totals  
• Resize rows and columns  
• Create metrics based on report objects already on the grid report | • Cannot create a new document  
• Cannot format layout and positioning of objects on the document  
• Cannot format widget Flash settings |
| Flash Mode       | • Intended for document analysts  
• Access and interact with features provided by Flash, such as widgets  
• Edit an existing document  
• View the results of a document  
• Use selectors to flip through panels in a panel stack or display attribute elements or metrics in a grid or graph report  
• Format widget Flash settings  
• Sort grid reports and pivot report objects | • Cannot create a new document  
• Cannot manipulate or format grid and graph reports, except to sort and pivot objects on them  
• If a Grid/Graph uses a graph type that is not supported in Flash, the graph is not displayed |
| Express Mode     | • Intended for document analysts  
• View the results of the document, as you might in a static PDF file  
• Provides better performance than all other modes | • Cannot create a new document  
• Cannot edit an existing document  
• Cannot manipulate objects or interact with features on the document  
• Documents containing multiple pages cannot display ascending page numbers |

**Document views in Desktop**

In Desktop, you can open a document in the following views:

- **PDF View** (the default view), which displays the document as it will look when printed (for example, with page breaks). Use PDF View to:
  - View the document as a PDF (especially helpful to see how your changes affect the final display of the document)
  - Interactively display groups on separate pages (using page-by)
- Navigate through large quantities of data that have been grouped into separate pages of the document
- View associated websites by clicking hyperlinks
- Print the document
- Save the final PDF (by exporting it)
- Export the PDF to Excel, PDF, Flash, or HTML

- **Flash View**, which displays a preview of the document as it will look in Flash Mode in MicroStrategy Web. In Flash View, you can interact with the document by using selectors, performing some manipulations such as pivoting and sorting, and viewing and interacting with widgets.

- **HTML View**, which displays a preview of the document as it will look in other MicroStrategy Web modes.

- **Design View**, which displays the structure of the document, or the placeholders for the document objects, without the actual results. It allows you to create and edit the document and the various objects that make up the document. Use Design View for the procedures described in this manual.

## Opening a document

![Warning] If a document has embedded Transaction Services, the document does not open. Instead, a message is displayed indicating that transaction-enabled documents are not supported in Desktop.

### To open a document in Design View

1. From a project in MicroStrategy Desktop, navigate to the folder containing the document.

2. Right-click the document name or icon, and select **Edit**. The Document Editor opens.
To open a document in PDF View

1. From a project in MicroStrategy Desktop, navigate to the folder containing the document.
   
   To enhance PDF viewing performance, open Acrobat Reader before opening the document.

2. Double-click the document name or icon. The document opens in PDF View, in Acrobat Reader.

Designing and creating documents: An overview

First, you open a blank document and select a report to use as the document’s dataset. Datasets provide the data that appears in documents. Datasets define which information the Intelligence Server should retrieve from the data warehouse or cache. This information can include attributes, custom groups, consolidations, and metrics.

These dataset objects are all of the objects from the dataset report, regardless of whether they are displayed on the report. For example, if a metric is in the Report Objects but not displayed on the grid, that metric is listed as a dataset object. For background information about view reports, including the different methods to add them to a document, see Using a view report or base report as a dataset, page 74.

When you create a new document, you can select the report or Intelligent Cube to use as the dataset. Once the document is created, you can:

- Add another dataset to the document
- Replace an existing dataset with another dataset
- Replace all the datasets in the document with a single dataset
- Remove a dataset from the document

For steps, see Adding, changing, or removing a dataset, page 48.

You can create a document with multiple dataset reports, and you can add more dataset reports after you create a document. One dataset must be
defined as the grouping and sorting dataset; you can group and sort only by the objects on this dataset. For details on how multiple datasets join together in a document, see *Working with multiple dataset reports, page 51*. For instructions to change the grouping and sorting dataset, see *Changing the grouping and sorting dataset for a document, page 51*.

An Intelligent Cube is a multi-dimensional cube (sets of data) that allow you to use OLAP Services features on reports, as well as share sets of data among multiple reports and documents. You can use an Intelligent Cube as a dataset, allowing you to use one Intelligent Cube for many different documents, while reducing access to the data warehouse. For background information on using Intelligent Cubes as datasets, including how to add a Grid/Graph with an Intelligent Cube as a dataset, see *Using Intelligent Cubes as datasets, page 74*.

After you open a document and add one or more datasets to it, you add controls to the document. Controls are the objects that display the data, images, and shapes in a document. Controls are shown in the document’s Layout area as you design the document. A control can be any of the following:

- **Text field**, which displays text such as:
  - Data (attributes, consolidations, custom groups, and metrics) from the document’s dataset reports. See *Adding text and data to a document: Text fields, page 81*, for examples and instructions.
  - Static text for labels. See *Adding a static text label to a document, page 82*, for examples and instructions.
  - Information about the document (such as page numbers) and the dataset reports (such as report names and filter information). See *Displaying document and dataset report information: Auto text codes, page 88*, for examples and instructions.
  - Metrics created within the document, which use the metrics on the dataset reports to obtain data not directly available from the datasets. These include derived metrics, calculated expressions, and summary metrics. For instance, a calculated expression combines metrics from different dataset reports. For more examples, and instructions to create them, see *Working with metrics in documents, page 114*.

- **HTML container**, which displays real-time information from the web. For steps to create HTML containers, and examples of how they can be used, see *Displaying real-time web and other HTML content: HTML containers, page 142*.
• **Line** or **Rectangle**. For instructions to create lines and rectangles, and examples of how they can be used, see *Adding shapes and lines to a document, page 149*.

• **Image**. For instructions to create images, including guidelines to ensure that the images are available as needed, see *Inserting images in a document, page 151*.

• **Grid/Graph**, which displays data in the form of a standard MicroStrategy grid report or graph report. For instructions to create Grid/Graphs and examples of how they can be used, see *Chapter 3, Displaying Reports in Documents: Grid/Graphs*.

  Creating a Table Control is reserved for MicroStrategy use.

Other types of controls, such as selectors and widgets, provide interactivity and visually intuitive graphic images for users. These controls are commonly used on Report Services (RS) dashboards, which are a specific type of document providing additional interactivity. These types of controls include:

• **Panel stack**, which is a holder for a collection of panels, or layers of data, in a document. A user can navigate or flip through the panels in a panel stack; only one panel is displayed at a time.

  The document sample below shows a Grid/Graph, Employee Info By Region, on a panel in a panel stack.

<table>
<thead>
<tr>
<th>Employee Info by Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category: Sales Report</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Cost</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellenkamp</td>
<td>Nancy</td>
<td>$720,449</td>
<td>$126,778</td>
<td>$847,227</td>
</tr>
<tr>
<td>Central</td>
<td>Gale</td>
<td>Loron</td>
<td>$1,416,036</td>
<td>$253,264</td>
<td>$1,669,300</td>
</tr>
<tr>
<td>Central</td>
<td>Tormison</td>
<td>Mary</td>
<td>$1,430,865</td>
<td>$259,486</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Central</td>
<td>Zemlicka</td>
<td>George</td>
<td>$897,933</td>
<td>$124,007</td>
<td>$1,022,940</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$901,702</td>
<td>$156,330</td>
<td>$1,060,032</td>
</tr>
</tbody>
</table>

• **Selector**, which allows users to interact with the document by easily flipping through the panels in a panel stack or by displaying different attributes or metrics in a Grid/Graph.
The selector in the document sample above is the list of Grid/Graphs at the left. When a user clicks Category Sales Report, that Grid/Graph on another panel in the panel stack is displayed, as shown below.

<table>
<thead>
<tr>
<th>Category Sales Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Month</strong></td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
</tbody>
</table>

- **Widget**, which displays the results of a dataset report in Flash in MicroStrategy Web, allowing users to visualize data in different ways than traditional reports displayed as Grid/Graphs do.

For more details and examples of RS dashboards and these controls, as well as procedures to define these controls, see the *Dashboards and Widgets Creation Guide*.

Each of these different kinds of controls is referred to as a control type.

Dragging and dropping a dataset object onto the Layout area of the Document Editor creates a control. If the dragged object is a dataset report, a Grid/Graph is created; otherwise, a text field containing the dataset object is added to the Layout area. When the document is displayed as a PDF, the Grid/Graph is displayed like a MicroStrategy report; the text field displays the elements or values of the dataset object.

The document section where a control is placed determines not only the location of the values but also whether the control is repeated on subsequent pages of the document, and at what level the values are calculated. For example, some document sections, such as the Page Header or Page Footer, are appropriate for displaying page numbers because those sections are automatically repeated throughout the document. A metric placed in different document sections is calculated differently in each section. In the Detail section, the metric is calculated at the level of the attribute element, while the same metric placed in the Group Header section is calculated at the level of the group. This is described in more detail, including examples, in *Metric calculation in document sections, page 114.*
For details of each document section, including explanations of where they appear when the document is generated and the type of information they typically contain, see *Understanding and working with document sections, page 28.*

After you add controls, you can move and arrange them to determine how they appear when the document is viewed as a PDF. For instructions and examples of the various ways in which you can move and arrange controls, see *Arranging controls on a document, page 156.*

You can format the document as a whole, and also the separate controls that are included in the document. For information on the formatting available in documents, including instructions and examples, see *Chapter 4, Formatting Documents.*

Best practices for designing effective documents

Before you begin creating a document, review the best practices listed below. These suggestions will help you design an effective, attractive, and practical document.

The best practices are grouped into the following sections:

- *Gather information about your user audience, page 11*
- *Gather information about your data source, page 11*
- *Gather information about your MicroStrategy project, page 12*
- *Locate or create time-savers, page 13*
- *Design the Report Services document or dashboard effectively, page 14*
- *Best practices: Designing documents for Excel, page 15* if you are designing a document that may be exported to Excel
- *Best practices: Designing documents for Kindle and Nook, page 16* if you are designing a document that may be exported to a Nook or Kindle
Gather information about your user audience

Ask yourself who the audience is for the document you plan to create. Questions you should have answers to include:

- What is the main topic area the document needs to address? In other words, at a general level, what do users need to know?
- What level of detail do users need? For example, sometimes executive level users only want to see a few key metrics of certain data. Other analysts may need to see very detailed financial numbers or inventory counts.
- What types of documents do users expect? Higher level executives sometimes have expectations about how data is displayed in a document, so it can be helpful to ask what types of documents they are used to receiving, and whether it is important to try to adhere to that data display style.
- Who is your universe of users made up of?
  - If your universe of users is extremely diverse, consider making documents as flexible as possible for each user who executes them, by adding prompts. A prompt asks users questions about the results they want to see on a document, and then submits the appropriate query to the data source. For an introduction to prompts, see the Basic Reporting Guide.
  - Your universe of users may include different security requirements. For example, you may need a single document for a group of users, but that group includes both external and internal users, and you want to restrict some data from external view. You must confirm that appropriate security is in place for a document’s underlying objects, and that security filters are in place to control row-level access to data. Object-level security is performed using ACLs, or access control lists.

Security filters and ACLs are generally implemented by your system administrator, but one or both may be under the control of your project designer. See the System Administration Guide for details on security filters, ACLs, and other security features.

Gather information about your data source

If you need an introduction to or refresher on data sources, see the Basic Reporting Guide.
Make sure the data your organization stores can support the information your users want to analyze in a reporting environment. Questions you should ask include:

- Does your organization gather the data that users want to see documents on?

- Is your data organized in such a way that it can be used? Is the data reliable, and is it clean? One way to check on the reliability of your data is to create some simple grid reports designed to validate whether your data reflects your understanding of reality.

For example, if you have a good sense of how many customers own two or three of your organization’s products, create a report that shows basic data on the count of customers who purchased those specific products over the past few years. If the numbers you see in the report do not come close to what you expected to see, it is worthwhile to spend some time with your database administrator to address the reliability of the data stored in your data source.

**Gather information about your MicroStrategy project**

Many of the objects within a project are generally created by the project’s designer when the project is first created. Since you use these objects to design datasets for documents, it can be useful to understand your project’s design, and specifically how the project’s objects reflect the actual data in your organization’s data source. In this way, you can choose objects to use in datasets with full knowledge of the data source tables that data is coming from when the document is executed.

For details on general project design and data modeling, see the *Project Design Guide*.

Questions you should ask about your project include:

- Do objects exist in the MicroStrategy metadata which match what users want to see on documents? If not, you (or a user with the appropriate privileges) can create them.

MicroStrategy provides flexibility in combining information from your data source into specific objects which reflect the concepts that make sense to your users. Consolidations and custom groups are just two examples of ways you can present data to your users in a way that does not directly reflect your data source’s storage structure. For an introduction to consolidations and custom groups, see the *Advanced Reporting Guide*. 
• What VLDB (Very Large Database) options have been set? These settings affect how the SQL is written when a document sends a SQL query to your data source. VLDB settings are usually determined by an administrator, but some may also be defined by a project’s designer. All VLDB settings are described in detail in the MicroStrategy Supplemental Reference for System Administration.

• What project configuration settings have been set that will affect reports or documents? Ask your project designer about any configuration settings made for the project as a whole, because most reports and report objects revert to the project’s settings when no object-specific or report-specific settings override them.

**Locate or create time-savers**

• Before you create a document, search through MicroStrategy to see whether a similar document already exists that can serve the same purpose as the document you intend to create. This can save you time and help you avoid unnecessary duplication in your MicroStrategy metadata.

You can deploy out-of-the-box documents to your project by reconciling the documents’ content to your own project objects. For example, you can use a Report Services document or dashboard from the MicroStrategy Tutorial project or any of the Analytical Modules projects, in your own project. To do this, you use the portable documents feature. A portable document contains all the design of the document without the data, allowing you to copy documents between projects, even when the projects do not have the same metadata. When you import the document into the replacement project, you map the document to the new project (referred to as reconciling the document). For steps to create and reconcile portable documents, see *Portable documents: Reusing documents across projects, page 505.*

• Before you create the finished document, use Microsoft Excel, Paint, PowerPoint, or another tool to create a mock-up of the document you intend to design. Send the mock-up to your user community to gather their feedback on its usefulness. This can save you valuable time creating a complex, finished document that may have to be redone.

• You can select multiple controls on a document so that you can perform an action on all of them, such as formatting, aligning, or sizing. To select multiple controls, press and hold CTRL while you click each control.
Design the Report Services document or dashboard effectively

• Hide unused document sections (by collapsing the section on the template) so that the document is easier to work with. See Displaying, hiding, and resizing document sections, page 37.

• Use the grouping feature and/or incremental fetch to minimize the amount of data passed between the web server and the web browser, for documents designed to be viewed in MicroStrategy Web. See Grouping records in a document, page 374 and Improving document execution performance, page 494.

• Determine whether the dataset(s) will return a large amount of data. If so, consider adding grouping to the document, by choosing which attributes you want to group the pages by. See Grouping records in a document, page 374.

• Make the following decisions as you are planning the design of your document, not after you are finished:
  ▪ Determine the logic for page breaks. See Adding page breaks and numbering pages, page 343.
  ▪ Decide what export options you will enable for users of this document. See Formatting a document for export, page 363.
  ▪ Decide whether you need landscape or vertical orientation to best display the data you want to include. See Formatting a document for exporting or printing, page 342.
  ▪ If the document will be viewed in PDF, be sure to include bookmarks. See Including or hiding bookmarks in PDFs, page 356.

• Do not include so many graphical objects that the data becomes unimportant. Make sure the data is the main focus of the document. The overall goal is to achieve a clean look.

• Plan your design so that all related data can be seen on a single screen or page, and that it can be interpreted from the top left to the bottom right.

• Save your document frequently as you design and make formatting changes to it.
Best practices: Designing documents for Excel

The following best practices will help ensure that your document is displayed correctly when it is exported to Microsoft Excel. When you export to Excel, the resulting spreadsheet looks like a PDF of the document. For example, objects have the same position and size in Excel that they do in a PDF.

For steps to export a document to Excel, see the Document and Dashboard Analysis Guide or click Help.

When designing a document that might be exported to Excel, do the following to ensure that the document is displayed correctly in Microsoft Excel:

- Know how different object types are exported and displayed in Excel, as shown in the following table:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Excel Export Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text field</td>
<td>Data in spreadsheet cells</td>
</tr>
<tr>
<td>Grid/Graph:</td>
<td></td>
</tr>
<tr>
<td>• Displayed as a grid</td>
<td>• Data in spreadsheet cells</td>
</tr>
<tr>
<td>• Displayed as a graph</td>
<td>• Excel chart object</td>
</tr>
<tr>
<td>• Displayed as both a grid and a graph</td>
<td>• A combination of the above</td>
</tr>
<tr>
<td>Line</td>
<td>Not exported</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Not exported</td>
</tr>
<tr>
<td>Image</td>
<td>Linked image</td>
</tr>
</tbody>
</table>

- Choose Excel-compatible colors for all objects, including panels, shapes, and Grid/Graphs. Use the set of 40 colors that appear in the Color dialog box in the Document Editor. Excel supports these 40 colors in addition to many more. Other colors are matched by Microsoft Excel as closely as possible. Avoid using gradient colors, since they are not exported to Excel.

- Use graph styles that are supported by Microsoft Excel. For example, if you include a Gauge graph in the document, it is not displayed in Excel. If you include a Combination graph, the exported version in Excel may not be displayed exactly like the original graph in MicroStrategy Web. For a list of graph types that appear differently in Excel than in MicroStrategy, see Displaying images in Excel, page 368.
• Avoid overlapping objects. When exported, the document may not be displayed correctly. For example, an object in the background of the document may be displayed in the foreground of the Excel spreadsheet.

• Provide extra space around objects because they may increase in size when the document is exported to Excel.

• Use text field borders to create lines and rectangles. Standard MicroStrategy line and rectangle controls may not be displayed correctly in Excel. You can also use a panel stack to create a colored background; for instructions to create panel stacks, see the Dashboards and Widgets Creation Guide.

• Avoid inserting line breaks within text fields. Line breaks (inserted by typing CTRL+ENTER) are not rendered in Excel.

• Do not enable word-wrapping in a column header on a Grid/Graph in MicroStrategy. If you do so, the headers are not displayed correctly in Excel or PDF. Enable word-wrapping in Excel after you export the document.

• Use an absolute file path to define the location of an image used in a document. Do not use a relative file path. Images in documents specified with paths relative to MicroStrategy Web and Intelligence Server are not displayed when exported to Excel.

Best practices: Designing documents for Kindle and Nook

You can export a document to a PDF, then transfer the PDF to a Kindle or Nook for viewing. A Kindle user can go to a specific page in the PDF, search for text phrases, and switch between landscape to portrait view (on the Kindle DX). A Nook user can use bookmarks to jump to a specific section of the PDF, go to the last read page, change the text font size, rotate PDF pages, and search for text phrases.

For directions to export a document to PDF, see the Document and Dashboard Analysis Guide or click Help.

When designing a document that might be viewed on a Kindle or Nook, do the following to ensure that the document is displayed correctly:

• If the document contains multiple layouts, set the default export option to export all layouts. This ensures that the Kindle or Nook user can view all the data. For information about multiple layouts, see Creating multi-layout documents, page 476; for information about setting default export options, see Specifying default export options, page 365.
• If your document contains page-by fields, set the default export option to export all pages. This ensures that the Kindle or Nook user can view all the data. For information about page-by, see Using page-by on a document, page 403; for information about setting default export options, see Specifying default export options, page 365.

• If the document will be viewed on a Nook, include bookmarks so that a user can quickly access a specific section of the document. Bookmarks are displayed in the PDF in a tree format, creating a table of contents as a navigation aid. Bookmarks are created only when a document is grouped or contains multiple layouts. For instructions to create bookmarks, see Including or hiding bookmarks in PDFs, page 356.

• Embed fonts in the PDF, so that bullets, thresholds, and any other objects that require special fonts are displayed correctly. A Nook user can change the text font only if the fonts are embedded. For instructions, see Embedding fonts in PDFs, page 353.

• Both the Kindle and the Nook have a gray-scale display, so be sure that the contrast in graphs and other images are high enough so that a user can easily distinguish between different areas.

• The Kindle resizes the PDF to the size of the Kindle screen, so ensure that text and graphics are sized large enough to be clearly viewable on the Kindle.

Creating documents

You can create a document in one of several ways, depending on your needs:

• On your own from start to finish using the Document Editor, which allows you to select the information to be included and the formatting of the document (see Creating a document from scratch, page 18). You can add one or more dataset reports to the document.

• Using another document as a template, which allows you to pattern the new document after an existing one (see Creating a document using another document as a template, page 20). The same dataset, controls, formatting, and layout as the template are used in the new document. You can add to or modify the new document after it is created.

• From a report. The report is added as a Grid/Graph (an object that acts like a standard MicroStrategy report) in the Detail Header of the new document (see Creating a document from a report, page 25). You can also select multiple reports at the same time to create a multi-layout

You can also create, edit, or delete multiple documents at the same time by using a Command Manager script. Command Manager is a MicroStrategy tool designed to automate certain tasks and processes. For example, you can create multiple empty documents that use the same document template. For more information about Command Manager, including instructions, see the Command Manager chapter of the System Administration Guide.

For steps to create a document in MicroStrategy Desktop, see the Desktop Help.

Prerequisites

- To create a document using any method (from scratch, from a template, or from a report), you must have the necessary document designer privileges in MicroStrategy. For details, contact your administrator.

- To create a document from a report, it is assumed that the report is already created and saved. See the Basic Reporting Guide for steps to creating reports.

Creating a document from scratch

When you create a document from scratch, you can select the information to be included on the document and the formatting of the document. Documents use datasets as sources for the objects placed on the documents.

To create a document using the Document Editor


2. If you have the appropriate privileges, the View document in Design Mode check box is selected by default. Clear the check box if you want to open the document in the default mode specified by the template’s designer.
3 Select **Blank Document** in the Document Templates area (you may have to scroll down). A new document opens in Design Mode.

**Add a dataset report**

4 To designate a report to supply the data for your document, do one of the following:

- From the **Data** menu, select **Add Dataset**.
- Click the **Add Dataset** icon on the Dataset Objects panel on the left.

The Select Dataset dialog box opens.

5 Browse to and select the MicroStrategy report or reports to use as datasets. You can type a name in the **Find** field to locate a specific report.

6 Click **OK**. The selected dataset and its objects are displayed in the Dataset Objects panel.

   If you have OLAP Services, be aware that the Dataset Objects panel contains all of the objects from the dataset report, regardless of whether they are displayed on the report. For example, even if a metric is in the Report Objects but not displayed on the report’s grid, that metric is still listed as a Dataset Object.

7 Repeat the steps above, starting at **Add a dataset report**, for each dataset you want to include in the document.

   If you include multiple datasets on the document, the first dataset in alphabetical order is defined as the grouping and sorting dataset. You can sort and group the document using fields from the grouping and sorting dataset. For steps to change the grouping and sorting dataset, see **Defining a dataset as primary or secondary, page 60**. For an introduction to using multiple datasets in documents, see **Working with multiple dataset reports, page 51**.

**Add objects to the document**

8 Select and add the dataset objects to the appropriate sections in the document. Dataset objects can be added to the document inside various fields, grid or graph reports (Grid/Graphs), or HTML containers. You an also add images and shapes. For details of each, see:

   - **Adding text and data to a document: Text fields, page 81**
• Displaying document and dataset report information: Auto text codes, page 88
• Adding a Grid/Graph to a document, page 170
• Displaying real-time web and other HTML content: HTML containers, page 142
• Inserting images in a document, page 151
• Adding shapes and lines to a document, page 149

9 Arrange the controls as you like. For steps, see Arranging controls on a document, page 156.

10 Format the various controls and sections, as well as the document as a whole. For descriptions of the various formatting options, and steps to apply them, see Chapter 4, Formatting Documents.

11 Group and sort the data. For instructions and background information, see Grouping and Sorting Records in a Document, page 373.

12 Add totals, if desired. For instructions, see Calculating totals in documents, page 125.

Save the document

13 Save the document by selecting Save As from the Home menu.

14 Type a name for the document and click OK.

Creating a document using another document as a template

You can save a document as a template and create new documents based on template. Any new document made using this template will contain the same underlying datasets, fields, formatting, and layout as the template document. After the new document is created, you can edit the new document as you want.
A document automatically becomes a template when it is saved in the Object Templates/Documents folder. It is then available as a choice in the New Document dialog box when you create a new document.

The Object Templates folder is a hidden folder. To see it, use the steps below to have hidden objects displayed.

1. In Desktop, from the Tools menu, choose Desktop Preferences. The Desktop Preferences dialog box opens.
2. Expand the Desktop folder, and click Browsing.
3. At the bottom of the dialog box on the right, select Display Hidden Objects.
4. Click OK. The Object Templates folder appears in your project list.

MicroStrategy provides predefined document templates, including the Blank Document template and the Blank Dashboard template. Use the Blank Document template to create a traditional document, with multiple sections. The Blank Dashboard template displays only one section, the Detail Header, allowing you to easily design a Report Services (RS) dashboard using the whole screen. For a detailed description of the Blank Dashboard template, including default settings and an example of a document created with it, see the Dashboards and Widgets Creation Guide.

Steps are below to create new document templates from scratch. Steps are also below to create a new template, and to import and export documents between projects to use as document templates.

You can also use portable documents to reuse documents across projects. Unlike a document template imported and exported between projects, a portable document can contain dependencies on schema or application objects, such as a dataset report. After importing a portable document into a project, you reconcile the document to the new project. For more details on portable documents and the reconciliation process, including reasons to use them and instructions, see Portable documents: Reusing documents across projects, page 505.

Do not confuse document templates and Autostyles. Autostyles contain formatting information only, while document templates contain datasets, controls, and layout as well. Layout templates, available only in the Document Wizard, affect only the position and placement of controls on the document.
To create a document using a document template

1 In MicroStrategy Web, click the MicroStrategy icon at the top of any page and select New Document. The Create Document page is displayed.

2 If you have the appropriate privileges, the View document in Design Mode check box is selected by default. Clear the check box if you want to open the document in the default mode specified by the template’s designer.

3 Document templates are listed on the Create Document page. Select a document template. The new document opens in Design Mode, displaying the datasets, controls, formatting, and layout of the template.

Add a dataset report

The document template may already include a dataset report. You can add other datasets, as described below. You can also remove datasets; for steps see Adding, changing, or removing a dataset, page 48.

4 To designate a report to supply the data for your document, do one of the following:
   • From the Data menu, select Add Dataset.
   • Click the Add Dataset icon on the Dataset Objects panel on the left.

The Select Dataset dialog box opens.

5 Browse to and select the MicroStrategy report or reports to use as datasets. You can type a name in the Find field to locate a specific report.

6 Click OK. The selected dataset and its objects are displayed in the Dataset Objects panel.

   If you have OLAP Services, be aware that the Dataset Objects panel contains all of the objects from the dataset report, regardless of whether they are displayed on the report. For example, even if a metric is in the Report Objects but not displayed on the report’s grid, that metric is still listed as a Dataset Object.

7 Repeat the steps above, starting at Add a dataset report, for each dataset you want to include in the document.

   If you include multiple datasets on the document, the first dataset in alphabetical order is defined as the grouping and sorting
dataset. You can sort and group the document using fields from the grouping and sorting dataset. For steps to change the grouping and sorting dataset, see Changing the grouping and sorting dataset for a document, page 51. For an introduction to using multiple datasets in documents, see Working with multiple dataset reports, page 51.

### Add objects to the document

**8** Add controls such as data, Grid/Graphs, images, shapes, and web feeds to the document. For examples and steps, see the following:

- Adding text and data to a document: Text fields, page 81
- Displaying document and dataset report information: Auto text codes, page 88
- Displaying real-time web and other HTML content: HTML containers, page 142
- Adding shapes and lines to a document, page 149
- Inserting images in a document, page 151
- Adding a Grid/Graph to a document, page 170

**9** Move, size, and align the controls that you added. For steps, see Arranging controls on a document, page 156.

**10** Format the document and controls by applying colors, effects, borders, drop shadows, gradients, and more. For descriptions of the various formatting options, and steps to apply them, see Chapter 4, Formatting Documents.

**11** Group and sort the data, as required. For descriptions of these options, and steps to apply them, see Chapter 5, Grouping and Sorting Records in a Document.

**12** Add totals, if desired. For instructions, see Calculating totals in documents, page 125.

**13** Save the document by selecting Save As from the Home menu.

**14** Type a name for the document and click OK.
To create a new template for documents

If you want a document to be available as a template so that you can format your other documents based on it, save it or copy it to the following folder in Desktop:

`Project name\Object Templates\Documents`

The document will then be available as a template for selection in the Create Document page in MicroStrategy Web and the New Document dialog box in Desktop, when you create a new document.

The Object Templates folder is hidden by default. To display it, from the Tools menu in Desktop, select Desktop Preferences. On the Desktop tab, click Browsing Options. Select the Display Hidden Objects check box and click OK.

To export a document template

A document can be exported from one project and then imported into another project to use as a template to create a new document. The document cannot have any dependencies on schema or application objects, such as a dataset report.

1. In Desktop, select the document to export.
2. From the Tools menu, select Export Document Template. The Browse for Folder dialog box opens.
3. Navigate to the folder to save the file in, then click OK.

The document, named `document_name.rst`, is saved in the selected folder.

To import a document template

After you export a document from one project, you can import it into another project to use it as a template to create new documents.

1. In Desktop, from the Tools menu, select Import Document Template. The Open dialog box opens.
2 Navigate to and select the file to import as a document template.

3 Click Open.

The document template is saved in the Object Templates\Documents folder in Desktop.

Creating a document from a report

You can quickly and easily create a document from an existing report. The report is added as a Grid/Graph (an object that acts like a standard MicroStrategy report) in the Detail Header section of a document. For full details on Grid/Graphs, including formatting, display modes, and view filters, see Chapter 3, Displaying Reports in Documents: Grid/Graphs.

The Grid/Graph reflects the definition of the report as closely as possible, as described below:

• The Grid/Graph uses the same definition as the report, including all embedded objects and derived metrics.

  The current view of the report is used as the definition of the Grid/Graph in the document. For example, an attribute that is in the Report Objects pane but not on the report grid is not included in the Grid/Graph, although it is included as a dataset object.

  Training metrics, used for Data Mining Services, will create predictive metrics when the document is executed, if they are included on the Grid/Graph and defined to automatically create predictive metrics. For background information about Data Mining Services, including training metrics, see the Data Mining Services chapter of the Advanced Reporting Guide.

• The mode in which the Grid/Graph is displayed is the same as the report-viewing mode for the report. A graph report creates a Grid/Graph that displays as a graph, and a grid report creates a Grid/Graph that displays as a grid. A report that displays as SQL is displayed as a grid in the document.

• All report formatting is duplicated in the Grid/Graph.

• If the report has a view filter, it is applied to the Grid/Graph.
• Any prompt answers that are stored in the report are copied to the document.

For an introduction to prompts in reports, and steps to create them, see the Building Query Objects and Queries, for Designers chapter of the Basic Reporting Guide.

• If page-by is applied to the report:
  ▪ The page-by fields are added as grouping fields on the document, based on the following:
    – The current element for each of the page fields in the report is set as the current element for each of the grouping fields in the document.
    – If a current element is not selected in the report, the first group-by element, other than All, is used. This scenario can occur when the report was not executed before a document was created from it; therefore, an element was not selected for the page-by. It can also occur if a subtotal is selected as the page-by in the report because documents do not allow subtotals as grouping elements.
    – If neither of the options above are possible, the grouping field is set to All. This scenario can occur when the report was not executed before a document was created from it; therefore, an element was not selected for the page-by. It can also occur if a subtotal is selected as the page-by in the report because documents do not allow subtotals as grouping elements.
  ▪ A Group Header and Group Footer for each page-by field are added to the document.

For information on how grouping and sorting works, including examples and instructions, see Grouping records in a document, page 374, and Using page-by on a document, page 403. For background information on page-by in reports, see the Building Query Objects and Queries, for Designers chapter of the Basic Reporting Guide.

Prerequisite

You must save the report before creating a document from it.
To create a document from a report

1 In MicroStrategy Web, do one of the following:
   - From a folder, right-click a report and then select Create Document.
   - Execute the report. Select Create Document from the Tools menu. The new document opens in Express Mode. To edit the document, click the Design Mode icon on the toolbar.

   The new document opens in Design Mode, with the report set as the grouping and sorting dataset and displayed as a Grid/Graph in the Detail Header section of the document.

2 Format or edit the Grid/Graph. For steps to edit and format Grid/Graphs, as well as background information about Grid/Graphs, see Chapter 3, Displaying Reports in Documents: Grid/Graphs.

3 Format and edit the rest of the document. A few suggestions are listed below:
   - Select additional data for the document. Add data fields, auto text codes, text labels, images, and other controls. See the following for instructions:
     - Adding text and data to a document: Text fields, page 81
     - Displaying document and dataset report information: Auto text codes, page 88
     - Displaying real-time web and other HTML content: HTML containers, page 142
     - Adding shapes and lines to a document, page 149
     - Inserting images in a document, page 151
     - Adding a Grid/Graph to a document, page 170
   - Move, size, and align the controls that you added. For instructions, see Arranging controls on a document, page 156.
   - Change the formatting of the document. You can format the various controls and sections, as well as the document as a whole. For descriptions of the various formatting options, and instructions to apply them, see Chapter 4, Formatting Documents.
• Group and sort the data. For instructions, see Chapter 5, Grouping and Sorting Records in a Document.

• Add totals, if desired. For instructions, see Calculating totals in documents, page 125.

4 Save the document by selecting Save As from the Home menu.

5 Type a name for the document and click OK.

Understanding and working with document sections

A section of a document is a portion of the document that is commonly used for a specific purpose or certain type of information. For example, headers generally contain titles or other general information that should be shared at the top of all pages of the document. Likewise, footers generally contain page numbers or other similar information.

The Layout area of the Document Editor displays all the document’s sections, as shown below:

If the document is grouped, a Group Header section is displayed between the Document Header and the Detail Header, and a Group Footer section between the Detail Footer and the Document Footer. (When you group records in a document, you define the document’s hierarchy and therefore its inherent sort order. You can then sort a group in either ascending or
descending order. For examples of grouped documents, see *Grouping records in a document, page 374.*

The following document sample shows a document grouped by Region, so a Region Header and a Region Footer are displayed. The document contains only one layout, so a single Document Header and Document Footer are displayed.
The first page of the executed document is shown below.

|Page Header| Printed: 6/30/2009 |
|Document Header| Document name: Regional Revenue |
|Region (Group) Header| Data for the Central region |
|Detail Header| Employee Name Revenue |
|Detail| Ellerlamp;flancy $847,227 |
|Detail| Galile;oren $1,669,290 |
|Detail| Torriton;mary $1,690,350 |
|Detail| Zemlicka;george $822,500 |
|Detail Footer| |
|Region (Group) Footer| Total Revenue for Central: $5,029,366 |
|Region (Group) Header| Data for the Mid-Atlantic region |
|Detail Header| Employee Name Revenue |
|Detail| Bernstein;lawrence $1,060,632 |
|Detail| Brown;verson $331,735 |
|Detail| Corcoran;heter $325,147 |
|Detail| Follas;adriene $1,047,776 |
|Detail| Hollywood;robert $1,025,874 |
|Detail Footer| |
|Page Footer| Page 1 of 5 |

The only document section not displayed on the first page is the Document Footer, which appears at the end of the document. The following sample shows the last page of the document, with the Document Footer.

|Page Header| Printed: 6/30/2009 |
|Region (Group) Footer| Total Revenue for Web: $3,912,782 |
|Document Footer| Total Revenue: $35,021,708 |

Page Footer Page 5 of 5

The Page Footer was moved up on the page to conserve space.
If the document contained multiple layouts, the Document Header and Document Footer are replaced by the Layout Header and Layout Footer, as shown in the multi-layout document below:

```
<table>
<thead>
<tr>
<th>Layout 1</th>
<th>Layout 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>+ Page Header (shared)</td>
<td>+ Page Header (shared)</td>
</tr>
<tr>
<td>+ Layout Header</td>
<td>+ Layout Header</td>
</tr>
<tr>
<td>+ Region Header</td>
<td>+ Region Header</td>
</tr>
<tr>
<td>+ Detail Header</td>
<td>+ Detail Header</td>
</tr>
<tr>
<td>+ Detail</td>
<td>+ Detail</td>
</tr>
<tr>
<td>+ DetailFooter</td>
<td>+ DetailFooter</td>
</tr>
<tr>
<td>+ RegionFooter</td>
<td>+ RegionFooter</td>
</tr>
<tr>
<td>+ LayoutFooter</td>
<td>+ LayoutFooter</td>
</tr>
<tr>
<td>+ PageFooter (shared)</td>
<td>+ PageFooter (shared)</td>
</tr>
</tbody>
</table>
```

The Page Header and the Page Footer are shared, by default, although you can change that. For steps to create a multi-layout document, see *Creating multi-layout documents, page 476*.

Each document section is described below, with an explanation of where it appears when the document is generated, and the type of information it typically contains.

This chapter also contains information on collapsing, expanding, hiding, and resizing document sections; for details, see *Displaying, hiding, and resizing document sections, page 37*. You can also insert additional sections within the predefined document sections. This allows you to customize a section without affecting another section. For examples and steps, see *Adding sections in documents, page 39*.

### Page Header

The Page Header section and the controls within it print at the top of every page in the document. Any data fields placed in the Page Header are calculated once for the entire document, and then repeated on every page.

You can use the Page Header for the types of controls that will not change from page to page, such as a logo, the document title, execution time, and so on. For information about these auto text fields, see *Displaying document and dataset report information: Auto text codes, page 88*. 
Page Header in a multi-layout document

If a document contains multiple layouts, the Page Header sections are shared for all layouts. You can change this setting so that each layout has a separate Page Header. For an example and steps, see Using a separate Page Header and Page Footer for a layout, page 484.

Document Header

This section prints once at the beginning of the document immediately below the Page Header section. Any data fields placed in the Document Header are calculated using all of the data in the document. The Document Header can be used for grand totals and document information, such as the name and execution time.

Document Header in a multi-layout document

If a document contains multiple layouts, the Document Header is replaced by the Layout Header, described below.

Layout Header

The Layout Header only appears in multi-layout documents. This section prints once at the beginning of the layout, immediately below the Page Header section. Any data fields placed in the Layout Header are calculated using all of the data in the layout. For example, a metric in the Layout Header displays as a grand total.

Each layout of a multi-layout document contains a Layout Header and a Layout Footer, so a document can contain several Layout Header sections and several Layout Footer sections.

A document with only one layout has a Document Header, described above, instead of Layout Headers.
Group Headers

In Design View/Mode, this type of section is displayed as Group Header, where Group is replaced by the name of the group, such as Region.

If the document is grouped, the Group Headers follow the Document Header. If the document contains multiple layouts, the Group Headers are displayed after the Layout Header. The Group Headers can be used to display information about the group, such as the group element (such as Northeast or Southwest) and group totals.

For each field in the Grouping panel at the top of the editor, there is a corresponding header and footer surrounding the Detail sections. For example, if you have Region and Year in the Grouping panel, the layout area of the document has a pair of Region Header/Footer sections and a pair of Year Header/Footer sections as shown in the following example.

For the attribute that is farthest to the left in the Grouping panel, its corresponding header follows the Document Header or Layout Header section. The rightmost attribute Group Header immediately precedes the Detail Header. All other headers for attributes in the Grouping panel fall in between.

You can also display groups horizontally (across the page) instead of vertically. If you choose to display groups horizontally, the Group Header, Group Footer, Detail Header, Detail Footer, and the Detail sections are all displayed horizontally. For an example and steps, see Displaying a group horizontally, page 389.
Detail Header

<table>
<thead>
<tr>
<th>Detail Header</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Name</td>
</tr>
</tbody>
</table>

The Detail Header is commonly used to display column headings, above their corresponding data fields in the Detail section. You can also have the column headings repeat on each page.

This section immediately precedes the Detail section of the document. If the document is not grouped, the Detail Header follows the Document Header. If the document is grouped, it follows the Group Headers.

If the document contains multiple layouts, the Layout Header replaces the Document Header, so the Detail Header follows either the Layout Header or the Group Headers.

You can display the Detail Header, Detail, and Detail Footer sections horizontally across the page, instead of vertically. For an example, reasons to use horizontal display, and steps, see Displaying sections horizontally, page 293.

Detail

<table>
<thead>
<tr>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellerkamp:Nancy</td>
</tr>
<tr>
<td>Gale:Loren</td>
</tr>
<tr>
<td>Torrison:Mary</td>
</tr>
<tr>
<td>Zemlicka:George</td>
</tr>
</tbody>
</table>

This section often contains the main content of the document. One row prints for each row of data in the document’s dataset. Typically, this is where you place most of the attributes and metrics. The Detail section provides the most detailed or granular information.
You do not always need to use the Detail section of a document. You can place controls in the Group Header, for example, to aggregate data to a higher level. In addition, you cannot place a Grid/Graph in the Detail section. A Grid/Graph displays a MicroStrategy report in a document. Since controls in the Detail section are repeated once per row of the dataset, the Grid/Graph would be repeated on each row. You can place a Grid/Graph anywhere in a document except in the Detail section. For examples, and steps to create Grid/Graphs, see *Chapter 3, Displaying Reports in Documents: Grid/Graphs*.

You can display the Detail section horizontally, across the page, instead of vertically. For an example, reasons to use horizontal display, and steps, see *Displaying sections horizontally, page 293*.

**Detail Footer**

<table>
<thead>
<tr>
<th>Detail Footer</th>
</tr>
</thead>
</table>

Controls in this section print immediately following the Detail section. This is typically a good place for totals. In this document, totals are placed in the Region Group Footer, so there was no need to duplicate them here.

You can also display the Detail Header, Detail, and Detail Footer sections horizontally across the page, instead of vertically. For an example, reasons to use horizontal display, and instructions, see *Displaying sections horizontally, page 293*.

**Group Footers**

<table>
<thead>
<tr>
<th>Region (Group) Footer</th>
<th>Total Revenue for Central: $5,029,366</th>
</tr>
</thead>
</table>

In Design View/Mode, this type of section is displayed as *Group Footer*, where *Group* is replaced by the name of the group, such as Region.

Group Footers are used to display totals at the group level. The order of the Group Footer sections varies depending on the fields in the Grouping panel, as described in *Group Headers, page 33*.

You can display groups horizontally across the page, instead of vertically. If you choose to display groups horizontally, the Group Header, Group Footer, Detail Header, Detail Footer, and the Detail sections are all displayed.
horizontally. For an example and steps, see *Displaying a group horizontally*, page 389.

### Layout Footer

The Layout Footer only appears in multi-layout documents. This section displays only once, at the end of the layout. It can be used to display closing notes, a conclusion, or a summary.

Each layout of a multi-layout document contains a Layout Header and a Layout Footer. Therefore, a document can contain several Layout Headers and several Layout Footers, unlike other document sections.

A document with only one layout has a Document Footer, described below, instead of a Layout Footer.

### Document Footer

| Document Footer | Total Revenue: $35,023,708 |

The Document Footer displays once at the end of the document. It can be used to display information such as closing notes, a conclusion, or a summary.

### Document Footer in a multi-layout document

If a document contains multiple layouts, the Document Footer is replaced by the Layout Footer, described above.

### Page Footer

| Page Footer | Page 1 of 5 |

The Page Footer displays at the bottom of every page in the document. You may want to insert the page number or the date/time in this section.
Page Footers in a multi-layout document

If a document contains multiple layouts, the Page Footers are shared for all layouts. You can change this setting so that each layout has a separate Page Footer. For an example and steps, see Using a separate Page Header and Page Footer for a layout, page 484.

Displaying, hiding, and resizing document sections

You can hide or display sections of a document for several purposes, as well as resize sections:

- Collapsing and expanding document sections for design purposes, page 37
- Displaying and hiding document sections for end users, page 38
- Displaying document sections horizontally, page 39
- Resizing document sections, page 39

For information on hiding and displaying sections in the finished document, see Hiding or displaying sections for a finished document, page 289.

Collapsing and expanding document sections for design purposes

Collapsing sections conserves space within the editor as you design the document. Collapsing a section does not affect its size or whether controls in it appear or are hidden when the document is viewed as a PDF.

By default, when you create a new document using the Blank Document template, the Detail Header, Detail section, and Detail Footer are expanded. The other sections are collapsed.

The Blank Dashboard template displays only one section, the Detail Header, by default, allowing you to easily design a Report Services (RS) dashboard using the whole screen.

To expand or collapse a document section, click the plus sign or minus sign next to it (as highlighted in the example below).
You can also create your own template that has the sections that you commonly work with expanded by default. For steps to create a document using a template and to create a template, as well as general information about templates, see *Creating a document using another document as a template, page 20*.

**Displaying and hiding document sections for end users**

You can determine whether end users open a document with certain sections hidden or displayed. For example, a Page Footer section contains page numbers, which makes sense in a printed document but not in one displayed in MicroStrategy Web. In this case, you can hide the Page Footer in all MicroStrategy Web modes but display it when the document is viewed as a PDF. (The section is still displayed in Design View/Mode in both Desktop and MicroStrategy Web.) For steps and examples, see *Hiding or displaying sections for a finished document, page 289*.

By default, all document sections are displayed to all users, in all views in Desktop and in all modes in MicroStrategy Web. If a section is empty and does not contain any controls, that section is automatically not displayed to users.

If the document contains multiple layouts, you can hide and display different sections for different layouts. Each layout is independent of the others in this regard. For background information on multi-layout documents, including which options apply to the document as a whole or to individual layouts, see *Creating multi-layout documents, page 476*.
Displaying document sections horizontally

The Detail Header, Detail, and Detail Footer sections can be displayed horizontally so that they are listed across the page instead of vertically. In the following image, only these horizontally arranged sections are expanded.

For an expanded example, reasons to use horizontal display, and steps, see Displaying sections horizontally, page 293.

You can also horizontally display the Group Header and Group Footer for a group. For an example and steps, see Displaying a group horizontally, page 389.

Resizing document sections

To resize a document section, drag its lower boundary to make it larger or smaller. By default, sections expand to fit the controls that they contain but they do not shrink if the controls are smaller than the size of the section. For steps to use the section size options in combination, see Changing the size of a section, page 296.

Adding sections in documents

You can add other sections to the predefined document sections. This allows you to customize a section without affecting another section. For example, you may want one section that repeats before the Detail section and after any Group Headers, and a second section that does not repeat. You can add an additional section within the Detail Header, which divides the Detail Header into two sections, and set the options for each section.
As shown in the following example, the Detail Header of the document has two sections in it.

The first Detail Header section contains an explanation of how the metrics are calculated. It does not repeat on every page in the document because the explanation is needed only once. The second Detail Header section contains column headers and repeats on each page in the document. When viewed as a PDF, the sample document appears as follows.

### NOTE:
End on hand is calculated by taking the number of Begin on hand and subtracting any Units sold and adding any Units received.

<table>
<thead>
<tr>
<th>Item</th>
<th>End on hand</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFX 5” AM/FM Portable TV</td>
<td>23</td>
<td>1,582</td>
</tr>
<tr>
<td>RCA 32” Stereo TV</td>
<td>61</td>
<td>749</td>
</tr>
<tr>
<td>RCA Indoor TV Antenna</td>
<td>22</td>
<td>2,248</td>
</tr>
<tr>
<td>RCA Power TV Antenna</td>
<td>12</td>
<td>1,508</td>
</tr>
<tr>
<td>RCA 27” Stereo TV</td>
<td>12</td>
<td>813</td>
</tr>
<tr>
<td>RCA 13” TV/VCR</td>
<td>24</td>
<td>776</td>
</tr>
<tr>
<td>RCA 13” TV</td>
<td>27</td>
<td>733</td>
</tr>
<tr>
<td>RCA 4” LCD Color TV</td>
<td>38</td>
<td>802</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>End on hand</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCA 2” Diagonal LCD Color TV</td>
<td>5</td>
<td>1,495</td>
</tr>
<tr>
<td>Sharp 25” TV/VCR Combo</td>
<td>45</td>
<td>735</td>
</tr>
<tr>
<td>Sharp 25” Stereo Color TV</td>
<td>5</td>
<td>770</td>
</tr>
</tbody>
</table>
The formatting of the new section is copied from the section in which it is added.

Sections can be added to existing sections that are either horizontally or vertically displayed. Examples are below, followed by steps to add a section.

Adding sections to horizontally displayed sections

If a section is displayed horizontally, it is printed horizontally across the page. For example, the Detail Header, Detail, and Detail Footer in the following document sample, shown in Design View/Mode, are displayed horizontally.

When viewed as a PDF, the Detail section is displayed next to the Detail Header, beneath the Region Header, as shown in the document sample below. (The remaining employees in the Detail section, and the Detail Footer that follows, are not shown in the sample, for space reasons.)

You can add a section to a horizontally displayed section. You insert the section to the left or right of the original section. The new section is displayed horizontally. For example, a section has been added to the previous
document, to the right of the Detail Header. The new section is shown below, in Design View.

For an expanded example, reasons to use horizontal display, and steps, see *Displaying sections horizontally, page 293.*

### Controlling vertical positioning of sections

Another reason for inserting additional sections is relative vertical positioning. If you have one Grid/Graph placed above another in a section, the resulting grid or graph reports can overlap when the PDF is generated. Inserting a new section and placing each Grid/Graph into its own section allows them to grow without overlapping.

For example, a document contains two datasets: Cost, Price, and Profit per Unit, and Inventory Received from Suppliers by Quarter. A Grid/Graph is created from each dataset. In Design View/Mode, it appears as if the Grid/Graphs are positioned well, as shown below:
When you view the document as a PDF, the resulting grid reports overlap because of the amount of information they contain, as shown below:

<table>
<thead>
<tr>
<th>Category</th>
<th>Item</th>
<th>Subcategory</th>
<th>Metrics</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>100 Places to Go While Still Young at Heart</td>
<td>Art &amp; Architecture</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Art As Experience</td>
<td>Art &amp; Architecture</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Painted Word</td>
<td>Art &amp; Architecture</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hirschfeld on Line</td>
<td>Art &amp; Architecture</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Adirondack Style</td>
<td>Art &amp; Architecture</td>
<td></td>
</tr>
<tr>
<td>Quarter</td>
<td>Subcategory</td>
<td>Supplier</td>
<td>Metrics</td>
</tr>
<tr>
<td>Audio Equipment</td>
<td>ATF Electronics</td>
<td>170</td>
<td></td>
</tr>
<tr>
<td>Cameras</td>
<td>Audiotronics Inc.</td>
<td>935</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACS Innovations</td>
<td>1,040</td>
<td></td>
</tr>
</tbody>
</table>

To resolve this problem, you can insert a new section into the Detail Header. This creates two Detail Headers, named Detail Header 1 and Detail Header 2. Place the second Grid/Graph into the new section. When you generate the PDF, the resulting grid reports are separated as shown in the following image:

---

To add a section to a document

1. In MicroStrategy Web, open the document in **Design Mode**.
2 In the Layout area, right-click in the section above or below where you want to add the new section, and then select either **Insert Section Above** or **Insert Section Below**. A line appears in the Layout area to divide the sections.

   If the selected section is displayed horizontally, the options are **Insert Section Left** and **Insert Section Right**. For instructions to specify that a section displays horizontally, see *Displaying sections horizontally, page 293*.

3 You can size the sections by clicking the line divider and dragging it.

The new section is automatically formatted like the section it was added to. You can format the new section and the original section independently.
**INTRODUCTION**

After you create a new document, you specify the data that appears and control the layout, formatting, grouping, and subtotaling of data. In addition, you can insert pictures and draw borders in the document. All of these capabilities provide for documents that are suitable for presentation to management for printing boardroom quality material. They are used to create the highest-quality, *Pixel Perfect™* documents such as scorecards and dashboards, managed metrics documents, production and operational documents, and more.

This chapter contains examples of the different kinds of objects that you can add to a document, with steps to create them.

**Using datasets in documents**

Datasets contain the warehouse data and the MicroStrategy objects that are displayed in a document. Datasets are based on MicroStrategy reports, which define what information Intelligence Server should retrieve from the data warehouse (or cache) and make available to use in the document.
For example, the following report contains four rows.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Revenue</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2007</td>
<td>$2,246,294</td>
<td>53,938</td>
</tr>
<tr>
<td></td>
<td>2008</td>
<td>$2,870,291</td>
<td>69,707</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2007</td>
<td>$1,140,008</td>
<td>27,636</td>
</tr>
<tr>
<td></td>
<td>2008</td>
<td>$1,518,562</td>
<td>36,363</td>
</tr>
</tbody>
</table>

The same report is used as a dataset in a document, and each of its objects are used in the Detail section. The document contains four rows as well.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2007</td>
<td>$339,961</td>
</tr>
<tr>
<td></td>
<td>2008</td>
<td>$435,701</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2007</td>
<td>$171,354</td>
</tr>
<tr>
<td></td>
<td>2008</td>
<td>$228,509</td>
</tr>
</tbody>
</table>

You can also add a Grid/Graph, which displays the information from the dataset report; it looks like a report. The Grid/Graph in the document would also contain the same four rows.

Dataset information can include objects such as attributes, custom groups, consolidations, or metrics. These dataset objects include all of the objects from the report that the dataset is based on (the dataset report), regardless of whether they are displayed on the report itself. For example, if a metric is in the report’s set of Report Objects but is not displayed on the report’s grid, that metric is still part of the dataset and is listed as a dataset object.

A report that displays only a subset of the objects that define it is called an OLAP Services report. For more information about these subset reports, see *Using a view report or base report as a dataset*, page 74.

Freeform SQL reports, Query Builder reports, MDX cube reports, and reports created using the Data Import feature can be used as datasets in documents. You can also import data directly from a data source to create a dataset. The imported data is used as a dataset on the document.

- For information on Freeform SQL and Query Builder reports, see the *Advanced Reporting Guide*.

- For information on modeling MDX cube sources into MicroStrategy to be used as datasets, see the *MDX Cube Reporting Guide*. 

© 2013 MicroStrategy, Inc.
For information on importing data into a document, see *Importing data from different data sources* below.

### Importing data from different data sources

You can use MicroStrategy Web to import data from different data sources, such as an Excel file, a table in a database, the results of a Freeform SQL query, or a Salesforce.com report, into MicroStrategy metadata with minimum project design requirements. You link this imported data to define attributes and metrics. You then save and publish it as an Intelligent Cube.

You can:

- Import data while creating a document. Your imported data is saved and can be used immediately in the document.
- Import and save data in a folder location. If desired, you can create a document immediately from the imported data.

Some common uses for importing data include:

- Combining and analyzing personalized data with your project data
- Quickly integrating data into MicroStrategy as part of a proof-of-concept
- Importing and reporting on personalized data from various data sources
- Immediately building reports, documents, and VI dashboards without having to "model" the data source
- Modifying the data in your data source, then republishing the Intelligent Cube to quickly update the data in your reports, documents, and VI dashboards

You can import data from the following data sources:

- A file on your computer, network, or from a specified URL or UNC path
- A table in a database
- The results of a Freeform SQL query on a database
- A Salesforce.com report

When you import data into a document, the imported data is automatically linked to attributes that already exist in the document. For example, a document contains a dataset that includes the Year attribute. You import
data from a file that contains year and region information. The year is automatically linked to the Year attribute during the data import process. You can unlink the data, if the link is incorrect for your needs.

For high-level steps to import data as a dataset, see *To import data to use as a dataset, page 49*. For more detailed steps, including steps to link data to attributes, see the *MicroStrategy Web Help*. For more information on including supplemental data in a project using the Data Import feature, see the *Creating and Configuring a Project* chapter in the *Project Design Guide*.

**Adding, changing, or removing a dataset**

When you create a document, you must provide the data that appears in the document by selecting at least one dataset. The dataset can be an existing report, or you can import data directly into the document. You can add a dataset to a document, replace a dataset that has already been added, or remove a dataset from a document. A document can contain multiple datasets.

If you remove or replace a dataset, controls on the document that contain data that is no longer available from the dataset will be updated and will no longer contain data from the replaced or removed dataset. For example, if a Grid/Graph contains attributes and metrics from a dataset report, and the dataset report is deleted from the document, the Grid/Graph is cleared and no longer contains any data. (A Grid/Graph displays the information from the dataset report in a report-like format.)

If the document contains multiple datasets, and one dataset is removed or replaced, objects from that dataset that are available in another dataset are updated to contain data from the other dataset. Objects from the deleted or replaced dataset that are not available in another dataset are cleared or removed. For example, a document contains two datasets. Dataset 1 has Category, Region, and the Revenue and Cost metrics. Dataset 2 has Category, Year, and the Revenue and Profit metrics. A Grid/Graph displays Category, Region, Revenue, and Cost from Dataset 1, and Year and Profit from Dataset 2. Dataset 1 is removed from the document. The Grid/Graph now displays Category, Year, Revenue, and Profit from Dataset 2. Region and Cost, which only exist in Dataset 1, are removed.

You can change this behavior by specifying that missing units are kept, at either the project or document level. For steps, see *Removing or keeping missing objects in a Grid/Graph when datasets are removed or replaced, page 54*. 
If you delete a dataset from a multi-layout document, it is deleted from the entire document. A multi-layout document contains multiple documents, each in its own layout, creating a “book” of documents. For information about multiple layouts, see *Creating multi-layout documents, page 476*.

A document can be grouped and sorted only by the objects in the grouping and sorting dataset, as described in *Changing the grouping and sorting dataset for a document, page 51*. If you delete the grouping and sorting dataset, any grouping fields are removed, including the corresponding Group Header and Group Footer sections, all of their contents, and the grouping sort keys.

If a Grid/Graph in a document is linked as a shortcut to a dataset report, when you replace that dataset report, the data from the new dataset report automatically replaces the data in the Grid/Graph. For information about shortcuts, see *Adding a Grid/Graph as a shortcut, page 191*.

⚠️ You can add a dataset and use it to populate an empty Grid/Graph in one step. For steps, see *Adding a dataset to an empty Grid/Graph, page 177*.

---

**To add an existing report as a dataset**

1 In MicroStrategy Web, open the document in **Design Mode** or **Editable Mode**.

2 From the **Data** menu, select **Add Dataset**. The Select Dataset dialog box opens.

3 Navigate to and select the new dataset report, then click **OK**. The dataset is added to the document.

---

**To import data to use as a dataset**

1 In MicroStrategy Web, open the document in **Design Mode** or **Editable Mode**.

2 From the **Data** menu, select **Add Dataset**. The Select Dataset dialog box opens.

3 Click **Import new data**.
4 From the Select your Data Source panel on the left, click the source of the data.

5 Select the appropriate options to import your data. For detailed steps, see the MicroStrategy Web Help. The imported data is saved and published as an Intelligent Cube, and added to the document as a dataset.

---

**To remove a dataset from a document**

1 In MicroStrategy Web, open the document in **Design Mode**.

2 From the Dataset Objects panel, right-click the name of the dataset report you want to replace, then select **Delete from Document**.

3 A dialog box is displayed warning you that you are about to delete the dataset. Click **OK**. The dataset is deleted from the document.

---

**To replace a dataset report in a document**

1 In MicroStrategy Web, open the document in **Design Mode**.

2 From the Dataset Objects panel, right-click the name of the dataset report you want to replace, then select **Replace Dataset**. The Select Dataset dialog box opens.

3 Navigate to and select the new dataset report, then click **OK**. The dataset report is replaced.

---

**To replace all dataset reports in a document with a single dataset report**

1 In MicroStrategy Web, open the document in **Design Mode**.

2 From the Dataset Objects panel, right-click the name of any dataset report that you want to replace, then select **Replace all datasets**. The Select Dataset dialog box opens.

3 Navigate to and select the new dataset report, then click **OK**. All of the dataset reports in the document are removed and replaced with the new dataset report.
Changing the grouping and sorting dataset for a document

When a document contains multiple datasets, one dataset is designated as the grouping and sorting dataset. The document can be grouped and sorted only by the objects in this dataset.

If the document contains multiple layouts, each layout can have its own grouping and sorting dataset. A multi-layout document contains multiple documents, each in its own layout, creating a “book” of documents. For information about multiple layouts, see Creating multi-layout documents, page 476.

The grouping and sorting dataset is bolded in the Dataset Objects panel.

For example, a document contains two datasets. Dataset 1, which is designated as the grouping and sorting dataset, contains the Region and Call Center attributes, as well as the Revenue metric. Dataset 2 contains the Region and Category attributes, as well as the Revenue metric. You can group the document by Region and Call Center, but not by Category. You can sort the Detail section of the document by Region or Call Center.

For more information on how to group or sort data, see Chapter 5, Grouping and Sorting Records in a Document.

When you change the grouping and sorting dataset of a document, all the grouping fields (the attributes that the document is grouped by) that are associated with the old grouping and sorting dataset but do not exist in the new one are removed. These items are also removed from the corresponding headers and footers.

To change the grouping and sorting dataset

1 In MicroStrategy Web, open the document in Design Mode.

2 In the Dataset Objects panel, right-click the dataset that you want to be the primary dataset and select Set as grouping and sorting dataset. The dataset appears in bold text.

Working with multiple dataset reports

You can create a document with multiple dataset reports, and you can add more dataset reports after you create a document.
You can define the join behavior of each dataset as either primary or secondary. This functionality allows you to control which datasets determine the attribute elements that appear in the document results.

- All of the elements from the primary datasets are displayed in the results.

- Elements from the secondary datasets are displayed only if they also appear in a primary dataset.

These rules do not affect Grid/Graphs that use a single dataset report. In this case, an element from a secondary dataset is displayed in a grid or graph report in a document even if it does not also appear in a primary dataset. If the Grid/Graph uses data from multiple dataset reports, the join behavior affects the content of the Grid/Graph. For more details on how join behavior affects Grid/Graphs, see Chapter 3, Displaying Reports in Documents: Grid/Graphs.

Datasets are joined following these rules:

- If a document contains one primary dataset, then all secondary datasets are joined to the primary dataset using left outer joins.

- If a document contains at least two primary datasets, all primary datasets are joined using compound joins. The results are used to left outer join all secondary datasets.

- If a document does not contain any primary datasets, all datasets are joined using inner joins.

For examples, see Defining a dataset as primary or secondary, page 60.

For a compound join, Intelligence Server joins the data in the datasets as described below:

- If the datasets have any of the same attributes, the common attribute elements are matched.

- Then, beginning with the first row of each dataset and continuing to the last, a row is created in a virtual dataset, which is the complete set of joined rows held in memory. The virtual dataset contains all attributes, consolidations, custom groups, and metrics. You can determine whether sections that do not have metric data are displayed and whether grouping elements that contain null values are displayed. For examples and instructions, see Displaying grouping elements that contain null values, page 75 and Removing sections that do not have metric data, page 79.
The compound join saves memory space and processing time on the Intelligence Server executing the document. For examples of joining datasets, see *Defining a dataset as primary or secondary, page 60* and *Joining multiple datasets: Examples, page 65*.

When there are multiple datasets in a document, the grouping and sorting dataset is the one that is bolded in the Dataset Objects panel. A document can be grouped and sorted using fields from the primary dataset only.

A document can also pull data from any number of MDX cube, Freeform SQL, and Query Builder reports, which facilitate joining data across multiple sources. For details on these types of reports, see the *MDX Cube Reporting Guide* and the *Advanced Reporting Guide*.

Any attributes common to multiple datasets are displayed with a blue icon in Dataset Objects. In the example below, the Category attribute is available in both the “Category & Subcategory Profit” dataset and the “Regional and Category Revenue” dataset:

![Dataset Objects Panel](image)

When a document contains multiple datasets, a threshold or a view filter on a Grid/Graph can include any objects from any of the datasets, regardless of whether the Grid/Graph uses that dataset. Thresholds are special formatting that is automatically applied to data in a Grid/Graph, when the data meets a specified value. A view filter on a Grid/Graph places conditions on attributes and metrics which restrict the amount of data displayed on the Grid/Graph.

For example, a document contains a Regional Revenue dataset and a Regional Profit dataset. A Grid/Graph is created for the Regional Revenue dataset. Profit is not displayed on the Grid/Graph, nor is it in the data source for the Grid/Graph.

- In the Grid/Graph, you can create a threshold to change the formatting of the revenue amounts when the profit is greater than a specified amount. For a more detailed example, see *Conditional formatting on a document with multiple datasets, page 313*. For background information on
In the Grid/Graph, you can create a view filter to display only the regions with profits greater than a specified amount. For a more detailed example, see View filters in documents with multiple datasets, page 219. For background information on view filters in general, see Using view filters on Grid/Graphs, page 217.

If a document contains multiple datasets and a selector, which items are displayed in a selector depends whether the selector filters or slices the data. A selector provides interactivity, allowing each user to change how he sees the data. When a user clicks a selector, a selector can change the focus of a grid or graph report or dynamic text fields (a text field that is a reference to an object on a report) in a panel stack.

- A slicing selector shows only the items available on the target.
- A filtering selector shows all the items available in all the datasets.

For example, a selector on Category targets a Grid/Graph that displays only Books and Movies. A second dataset on the document is filtered for Books and Music, but is not used on the Grid/Graph.

- If the selector is filtered, the selector displays Books, Movies, and Music (all the categories available in all the datasets).
- If the selector is sliced, the selector displays Books and Movies (only the categories available on the target).

For a more detailed example of filtering vs. slicing selectors on a document with multiple datasets, as well as general background information on selectors, see the Dashboards and Widgets Creation Guide.

Removing or keeping missing objects in a Grid/Graph when datasets are removed or replaced

If you remove or replace a dataset, controls on the document that contain data that is no longer available from the dataset will be updated and will no longer contain data from the replaced or removed dataset. For a Grid/Graph, objects that are available in another dataset are updated to contain data from the other dataset. Any missing objects can then be kept or replaced:

- If missing objects are kept, the headers for the missing objects are displayed in the Grid/Graph, without any data.
If missing objects are removed, the missing objects are not displayed in the Grid/Graph. If the Grid/Graph only contains missing objects, it is displayed as an empty placeholder.

No matter whether missing objects are removed or kept, a text field that contains a dataset object (such as an attribute or a metric) will display the object name instead of values. For example, a text field displays \{Region\} instead of North, South, and so on.

For example, a document contains two datasets. Dataset 1 has Category, Region, and the Revenue and Cost metrics. Dataset 2 has Category, Subcategory, and the Revenue and Profit metrics. A Grid/Graph displays Category, Region, Revenue, and Cost from Dataset 1, and Subcategory and Profit from Dataset 2. A part of this Grid/Graph is shown below:

<table>
<thead>
<tr>
<th>Category</th>
<th>Region</th>
<th>Subcategory</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Central</td>
<td>Art &amp; Architecture</td>
<td>$480,173</td>
<td>$110,012</td>
<td>$295,505</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Business</td>
<td>$400,671</td>
<td>$69,274</td>
<td>$295,505</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Literature</td>
<td>$296,229</td>
<td>$57,986</td>
<td>$295,505</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Books - Miscellaneous</td>
<td>$315,929</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mid-Atlantic</td>
<td>Science &amp; Technology</td>
<td>$811,787</td>
<td>$184,275</td>
<td>$295,505</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sports &amp; Health</td>
<td>$335,106</td>
<td>$74,724</td>
<td>$295,505</td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>Art &amp; Architecture</td>
<td>$480,173</td>
<td>$110,012</td>
<td>$506,490</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Business</td>
<td>$400,871</td>
<td>$69,274</td>
<td>$506,490</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Literature</td>
<td>$296,229</td>
<td>$57,986</td>
<td>$506,490</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Books - Miscellaneous</td>
<td>$315,929</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Science &amp; Technology</td>
<td>$811,787</td>
<td>$184,275</td>
<td>$506,490</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sports &amp; Health</td>
<td>$335,106</td>
<td>$74,724</td>
<td>$506,490</td>
</tr>
</tbody>
</table>

Dataset 1 is removed from the document. The Grid/Graph now displays Category, Year, Revenue, and Profit from Dataset 2. By default, Region and
Cost, which only exist in Dataset 1, have been removed. A part of the updated Grid/Graph is shown below:

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Art &amp; Architecture</td>
<td>$460,173</td>
<td>$110,012</td>
</tr>
<tr>
<td></td>
<td>Business</td>
<td>$400,671</td>
<td>$89,274</td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td>$296,229</td>
<td>$57,986</td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td>$315,929</td>
<td>$53,007</td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td>$811,787</td>
<td>$184,275</td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td>$335,106</td>
<td>$74,724</td>
</tr>
<tr>
<td>Electronics</td>
<td>Audio Equipment</td>
<td>$3,762,832</td>
<td>$633,169</td>
</tr>
<tr>
<td></td>
<td>Cameras</td>
<td>$5,061,148</td>
<td>$900,830</td>
</tr>
<tr>
<td></td>
<td>Computers</td>
<td>$1,928,998</td>
<td>$338,585</td>
</tr>
<tr>
<td></td>
<td>Electronics - Miscellaneous</td>
<td>$4,671,957</td>
<td>$679,393</td>
</tr>
<tr>
<td></td>
<td>TV's</td>
<td>$3,837,906</td>
<td>$679,393</td>
</tr>
<tr>
<td></td>
<td>Video Equipment</td>
<td>$5,108,464</td>
<td>$927,202</td>
</tr>
<tr>
<td></td>
<td>Action</td>
<td>$617,565</td>
<td>$37,746</td>
</tr>
<tr>
<td></td>
<td>Comedy</td>
<td>$669,642</td>
<td>$33,243</td>
</tr>
<tr>
<td></td>
<td>Drama</td>
<td>$698,840</td>
<td>$42,376</td>
</tr>
</tbody>
</table>

You can instead allow objects missing from the source dataset to be displayed. The object name is displayed, but without any data. In the example above, the Region and Cost headers are displayed, as shown below:
If the document contains only one dataset, and it is removed, the Grid/Graph is displayed as an empty placeholder, because the document no longer contains any data. The missing objects behavior does not apply in this case.

MicroStrategy recommends that objects missing from datasets are displayed. This can alert you if objects are removed from a report used as a dataset. You can change this at the project or document level. Steps to change this behavior at the document level are provided below. For steps to change it at the project level, see Determining whether Grid/Graphs can use multiple datasets, page 58.

To determine whether missing objects are displayed or removed in a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.


3. From the left, select Advanced, under Document Properties.

4. From the Remove Missing Units drop-down list, select one of the following:
   - To use the project-level property, select Inherit value from project-level setting.
• To remove unavailable objects, select **Remove objects not available in the source datasets.**

• To display unavailable objects, select **Do not remove objects not available in the source dataset.**

5 Click **OK** to save your changes and return to the document.

### Determining whether Grid/Graphs can use multiple datasets

A Grid/Graph displays the information from a dataset report in a report-like format. For examples, see *Chapter 3, Displaying Reports in Documents: Grid/Graphs.*

By default, a single Grid/Graph can contain objects from multiple datasets. For example, a document contains two datasets. Dataset 1 contains Region and Revenue; Dataset 2 contains Region and Profit. You can create a Grid/Graph with Region, Revenue, and Profit.

You can change the project configuration settings to require that all objects in a single Grid/Graph come from a single dataset. In the example above, a Grid/Graph could contain Region and Revenue, or Region and Profit, but not Region, Revenue, and Profit.

To allow a single Grid/Graph to contain objects from multiple datasets, you can change the project configuration settings as described below.

If Grid/Graphs can contain objects from multiple datasets, a single visualization in a Visual Insight (VI) dashboard can also use objects from multiple datasets. If this setting is disabled, each visualization can only use objects from a single dataset.

### Prerequisites

• To view Grid/Graphs that use objects from multiple datasets, you must have the Execute Report that Uses Multiple Data Sources privilege.

• To create Grid/Graphs that use objects from multiple datasets, you must have the Import Table from Multiple Data Sources privilege.
To determine whether Grid/Graphs and visualizations can contain objects from multiple datasets

1. In Desktop, right-click the project to update, and select **Project Configuration**. The Project Configuration Editor opens.

2. Expand **Project Definition** in the list of categories, and then click **Advanced**.

3. Click **Configure** in the Analytical Engine VLDB Properties section. The VLDB Properties Editor opens.

4. Expand **Analytical Engine** in the list on the left, and select **Document Grids from Multiple Datasets**.

   If this VLDB property is not displayed, you must upgrade the project metadata. For steps, see the **Upgrade Guide**.

5. If the **Use default inherited value** check box is selected, clear it.

6. Do one of the following:

   - To allow a single Grid/Graph or visualization to use objects from multiple datasets, select **Allow objects in document grids to come from multiple datasets**.

   - To require that Grid/Graphs and visualizations use objects from a single dataset, clear **Allow objects in document grids to come from multiple datasets**.

7. MicroStrategy recommends that objects missing from the source datasets are displayed. The object name is displayed, but without any data. This can alert you if objects are removed from a report used as a dataset. For examples of the different behaviors, see *Removing or keeping missing objects in a Grid/Graph when datasets are removed or replaced*, *page 54*. To select this property, follow the steps below:

   a. In the list on the left, select **Remove Missing Units in Documents**.

   b. Clear the **Use default inherited value** check box.

   c. Select **Do not remove objects not available in the source dataset(s)**.
You can also define this property at the document level, in the Document Properties dialog box. For instructions, see *To determine whether missing objects are displayed or removed in a document, page 57.*

8 Click **Save and Close**.

9 Click **OK**.

10 Restart Intelligence Server.

### Defining a dataset as primary or secondary

If a document contains multiple dataset reports, you can define the join behavior of each dataset as either **primary** or **secondary**. This functionality allows you to decide which datasets determine which attribute elements appear in the document results.

#### Primary and secondary datasets examples

For example, consider the following three datasets:

- **Dataset 1** contains Region and the Revenue metric, filtered for Central, Mid-Atlantic, Northeast, and Southeast

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$3,554,415</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,851</td>
</tr>
</tbody>
</table>

- **Dataset 2** contains Region and the Profit metric, filtered for Mid-Atlantic, Northeast, Northwest, and South

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$784,323</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$266,986</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$336,675</td>
</tr>
</tbody>
</table>
• Dataset 3 contains Region and the Customer Count metric, filtered for Mid-Atlantic, Northwest, Southeast, and Southwest

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Customer Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>1,432</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td>554</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>731</td>
<td></td>
</tr>
<tr>
<td>Southwest</td>
<td>1,206</td>
<td></td>
</tr>
</tbody>
</table>

A document contains all three datasets. The Detail section contains Region and the three metrics. The document could contain a Grid/Graph with the same objects, instead of text fields, and the results would be the same.

By default, all three datasets are primary datasets. Since the datasets are joined together using compound joins, all of the elements from all three datasets are therefore displayed in the seven rows of results. A metric value is displayed only when that region appears in the dataset report that contains the metric. For example, Southwest shows a value only for Customer Count because Southwest appears only in Dataset 3 (the Customer Count dataset). Similarly, Mid-Atlantic shows values for all three metrics because Mid-Atlantic is the only region included on all three datasets.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$873,084</td>
<td>1,432</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td>$266,986</td>
<td>$806,956</td>
<td>554</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td></td>
<td>731</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td></td>
<td>1,206</td>
</tr>
</tbody>
</table>

Change the join behavior:

• Dataset 1 and Dataset 2 = primary
• Dataset 3 = secondary

Dataset 1 and Dataset 2, as primary datasets, are joined with compound joins, and all their regions are displayed on the document. Those results are
left outer joined with Dataset 3, so the only regions from Dataset 3 that appear in the document are the regions that also appear in one of the primary datasets. In this case, Southwest appears only in Dataset 3, so it is not displayed in the results. Only six rows are displayed, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$873,084</td>
<td>1,432</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$266,986</td>
<td>554</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$806,956</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td></td>
<td>731</td>
</tr>
</tbody>
</table>

Change the join behavior:

- Dataset 1 and Dataset 3 = primary
- Dataset 2 = secondary

Again, only six regions are displayed, but now Southwest is shown instead of South, since South is available only in Dataset 2.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$873,084</td>
<td>1,432</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$266,986</td>
<td>554</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$806,956</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td></td>
<td>731</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td></td>
<td>1,206</td>
</tr>
</tbody>
</table>

Change the join behavior:

- Dataset 1 = secondary
- Dataset 2 and Dataset 3 = primary
This time, Central does not appear because it is available only on Dataset 1, a secondary dataset.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>1,432</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$266,986</td>
<td>554</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$806,956</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td></td>
<td>731</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td></td>
<td>1,206</td>
</tr>
</tbody>
</table>

Change the join behavior:
- Dataset 1 = primary
- Dataset 2 and Dataset 3 = secondary

Since the document has only one primary dataset, all the other datasets are joined to the primary dataset with left outer joins. Only the four regions from the primary dataset are displayed in the document. Those are the regions that have Revenue values, since Revenue is the metric in Dataset 1. South, which is only in Dataset 2, and Southwest, which is only in Dataset 3, are not displayed. Northwest is in both Dataset 2 and Dataset 3, but since it is not in the primary dataset, it is not displayed.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>1,432</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td></td>
<td>731</td>
</tr>
</tbody>
</table>

Change the join behavior:
- Dataset 1 and Dataset 3 = secondary
- Dataset 2 = primary
Since Dataset 2 is primary, only the four regions that are in that dataset are displayed.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>1,432</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td>$266,986</td>
<td></td>
<td>554</td>
</tr>
<tr>
<td>South</td>
<td>$806,956</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Change the join behavior:
- Dataset 1 and Dataset 2 = secondary
- Dataset 3 = primary

Similarly, since Dataset 3 is primary, only the four regions that are in that dataset are now displayed. Notice that these regions all have values for the Customer Count metric, since that is the metric in that dataset.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>1,432</td>
</tr>
<tr>
<td>Northwest</td>
<td>$266,986</td>
<td></td>
<td>554</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td></td>
<td>731</td>
</tr>
<tr>
<td>Southwest</td>
<td>$806,956</td>
<td></td>
<td>1,206</td>
</tr>
</tbody>
</table>

Change the join behavior:
- Dataset 1, Dataset 2, and Dataset 3 = secondary

Since the document does not contain any primary datasets, all datasets are joined using inner joins. Only the one region (Mid-Atlantic) that is in all the datasets is displayed.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue (Dataset 1)</th>
<th>Profit (Dataset 2)</th>
<th>Customer Count (Dataset 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>1,432</td>
</tr>
</tbody>
</table>
To define the join behavior of a dataset

1 In MicroStrategy Web, open the document in Design Mode.

2 Make sure that the Dataset Objects pane is displayed. (If it is not displayed, click Dataset Objects in the list on the left.)

3 Right-click the dataset in the Dataset Objects pane, point to Join Behavior, and select either Primary or Secondary.

Joining multiple datasets: Examples

The following examples show how datasets are joined.

- Example 1: Same attributes in both datasets, different metric, and same filter (same element values). Result: Acts as one dataset. (See Example 1: Same attributes, same filter, page 65)

- Example 2: Same attributes with different element values. Result: Acts mostly as one dataset, but missing values are blank. (See Example 2: Same attributes, different filter, page 67)

- Example 3: Dataset with attributes that are a superset of attributes in other datasets. Result: All Detail is at a level combining all attributes. (See Example 3: Dataset with a superset of attributes that are in another dataset, page 68)

- Example 4: Different attributes. Result: All Detail is at a level combining all attributes. (See Example 4: Different attributes, page 71)

Example 1: Same attributes, same filter

This example explains how a document behaves with multiple datasets that have the same attributes and the same report filter. The result is that the Detail, Group Header, and Group Footer sections behave as if the document has only one dataset.

Two sample dataset reports are executed as standard MicroStrategy reports displayed in grid view. Both datasets contain the same Region and Year
attributes. Dataset 1 (the grouping and sorting dataset) contains the metrics Revenue and Units Sold, while dataset 2 contains the metric Profit.

<table>
<thead>
<tr>
<th>Dataset 1 (grouping and sorting dataset)</th>
<th>Dataset 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Year</td>
</tr>
<tr>
<td>------------</td>
<td>------</td>
</tr>
<tr>
<td>Northeast</td>
<td>2002</td>
</tr>
<tr>
<td>Northeast</td>
<td>2003</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2003</td>
</tr>
</tbody>
</table>

A document contains these two reports as datasets. When the document is executed, it creates a virtual dataset by joining the two datasets. In this case, because the attributes and the filter are the same, the result displayed in the Detail section has the same number of rows as the original reports, but it can display all three metrics together, as shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Revenue</th>
<th>Units Sold</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2002</td>
<td>$1,230,989</td>
<td>29,368</td>
<td>$298,472</td>
</tr>
<tr>
<td>Northeast</td>
<td>2003</td>
<td>$1,103,875</td>
<td>27,380</td>
<td>$266,107</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>$1,784,622</td>
<td>42,757</td>
<td>$432,541</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2003</td>
<td>$1,628,718</td>
<td>39,211</td>
<td>$393,828</td>
</tr>
</tbody>
</table>

You can also create a Grid/Graph that contains the attributes and metrics from the two datasets. The Grid/Graph would display the same four rows and data, as shown below:

You can create a Grid/Graph for each of the datasets, so that each Grid/Graph shows the data from its respective dataset, with no impact from the other datasets. For example, if we add Year to the Grouping panel and add a
grid for each of the datasets to the Year Header, the grids display a summary of the year values, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Revenue</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2002</td>
<td>$1,230,989</td>
<td>29,368</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>$1,784,622</td>
<td>42,757</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Revenue</th>
<th>Units Sold</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2002</td>
<td>$298,472</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>$432,541</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Example 2: Same attributes, different filter

This example explains the behavior of a document that contains multiple datasets having the same attributes but different report filters or prompt answers. The result is that the Detail, Group Header, and Group Footer sections behave as if the document has only one dataset, but with some data missing.

The following example has a document with two datasets. Dataset 1, which is the grouping and sorting dataset, has information for the Year 2002 and Dataset 2 has information for the Year 2003 because of the different filters or
prompt answers. The Detail section displays a combination of both datasets and has empty cells where the data does not exist.

**Example 3: Dataset with a superset of attributes that are in another dataset**

In a document, if the attributes in one of the datasets are a superset of the attributes in the other datasets, the Detail section of the document is at the same level as in the superset dataset.
For example, consider the following scenario:

- Dataset 1, the grouping and sorting dataset, contains Region, Year, and Category.
- Dataset 2 contains Region and Year.
- Dataset 3 contains Region and Category.

The grouping and sorting dataset contains all of the attributes that are in the other datasets, so the grouping and sorting dataset contains a superset of the attributes in the other datasets.

The following image shows the Revenue metric supplied by the grouping and sorting dataset for Region, Year, and Category. In this example, the following was selected for all three datasets:

- Year: 2002 and 2003
- Region: Mid-Atlantic
- Category: All

The Detail section of the document is calculated at the level of Region, Year, and Category with the metrics coming from the respective datasets. In this example, each metric comes from a different dataset. Since the Revenue metric is from the grouping and sorting dataset, it is calculated at the Region-Year-Category level. The Profit metric originated in Dataset 2, so it is calculated at the Region-Year level. Finally, the Cost metric is from Dataset 3 and is calculated by Region-Category. This is shown in the following image.
Notice that there are eight rows in the Detail section—one row for each combination of Region, Year, and Category.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Category</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Books</td>
<td>$6,771</td>
<td>$432,541</td>
<td>$9,948</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Electronics</td>
<td>$1,196,217</td>
<td>$432,541</td>
<td>$1,658,723</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Movies</td>
<td>$288,814</td>
<td>$432,541</td>
<td>$419,327</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Music</td>
<td>$292,820</td>
<td>$432,541</td>
<td>$498,973</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2003</td>
<td>Books</td>
<td>$6,807</td>
<td>$393,828</td>
<td>$9,948</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2003</td>
<td>Electronics</td>
<td>$1,085,630</td>
<td>$393,828</td>
<td>$1,658,723</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2003</td>
<td>Movies</td>
<td>$268,436</td>
<td>$393,828</td>
<td>$419,327</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2003</td>
<td>Music</td>
<td>$267,845</td>
<td>$393,828</td>
<td>$498,973</td>
</tr>
</tbody>
</table>

Metrics are never displayed at a level of greater detail than the level in the dataset report that they come from. The value for the Profit metric repeats for all four categories, because Dataset 2 contains only two values for Profit.

If you group by Year, you see the following:

2002

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Category</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Books</td>
<td>$6,771</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Electronics</td>
<td>$1,196,217</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Movies</td>
<td>$288,814</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>Music</td>
<td>$292,820</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>2002</td>
<td>$432,541</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>Books</td>
<td>$9,948</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Electronics</td>
<td>$1,658,723</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Movies</td>
<td>$419,327</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Music</td>
<td>$498,973</td>
</tr>
</tbody>
</table>
Example 4: Different attributes

If the datasets in a document do not have any of the same attributes, the Detail section of the document represents a compound join of the attributes in all of the datasets.

For example, consider the following scenario:

- Dataset 1, the grouping and sorting dataset, contains Year
- Dataset 2 contains Region
- Dataset 3 contains Category

The datasets are shown below.
The Detail section is at the level of Region, Year, and Category with the metrics coming from the respective datasets. Because no relationship exists between the attributes, they cannot be joined in a meaningful way, as shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Category</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Southeast</td>
<td></td>
<td>Movies</td>
<td>$489,254</td>
<td>$2,090,825</td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td></td>
<td>Music</td>
<td>$428,729</td>
<td>$2,484,538</td>
<td></td>
</tr>
<tr>
<td>South</td>
<td></td>
<td></td>
<td>$335,333</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td></td>
<td>$358,453</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td></td>
<td>$681,266</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td></td>
<td>$415,125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>2002</td>
<td>Books</td>
<td>$8,876,630</td>
<td>$564,579</td>
<td>$47,174</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2003</td>
<td>Electronics</td>
<td>$8,059,804</td>
<td>$826,369</td>
<td>$8,214,789</td>
</tr>
</tbody>
</table>

The “holes” in the data occur because metrics cannot be any more detailed than in their datasets. So, Revenue cannot be calculated for the South region because that level of granularity does not exist in the grouping and sorting dataset, which is the origin of the Revenue metric. Since the grids in this document are meaningful and predictable, they can be used for data reporting.

If the same document is grouped by Year, eight rows of data are still returned—one row for each Year, with the remaining six rows, which do not have a Year attribute, placed in a separate grouping section. Again, the data cannot be joined in a meaningful way because no relationships exist between the attributes.
### 2002

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>$8,876,630</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>$564,579</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$826,369</td>
</tr>
<tr>
<td>Southeast</td>
<td>$489,254</td>
</tr>
<tr>
<td>Central</td>
<td>$428,729</td>
</tr>
<tr>
<td>South</td>
<td>$335,333</td>
</tr>
<tr>
<td>Northwest</td>
<td>$358,453</td>
</tr>
<tr>
<td>Southwest</td>
<td>$681,266</td>
</tr>
<tr>
<td>Web</td>
<td>$415,125</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$47,174</td>
</tr>
<tr>
<td>Electronics</td>
<td>$8,214,789</td>
</tr>
<tr>
<td>Movies</td>
<td>$2,090,825</td>
</tr>
<tr>
<td>Music</td>
<td>$2,484,538</td>
</tr>
</tbody>
</table>

### 2003

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>$8,059,804</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>$564,579</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$826,369</td>
</tr>
<tr>
<td>Southeast</td>
<td>$489,254</td>
</tr>
<tr>
<td>Central</td>
<td>$428,729</td>
</tr>
<tr>
<td>South</td>
<td>$335,333</td>
</tr>
<tr>
<td>Northwest</td>
<td>$358,453</td>
</tr>
<tr>
<td>Southwest</td>
<td>$681,266</td>
</tr>
<tr>
<td>Web</td>
<td>$415,125</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$47,174</td>
</tr>
<tr>
<td>Electronics</td>
<td>$8,214,789</td>
</tr>
<tr>
<td>Movies</td>
<td>$2,090,825</td>
</tr>
<tr>
<td>Music</td>
<td>$2,484,538</td>
</tr>
</tbody>
</table>

### 2004

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2004</td>
<td>$7,985,432</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>$564,579</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$826,369</td>
</tr>
<tr>
<td>Southeast</td>
<td>$489,254</td>
</tr>
<tr>
<td>Central</td>
<td>$428,729</td>
</tr>
<tr>
<td>South</td>
<td>$335,333</td>
</tr>
<tr>
<td>Northwest</td>
<td>$358,453</td>
</tr>
<tr>
<td>Southwest</td>
<td>$681,266</td>
</tr>
<tr>
<td>Web</td>
<td>$415,125</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$47,174</td>
</tr>
<tr>
<td>Electronics</td>
<td>$8,214,789</td>
</tr>
<tr>
<td>Movies</td>
<td>$2,090,825</td>
</tr>
<tr>
<td>Music</td>
<td>$2,484,538</td>
</tr>
</tbody>
</table>
Using Intelligent Cubes as datasets

After you create an Intelligent Cube, you can use it as a dataset in a document. An Intelligent Cube is a multi-dimensional cube (set of data) that allows you to use OLAP Services features on reports, as well as share sets of data among multiple reports and documents. Intelligent Cubes also help optimize performance by reducing access to the data warehouse. You can have multiple Intelligent Cubes in the same document, or a mix of Intelligent Cubes and reports.

For an introduction to Intelligent Cubes, see the OLAP Services Guide.

Using a view report or base report as a dataset

If you move objects from the body of a report to the Report Objects pane, or you use a view filter or create a derived metric on the report, you have created a subset report. The report before you made these modifications is referred to as the base report.

The new report is called the view or subset report. If you use that subset report as a dataset report for a document, all the information on the base report is available in the document. All the objects from the base report, whether they are displayed on the grid or are only available on the Report Objects panel, are displayed in the Dataset Objects panel in Design Mode. Any view filter on the report is ignored, so that all the data from the base report is available in the document.

Creating a subset report requires MicroStrategy OLAP Services.

A Grid/Graph is a document object that displays the information from a dataset report; it looks like a report. (For more information on Grid/Graphs in general, see Chapter 3, Displaying Reports in Documents: Grid/Graphs.) How you add a Grid/Graph to a document impacts whether the base report or the subset report is used:

- If you add the Grid/Graph without formatting, the base report is used.
  - The view filter is ignored, so all the data from the base report is displayed on the Grid/Graph.
  - All objects from the report are displayed in the Grid/Graph, whether or not the objects are on the grid or only in the Report Objects pane of the report.
• If you add the Grid/Graph with formatting or as a shortcut, the subset report is used.
  • The view filter is applied.
  • Only objects on the grid of the report are displayed in the Grid/Graph.

In all cases, any derived metrics on the dataset report are included in the Grid/Graph.

You can create view filters in Grid/Graphs, as long as the Grid/Graph is not a shortcut. These view filters are local to the document, so they do not affect the report results, only the Grid/Graph defined in the document. For more information about view filters in documents, see Using view filters on Grid/Graphs, page 217. For more information on Grid/Graph shortcuts, see Adding a Grid/Graph as a shortcut, page 191.

For steps to create Grid/Graphs, see Adding a Grid/Graph to a document, page 170. For more information on view filters and report objects in reports, see the Advanced Reporting Guide.

**Displaying grouping elements that contain null values**

A join between datasets can result in null values. If null values are produced in the dataset join, you can determine whether or not to display grouping elements that contain null values. Null values are produced in the following scenarios:

• If the attributes in the datasets are not in the same hierarchy, no null values are produced. For example, Dataset 1 contains Region and Profit, while Dataset 2 contains Category and Revenue. Since Region and Category are from different hierarchies, no null values are produced.

• If the attributes in the datasets are in the same hierarchy, and a full dataset relationship exists to support the join, no null values are produced. For example, Dataset 1 contains Category, Subcategory, and Profit, and Dataset 2 contains Category and Revenue. Since both datasets contain Category, and each category can be matched to its subcategories, no null values are produced.

• If the attributes in the datasets are in the same hierarchy, and only a partial dataset relationship exists to support the join, null values are produced. For example, Dataset 1 contains Category, Subcategory, and Profit. Dataset 2 contains Category and Revenue, filtered to display the Books category only. Although Category and Subcategory are from the
same hierarchy, because of the filter, each category cannot be matched to its subcategories, so null values are produced.

- If the attributes in the datasets are in the same hierarchy, and no dataset relationship exists to support the join, null values are produced. For example, Dataset 1 contains Category and Profit, while Dataset 2 contains Subcategory and Revenue. Although Category and Subcategory are from the same hierarchy, they do not exist in the same dataset in the document. Therefore, the category cannot be matched to its subcategories, so null values are produced.

When null values are produced, you can decide whether their related grouping elements are displayed.

For example, a document contains two dataset reports. Dataset 1 contains Category and Profit. Dataset 2 contains Category, Subcategory, and Revenue, filtered to display Books only. The document contains Category, Subcategory, Profit, and Revenue in the Detail section. The dataset join is supported by a partial relationship between Category and Subcategory: the Books category is matched to its subcategories, but the other categories are not.

As shown below, the document contains nine rows:

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Art &amp; Architecture</td>
<td>$569,278</td>
<td>$480,173</td>
</tr>
<tr>
<td>Books</td>
<td>Business</td>
<td>$569,278</td>
<td>$400,871</td>
</tr>
<tr>
<td>Books</td>
<td>Literature</td>
<td>$569,278</td>
<td>$296,229</td>
</tr>
<tr>
<td>Books</td>
<td>Books - Miscellaneous</td>
<td>$569,278</td>
<td>$315,929</td>
</tr>
<tr>
<td>Books</td>
<td>Science &amp; Technology</td>
<td>$569,278</td>
<td>$811,787</td>
</tr>
<tr>
<td>Books</td>
<td>Sports &amp; Health</td>
<td>$569,278</td>
<td>$335,106</td>
</tr>
<tr>
<td>Electronics</td>
<td></td>
<td>$4,289,603</td>
<td></td>
</tr>
<tr>
<td>Movies</td>
<td></td>
<td>$254,698</td>
<td></td>
</tr>
<tr>
<td>Music</td>
<td></td>
<td>$180,044</td>
<td></td>
</tr>
</tbody>
</table>

Null values are displayed for the Electronics, Movies, and Music subcategory and Revenue, because that data is not available in either dataset.

Now, group the document by Subcategory. When you execute the document, only the subcategories for the Books category are displayed in the page-by
options. When you select Art & Architecture, only the row for Art & Architecture is shown, as displayed below:

![Grouping: Subcategory: Art & Architecture](image)

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Art &amp; Architecture</td>
<td>$569,278</td>
<td>$480,173</td>
</tr>
</tbody>
</table>

If you select All for the page-by, six rows are displayed, as shown below:

![Grouping: Subcategory: All](image)

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Art &amp; Architecture</td>
<td>$569,278</td>
<td>$480,173</td>
</tr>
<tr>
<td>Books</td>
<td>Business</td>
<td>$569,278</td>
<td>$400,871</td>
</tr>
<tr>
<td>Books</td>
<td>Literature</td>
<td>$569,278</td>
<td>$296,229</td>
</tr>
<tr>
<td>Books</td>
<td>Books - Miscellaneous</td>
<td>$569,278</td>
<td>$315,929</td>
</tr>
<tr>
<td>Books</td>
<td>Science &amp; Technology</td>
<td>$569,278</td>
<td>$811,787</td>
</tr>
<tr>
<td>Books</td>
<td>Sports &amp; Health</td>
<td>$569,278</td>
<td>$335,106</td>
</tr>
</tbody>
</table>

Three of the rows from the original document are missing, the ones containing the data for Electronics, Movies, and Music. You are grouping by Subcategory and that row does not contain any information about categories. The rows for Electronics, Movies, and Music are not displayed, because they contain null values for Subcategory and by default, groups that contain null elements are removed.

To see the information for all the categories, clear the **Remove groups that contain null elements** check box. The page-by options are now the book
subcategories, NULL, and All. When you select All for the page-by, the document displays with nine rows, as shown below:

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronics</td>
<td></td>
<td>$4,289,603</td>
<td></td>
</tr>
<tr>
<td>Movies</td>
<td></td>
<td>$254,698</td>
<td></td>
</tr>
<tr>
<td>Music</td>
<td></td>
<td>$180,044</td>
<td></td>
</tr>
<tr>
<td>Books</td>
<td>Art &amp; Architecture</td>
<td>$569,278</td>
<td>$480,173</td>
</tr>
<tr>
<td>Books</td>
<td>Business</td>
<td>$569,278</td>
<td>$400,871</td>
</tr>
<tr>
<td>Books</td>
<td>Literature</td>
<td>$569,278</td>
<td>$296,229</td>
</tr>
<tr>
<td>Books</td>
<td>Books - Miscellaneous</td>
<td>$569,278</td>
<td>$315,929</td>
</tr>
<tr>
<td>Books</td>
<td>Science &amp; Technology</td>
<td>$569,278</td>
<td>$811,767</td>
</tr>
<tr>
<td>Books</td>
<td>Sports &amp; Health</td>
<td>$569,278</td>
<td>$335,106</td>
</tr>
</tbody>
</table>

If you select NULL, the rows for Electronics, Movies, and Music are displayed.

To display grouping elements that contain null values

1. In MicroStrategy Web, open the document in **Design Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. Under Document Properties on the left, select **Advanced**.
4. By default, the **Remove groups that contain null elements** check box is selected. To display any grouping elements sections that contain null elements, clear this check box.
5. Click **OK** to return to the document.
Removing sections that do not have metric data

A cross join between datasets can result in rows or Group Header/Footer sections that do not have metric data. For example, a document contains two dataset reports. Dataset 1 contains Year and Revenue, with data for three years (2007-2009). Dataset 2 contains Year and Profit, filtered to return data for only two years (2008 and 2009). If you place Year and Profit in the Details and execute the document, it displays three rows, although no profit data exists for 2007. This is a product of the cross join between the two datasets.

<table>
<thead>
<tr>
<th>Year</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td>$1,740,085</td>
</tr>
<tr>
<td>2009</td>
<td>$2,249,397</td>
</tr>
</tbody>
</table>

You do not want to see the blank line for 2007 since it does not give you any data for profit. You can select the **Trim sections for which no metric value data is available** check box. This removes the row for 2007, since no metric data for Profit is available for 2007. The results are shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>$1,740,085</td>
</tr>
<tr>
<td>2009</td>
<td>$2,249,397</td>
</tr>
</tbody>
</table>

An alternative solution is to define Dataset 2 as a primary dataset and Dataset 1 as secondary. For instructions and details, see *Defining a dataset as primary or secondary*, page 60.

In another example, a document contains two dataset reports. Dataset 1 contains Region and Revenue, filtered to display Northeast and Northwest only. Dataset 2 contains Year and Profit. Data for three years (2007-2009) is available. The document contains Region and Revenue in the Detail section. You want to display:

- A Grid/Graph that contains three years of Profit in the Document Header
- A row for each region, with year and profit information
You do not want to group the document by region. The document looks like the following:

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td></td>
<td>$1,304,141</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$1,740,085</td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td>$2,249,397</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2007</td>
<td>$8,547,238</td>
</tr>
<tr>
<td>Northwest</td>
<td>2008</td>
<td>$11,517,606</td>
</tr>
</tbody>
</table>

The Grid/Graph contains the three rows of yearly profit data. The document contains three rows, one of which is blank, a product of the cross join between the two datasets. Since you want only a row for each region, and the blank row is not providing any information about region or revenue, it can be removed. To do this, select the **Trim the sections for which no metric value data is available** check box. The resulting document is shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td></td>
<td>$1,304,141</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$1,740,085</td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td>$2,249,397</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2007</td>
<td>$8,547,238</td>
</tr>
<tr>
<td>Northwest</td>
<td>2008</td>
<td>$11,517,606</td>
</tr>
</tbody>
</table>

---

**To remove sections that do not have metric data**

1. In MicroStrategy Web, open the document in **Design Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. Under Document Properties on the left, select **Advanced**.
4 Select the **Trim sections for which no metric value data is available** check box.

5 Click **OK** to return to the document.

## Adding text and data to a document: Text fields

Text is displayed in documents using text fields. All of the text (such as employee names, numbers, the words “Employee” and “Revenue”, page numbers, and so on) in the following document are displayed in text fields:

<table>
<thead>
<tr>
<th>Central Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee</strong></td>
<td><strong>Revenue</strong></td>
</tr>
<tr>
<td>Ellerkamp:Nancy</td>
<td>$847,227</td>
</tr>
<tr>
<td>Gale:Loren</td>
<td>$1,669,290</td>
</tr>
<tr>
<td>Torison:Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Zemlicka:George</td>
<td>$822,500</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$5,029,366</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mid-Atlantic Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee</strong></td>
<td><strong>Revenue</strong></td>
</tr>
<tr>
<td>Bernstein:Lawrence</td>
<td>$1,060,632</td>
</tr>
<tr>
<td>Brown:Vernon</td>
<td>$331,735</td>
</tr>
<tr>
<td>Corcoran:Peter</td>
<td>$325,417</td>
</tr>
<tr>
<td>Folks:Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td>Hollywood:Robert</td>
<td>$1,026,374</td>
</tr>
<tr>
<td>Ingles:Walker</td>
<td>$229,439</td>
</tr>
<tr>
<td>Smith:Thomas</td>
<td>$221,379</td>
</tr>
<tr>
<td>Young:Sarah</td>
<td>$209,634</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$4,452,615</strong></td>
</tr>
</tbody>
</table>

A text field is the type of document control that displays data and text. Text fields can display metrics, attributes, consolidations, and custom groups from a dataset. They can also display page numbers or descriptive labels, such as the words “Employee” and “Region” in the sample above.

The different types of text fields include:

- **Static text**: This text does not change and is commonly used for labels or descriptions. Examples in the sample above are the words “Employee”
Adding text and data to documents: Text fields © 2013 MicroStrategy, Inc.

Adding text and data to a document: Text fields © 2013 MicroStrategy, Inc.

and “Revenue”. For steps to add static text, see *To add a text field to a document, page 85*.

- **Dynamic text**: This text is automatically populated by the document or dataset. Dynamic text is always included within braces { }. There are two types of dynamic text:
  - Data field: This is automatically populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache), such as the employee names and revenue amounts in the document sample above. A data field is a reference to an object on a report. The object can be a metric, attribute, consolidation, or custom group. For an example and steps, see *Adding dynamic data to a document, page 83*.
  - Auto text code: This is automatically populated by the document or dataset. It consists of the document’s or dataset’s settings rather than data from the data warehouse. For example, auto text codes can display the document’s name and page numbers, and the dataset report’s name and filter information. In the document sample above, auto text codes display the page numbers. For the full list of available codes, as well as steps to create auto text codes, see *Displaying document and dataset report information: Auto text codes, page 88*.

- **A combination of any or all of the types**: You can use a combination of different types of text fields in a single text field. For example, the text “Central Region” in the sample document above contains the dataset object Region, followed by the static text “Region”. For an example and steps, see *Combining different types of text fields in a document, page 86*.

You can edit the text within any text field in a document. For steps, see *Editing the text in a text field, page 87*.

**Adding a static text label to a document**

Static text serves as a label in the document. A static text field does not change when viewed as a PDF; static text displays just as it is typed and formatted in the text field when the document is in Design Mode. Any text in a text field prints as it exists in the field unless it is within braces { } and the document recognizes it as an auto text code or as data from a dataset.

For steps, see *To add a text field to a document, page 85*. 

82 Adding text and data to a document: Text fields  © 2013 MicroStrategy, Inc.
Adding dynamic data to a document

A data field is a text field that contains a reference to an object (metric, attribute, consolidation, or custom group) on a report. When you view the document as a PDF, the data fields are replaced by the actual data.

The reference in a data field is the object name inside braces { }. The braces indicate that the text fields are data fields, not static text. In Design View/Mode, data fields for the Employee attribute and the Revenue metric look like the following:

When the document is executed, all data fields are automatically populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache).

When the data fields shown above are displayed in PDF View, the attribute elements and revenue values are displayed, as shown below:

Ellerkamp:Nancy $647,227  
Gale:Loren $1,269,290  
Torrison:Mary $1,690,350  
Zemlicka:George $822,500

If the object referenced by a data field is removed from the dataset report, the data field will become static text when the PDF is created.

The value of a metric, whether it is created in the document or is a dataset object, is calculated differently depending on its location in the document, as described in Metric calculation in document sections, page 114.

You can add data fields in any of the following ways:

- Drag and drop a dataset object onto any section of the Layout area. A text field containing a reference to the dataset object is added to the document. For example, if you drag Year, Category, and Subcategory to the Detail section, near the Revenue metric that you added before, it looks like this:
When you view the document as a PDF, the result looks like this:

<table>
<thead>
<tr>
<th>Year</th>
<th>Type</th>
<th>Subtype</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td>Books</td>
<td>Art &amp; Architecture</td>
<td>$17,492</td>
</tr>
<tr>
<td>2007</td>
<td>Books</td>
<td>Art &amp; Architecture</td>
<td>$22,372</td>
</tr>
<tr>
<td>2006</td>
<td>Books</td>
<td>Business</td>
<td>$14,589</td>
</tr>
<tr>
<td>2007</td>
<td>Books</td>
<td>Business</td>
<td>$18,947</td>
</tr>
<tr>
<td>2006</td>
<td>Books</td>
<td>Literature</td>
<td>$11,087</td>
</tr>
<tr>
<td>2007</td>
<td>Books</td>
<td>Literature</td>
<td>$14,699</td>
</tr>
<tr>
<td>2006</td>
<td>Books</td>
<td>Books - Miscellaneous</td>
<td>$12,245</td>
</tr>
<tr>
<td>2007</td>
<td>Books</td>
<td>Books - Miscellaneous</td>
<td>$15,577</td>
</tr>
<tr>
<td>2006</td>
<td>Books</td>
<td>Science &amp; Technology</td>
<td>$30,045</td>
</tr>
<tr>
<td>2007</td>
<td>Books</td>
<td>Science &amp; Technology</td>
<td>$36,204</td>
</tr>
<tr>
<td>2006</td>
<td>Books</td>
<td>Sports &amp; Health</td>
<td>$12,744</td>
</tr>
<tr>
<td>2007</td>
<td>Books</td>
<td>Sports &amp; Health</td>
<td>$16,248</td>
</tr>
</tbody>
</table>

- Drag and drop a specific attribute form into any section of the Layout area. Many attributes have both an ID and description. In the document sample below, Item is displayed in two attribute forms: ID, which is listed in the SKU column, and Description.

- Insert a blank text field in any section of the Layout area, then type the reference to the dataset object in the text field.

- Create a metric within the document, which creates a text field containing a reference to the metric. For details, see *Creating metrics in documents, page 128.*
To add a text field to a document

1. In MicroStrategy Web, open the document in **Design Mode**.

2. Add a text field using one of the following methods depending on your goal for the text field:

   - To create a static label, type text:
     
     a. From the **Insert** menu, select **Text**. A blank text field is inserted.
     
     b. Type the static text.
     
     c. Press **Enter**.

   - To create dynamic text, drag and drop a dataset object:
     
     a. From the objects displayed in Dataset Objects, select the object you want to use.
     
     b. Drag and drop the selected object into the Layout area.

     **Note the following:**

     - If an object name contains special characters, the text field is automatically placed within square brackets [ ] when you drop it in the Layout area. This ensures that data fields are resolved correctly when the PDF is displayed in a language other than English. A special character is any character other than a-z, A-Z, 0-9, #, _, and . (period).

     - When you add a metric to the document, the dataset name is added to the string if the metric exists in multiple datasets.

   - To create dynamic text, type the data field manually:
     
     a. From the **Insert** menu, select **Text**. A blank text field is inserted.
     
     b. Type the object’s name within braces, such as {Revenue} or {Region}. The name must match either the name of an object in a dataset or its alias. If either name contains spaces or special characters, you must type it in square brackets [ ] within the braces, as in {{Last Year Revenue}}. A special character is any character other than a-z, A-Z, 0-9, #, _, and . (period).

     c. To display a particular attribute form, type @ attribute_form after the object name, within braces, where attribute_form is the name of the attribute form to be displayed. If you specify an
attribute form that does not exist for an attribute, the data field cannot be resolved and the syntax is displayed as text in the PDF.

d If a metric exists in multiple datasets, use the syntax {{dataset name}: [object name]}. Do not associate an attribute with a specific dataset, as attribute elements come from the joined datasets.

e Press Enter.

3 To resize the text field, click and drag the field.

The text field is automatically formatted in the default style for the text field control type. To change the formatting, right-click the text field and select Properties and Formatting. For details to format the text field, see Formatting text fields, page 273.

If you want a user to be able to click a piece of text and go to a web page, you can define the text field as a link. For details, see Linking to a web page, page 415.

**Combining different types of text fields in a document**

You can combine any number of static text entries, data fields, and auto text codes in a single text field. The document displays any auto text codes and data fields according to the dataset and document details and combines it with the static text in the field.

For example, if you type Date/time: in a text field, then insert the Date and Time auto text code into the same field, the final text field looks like Date/time: {&DATETIME}, in Design Mode. When viewed as a PDF, the result is displayed as:

Date/time: 11/15/2003 07:15:00 PM

When different types of text are combined in one text field, the entire text field has the same formatting and settings. For example, if you want to make the label Date/time: bold but keep the actual date and time in plain text, you should place them in separate text fields and format them differently.

---

**To combine different types of text fields**

1 In MicroStrategy Web, open the document in Design Mode.
2 Expand the section where you want to place the text, by clicking the plus sign next to the section name.

3 Add a text field of any type. For steps, see *To add a text field to a document, page 85.*

4 Type some text in the text field. To create a new line in the text field, press **Enter**.

5 Add another text field of any type, as described below. The new data is added at the position of the text cursor.

   • To add a data field, drag and drop a dataset object into the selected text field.

   • To add an auto text code, from the **Insert** menu, select **Auto Text** and select the code, or type the code into the text field. For a list of auto text codes, see *Auto text codes for document information, page 90* or *Auto text codes for dataset report information, page 91.*

6 When you have finished making all the text entries in the text field, click anywhere outside the text field.

   You can change the formatting of the text field. See *Formatting text fields, page 273* for steps.

---

**Editing the text in a text field**

You can edit any text field in a document. One common reason to edit a text field is to update an object name that has been changed in the project. When you rename an object, such as a metric, any text fields that reference that metric are not automatically updated with the new name.

Use the steps below to edit a text field in a document.

---

**To edit a text field**

1 In MicroStrategy Web, open the document in **Design Mode**.

2 Double-click a text field.
3 Edit the text by doing any of the following:

- Type new text.
- Add a data field by dragging and dropping a Dataset Object into the selected text field.
- Add an auto text code by selecting **Auto Text** from the **Insert** menu, then typing the code into the text field. For lists of auto text codes, see *Auto text codes for document information, page 90* or *Auto text codes for dataset report information, page 91*.
- Begin on another line by pressing **Enter**.

4 To exit editing, click anywhere outside the text field.

5 Save the document to save your changes.

### Displaying document and dataset report information: Auto text codes

Auto text codes allow you to automatically display information in a document, such as page numbers, the current date and time, and report filter details. For example, you can add the auto text code `{&DOCUMENT}` to a text field in a document. When you view the document as a PDF, or display the document in Interactive, Express, or Flash Modes, the auto text code is automatically replaced with the name of the document.

Auto text codes are grouped into two types:

- **Document information** includes page numbers, the document name and description, the prompts used in the document, and so on.

- **Dataset information** includes the dataset report name and description, the prompts on the specific dataset report, information about the report filter used on the dataset report, and so on.

This section provides steps to add an auto text code and explains the auto text codes that you can use to display these types of variables, with examples of each.
To add an auto text code to a document

1 In MicroStrategy Web, open a document in **Design Mode**.

2 Expand the section where you want the auto text code by clicking the plus sign next to the section name.

3 Do one of the following:
   - To select the auto text code from a list, from the **Insert** menu, select **Auto Text**, then select the code to insert. The text field that contains the auto text code is added at the top left corner of the selected section, although you can move the text field to any position.
   - To add an auto text code to an existing text field, edit the text field (select it and press **F2**) and then add the auto text code. You may need to resize the text field to view the auto text code.
   - To type the auto text code manually, insert a blank text field and type the code within braces `{ }`. If an object’s name contains spaces or special characters, enclose it in square brackets `[ ]` within the braces.

   For lists of the available auto text codes, see the following:
   - *Auto text codes for document information, page 90*
   - *Auto text codes for dataset report information, page 91*

4 After you add an auto text code, you can configure how it is displayed. For example, if you add an auto text code to display the filter information for a dataset report, you can select whether to include view filter information or to display attribute names. For report details, you can choose whether to include information on prompts, filters, or both. For examples and steps, see *Configuring auto text codes, page 94*.

When you view the document as a PDF or display it in Interactive, Express, or Flash Modes, the code is replaced with the information from the document or dataset.

For steps to format the text field that contains the auto text code (such as the font name or background color), see *Formatting text fields, page 273*. 
## Auto text codes for document information

The following auto text codes allow you to add document variable information to your document. These auto text codes are automatically replaced by information about the document.

<table>
<thead>
<tr>
<th>Description</th>
<th>Code</th>
<th>Sample Output</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page number</td>
<td>{&amp;PAGE}</td>
<td>1</td>
<td>The current page number</td>
</tr>
<tr>
<td>Total number of pages</td>
<td>{&amp;NPAGES}</td>
<td>12</td>
<td>The total number of pages in the document or in the group’s section before page numbering restarts</td>
</tr>
<tr>
<td>Date &amp; Time</td>
<td>{&amp;DATETIME}</td>
<td>11/15/2003 7:10:55 PM</td>
<td>Current date and time, of the client computer. For PDFs, this is the date and time when the PDF was generated. You can display only the date without the time, or the month name rather than the number, and so on. To format the date and time, see Formatting text field options, page 274.</td>
</tr>
<tr>
<td>Current user</td>
<td>{&amp;USER}</td>
<td>Jane User</td>
<td>The full name, not login, of the user who generates the PDF or views the document</td>
</tr>
<tr>
<td>Document name</td>
<td>{&amp;DOCUMENT}</td>
<td>Regional Sales Summary</td>
<td>The name of the document as stored in the project</td>
</tr>
<tr>
<td>Document description</td>
<td>{&amp;DESCRIPTION}</td>
<td>Revenue and profit by region</td>
<td>Short description of the document</td>
</tr>
<tr>
<td>Document inbox title</td>
<td>{&amp;TITLE}</td>
<td>Regional Sales Summary for Tuesday</td>
<td>The name of the document instance If you send a document to your History List, you can rename that instance of the document. This auto text code displays that name, rather than the document name stored in the project.</td>
</tr>
<tr>
<td>Document notes</td>
<td>{&amp;NOTES}</td>
<td>User1: 8/15/2010 10:10:10 AM: Reviewed and approved</td>
<td>Notes (annotations) added to the document. For background information on notes, see Notes, page 523.</td>
</tr>
<tr>
<td>Project name</td>
<td>{&amp;PROJECT}</td>
<td>MicroStrategy Tutorial</td>
<td>The name of the project in which the document is stored</td>
</tr>
</tbody>
</table>
To differentiate between Date and Time and Document execution time, do the following:

1. Run a document and send it to the History List.
2. Each time you retrieve the document from the History List, the PDF is regenerated. The Date and Time change each time, but the Document execution time does not change.

### Auto text codes for dataset report information

The following auto text codes allow you to add dataset information to your document. For all these codes, replace `REPORTNAME` with the name of the related dataset report. If the name contains any spaces or special characters, type the name within square brackets `[ ]`. For example, to display the report details for a report named Sales Forecast, type `&([Sales

<table>
<thead>
<tr>
<th>Description</th>
<th>Code</th>
<th>Sample Output</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Prompts                        | `{&PROMPT1&}
{&PROMPT2&}
:{&PROMPTn&}` | South (for example, if prompt1 is for the attribute Region)                   | The user’s answers to each prompt in the document, identified by number if n is greater than the number of prompts in the document, the code cannot be replaced with pertinent information. Therefore the code itself is displayed in the PDF. |
| Prompt details                  | `{&PROMPTDETAILS}`         | Prompt 1: Region prompt
Northwest, Southwest Prompt 2: Year Year (ID)= 2007                       | Details for all the prompts in the document
You can define how this auto text code is displayed (for example, if the prompt name is shown). For steps, see Configuring the prompt details auto text code, page 102. |
| MicroStrategy Web Server       | `{&WEBSERVER}`             | http://localhost:8080/MicroStrategy/servlet/mstrWeb                          | Path to the web server being used, if the document is executed in MicroStrategy Web; otherwise, the value in project configuration |
| Document execution time        | `{&EXECUTIONTIME}`         | 11/15/2003 7:11:15                                                           | The date and time the document was executed
You can display only the date without the time, or the month name rather than the number, and so on. To format the date and time, see Formatting text fields, page 273. |
### Displaying document and dataset report information: Auto text codes

Special characters are anything other than a-z, A-Z, #, _, . (period), and 0 - 9.

<table>
<thead>
<tr>
<th>Description</th>
<th>Code</th>
<th>Sample Output</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset report description</td>
<td>{&amp;REPORTNAME:DESCRIPTION}</td>
<td>Revenue, profit, &amp; cost by employee &amp; region</td>
<td>The short description of the specified dataset report. If the dataset does not have a description, the text field remains blank.</td>
</tr>
<tr>
<td>Dataset report details</td>
<td>{&amp;REPORTNAME:REPORTDETAILS}</td>
<td>Report Description: Revenue, profit, &amp; cost by region &amp; employee</td>
<td>The complete report details, including report description, prompt details, filter details, and template details of the specified dataset. You can configure how this auto text code is displayed (for example, if the report description is shown). For steps, see Configuring the report details auto text code, page 97.</td>
</tr>
<tr>
<td>Dataset report filter and limit details</td>
<td>{&amp;REPORTNAME:FILTERDETAILS} or {&amp;FILTERDETAILS}</td>
<td>If the filter in the dataset's Filter editor is defined as: A=1 AND B=2 OR C=3 it prints as: A=1 and (B=2 or C=3) For example, Region=South and (Year=2002 or Year=2003)</td>
<td>The report filter and report limit used in the dataset report. An example is {&amp;[Sales Forecast]:FILTERDETAILS} for the Sales Forecast report. If the dataset report has a report filter and a report limit, the system displays an “or” between them. If there is no filter, “Empty Filter” is displayed. If there is no limit, “Empty Limit” is displayed. If you do not replace REPORTNAME with the name of the dataset, the filter and limit information from the document’s grouping and sorting dataset are displayed. By default, only the report filter and report limit are displayed, but other filters, such as view filters and security filters, can be displayed as well. For details, see Configuring the filter details auto text code, page 105.</td>
</tr>
<tr>
<td>Description</td>
<td>Code</td>
<td>Sample Output</td>
<td>Comments</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dataset report prompt details</td>
<td>{&amp;REPORTNAME: PROMPTDETAILS}</td>
<td>Prompt 1: Region prompt Northwest, Southwest Prompt 2: Year Year (ID)= 2007</td>
<td>The prompt information for all prompts in the specified dataset report. You can configure how this auto text code is displayed (for example, if the prompt name is shown). For details, see Configuring the prompt details auto text code, page 102.</td>
</tr>
<tr>
<td>Dataset report filter details</td>
<td>{&amp;REPORTNAME: REPORTFILTERDETAILS}</td>
<td>Report Filter: Year = 2007</td>
<td>The report filter used in the specified dataset report. If you do not replace REPORTNAME with the name of the dataset, the filter information from the document’s grouping and sorting dataset is displayed.</td>
</tr>
<tr>
<td>Dataset report limit details</td>
<td>{&amp;REPORTNAME: REPORTLIMITDETAILS}</td>
<td>Report Limits: Revenue &gt; 2000000</td>
<td>The report limit used in the specified dataset report. If you do not replace REPORTNAME with the name of the dataset, the report limit information from the document’s grouping and sorting dataset is displayed.</td>
</tr>
<tr>
<td>Dataset report template details</td>
<td>{&amp;REPORTNAME: TEMPLATEDETAILS}</td>
<td>Template: Region, Employee Metrics: Revenue, Revenue {<del>+}, Cost, Sum(Cost){</del>+}, Profit, Sum(Profit){~+}</td>
<td>The complete template details, including attribute details and metric details. You can define how this auto text code is displayed (for example, if the template name is shown). For steps, see Configuring the template details auto text code, page 100.</td>
</tr>
<tr>
<td>Dataset report execution time</td>
<td>{&amp;REPORTNAME: EXECUTIONTIME}</td>
<td>11/15/2003 7:10:55 PM</td>
<td>The date and time the dataset report was executed, or, for an Intelligent Cube, the cube publication date and time.</td>
</tr>
</tbody>
</table>
Configuring auto text codes

You can configure the content of any of the following auto text codes:

- **Filter details**, which display the report filter and report limit by default. You can also configure user filter details and view filter details. See *Configuring the filter details auto text code, page 105*.

- **Report limit details**, which displays the report limit. Report limits are minimum and maximum values for a metric that you specify at the report level. They determine the rows for a dataset that are displayed in the final report. See *Configuring the filter details auto text code, page 105*.

- **Prompt details**, which display the prompt information for all prompts in the report. See *Configuring the prompt details auto text code, page 102*.

- **Report details**, which display the report description, prompt details, filter details, and template details. See *Configuring the report details auto text code, page 97*.

- **Template details**, which display attribute details and metric details. See *Configuring the template details auto text code, page 100*.

You can configure different options for different types of auto text codes. For example, you can select whether to include view filter information or the attribute name in a report filter details auto text code. For report details, you can choose whether to include information on prompts or filters. See *Configuring the display of object name delimiters for auto text codes, page 95*.

To format the text field that contains the auto text code (such as the font name or background color), see *Formatting text fields, page 273*.

Levels of auto text code configuration

You can configure:

- The auto text codes in a specific text field in a document, from the Properties and Formatting dialog box (the text field level)

- All the auto text codes in a specific document, from the Document Properties dialog box (the document level)

- The Report Details in the Report Editor, from the Report Details Properties option (the report level)
All the auto text codes in a project, using the Project Configuration Editor (the project level)

The list above shows the order of precedence. The configuration of a particular text field in a document overrides the configuration at the document level, which overrides the configuration in the related dataset report, which overrides the project configuration. For example, if an option is set one way for a document and another for the report, the document setting takes precedence.

Configuring the display of object name delimiters for auto text codes

One setting, Use delimiters around report object names, is used in all the auto text codes. Report objects include attributes and metrics. Delimiters are the characters around these objects which set them off from other text. In the executed document, braces { } are used as delimiters. You can select whether to:

- Display delimiters for all report objects
- Omit delimiters for all report objects
- Automatically display delimiters only for those objects that contain a special character

Special characters are characters other than a - z, A - Z, 0 - 9, #, _, and . (period).

For example, the following filter details auto text code displays delimiters:

\( ([\text{Revenue}] > 10000000) \text{ And } ([\text{Profit}] > 2000000) \text{ And } ([\text{Region}] = \text{Mid-Atlantic}) \)

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$23,178,823</td>
<td>$4,007,580</td>
</tr>
</tbody>
</table>

You can choose to inherit the setting instead. If you are configuring the auto text codes in a specific text field, the setting is inherited from the document setting. If you are configuring all the auto text codes in the document, the setting is inherited from the report setting. For a list of the levels of inheritance, see Levels of auto text code configuration, page 94.
To configure the display of object name delimiters for auto text code

1. In MicroStrategy Web, open the document in Design Mode.
2. Expand the section where you want the auto text code by clicking the plus sign next to the section name.
3. Perform one of the following:
   - To select the auto text code from a list, from the Insert menu, select Auto Text, then select the auto text code to insert. You can move the text field to any desired position.
     For a list of auto text codes, see Displaying document and dataset report information: Auto text codes, page 88
   - To add an auto text code to an existing text field, double-click the text field to edit it, and then add the auto text. You may need to resize the text field to view the auto text.
   - To type the auto text code manually, insert a blank text field and type the code within braces { }. If an object's name contains spaces or special characters, enclose it in square brackets [ ] within the braces.
4. Right-click the auto text code and then click Report Details Properties. The Report Details Properties dialog box opens.
5. Click the General tab.
6. Select one of the following from the Use delimiters around report object names drop-down list:
   - To display delimiters for all report objects, select Always.
   - To omit delimiters for all report objects, select Never.
   - To automatically display delimiters only for those objects that contain a special character, select Only when the name contains special characters.
     Special characters are characters other than a - z, A - Z, 0 - 9, #, _, and . (period).
   - To inherit the document or report setting, as described in Levels of auto text code configuration, page 94, select Inherit.
7. Click OK to save your changes and return to the document.
When you view the document as a PDF or display it in Interactive, Express, or Flash Modes, the code is replaced with the information from the document or dataset.

**Configuring the report details auto text code**

The report details auto text code can be used to display the complete report details, including report description, prompt details, filter details, and template details of the specified dataset report. Steps are below to add auto text code to a document, as well as to edit existing auto text.

You can choose whether to include or omit the following:

- Report description (the short description of the report)
- Prompt details (the prompts on the report)
- Filter details (the report filter, view filter (for view reports based on Intelligent Cubes only), and report limits)
- Template details (the objects on the report and the metric definitions)

You can also choose to inherit the setting instead. If you are configuring the auto text codes in a specific text field, the setting is inherited from the document setting. If you are configuring all the auto text codes in the document, the setting is inherited from the report setting. For a list of the levels of inheritance, see *Levels of auto text code configuration, page 94*.

The following document sample shows the report details, as well as a portion of the grid report within the Grid/Graph container, displayed as a PDF.
Notice that the report description, report filter, report limits, and template information are displayed.

Report Description:
Revenue, profit, and cost by region & employee

Report Filter:
Year = 2007

Report Limits:
Empty Filter

Template:
Region
Employee
Metrics:
Revenue
Cost
Profit

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Gale</td>
<td>Loren</td>
<td>$559,002</td>
<td>$472,987</td>
<td>$86,016</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$548,764</td>
<td>$464,924</td>
<td>$83,839</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$377,455</td>
<td>$319,576</td>
<td>$57,479</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$338,471</td>
<td>$288,536</td>
<td>$49,935</td>
</tr>
<tr>
<td>Northeast</td>
<td>Kelly</td>
<td>Laura</td>
<td>$797,466</td>
<td>$676,808</td>
<td>$120,658</td>
</tr>
<tr>
<td></td>
<td>Sawyer</td>
<td>Leanne</td>
<td>$787,343</td>
<td>$666,516</td>
<td>$120,827</td>
</tr>
<tr>
<td></td>
<td>Yager</td>
<td>Beth</td>
<td>$777,573</td>
<td>$659,368</td>
<td>$118,205</td>
</tr>
</tbody>
</table>

Based on the information provided by the auto text code in the sample above, you may decide that the template information is not valuable to you, but that you do need to know how the dataset report is filtered, to know how the metrics are calculated, and which employees are included on the grid report. In addition, the report description is not very informational in this case. The
image below shows the same document, but the Report Details auto text code has been configured to display only the information you need.

Report Filter:
Year — 2007

Report Limits:
Empty Filter

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Gale</td>
<td>Loren</td>
<td>$559,002</td>
<td>$472,987</td>
<td>$86,016</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$548,764</td>
<td>$464,924</td>
<td>$83,839</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$73,407</td>
<td>$317,366</td>
<td>$56,041</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$177,455</td>
<td>$319,576</td>
<td>$57,479</td>
</tr>
<tr>
<td>Northeast</td>
<td>Kelly</td>
<td>Laura</td>
<td>$797,466</td>
<td>$676,608</td>
<td>$120,658</td>
</tr>
<tr>
<td></td>
<td>Sawyer</td>
<td>Leanne</td>
<td>$787,343</td>
<td>$666,516</td>
<td>$120,827</td>
</tr>
<tr>
<td></td>
<td>Yager</td>
<td>Beth</td>
<td>$777,573</td>
<td>$559,368</td>
<td>$118,205</td>
</tr>
</tbody>
</table>

To configure the report details auto text code or edit auto text

1. In MicroStrategy Web, open the document in Design Mode.

2. Expand the section where you want the auto text code by clicking the plus sign next to the section name.

3. Perform one of the following:
   - To select the auto text code from a list, from the Insert menu, select Auto Text, then select the auto text code to insert. You can move the text field to any desired position.
   - For a list of auto text codes, see Displaying document and dataset report information: Auto text codes, page 88
   - To add an auto text code to an existing text field, double-click the text field to edit it, and then add the auto text. You may need to resize the text field to view the auto text.
   - To type the auto text code manually, insert a blank text field and type the code within braces { }. If an object’s name contains spaces or special characters, enclose it in square brackets [ ] within the braces.

4. Right-click the auto text code and then click Report Details Properties. The Report Details Properties dialog box opens.

5. Click the General tab and choose whether to include the features listed in the Report Details area.
Modify options in the Miscellaneous area of the General tab.

When you view the document as a PDF or display it in Interactive, Express, or Flash Modes, the code is replaced with the information from the document or dataset.

**Configuring the template details auto text code**

The template of a report contains:

- The group of objects (attribute, metrics, custom groups, and so on) that defines the columns of data to be included in the report
- The layout and format of these objects

The template details auto text code displays the complete template details, including attribute details and metric details, unless the template details have been configured differently at the report or project level. For a list of the different levels and their order of precedence, see *Levels of auto text code configuration, page 94*. Steps are below to add auto text code to a document, as well as to edit existing auto text.

You can:

- Determine whether the template name of the dataset report is displayed. You can also select how to identify an embedded template.
- Determine whether the short description of the template is included. If the template is embedded or does not have a description, the template description line is not displayed.
- Determine whether dataset objects other than metrics (such as attributes and consolidations) are listed.
- Determine whether the metrics on the dataset report are listed.
- If metrics are displayed, select whether or not to display each of the following:
  - Conditional metrics only
  - Metric formulas
  - Metric dimensionality
  - Metric conditionality
Metric transformation

If you choose to inherit whether metrics are displayed, these settings are also inherited.

Use the Units from View or Base setting to choose whether to include the report objects from either the base report or the view report. If you move objects from the grid of a report to the Report Objects pane, or you use a view filter or create a derived metric, you have created a view report. The report before you made these kinds of modifications is referred to as the base report. The template details can show all the objects on the report, regardless of whether they are on the report grid, if you select Base. If you select View, only those objects on the report grid are included in the template details.

To configure the template details auto text code or edit auto text

1. In MicroStrategy Web, open the document in Design Mode.
2. Expand the section where you want the auto text code by clicking the plus sign next to the section name.
3. Perform one of the following:
   - To select the auto text code from a list, from the Insert menu, select Auto Text, then select the auto text code to insert. You can move the text field to any desired position.
     For a list of auto text codes, see Displaying document and dataset report information: Auto text codes, page 88.
   - To add an auto text code to an existing text field, double-click the text field to edit it, and then add the auto text. You may need to resize the text field to view the auto text.
   - To type the auto text code manually, insert a blank text field and type the code within braces { }. If an object’s name contains spaces or special characters, enclose it in square brackets [ ] within the braces. To see all template details, type the following text into the text field:

     { &TEMPLATEDETAILS }

4. Right-click the auto text code and then click Report Details Properties. The Report Details Properties dialog box opens.
5 Click the **Template Details** tab and choose whether to include the features listed.

By default, each setting on this tab inherits the document or report setting, as described in *Levels of auto text code configuration, page 94*. You can return to this default by selecting **Inherit** from the drop-down list for the specific setting.

When you view the document as a PDF or display it in Interactive, Express, or Flash Modes, the code is replaced with the information from the document or dataset.

**Configuring the prompt details auto text code**

The prompt details auto text code displays the prompt information for all prompts in the document. Steps are below to add auto text code to a document, as well as to edit existing auto text.

You can configure:

- Whether the prompt title and index (a number indicating the order of the prompts in the dataset report) are displayed.

- The text to display when a prompt is unanswered. The options are:
  - Use the default document or report setting for unanswered prompts
  - Display nothing
  - Display “Prompt Not Answered”
  - Display “No Selection”
  - Display “All/None”

  Whether the word “All” or “None” displays depends on the type of prompt. For example, an unanswered object prompt displays as “None” because no objects are selected. An unanswered filter definition prompt displays as “All” because the report is not filtered and therefore all the objects appear on the report.

- Whether and how to display the attribute name for any attribute element list prompts in the document. The options are:
  - Use the default document or report setting for attribute element prompts
  - Display the attribute name (for example, Region)
- Omit the attribute name
- Repeat the attribute name for each prompt answer (for example, Region = North, Region = South)

The browse form of the attribute, which is displayed when a user answers the prompt, is used to display the attribute elements in the prompt details auto text code. For information on browse forms, see the Project Design Guide.

- Whether to include unused prompts. An unused prompt occurs when you drill on a grid or graph report in a document, and the grid or graph report contains a prompt. The resulting report, which you can use as a dataset report, can display or omit the prompt details from the original report (the report that you drilled on).

For example, a document contains two dataset reports, which are displayed as grid reports in the document:

- Customers per Employee contains the Region attribute and the metrics Count of Customers, Employee Headcount, and Customers per Employee. It is prompted for Region.
- Regional Revenue contains the Year and Region attributes, and the Revenue metric. It is prompted for Region and Year.

The document also contains a prompt details auto text code, which is configured to display the prompt titles and index. The prompt title is specified when the prompt is created (Region prompt and Year in the example below), and the index is a number indicating the order of the prompts in the dataset reports (Prompt 1 and Prompt 2 below).

```
Prompt 1: Region prompt
Northwest, Southwest
Prompt 2: Year
Year (ID) = 2007

<table>
<thead>
<tr>
<th>Region</th>
<th>Count of Customers</th>
<th>Employee Headcount</th>
<th>Customers per Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northwest</td>
<td>10,000</td>
<td>3</td>
<td>3,333</td>
</tr>
<tr>
<td>Southwest</td>
<td>10,000</td>
<td>5</td>
<td>2,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>Northwest</td>
<td>$603,906</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southwest</td>
<td>$1,243,947</td>
<td></td>
</tr>
</tbody>
</table>
```

Although the dataset reports contain three prompts, only two are displayed. Since both datasets contain the same prompt on Region, that prompt is only displayed once.
If you change the prompt details auto text code to omit the prompt titles and index, only the prompt answers are displayed, as shown below:

```
Northwest, Southwest
Year (ID) = 2007

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Count of Customers</th>
<th>Employee Headcount</th>
<th>Customers per Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northwest</td>
<td></td>
<td>10,000</td>
<td>3</td>
<td>3,333</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>10,000</td>
<td>5</td>
<td>2,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>Northwest</td>
<td></td>
<td>$603,996</td>
</tr>
<tr>
<td></td>
<td>Southwest</td>
<td></td>
<td>$1,243,847</td>
</tr>
</tbody>
</table>
```

The Region prompt is an attribute element list prompt, so you can also specify whether and how to display the attribute name. In the example above, the attribute name is not displayed; the auto text code lists the selected attribute elements only. In the following document sample, the remaining options are shown. The prompt details auto text code on the left displays the attribute name, while the one on the right repeats the attribute name for each prompt answer.

```
Prompt 1: Region prompt
Region = Northwest, Southwest
Prompt 2: Year
Year (ID) = 2007

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Count of Customers</th>
<th>Employee Headcount</th>
<th>Customers per Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northwest</td>
<td></td>
<td>10,000</td>
<td>3</td>
<td>3,333</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>10,000</td>
<td>5</td>
<td>2,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>Northwest</td>
<td></td>
<td>$603,996</td>
</tr>
<tr>
<td></td>
<td>Southwest</td>
<td></td>
<td>$1,243,847</td>
</tr>
</tbody>
</table>
```

Sometimes users do not answer all the prompts. You can choose what to display when a prompt is not answered. You can select pre-defined text, or you can choose to display nothing at all.
To configure prompt details auto text codes or edit auto text

1 In MicroStrategy Web, open the document in Design Mode.

2 Expand the section where you want the auto text code by clicking the plus sign next to the section name.

3 Perform one of the following:
   
   • To select the auto text code from a list, from the Insert menu, select Auto Text, then select the auto text code to insert. You can move the text field to any desired position.

   For a list of auto text codes, see Displaying document and dataset report information: Auto text codes, page 88

   • To add an auto text code to an existing text field, double-click the text field to edit it, and then add the auto text. You may need to resize the text field to view the auto text.

   • To type the auto text code manually, insert a blank text field and type the code within braces { }. If an object’s name contains spaces or special characters, enclose it in square brackets [ ] within the braces.

4 Right-click the auto text code and then click Report Details Properties. The Report Details Properties dialog box opens.

5 Click the General tab and choose whether to include the features listed in the Prompt Details area.

When you view the document as a PDF or display it in Interactive, Express, or Flash Modes, the code is replaced with the information from the document or dataset.

Configuring the filter details auto text code

The filter details auto text code displays information about the report filter and report limit used in the specified dataset report by default, although other types of filters can be displayed. Steps are below to add auto text code to a document, as well as to edit existing auto text.
You can configure the following:

- You can configure the content of the filter details auto text code, by selecting which filter types to include (report filter, view filter (for view reports based on Intelligent Cubes only), report limits, and so on) and how the filters are displayed. For example, you can select whether to include the name of the filter type and whether to display the report limits before or after view filters.

- For filters that contain attribute element list qualifications, you can configure how those lists are displayed. For example, you can specify whether to show the attribute name (such as Region or Year) and the separator between attribute names.

- You can configure how attribute form and set qualifications in filters are displayed. For example, you can select whether to use names or symbols for the operators.

- You can configure how logical operators, which join multiple qualifications or filters, are displayed. For example, you can choose whether or not to display operators. You can select to display only the AND operator or only the OR operator.

- You can configure whether aliases replace object names in the filter details.

For an introduction to filters, see the *Basic Reporting Guide*.

---

**To configure the filter details auto text code or edit auto text**

1. In MicroStrategy Web, open the document in **Design Mode**.

2. Expand the section where you want the auto text code by clicking the plus sign next to the section name.

3. Perform one of the following:

   - To select the auto text code from a list, from the **Insert** menu, select **Auto Text**, then select the auto text code to insert. You can move the text field to any desired position.

     For a list of auto text codes, see *Displaying document and dataset report information: Auto text codes, page 88*.

   - To add an auto text code to an existing text field, double-click the text field to edit it, and then add the auto text. You may need to resize the text field to view the auto text.
• To type the auto text code manually, insert a blank text field and type the code within braces { }. If an object’s name contains spaces or special characters, enclose it in square brackets [ ] within the braces.

4 Right-click the auto text code and then click **Report Details Properties**. The Report Details Properties dialog box opens.

5 Click the **Filter Details - Contents** tab and the **Filter Details - Other** tab and choose whether to include the features listed below:

• You can choose whether or not to include each type of filter.

• You can configure how the filters are displayed in the filter details auto text code by specifying the following settings:

  ▫ Whether to include the names of the filter types (Report Filter, View Filter, and so on). If the filter type names are omitted, the auto text code displays as:

  
  (Local Filter): Year=2006, 2007
  Region=Northeast, Mid-Atlantic, Southeast

  ▫ If the filter type name is included, specify whether to include empty expressions. An empty expression is a filter type that is not included on the dataset report.

  ▫ Whether to add a new line after each filter type name, before the definition of the filter.

  For example, if the new line is omitted, the auto text code displays as:

  
  Security Filter: Region= Northeast, Mid-Atlantic, Southeast

  ▫ Whether to add a new line between the different filter types to help differentiate between them.

  For example, if the new line is omitted, the results are:

  
  Security Filter: Region= Northeast, Mid-Atlantic, Southeast

  ▫ Whether to show the report limits before or after the view filter.
Whether to display details about shortcut filters, which are stand-alone filters used in the report filter.

For example, Filter 1 is created as a stand-alone filter in the Filter Editor. The filter is defined as Region = Northeast. A report contains the Year and Region attributes, as well as the Revenue metric. A local filter (a filter defined in the Report Editor, not the Filter Editor) is created in the report, filtering on 2005. Then Filter 1 is added to the report filter, so Filter 1 becomes a shortcut filter in the report.

This report is used to create the document shown below, which contains three filter details auto text codes, one for each of the shortcut filter options. The definition of the local filter (Year = 2005) is displayed in each auto text code.

- The first auto text code shows just the filter name, Filter 1.
- The second auto text code shows the filter definition, Region = Northeast.
- The third auto text code shows both the name and filter.

• The drill filter is displayed on the report that is created by drilling on a grid or graph report in a document. The drill filter is the attribute element(s) that you selected when you drilled on the grid or graph report.

For example, a Grid/Graph in a document contains the Year and Region attributes, as well as the Revenue and Profit metrics. The document uses a filter details auto text code which is configured to display only the drill filter. A portion of the document is shown below in Interactive Mode in MicroStrategy Web. The filter details auto text
code displays as “Empty Filter,” since the only filter displayed is a drill filter, and no drilling has occurred.

Drill on the Grid/Graph from 2006 Central down to Call Center, as shown above. The following report is displayed, with a Report Details pane that displays the drill filter information, that 2006 and Central were selected when the drill was performed.

If the drill filter was disabled, the Report Details pane would be blank in the drilled-to report.

If you drill from an attribute (as opposed to drilling from attribute elements), a drill filter is not created. The resulting report is not filtered; it is just displayed at a different level from the grid or graph report in the document.

- A filter can contain an attribute element list qualification, which qualifies on a list of attribute elements. For example, you can use an attribute element list qualification on the attribute Customer, in a
report, to return data only for those customers that you specify in your list.

For these filters, you can configure how the lists are displayed using the following settings.

- **Show attribute name for In List conditions**: Determines whether or not the name of the attribute in the filter’s attribute element list is displayed. The name can also be repeated for each attribute element (for example, Region = Northeast, Region = Mid-Atlantic).

- **Separator after attribute name**: Specifies the characters that separate the attribute name from the attribute element. To specify a separator, you must clear the *Inherit* check box before you can type in the *Separator after attribute name* field.

- **New line after attribute name**: Determines whether or not the attribute name and its element display on separate lines.

- **Separator between last two elements**: Specifies the text that separates the last two attribute elements in the list. The choices are:
  - or
  - and
  - comma (the character is used, not the text)
  - custom (in the *Custom separator* field, type the characters to use as the separator)

- **New line between elements**: Determines whether or not each attribute element displays on a separate line.

- **Trim elements**: Determines whether extra spaces in the attribute elements are deleted. For example, an element of an account attribute is PSI2415 : 10 : COMMERCIAL. If *Trim elements* is enabled, the attribute is displayed as PSI2415:10:COMMERCIAL, omitting the extra spaces.

- A filter can contain:
  - An attribute form qualification, which is based on attribute forms (such as First Name and Last Name for the Customer attribute)
  - A metric set qualification, which is based on metric value or rank
A relationship set qualification, which is based on relationships between attributes

For these types of filters, you can configure how the qualifications are displayed using the following settings:

- **Use names or symbols for operators**: Determines whether names (such as Equals or Greater Than) or symbols (such as = or >) are displayed.

The following document sample shows two filter details auto text codes. The one on the left uses a symbol to indicate the operator, while the one on the right uses a name.

<table>
<thead>
<tr>
<th>Revenue &gt; 6000000</th>
<th>Revenue Greater than 6000000</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Revenue</strong></td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>$14,629,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$14,352,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$18,454,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$11,661,187</td>
</tr>
</tbody>
</table>

- **Include attribute form names in qualification conditions**: For conditions in attribute qualification filters, determines whether or not to display attribute form names (such as DESC or ID).

The following document sample shows two filter details auto text codes. The first one includes the attribute form name (DESC), while the second does not.

(Region (DESC) Begins with "North")
(Region Begins with "North")

<table>
<thead>
<tr>
<th>Region Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
</tr>
</tbody>
</table>

- **Dynamic dates**: Determines whether dynamic dates are shown as the date or as the expression that calculates the date.
The following document sample shows two filter details auto text codes. The top one displays the dynamic date as a date, while the bottom one shows the expression.

<table>
<thead>
<tr>
<th>Report Filter: Day (ID) = 4/1/2008</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Filter: Day (ID) = Today minus 12 Month(s)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$2,963</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,102</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$3,781</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Filters can have multiple qualifications, which are the conditions (such as Revenue > 6,000,000) that the data must meet to be included in a report. A dataset report can also contain multiple filters in its report filter.

Use the following settings to configure how to display the logical operators that join multiple conditions:

- **New line between conditions**: Determines whether or not each condition is placed on a separate line. You can also select **Automatic**, which inserts a line only when conditions are joined by different logical operators.

For example, a report is filtered for revenue greater than 10 million and profit greater than 2 million and the Mid-Atlantic region. A second report uses the same filter conditions, except the second logical operator is replaced by or, which filters the report for revenue greater than 10 million and either profit greater than 2 million or the Mid-Atlantic region. These two reports are used in the following document. A filter details auto text code is displayed for each dataset report; both use the **Automatic** option for **New line between conditions**. In the first filter details auto text code, the text wraps within the text field. In the second filter details, a new line is started at the logical operator AND, and again before the second condition. Using the new lines helps to distinguish between the conditions.

<table>
<thead>
<tr>
<th>(Revenue &gt; 10000000) And (Profit &gt; 2000000) And (Region = Mid-Atlantic)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Revenue &gt; 10000000</th>
</tr>
</thead>
<tbody>
<tr>
<td>And (Profit &gt; 2000000 And Region = Mid-Atlantic)</td>
</tr>
<tr>
<td>Region</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
</tr>
<tr>
<td>Northeast</td>
</tr>
</tbody>
</table>
If you select **Yes** or **Automatic**, you can specify whether to **Single space** or **Double space** the conditions.

- **Parentheses around conditions**: Determines whether or not parentheses are placed around each condition, such as (Region = Northeast). If a new line is inserted between conditions, you can often omit the parentheses since the conditions are already differentiated from each other.

You can also select **Automatic**, which displays parentheses only when they resolve ambiguity in the expression. Parentheses are not included around conditions that are joined by the same logical operator. When conditions are joined by different operators, the parentheses are necessary to ensure that the conditions are grouped correctly.

- **Logical operator between conditions**: Specifies whether or not to display the logical operator between conditions. The options are:
  - **Yes** to display all operators
  - **No** to omit all operators
  - **AND only** to display only the AND operator
  - **OR only** to display only the OR operator

The first filter details auto text code in the following document sample displays all the logical operators. The second one displays “and” only; notice that the “or” before the Region condition is replaced by a comma.

(Revenue > 10000000) And ((Profit > 2000000) Or (Region = Mid-Atlantic))

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$23,178,823</td>
<td>$4,007,580</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$11,375,413</td>
<td>$2,009,740</td>
</tr>
</tbody>
</table>

You can rename an object on a report, to display a more meaningful description in the context of that particular report, for example. An alias does not change the name of the object, only the name displayed on the report. A filter uses the name of the object, not the alias. You can determine whether aliases replace object names in a filter details auto text code.

By default, each setting on these tabs inherits the document or report setting, as described in *[Levels of auto text code configuration]*, [113]
Working with metrics in documents

This section assumes that you understand the concepts of metrics, levels of calculation on reports, and how calculation works on various document sections. For background information on metrics and reports, see the Advanced Reporting Guide. For background information on document sections, see Understanding and working with document sections, page 28.

This section describes how metrics are calculated based on their location in the document. It also provides steps to add a metric to a document or create a new metric based on existing metrics in the document.

The level of calculation for metrics depends on their location in the document. This allows you to create metric totals in documents, such as a grand total or a group total. This section describes how metrics are calculated based on their location in the document; for details, see Metric calculation in document sections, page 114.

For a description of the different types of metrics that you can create in a document and steps to create them, see Creating metrics in documents, page 128.

Metric calculation in document sections

A metric is calculated differently depending on its location in a document. This section of the guide describes how metrics are calculated in each document section:

- Calculating metrics at the dataset level: Detail section, page 115
- Calculating metrics at the group level: Group Headers and Group Footers, page 116
• Calculating grand totals for metrics: header and footer sections, page 118

• Calculating metrics at the level of a Grid/Graph, page 120

• Calculating metrics at the level of a Grid/Graph and a group: Group Headers and Group Footers, page 122

• Dynamic aggregation in documents, page 124

When a metric is placed in a document section other than the Detail section, the metric is calculated using the dynamic aggregation specified in the metric definition. For details on how metrics are aggregated in documents, see Dynamic aggregation in documents, page 124.

For a description of the different types of metrics you can create in a document and steps to create them, see Creating metrics in documents, page 128.

**Calculating metrics at the dataset level: Detail section**

A metric placed in a text field in the Detail section is calculated at the level returned by the dataset report that the metric comes from. The level of the dataset report is defined by the attributes, consolidations, and custom groups on the report.

For example, a report contains the Region and Employee attributes, as well as the Revenue metric. A portion of this report is shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Blankenpach</td>
<td>Nancy</td>
<td>$247,227</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,859,290</td>
</tr>
<tr>
<td></td>
<td>Tarrison</td>
<td>Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td></td>
<td>Zamlicka</td>
<td>George</td>
<td>$322,500</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bohn</td>
<td>Lawrence</td>
<td>$1,080,632</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$351,735</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,028,874</td>
</tr>
<tr>
<td></td>
<td>Ingles</td>
<td>Valderi</td>
<td>$229,436</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,575</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$20,634</td>
</tr>
</tbody>
</table>

This report is used as the dataset for a document. The Revenue metric is placed in a text field in the Detail section of the document. When the document is executed, the Revenue metric is calculated at the level of the
dataset report, which is Employee, as shown below. A portion of the document is shown below:

<table>
<thead>
<tr>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>$847,227</td>
</tr>
<tr>
<td>$1,669,290</td>
</tr>
<tr>
<td>$1,690,350</td>
</tr>
<tr>
<td>$822,500</td>
</tr>
<tr>
<td>$1,060,632</td>
</tr>
<tr>
<td>$331,735</td>
</tr>
<tr>
<td>$325,147</td>
</tr>
<tr>
<td>$1,047,776</td>
</tr>
<tr>
<td>$1,026,874</td>
</tr>
<tr>
<td>$229,439</td>
</tr>
<tr>
<td>$221,379</td>
</tr>
<tr>
<td>$209,634</td>
</tr>
</tbody>
</table>

The numbers in the document match those calculated in the original report. A document would include additional information to give perspective to the numbers. This example shows that the numbers are calculated regardless of what is placed on the document.

To change the calculation of a metric, place it in a Grid/Graph or a text field in a different section of the document. For example, placing a metric in the Document Footer provides a grand total for the document.

**Calculating metrics at the group level: Group Headers and Group Footers**

A metric placed in a text field in a Group Header section or Group Footer section is calculated at the level of the group. Grouping allows you to specify the attribute, consolidation, or custom group to use to calculate the metric. (For an introduction to grouping data in a document, see *Chapter 5, Grouping and Sorting Records in a Document.*)

For example, a report contains the Region and Employee attributes and the Revenue metric. A portion of the report is displayed below. The report is
This report is used as the dataset for a document. The document is grouped by Region. The Revenue metric is placed in two text fields, one in the Group Header and the other in the Detail section. The region name is included in the Group Header, to differentiate between the groups.

In the executed document, in the Group Header, the Revenue metric is calculated at the level of the group (Region). The group's elements are the elements of the Region attribute. This provides regional totals. In the Detail section, the Revenue metric is calculated at the level of the dataset report, which is Employee. A portion of the document is shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Total</strong></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,832</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
</tr>
<tr>
<td></td>
<td>Ingles</td>
<td>Watter</td>
<td>$229,439</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$209,634</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Total</strong></td>
</tr>
</tbody>
</table>

The metric values match those calculated in the report.
The example above uses a metric in a text field. Metric values in a Grid/Graph in the Group Header or Group Footer are calculated at the level of both the group and the Grid/Graph. For details and an example, see *Calculating metrics at the level of a Grid/Graph and a group: Group Headers and Group Footers, page 122*.

The calculation of the group total is determined by the metric’s definition, specifically by the dynamic aggregation function. For a description of how dynamic aggregation works in documents, see *Dynamic aggregation in documents, page 124*. Summary metrics explicitly set the aggregation function. For other metrics created directly in the document, the function specified in the definition is also used as the aggregation function, if the function is SUM, MIN, or MAX. For steps to create metrics in documents, see *Creating metrics in documents, page 128*.

**Calculating grand totals for metrics: header and footer sections**

A metric placed in a text field in any header or footer section other than a Group Header or Group Footer is calculated as a grand total, totaled across the entire dataset. These document sections include:

- Detail Header
- Detail Footer
- Document Header
- Document Footer
- Layout Header
- Layout Footer

Layout Headers and Layout Footers are only displayed in multi-layout documents. For descriptions and examples of these document sections, see *Layout Header, page 32* and *Layout Footer, page 36*. For background information about layouts in documents, including examples and steps, see *Creating multi-layout documents, page 476*.

- Page Header
- Page Footer

For example, a report contains the Region and Call Center attributes, as well as the Revenue metric. A portion of this report is shown below. The report
contains a grand total to help you compare metric values between the report and the document.

<table>
<thead>
<tr>
<th>Region</th>
<th>Call Center</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>$35,023,708</td>
</tr>
<tr>
<td>Central</td>
<td>Milwaukee</td>
<td>$4,182,139</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fargo</td>
<td>$847,227</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Washington, DC</td>
<td>$3,135,283</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Charleston</td>
<td>$1,317,332</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>Boston</td>
<td>$1,487,936</td>
<td></td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>$7,066,478</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td>San Francisco</td>
<td>$1,021,447</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Seattle</td>
<td>$739,741</td>
<td></td>
</tr>
<tr>
<td>South</td>
<td>New Orleans</td>
<td>$3,305,039</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memphis</td>
<td>$2,084,241</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>Atlanta</td>
<td>$1,052,108</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Miami</td>
<td>$1,187,843</td>
<td></td>
</tr>
<tr>
<td>Southwest</td>
<td>San Diego</td>
<td>$2,962,719</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Salt Lake City</td>
<td>$731,413</td>
<td></td>
</tr>
<tr>
<td>Web</td>
<td>Web</td>
<td>$3,902,762</td>
<td></td>
</tr>
</tbody>
</table>

This report is used as a dataset for a document. The Revenue metric is placed in text fields in the Page Header, Document Header, and Detail Header. Because it is not placed in the Detail section, the Call Center revenue values are not displayed. Labels are included in each document section to indicate the different groups.

- Page Header  $35,023,708
- Document Header $35,023,708
- Detail Header $35,023,708

Notice that the metric values are the same for all the document sections, and they match the grand total calculated in the report. Which document section you place the metric in depends on where you want the information to appear, for instance, the top or bottom of each page (Page Header or Page Footer) or at the beginning or end of the document (Document Header or Document Footer).

The preceding example uses metrics in text fields. Metric values in a Grid/Graph in these document sections are calculated at the level of the Grid/Graph. For details and an example, see *Calculating metrics*.
The calculation of grand totals is determined by the metric's definition, specifically by the dynamic aggregation function. For a description of how dynamic aggregation works in documents, see Dynamic aggregation in documents, page 124. Summary metrics explicitly set the aggregation function; this is their primary role. For other metrics created directly in the document, the function specified in the definition is also used as the aggregation function, if the function is SUM, MIN, or MAX. For steps to create metrics in documents, see Creating metrics in documents, page 128.

Calculating metrics at the level of a Grid/Graph

A metric placed in a Grid/Graph is calculated at the level defined by the attributes, consolidations, and custom groups on the Grid/Graph. (For background information on Grid/Graphs and steps to create them, see Chapter 3, Displaying Reports in Documents: Grid/Graphs.)

Note the following:

- If the Grid/Graph is placed in a Group Header or Group Footer, the level of the group is also included in the metric calculation, as described in more detail in Calculating metrics at the level of a Grid/Graph and a group: Group Headers and Group Footers, page 122.

- A Grid/Graph cannot be placed in the Detail section. This is because the Grid/Graph would be repeated on each row since controls in the Detail section are repeated once per row of the dataset.

For example, a dataset contains the Region and Employee attributes, as well as the Revenue metric. A Grid/Graph containing all these objects is placed in the Detail Header section of the document. A second Grid/Graph, which contains only Region and Revenue, is placed in the Document Header. In the sample report shown below, all of the Grid/Graph containing Region only is
shown, but only a portion of the Grid/Graph with both Region and Employee is included.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,280</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,951</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$347,227</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
</tr>
<tr>
<td></td>
<td>Tomson</td>
<td>Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$322,500</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
</tr>
<tr>
<td></td>
<td>Ingles</td>
<td>Walter</td>
<td>$229,439</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$209,634</td>
</tr>
</tbody>
</table>

The metrics in the Grid/Graphs are calculated at the level of the attributes in the Grid/Graphs—Region only in the top Grid/Graph, Region and Employee in the bottom Grid/Graph. If a Grid/Graph contained only Employee and Revenue, and an employee generates revenue in two regions, the metric value displayed in each region would reflect the total revenue of the employee, for both regions.

If the Grid/Graph does not contain any objects other than the metric, the metric behaves as though it were in a text field in that document section. A metric in a text field in any header or footer section other than a Group Header or Group Footer is calculated as a grand total, totaled across the entire dataset. For example, if Region and Employee were removed from the Grid/Graphs in the previous example, both Grid/Graphs calculate a revenue grand total, as shown below:

<table>
<thead>
<tr>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>
The calculation of these grand totals is determined by the metric’s definition, specifically by the dynamic aggregation function. For a description of how dynamic aggregation works in documents, see *Dynamic aggregation in documents, page 124.*

**Calculating metrics at the level of a Grid/Graph and a group: Group Headers and Group Footers**

A metric placed in a Grid/Graph is calculated at the level defined by the attributes, consolidations, and custom groups on the Grid/Graph, as described in *Calculating metrics at the level of a Grid/Graph, page 120.* When the Grid/Graph is placed in a Group Header or Group Footer, the level of the group is also included in the metric calculation, but only for those grouping fields that exist on the dataset to which the Grid/Graph belongs.

For example, a report contains the Region and Category attributes, as well as the Revenue metric. A portion of this report is shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Books</td>
<td>$370,036</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
<td>$3,506,062</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Movies</td>
<td>$589,357</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>$557,112</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Books</td>
<td>$337,856</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
<td>$3,106,840</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Movies</td>
<td>$518,969</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>$489,049</td>
<td></td>
</tr>
</tbody>
</table>

This report is used as the dataset for a document. The document is grouped by Region, and its Group Header contains a Grid/Graph with Category and Revenue. The Group Header also contains the Region name, to indicate the different groups. A portion of the document is shown below:

<table>
<thead>
<tr>
<th>Category</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$370,036</td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>$3,506,062</td>
<td></td>
</tr>
<tr>
<td>Movies</td>
<td>$589,357</td>
<td></td>
</tr>
<tr>
<td>Music</td>
<td>$557,112</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$337,856</td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>$3,106,840</td>
<td></td>
</tr>
<tr>
<td>Movies</td>
<td>$518,969</td>
<td></td>
</tr>
<tr>
<td>Music</td>
<td>$489,049</td>
<td></td>
</tr>
</tbody>
</table>
The revenue values are calculated at the level defined by the Grid/Graph (Category) but also at the group level (Region). Each Grid/Graph contains the revenue for its specific region and no others. The group (Region) exists on the dataset of the Grid/Graph.

In another example, a document contains two datasets:

- Dataset 1 contains Region, Category, and Revenue. It is the grouping and sorting dataset. (For a description of the role of the grouping and sorting dataset in a document, see Using Intelligent Cubes as datasets, page 74.)

- Dataset 2 contains Region, Call Center, and Revenue.

The document is grouped by Category (from Dataset 1). A Grid/Graph containing Call Center and Revenue (from Dataset 2) is placed on the Group Header. The Group Header also contains the Category name, to indicate the different groups. The Group Header is displayed horizontally, so that the Grid/Graphs are easier to compare. A portion of the document is shown below.

<table>
<thead>
<tr>
<th>Call Center</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Call Center</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlanta</td>
<td></td>
<td>$1,052,108</td>
<td>Atlanta</td>
<td></td>
<td>$1,052,108</td>
</tr>
<tr>
<td>San Diego</td>
<td></td>
<td>$2,062,719</td>
<td>San Diego</td>
<td></td>
<td>$2,062,719</td>
</tr>
<tr>
<td>San Francisco</td>
<td></td>
<td>$1,021,447</td>
<td>San Francisco</td>
<td></td>
<td>$1,021,447</td>
</tr>
<tr>
<td>Washington, DC</td>
<td></td>
<td>$3,135,283</td>
<td>Washington, DC</td>
<td></td>
<td>$3,135,283</td>
</tr>
<tr>
<td>Salt Lake City</td>
<td></td>
<td>$731,413</td>
<td>Salt Lake City</td>
<td></td>
<td>$731,413</td>
</tr>
<tr>
<td>Miami</td>
<td></td>
<td>$1,187,843</td>
<td>Miami</td>
<td></td>
<td>$1,187,843</td>
</tr>
<tr>
<td>Milwaukee</td>
<td></td>
<td>$4,102,139</td>
<td>Milwaukee</td>
<td></td>
<td>$4,102,139</td>
</tr>
<tr>
<td>New Orleans</td>
<td></td>
<td>$3,305,039</td>
<td>New Orleans</td>
<td></td>
<td>$3,305,039</td>
</tr>
<tr>
<td>Seattle</td>
<td></td>
<td>$739,741</td>
<td>Seattle</td>
<td></td>
<td>$739,741</td>
</tr>
<tr>
<td>Boston</td>
<td></td>
<td>$1,487,936</td>
<td>Boston</td>
<td></td>
<td>$1,487,936</td>
</tr>
<tr>
<td>New York</td>
<td></td>
<td>$7,066,478</td>
<td>New York</td>
<td></td>
<td>$7,066,478</td>
</tr>
<tr>
<td>Fargo</td>
<td></td>
<td>$647,227</td>
<td>Fargo</td>
<td></td>
<td>$647,227</td>
</tr>
<tr>
<td>Memphis</td>
<td></td>
<td>$2,084,241</td>
<td>Memphis</td>
<td></td>
<td>$2,084,241</td>
</tr>
<tr>
<td>Charleston</td>
<td></td>
<td>$1,317,332</td>
<td>Charleston</td>
<td></td>
<td>$1,317,332</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

Notice that the revenue values are the same for each Call Center, regardless of which Category is displayed. The revenue values are calculated at the level defined by the Grid/Graph (Call Center) but not at the group level (Category). Each Grid/Graph contains the revenue for all categories. The group (Category) does not exist on the dataset of the Grid/Graph.

If the Grid/Graph does not contain any objects other than the metric, the metric behaves as though it were in a text field in the same document section. As with metrics in text fields in Group Headers and Group Footers, the
calculation is determined by the metric’s definition, specifically by the
dynamic aggregation function. For a description of how dynamic aggregation
works in documents, see *Dynamic aggregation in documents, page 124.*

**Dynamic aggregation in documents**

For background information on dynamic aggregation in metrics, see the
*OLAP Services Guide*.

Dynamic aggregation is the rollup of metric values that occurs when a text
field or a Grid/Graph containing a metric is placed in any document section
other than the Detail section. The function used in this aggregation is defined
in the metric definition, as described in the following points:

- If the metric function is SUM, MIN, or MAX and the dynamic aggregation
  function is set to default, the document aggregates the metric using SUM,
  MIN, or MAX accordingly. If you do not want SUM, MIN, or MAX to be
  used as the dynamic aggregation, change the metric definition by
  specifying the new function to be used as the dynamic aggregation
  function.

- If a metric function other than SUM, MIN, or MAX is used and the
  dynamic aggregation function is set to default, dynamic aggregation does
  not occur. Instead of a value, dashes (--) are displayed (unless you have
  changed the replacement text). To use a specific function, change the
  metric definition by specifying the function to use as the dynamic
  aggregation function.

Compound metrics follow the same rules for aggregation. If a compound
metric does not use a SUM, MIN, or MAX function, and the dynamic
aggregation function is set to default, a null value is generated when the
compound metric is placed in any section other than the Detail section. To
trigger dynamic aggregation, specify the function to use for calculation.

In the case of metrics created directly in the document (calculated
expressions and derived metrics), the function specified in their definition is
used as the aggregation function if the function is SUM, MIN, or MAX. For
details on metrics created directly in a document, see *Creating metrics in
documents, page 128.*

For steps to change the dynamic aggregation function, see the *Dynamic
Aggregation* chapter of the *OLAP Services Guide.*
Calculating totals in documents

Totals reflect accumulations at a given level, and can be applied to any document. A total or subtotal is calculated differently depending on its location in the document.

The calculation of the total is determined by the default subtotal function that is defined in the metric's definition. To specify the function used to calculate a subtotal, create a summary metric (see Using a function to create a subtotal: Creating summary metrics, page 139). If a total does not aggregate the way that you want it or if it does not aggregate at all, see Dynamic aggregation in documents, page 124. To have grand totals calculated for the entire dataset, see Calculating grand totals for metrics: header and footer sections, page 118.

For example, the following document, which is shown in Design View/Mode, is grouped by Region. The same metric is placed in text fields in the Region Header, Detail, and Document Footer sections.

When the PDF is generated, the same metric returns different values in the different locations. The metric in the Detail section is revenue by employee; the metric in the Region Header is regional revenue; and the Document Footer calculates a revenue grand total for the entire document. These
The differences reflect the different locations in the document where the metric is placed.

<table>
<thead>
<tr>
<th>Region: Northeast</th>
<th>Regional Total: $8,554,415</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Revenue</td>
</tr>
<tr>
<td>De Le Torre:Sandra</td>
<td>$163,923</td>
</tr>
<tr>
<td>Kelly:Laura</td>
<td>$608,120</td>
</tr>
<tr>
<td>Kieferson:Jack</td>
<td>$159,489</td>
</tr>
<tr>
<td>Sawyer:Leanne</td>
<td>$639,177</td>
</tr>
<tr>
<td>Sonder:Melanie</td>
<td>$83,490</td>
</tr>
<tr>
<td>Yager:Beth</td>
<td>$592,096</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region: Mid-Atlantic</th>
<th>Regional Total: $1,392,367</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Revenue</td>
</tr>
<tr>
<td>Bernstein:Lawrence</td>
<td>$255,093</td>
</tr>
<tr>
<td>Brown:Vernon</td>
<td>$32,613</td>
</tr>
</tbody>
</table>

[Portions deleted]

<table>
<thead>
<tr>
<th>Region: Web</th>
<th>Regional Total: $3,902,762</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Revenue</td>
</tr>
<tr>
<td>Walker:Robert</td>
<td>$471,475</td>
</tr>
</tbody>
</table>

Grand Total: $13,849,544

The metric calculation for the totals is determined by the default subtotal specified in the metric definition. In this case, the Revenue metric uses SUM.

The following table describes where to place a metric in the document to calculate the metric at a specific level:

<table>
<thead>
<tr>
<th>How the Metric is Totaled</th>
<th>Where to Place the Metric to Achieve This Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totaled at the level returned by the dataset report</td>
<td>In a text field in the Detail section</td>
</tr>
<tr>
<td>Totaled at the level of the group</td>
<td>In a text field in a Group Header/Footer</td>
</tr>
<tr>
<td>Totaled across entire dataset</td>
<td>In a text field in the Document Header/Footer or Page Header/Footer</td>
</tr>
</tbody>
</table>
You can also display totals for groups and for selectors. For examples and steps to show totals for groups, see *Showing totals for a group, page 380.* For details to show totals for selector, see the *Dashboards and Widgets Creation Guide.*

<table>
<thead>
<tr>
<th>How the Metric is Totaled</th>
<th>Where to Place the Metric to Achieve This Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totaled at the level defined by attributes, consolidations, or custom groups on the Grid/Graph, and at the level of the grouping section</td>
<td>In a Grid/Graph control in a Group Header/Footer</td>
</tr>
<tr>
<td>Totaled at the level defined by attributes, consolidations, or custom groups on the Grid/Graph</td>
<td>In a Grid/Graph control in the Document Header/Footer or Page Header/Footer</td>
</tr>
</tbody>
</table>

**To calculate a total on a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. In the document’s Layout area, right-click the metric to be totaled and select **Copy**.

3. Right-click in the location where you want to place the metric and select **Paste**.
   - If you copy the metric to a Group Header or Footer, the metric subtotal at that level.
   - If you copy the metric to the Page Header or Footer, or the Document Header or Footer, a grand total for the metric is calculated.

For details of how a metric is totaled depending on the document section it is placed in, see *Metric calculation in document sections, page 114.*

Copying the metric from the Layout area also copies the metric's formatting. If you drag the metric from the Dataset Objects pane, the default formatting for the control is used (for details, see *Defining default formatting for control types: control defaults, page 255.*)
Creating metrics in documents

You can add metrics to a document in any of the following ways:

- Add metrics from the dataset reports of a document. See *Adding metrics from a dataset report to a document, page 128* for steps.

- Create new metrics directly in the document; for steps, see *Creating metrics directly in the document, page 129*. This approach is useful if you need to achieve any of the following:
  - Perform additional calculations on the metrics from the dataset reports (such as multiplying by a constant or using a function)
  - Create calculations that combine metrics from different dataset reports
  - Create totals using specific functions

For descriptions of the types of metrics that you can create within a document and steps to create each type, see *Creating metrics directly in the document, page 129*.

Adding metrics from a dataset report to a document

To use an existing metric from a dataset report, place the metric into the document in either a Grid/Graph or a text field. In summary:

- A metric in a text field is calculated at the level of the document section in which it is placed. For example, a metric in a Region Group Header is calculated at the regional level. A metric in the Document Footer section is calculated as a grand total for the entire document.

- A metric in a Grid/Graph is calculated at the level of the objects in the Grid/Graph. If the Grid/Graph is placed in a Group Header, the group level is also taken into account. For background information on Grid/Graphs and instructions to create them, see *Chapter 3, Displaying Reports in Documents: Grid/Graphs*.

For a more detailed description of how metrics are calculated in a document, see *Metric calculation in document sections, page 114*.

---

**To add a metric from a dataset report to a document**

1. In MicroStrategy Web, open the document in **Design Mode**.
2 Expand the document section where you want to place the metric by clicking the plus sign next to the section name.

The metric is calculated at the level of the section that you place it in. For example, a metric in a Region Group Header is calculated at the regional level. A metric in the Document Footer section is calculated as a grand total for the entire document. For more details, see *Metric calculation in document sections, page 114.*

3 Select the metric from the objects displayed in the Dataset Objects panel, then drag and drop the metric into the Layout area.

The metric is added to the document in a text field. The dataset name is added to the metric name if the metric exists in multiple datasets.

If the Dataset Objects panel is not displayed, click **Datasets** at the bottom of the panel on the left.

4 The metric is automatically formatted in a default style using the control defaults. You can change the formatting of the text field, as described in *Formatting text fields, page 273.*

5 You can also resize the text field, if needed. See *Sizing controls, page 161* for instructions.

**Creating metrics directly in the document**

Metrics that can be defined directly in the document include calculated expressions, derived metrics, and summary metrics. They are created in the document, not added from the dataset report. Like other metrics, they are calculated at the level returned by the dataset, based on the attributes, consolidations, and custom groups on the dataset.
The various types of metrics that can be created directly in a document all help to achieve different goals. Use the table below to determine which type of metric you should create based on your goal.

Summary metrics provide subtotals; they are discussed in *Calculating totals in documents, page 125* and *Using a function to create a subtotal: Creating summary metrics, page 139*.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Calculated expression</th>
<th>Derived metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use metrics from multiple datasets</td>
<td>Yes</td>
<td>• Yes, in a Grid/Graph</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• No, in a text field</td>
</tr>
<tr>
<td>Use advanced functions, such as banding, cosine, and Chi square distribution</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Place in a grid</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Place in a text field</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Use in conditional formatting</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Reuse within the document</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create on the fly in a text field, without creating a new object and adding it to the layout</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Creating calculated expressions**

A calculated expression is a metric that is calculated dynamically when the document is executed, directly from metrics on a document dataset. Metrics used to define the calculated metric can come from different datasets.

Calculated expressions are created directly in text fields on the document, which makes them quicker to create than derived metrics. Unlike derived metrics, calculated expressions cannot be reused within the document because they are not added to the document as dataset objects. They appear as text fields only.

A calculated expression is created using at least one of the metrics in the document. To define a calculated expression, you combine metrics using any of the following:

• Constants
• Simple arithmetic operators (+, -, *, /)
• Certain advanced functions including many financial, statistical, and mathematical functions

**To use an advanced function, you must type the function syntax in the calculated expression. Syntax for supported functions is included in Appendix D, Advanced Functions for Calculated Expressions.** For details on the individual functions, see the MicroStrategy Functions Reference.

• The logical operator IF

• Parentheses to set the order of arithmetic operations

For example, your grouping and sorting dataset contains the Revenue by Region metric and a second dataset contains Cost by Region. (For details on the grouping and sorting dataset, see Working with multiple dataset reports, page 51.) You need to find the profit, which is calculated from the revenue less the cost, so you create a calculated expression with a definition of Revenue - Cost.

To create the calculated expression for profit in Desktop, drag the Revenue metric from the Dataset Objects panel to the Layout area, which automatically creates a new text field. Right-click the new text field and select **Edit Text**. Type \(- \text{Cost}\) inside the braces, then press **ENTER**. The final text field looks like \{Revenue - Cost\}, as shown on the right side of the image below.

![Image of text field]{Region} {Revenue} {Cost} {Revenue - Cost}
The resulting document looks like the following sample:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td>$4,265,043</td>
<td>764,323</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$3,779,531</td>
<td>673,084</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$7,253,683</td>
<td>1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
<td>$1,494,202</td>
<td>266,986</td>
</tr>
<tr>
<td>South</td>
<td>$5,389,280</td>
<td>$4,582,324</td>
<td>806,956</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td>$1,903,276</td>
<td>336,675</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
<td>$3,132,800</td>
<td>561,331</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
<td>$3,319,225</td>
<td>583,538</td>
</tr>
</tbody>
</table>

An example of an advanced function is Banding, which maps metric values that fall within a certain range to a particular band value. The function returns a number indicating the band. The syntax of this function is `Banding(ValueList, StartAt, StopAt, Size)`.

For example, create bands on the Revenue metric in the document above. Bands are created in $250,000 increments, starting at $1,000,000 and ending at $4,000,000. Band 1 is $1,000,000 to $1,250,000; Band 2 is $1,250,001 to $1,500,000, which includes the Regions South and Northwest; and so on.

To create these bands in a calculated expression, create a text field and type the following in it:

```
{Banding(Revenue, 1000000, 4000000, 250000)}
```

Remember to use braces `{ }` if you type the expression.
The resulting document is shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Revenue Band</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td>0</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>0</td>
</tr>
<tr>
<td>Northeast</td>
<td>$5,554,415</td>
<td>0</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
<td>4</td>
</tr>
<tr>
<td>South</td>
<td>$5,389,280</td>
<td>0</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td>5</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
<td>11</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
<td>12</td>
</tr>
</tbody>
</table>

Because no Revenue value falls between $1,000,000 and $1,250,000, there is no Band 1. Because two regions have revenue between $1,250,001 and $1,500,000, there are two lines for Band 2.

To create a calculated expression

1. In MicroStrategy Web, open the document in Design Mode.
2. Expand the section where you want to place the calculated expression by clicking the plus sign next to the section name.
3. To enter the expression, do one of the following:
   • Drag and drop data fields from the Dataset Objects panel.
   • Add a text field and type the expression in it.
   • Combine the above methods.

Join data fields with an arithmetic operator (+, -, *, /) or use an advanced function. You can use constants and parentheses within the calculation. Parentheses indicate the order of arithmetic operations.

For more detailed instructions to use these methods, see Adding dynamic data to a document, page 83. For a list of supported functions...
and their syntax, see *Appendix D, Advanced Functions for Calculated Expressions*.

Note the following:

- If you type the expression, use braces {} around the entire calculated expression. If the name contains spaces or special characters, type it in brackets [ ] within the braces. Special characters are characters other than a - z, A - Z, 0 - 9, #, _, and . (period).

- If the object exists in multiple datasets, use the format {{dataset name}: [object name]}. This format also allows you to create calculated expressions across datasets.

### Creating, editing, and deleting derived metrics

A derived metric calculates data and displays results dynamically, when a document is executed, by using at least one of the metrics in a document dataset. Metrics used to define the derived metric can come from different datasets, when the derived metric is used on a Grid/Graph. Derived metrics provide the dynamic application of calculations to a document without requiring new metric definitions.

For example, if your dataset contains the dollar sales for a particular region, and you want to view the same data in millions, you can create a derived metric with a definition of \([\text{Dollar Sales}] / 1000000\).

A derived metric:

- Must be a compound metric. A compound metric does not have to be a derived metric.
- Can be reused within the document, including in Grid/Graphs and in conditional formatting expressions.
- Is calculated by the MicroStrategy Analytical Engine based on metrics that are contained in the Dataset Objects pane.
- Cannot use transformation objects.
- If the derived metric will be used on a Grid/Graph, it can use metrics from multiple datasets.
- If the derived metric will be used in a data field, the derived metric must use metrics from the same dataset. To create a calculation that uses
metrics from multiple datasets in a data field, create a calculated expression. For steps, see *Creating calculated expressions, page 130*.

You can also create derived training metrics, which are used for Data Mining Services, on a Grid/Graph. A training metric analyzes data and generates a forecast, or predictive metric. For background information on training metrics and predictive metrics, including instructions to create a derived training metric on a Grid/Graph, see the *Data Mining Services* chapter of the *Advanced Reporting Guide*.

When you create a derived metric, it is added to the Dataset Objects pane but is not placed on the document. You can add it to the document just as you would any other dataset object. If you select a Grid/Graph before creating the derived metric, the metric is added to the Grid/Graph as well as placed in the Dataset Objects pane for future use.

For example, you want to show profit for each region of your business. The grouping and sorting dataset contains both Revenue and Cost by Region. You create a derived metric defined as \((\text{Revenue} - \text{Cost})\).

The following image shows the new derived metric, Profit, in both the Layout area on the right and the Dataset Objects pane on the left.
The resulting document looks like the following sample:

Another document contains two datasets:

- Dataset 1: Category, Subcategory, and Profit
- Dataset 2: Category, Region, and Revenue

A Grid/Graph displays Category, Subcategory, Revenue, Profit, and a derived metric called Derived Cost. The formula of the Derived Cost metric is Revenue - Profit. Notice that the metrics come from different datasets. A sample of the resulting document is displayed below:

Notice that the Revenue amount is the same for each subcategory in a category, because Revenue is available at the Category level (from Dataset 2),
but not at the Subcategory level. Therefore, the Derived Cost metric calculates as Category Revenue - Subcategory Profit. This can be helpful to create a percent-to-total metric.

When a metric is requested at a level lower than it exists in a dataset, the metric level on the Grid/Graph is raised to that of the dataset. This occurs whether a single dataset or multiple datasets are involved.

Steps are below to create, edit, and delete derived metrics.

**Prerequisite**

Before you can combine metrics from multiple dataset reports in a single derived metric, you must have the Import Table from Multiple Data Sources privilege and enable this behavior at the project level. For steps, see *Determining whether Grid/Graphs can use multiple datasets, page 58*.

**To create a derived metric**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Do one of the following:
   - To create a derived metric in a Grid/Graph: Right-click a Grid/Graph in the document’s Layout area and select **Insert New Metric**. The Insert New Metric dialog box opens.
   - To create a derived metric based on an attribute in a Grid/Graph: Right-click the attribute in the Grid/Graph, point to **Insert Metric**, and select the function. The derived metric is created, and you can skip the remaining steps of this procedure.
   - To create a derived metric directly from a metric in the document: From the Dataset Objects pane, right-click the metric on which to base the derived metric, and select **Insert New Metric**. The Insert New Metric dialog box opens. You must be in Design Mode to access the Dataset Objects pane.
   - To create a derived metric directly from a metric or an attribute in the document and base the derived metric on a function: Right-click the metric or attribute in the Layout area and select **Insert Function**. The Insert Function dialog box opens. Continue creating this derived
metric by following the steps to create a summary metric in *Using a function to create a subtotal: Creating summary metrics, page 139.*

3 From the **Available** drop-down list on the left, select the dataset that contains the first object to use to define the derived metric.

4 The pane below the Available list displays objects in the selected dataset. Select the first object to use to define the derived metric and click the > (right arrow) icon. The object moves to the Definition pane on the right.

5 Add a function or operator in one of the following ways:

   • Type an operator such as + or - next to the object name.

   • Click the **Insert Function Wizard** icon to be guided through the process of creating a function. For details on using the Function Wizard, click **Help** in the Function Wizard.

6 Select additional objects to define the derived metric and add them to the Definition pane, or enter a constant. You can choose objects from the selected dataset or change the dataset.

   If you change the dataset to use metrics from multiple datasets, use the derived metric on a Grid/Graph.

7 Click **Apply**. The system assesses whether your derived metric’s definition is valid. If necessary, modify the expression until it is valid.

8 In the **Name** field, type a name for the new metric.

9 Click **OK** to apply the new metric to your document. The new metric is added to the appropriate dataset in the Dataset Objects pane. If you selected a Grid/Graph before creating the metric, the new metric is also added to that Grid/Graph.

10 You can change the number format of the derived metric:

   a In Design Mode, right-click the derived metric in the Dataset Objects pane and select **Number Format**. The Format dialog box opens.

   b Select a number format option, such as Currency or Percentage. An example of the number category and additional options are displayed on the right.

   c Specify the options, such as the number of decimal places.

   d Click **OK** to return to the document.
You can now use the derived metric as you would any other dataset object. You can drag and drop it from the Dataset Objects pane to the document’s Layout area to place it into the document.

If the derived metric uses metrics from multiple datasets, place the derived metric on a Grid/Graph to ensure correct calculations.

---

**To edit a derived metric**

1. In MicroStrategy Web, open the document in **Design Mode**.
2. Right-click the derived metric in the Dataset Objects pane and select **Edit**. The Rename/Edit Objects dialog box opens.
3. Apply any changes you want to make to the metric. See the steps above for creating a derived metric, for details to make changes to the metric.

---

**To delete a derived metric**

1. In MicroStrategy Web, open the document in **Design Mode**.
2. Right-click the derived metric in the Dataset Objects pane and select **Delete from Document**.

---

**Using a function to create a subtotal: Creating summary metrics**

A summary metric is essentially a shortcut to a subtotal. It allows you to select the function to use to calculate the subtotal. If you use a metric from a dataset report rather than a summary metric, the default subtotal function is used to subtotal the metric. This default subtotal function is defined in the metric’s definition and cannot be changed in the document.

A summary metric is calculated differently depending on its location in the document. (For details on how metrics calculate depending on their document section, see *Calculating totals in documents, page 125.*) You can place the same summary metric in multiple locations in the same document.

For example, you need to add a count of employees to a document containing Region and the Revenue metric. The count must be calculated at the regional and document levels. The Revenue metric uses SUM as the default subtotal, but the COUNT function is needed in this case. You can create a summary
metric for Revenue that uses COUNT. With the new summary metric named Count of Revenue, placed in the Region Header and the Document Footer, the result is shown in the following sample.

When the PDF is generated, the same summary metric returns different values in the different document section locations. The metric in the Region
Header calculates a regional count, and the metric in the Document Footer calculates a count for the entire document.

To create a summary metric

1. In MicroStrategy Web, open the document in Design Mode.

2. Right-click the metric in the Dataset Objects pane, point to New Summary Metric, then select the function to use. The new summary metric is added to the appropriate dataset in the Dataset Objects pane.
3 If you need to, you can rename the summary metric:
   a Right-click the summary metric in the Dataset Objects pane and select **Edit**. The Input Metric Formula dialog box opens.
   b Change the metric name and click **OK**.

You can now use the summary metric as you would any other dataset object, by dragging and dropping it from the Dataset Objects pane to the Layout area to place it in the document.

**Displaying real-time web and other HTML content: HTML containers**

You can display real-time information from the web, directly in your document. For example, you can display a stock ticker running in real time next to a Grid/Graph displaying a MicroStrategy report and interactive graphs displaying your corporate financial data, as shown below:

![Financial Analysis](image)

The interactive graphs shown on the bottom of the sample document above are displayed using widgets, which are Flash-based displays of the results of a dataset report. For details on widgets and how to create them, including examples, see the *Dashboards and Widgets Creation Guide*. 
You can interact with the web from the document, such as changing the stock that is being tracked in the stock ticker or clicking links on the web page.

You can also use an HTML container to display text that is formatted by HTML tags, by entering HTML tags into the HTML container. For an example, see *Displaying text formatted by HTML in an HTML container, page 144.*

You can achieve this by adding an HTML container to your document. Then you enter the URL of the website or enter the HTML tags. The real-time information from the web or the formatted HTML is displayed within the HTML container, in the following modes in MicroStrategy Web:

- Express
- Editable
- Flash (to display text formatted with HTML)
- Interactive

You can create HTML containers using either of the following methods:

- You can display a website by typing a URL in the HTML container. The HTML is retrieved dynamically when the document is executed. For examples, see *Displaying a website using a URL (iFrame), page 146.*

- You can display formatted HTML by entering HTML tags in the HTML container. The HTML is interpreted by the user’s browser when the document is executed. For an example, see *Displaying text formatted by HTML in an HTML container, page 144.*

  Fully formatted HTML is not displayed when the document is displayed as a PDF or when the document is exported to Excel.

You can format the HTML container itself, with borders and drop shadows, for instance. For examples and steps, see *Formatting HTML containers, page 281.* The formatting of content inside the HTML container is determined by either the HTML tags (as shown in the example below) or the website displayed by the URL.

You can also arrange and resize HTML containers, as you do other controls. For examples and steps, see *Arranging controls on a document, page 156* and *Sizing controls, page 161.*
Displaying text formatted by HTML in an HTML container

You can type text and HTML tags directly into the HTML container when you create an HTML container. The HTML tags are executed when the document is run in MicroStrategy Web’s Express Mode, Editable Mode, Flash Mode, and Interactive Mode.

For example, the following document, which is shown in Express Mode in MicroStrategy Web, contains an HTML container. The HTML tags in it are simple, but you can use most HTML tags; note the exceptions described in HTML tags supported in Flash Mode, page 144.

```
This is a paragraph in HTML code. The font is gray.
```

The HTML tags are interpreted by the user’s browser.

HTML tags supported in Flash Mode

The following HTML tags are supported in Flash Mode:

- `<A href, event, target>
- `<B>
- `<BR>
- `<FONT color, face, size>
- `<IMG src, width, height, align, hspace, vspace, id, checkPolicyFile>
- `<I>
- `<LI>
- `<P align, class>
- `<SPAN class>
- `<TextFormat blockindent, indent, leading, leftmargin, rightmargin, tabstops>`
• `<U>`

For a full description of the HTML that Flash supports, see the Adobe website at `livedocs.adobe.com/flex/201/langref/flash/text/TextField.html#htmlText`.

**HTML containers in PDF and Excel**

When the document is exported to PDF or Excel, only the text in the HTML container is displayed. The formatting is determined by the formatting of the HTML container, not the HTML tags within it. Notice that the first line is the same size and color as the second line, unlike in the previous sample.

```
HTML code
This is a paragraph in HTML code. The font is gray.
```

In PDF and Excel, anything within the following tags is removed, and does not display:

• `<HEAD>`
• `<STYLE>`
• `<SCRIPT>`

For example, this HTML container, shown in Design Mode:

```
<head> The quick brown fox </head>
<style> Jumped over </style>
<body> The <b>fence</b> </body>
<script> --Anonymous </script>
```

Displays as the following in a PDF:

```
The fence
```
Notice that the text within the head, style, and script tags is not displayed, and the word “fence” is not bolded.

The HTML tags in the examples above are not complete; they are used only to demonstrate the concept.

---

**To insert a HTML container that uses HTML tags**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. Do one of the following:
   - Click the **HTML Container** icon on the toolbar.
   - From the **Insert** menu, select **HTML Container**.

3. In the Layout area, click and drag in the location in which to insert the HTML container.

4. Right-click the HTML container and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

5. By default, an HTML container uses HTML tags rather than a URL to generate the display (see **Displaying a website using a URL (iFrame)**, page 146). Ensure that **HTML text** is selected for the **HTML type**.

6. Click **OK** to save your changes and close the Properties and Formatting dialog box.

7. Double-click the HTML container to type text.

8. Enter the HTML tags in the HTML container. To create a new line, press **CTRL+ENTER**. When you have finished typing, press **ENTER** or click anywhere outside the HTML container.

To see the changes, switch to **Express Mode**.

---

**Displaying a website using a URL (iFrame)**

You can enter the URL of a website in an HTML container. When the document is executed in MicroStrategy Web, the HTML tags are retrieved from the website. This type of HTML container is an iFrame, which is an
HTML element allowing one HTML document to be embedded inside another.

**HTML containers in MicroStrategy Web**

When you display the document in Express Mode, Editable Mode, or Interactive Mode in MicroStrategy Web, the website is displayed within the borders of the HTML container. For example, the HTML container in the following document uses a URL to display the MicroStrategy Resource Center website.

![MicroStrategy Resource Center](image)

The website is not displayed in Flash Mode. Instead, the website’s URL is displayed within the HTML container.

- **URLs** that point to the same MicroStrategy Web server as the one that you are using are not supported. This prevents you from opening the same URL to avoid an infinite loop.

**HTML containers in PDF and Excel**

When the document is exported to PDF or Excel, the contents of the web page are retrieved. The text is displayed, without any of the formatting from the HTML tags on the web page. The formatting is determined by the formatting of the HTML container, not from any HTML tags within it.
For example, the URL www.example.org displays this web page in Interactive Mode in MicroStrategy Web:

```plaintext
You have reached this web page by typing "example.com", "example.net", or "example.org" into your web browser.

These domain names are reserved for use in documentation and are not available for registration. See RFC 2606, Section 3.
```

In the PDF, the website from the same URL displays as:

```plaintext
You have reached this web page by typing &quot;example.com&quot;, &quot;example.net&quot;,
or &quot;example.org&quot; into your web browser.
These domain names are reserved for use in documentation and are not available
for registration. See RFC 2606, Section 3.
```

---

**To insert an HTML container that uses a URL**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Do one of the following:
   - Click the **HTML Container** icon on the toolbar.
   - From the **Insert** menu, select **HTML Container**.
3. In the Layout area, click and drag in the position in which to insert the HTML container.
4. Right-click the HTML container and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
5  Select **iFrame** for the **HTML type**.

6  In the **iFrame Source** field, type the URL of the website. The text “http://” is already automatically filled in, but you can edit or remove it.

7  Click **OK** to save your changes and close the Properties and Formatting dialog box.

The URL is displayed in the HTML container in Design View. To view the URL’s website, you must view the document in Express Mode, Editable Mode, or Interactive Mode in MicroStrategy Web.

---

**Adding shapes and lines to a document**

Shapes and lines can make it easier for business analysts to distinguish between parts of a document, and can help you highlight certain information. In the document sample below, lines are used to differentiate between the regions. A shaded rectangle sets off the regional totals.

<table>
<thead>
<tr>
<th>Central Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellerkamp:Nancy</td>
<td>$847,227</td>
</tr>
<tr>
<td>Gele:Loren</td>
<td>$1,669,290</td>
</tr>
<tr>
<td>Torrison:Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Zemlicka:George</td>
<td>$822,500</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$5,029,366</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mid-Atlantic Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bernstein:Lawrence</td>
<td>$1,060,632</td>
</tr>
<tr>
<td>Brown:Vernon</td>
<td>$331,735</td>
</tr>
<tr>
<td>Corcoran:Peter</td>
<td>$325,147</td>
</tr>
<tr>
<td>Folks:Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td>Hollywood:Robert</td>
<td>$1,026,874</td>
</tr>
<tr>
<td>Ingless:Walter</td>
<td>$229,439</td>
</tr>
<tr>
<td>Smith:Thomas</td>
<td>$221,379</td>
</tr>
<tr>
<td>Young:Sarah</td>
<td>$209,634</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$4,452,615</strong></td>
</tr>
</tbody>
</table>

You can add any of the following to a document:
• Rectangle
• Rounded rectangle
• Horizontal line
• Vertical line

A regular rectangle is shown on the left in the image below, in contrast to the rounded rectangle on the right.

The rounded rectangle in the sample above does not have a border. You can apply borders to rounded rectangles. Borders appear in Flash Mode in MicroStrategy Web.

For steps to change line and rectangle formatting, see Formatting lines and rectangles, page 284.

To add a rectangle to a document

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Expand the section where you want the rectangle to be located by clicking the plus sign next to the section name.

3 From the Insert menu, select Shape, and then Rectangle (for a rectangle with square corners) or Rounded rectangle (Flash only).

4 Click in the document where you want to place the rectangle. Drag to resize the rectangle.

To format a line or rectangle, see Formatting lines and rectangles, page 284.

For rounded rectangles, you can adjust how the rounded corners are displayed in Flash Mode in MicroStrategy Web. For examples and steps, see Controlling the display of rounded corners in Flash Mode, page 285.
To insert a line into a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Expand the section where you want the rectangle to be located by clicking the plus sign next to the section name.
3. From the Insert menu, select Line.
4. Click and drag to draw either a vertical or horizontal line, and to size the line.

You can format the line, such as changing the color and whether the line is solid or dashed. For a list of the various formatting options, see Formatting lines and rectangles, page 284.

Inserting images in a document

You can insert an image such as a logo into a document. The image must be stored so that it is available to both the Intelligence Server and to the designers of the document. If the designers do not have access to the image, they cannot see the image while creating the document.

You can also use dynamic images in documents.

Using dynamic images

Dynamic images allow different images to be displayed depending on the data in the dataset. You can use attributes and metrics to determine the file name of the image.
For example, a document is paged by Region. For each Region, a map for that particular region must be displayed, as in the two pages of the following sample document.

![Northeast Region Map](Northeast.jpg)

<table>
<thead>
<tr>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boston</td>
<td>$1,325,448</td>
</tr>
<tr>
<td>New York</td>
<td>$1,009,416</td>
</tr>
</tbody>
</table>

![Mid-Atlantic Region Map](Mid-Atlantic.jpg)

<table>
<thead>
<tr>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Washington, DC</td>
<td>$1,413,865</td>
</tr>
<tr>
<td>Charleston</td>
<td>$1,999,475</td>
</tr>
</tbody>
</table>

To do this, save the graphic files as the names of the Regions (for example, Northeast.jpg and Mid-Atlantic.jpg). Insert an image in the Region Header. Use the attribute name, within braces, as the name of the image file, for example, `\my_computer\shared\{Region}.jpg`. Specify the directory path and follow the guidelines above to ensure that the image is available to users and designers.
When the PDF is displayed, {Region} in the filename is replaced with the attribute element used in the page-by field. For example, on the Northeast page, the image displayed is Northeast.jpg.

In the same way, you can use a metric to return the name of the image file. For example, a document must display an icon for the daily revenue trend. For revenue growth, the icon is an arrow pointing up; for revenue decline the arrow points down; and for stable revenue the arrow is replaced by a bar.

To do this, create a metric that returns a 1 for growth, 2 for no change, and 3 for decline. Create and name the images accordingly. In the document, point the image to {MetricName}.jpg in the correct directory. When the PDF is displayed, the image path is resolved and the correct file is displayed on each line.

Format the metric as Fixed Type, zero decimal places, and no thousands separator. This ensures that the metric value is returned as 1, 2, or 3, not as $1.00, for example.

**Ensuring access to images**

To ensure that the image is available as needed, use the appropriate paths or references when you add an image:

- An http reference to a central Web server machine, such as http://microstrategy/Test/myimage.jpg. The Intelligence Server must be able to access the machine. If you are adding the image to the document in MicroStrategy Desktop, then Desktop must also be able to access the machine.

  Use this type of reference for documents that will be viewed in Flash Mode; images that use a non-HTTP-based path are not displayed in Flash Mode.

  Avoid using spaces in the URL. On UNIX machines, images with spaces in their URLs cannot display in PDFs. You can remove the space from the image name or replace the space with %20.

- A full path to the image on a shared network drive, such as my_computer\shared\myimage.jpg. All users, the Intelligence Server, and the web server must be able to access the drive. If you are adding the image to the document in MicroStrategy Desktop, then Desktop must also be able to access the drive.
• A partial path, such as Images\myimage.jpg. A partial path is relative to the working directory of the user or application, so that a full absolute path does not need to be provided.

If you use a partial path, the image must be copied in all of the following folders:

- Desktop (for a document viewed in Desktop)
- Documents and Settings\Username\Local Settings\Temp (for a document exported to Excel 2000 from Desktop or a document in MicroStrategy Office)

To export a document to Excel 2003 or later, embed images (see Displaying images in Excel, page 368, for instructions and more details) to ensure that the images are displayed correctly in Excel.

- Intelligence Server (for a document exported to PDF from MicroStrategy Web)
- Web ASPx\asp (for documents in MicroStrategy Web) or \jsp (for documents in MicroStrategy Web Universal)

The Web directory is the physical location where the Web product is installed (for MicroStrategy Web) or where it is deployed (for MicroStrategy Web Universal).

For example, if the image is on a Web server machine, you can specify the URL (an http reference) for the file as long as the Intelligence Server and users who design the documents can access that location. Once the location is established and the image file that you want to insert is available in that location, you can insert the image into a document.

In most instances, you can find the path and file name of images to use by viewing the source of a Web page.

The advantages of using partial or relative paths are:

- Desktop, Intelligence Server, and the web server can access the same shared file location.
- The path of the image is not part of the document definition. If the path changes, you do not have to manually change the image path in the document.
The advantage of using absolute paths (an http or full path) is:

- The images do not need to be duplicated onto each machine, as described above.

**Inserting an image**

To insert an image, follow the steps below.

**Prerequisites**

- The image file must be saved in the correct image type: bmp, jpg, jpeg, or gif.
- The image file must be stored so that it is available to both the Intelligence Server and to the designers of the document.
- For dynamic images, you must have created the image files with the appropriate names. To use an attribute the file names must be the attribute elements; to use a metric, the file names must be the values returned by the metric.

**To insert an image in a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, select **Image**.
3. Click and drag in the location where you want to insert the image. The Properties and Formatting dialog box opens.
4. In the **Source** field, type in the path for the image file. In general, you can type the file path in a C:/My_Images/logo.gif format, with the following important exceptions:
   - If the document will be opened in Flash Mode, use an HTTP-based image path. Do not use a network image path (for example, \\ corporate-administrator\Shared\image.jpg) or a local image path (for example, C:\My_Images\image.jpg). Images that use a non HTTP-based path are not displayed in Flash Mode.
   - If the document will be exported to Excel, use an absolute image path. Do not use a relative image path. Images that use a relative image path are not displayed in Excel.
• If you are inserting a dynamic image, type the folder path to the image files, then the attribute or metric name in braces { }, followed by the file extension. Use brackets [ ] if the attribute or metric name contains spaces. For example, the following image source points to the Revenue Trend metric: \my_computer\shared\{[Revenue Trend]}.jpg.

5 To have the size of the image adjust automatically, right-click the image and select Size and then select To Grid.

6 If you want users to be able to click the image and go to a web page, you can define the image as a hyperlink. From the Properties and Formatting dialog box, click General, select the Is Hyperlink check box, and type the URL in the Hyperlink field.

For information about changing image formatting, such as borders, see Formatting images, page 287.

Arranging controls on a document

Once you have added data and other controls to a document, you can arrange them on the document to determine their layout when viewed as a PDF. This section explains the ways in which you can move and arrange controls.

• Moving controls, page 156
• Snapping controls to the alignment grid, page 158
• Distributing controls evenly, page 160
• Sizing controls, page 161
• Locking and unlocking controls, page 162
• Ordering controls, page 163

Moving controls

You can modify the look of your PDF document by specifying the positions of the controls. You can move controls in relationship to each other, by aligning them.
If multiple controls are selected and moved, they move as a block. The selected controls do not have to be in the same document section; you can select controls that are in different document sections.

You can evenly distribute controls automatically; for steps, see Distributing controls evenly, page 160.

If a selected control does not move, it may be locked. A locked control cannot be resized or moved on the Layout area. For steps to unlock it, see Locking and unlocking controls, page 162.

---

**To move a control**

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Click a control to select it. To select multiple controls, press and hold CTRL while selecting controls.

3 Do any of the following:

   • Drag and drop the control(s) at the new location, which can be in the same document section or a different one.

   • Use the arrow keys on your keyboard to reposition a control within the document section. To move in smaller increments, press and hold CTRL while using the arrow keys. If you have Snap to grid enabled, it is temporarily disabled.

   • To specify an exact location within the document section, right-click a control and select Properties and Formatting. On the Layout tab, specify the new position for the control in the Position area.

   • To align controls in the same document section or a different one, select multiple controls, right-click a control, point to Align, then select one of the following options:

     ▪ **Align Left**: Horizontally aligns all selected controls with the left-most control.

     ▪ **Align Center**: Horizontally centers all selected controls.

     ▪ **Align Right**: Horizontally aligns all selected controls with the right-most control.

     ▪ **Align Top**: Vertically aligns all selected controls with the topmost control.
- **Align Middle**: Vertically centers all selected controls.

- **Align Bottom**: Vertically aligns all selected controls with the lowest control.

- **To Grid**: Aligns the upper left corner of all selected controls to the closest grid point.

**Snapping controls to the alignment grid**

Snap to grid means that controls are automatically aligned to grid points. If this feature is enabled, the top left corner of the control automatically moves from one grid point to another grid point when you move or resize the control. When you create a new control, the top left corner of the control is aligned to a grid point. If you drag a control while creating it, all corners of the control are aligned to the grid.

If snap to grid is disabled, you can add, move, or resize controls freely without reference to the alignment grid. The corners do not automatically move to grid points.

To temporarily disable snap to grid, press the **CTRL** key while moving or sizing controls.
For example, you can align a heading in the Detail Header above its data column in the Detail section. This is shown in the following Desktop image in which two Month controls, in different document sections, are aligned.

The resulting aligned controls are shown in the following image:
To enable or disable the Snap to Grid feature

1. In MicroStrategy Web, open the document in **Design Mode**.

2. From the **Tools** menu, select **Snap to Grid**. If Snap to Grid was enabled, it is now disabled. Snap to Grid is enabled by default.

   If the alignment grid is not visible when you enable Snap to Grid, you can display it by selecting **Alignment Grid** from the **Tools** menu.

Distributing controls evenly

You can evenly distribute controls that are not well-spaced. For example, the image below shows three controls in a document. Note the difference in vertical gaps between the selected controls (\&DOCUMENT, \&FILTERDETAILS, \&DATETIME).

The result after the vertical distribution is shown in the following image, where the controls are distributed relative to each other:
To distribute controls relative to the layout, instead of relative to other controls, use Desktop. For steps, see the Desktop Help.

---

**To distribute controls evenly**

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Press and hold CTRL, then select at least three controls.
3. Right-click one selected control and choose Align.
4. Select one of the following options:
   - **Distribute Horizontally**: Evenly spaces the selected controls across the width of the page.
   - **Distribute Vertically**: Evenly spaces the selected controls across the height of the section.

---

**Sizing controls**

You can size text fields, images, rectangles, and other controls. You can resize by dragging the edges of a control or by specifying a control’s height and width. If you resize multiple controls at one time, they can be uniformly sized. Steps to size a single control and multiple controls are below.

If a selected control does not resize, it may be locked. A locked control cannot be resized or moved until it is unlocked. For steps to unlock it, see *Locking and unlocking controls, page 162*.

---

**To size a single control**

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Select a control and do one of the following:
   - Drag any of its sizing handles to its new size.
   - Press and hold SHIFT while pressing the up, down, left, or right arrow keys on the keyboard.
   - Right-click the control and select Properties and Formatting. From the left, select Layout. Then define the sizing options for the control:
- **Width**: Sets the width of the control. This option is not available for section headers or footers.
  - **Fixed at**: The width does not change from the set size. This option is not available for sections, panel stacks, or selectors.
  - **100%**: Sets the item's width to that of the section. This option is used for lines and rectangles only; it is not available for sections, panel stacks, or selectors.
  - **Fit to contents**: The width expands to the width of the item. This option is not available for sections, panel stacks, text fields, or selectors.

- **Height**: Sets the height of the control.
  - **Fixed at**: The height does not change from the set size.
  - **100%**: Sets the item's height to that of the section. This option is used for lines and rectangles only; it is not available for sections or panel stacks.
  - **Fit to contents**: The height expands to the height of the item. This option is used for text fields and Grid/Graphs displayed as grids, and only affects display in Express Mode. This option is not available for sections or panel stacks.

- **Length**: These options are available for lines; they determine whether the length of a line adjusts dynamically.
  - **Fixed at**: The length does not change from the set size.
  - **100%**: The line's length changes automatically to remain the length of the section.

3 Display the document in Interactive Mode, Express Mode, or Flash Mode to see your resizing results.

4 Save the document.

**Locking and unlocking controls**

A control can be locked, so that it cannot be resized or moved. This is useful when a document template contains an object that should not be moved or resized inadvertently when multiple objects are selected at the same time. It also avoids a control being accidentally moved or resized using the sizing handles.
The following options are affected when a control is locked: height, left, top, and width.

**To lock a control**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Add a control to the document, if it does not already contain one.
3. Right-click the control and select the **Properties and Formatting** option. The Properties and Formatting dialog box opens.
4. In the Layout area of the dialog box, select the **Locked** check box and then click **OK**. The control is locked.

**To unlock a locked control**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Add a control to the document, if it does not already contain one.
3. Right-click the control and select the **Properties and Formatting** option. The Properties and Formatting dialog box opens.
4. In the Layout area of the dialog box, clear the **Locked** check box and then click **OK**. The control can now be moved.

**Ordering controls**

You may have controls that you want to overlap, with one control on top of the another that is in the background. You can change the order of a control and display it in front of or behind another control.
The example below, created in Desktop, shows a rectangle that needs to be placed behind the Document Title (to create a drop shadow).

The result, with the title in front, is shown below:

To order controls

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click a control, highlight Order, and select one of the following options:
   - **Send to Back**: Moves the control behind the other control(s).
   - **Bring to Front**: Moves the control in front of the other control(s).
   - **Send Backward**: When three or more controls overlap and you want to incrementally send one control back, but not all the way to the back.
   - **Bring Forward**: When three or more controls overlap and you want to incrementally bring one control forward, but not all the way to the front.

In MicroStrategy Web, you can also access these ordering options from the Align and Order toolbar. To show the Align and Order toolbar, from the menu, select Align and Order.
Restoring images to their default size

If you change the size of an image but are not satisfied with the results, you can restore the image to its original, or default, size.

To restore the default size of an image

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click the image and select Restore Default Size.
Introduction

In a document, you can display a report by adding a Grid/Graph to the document. A Grid/Graph acts as a standard MicroStrategy report.

Once a Grid/Graph is in the document, you can display it in several ways:

- **Grid**: Displays the Grid/Graph as a standard MicroStrategy grid report with rows and columns of attributes and metrics, as shown below. For details, see *Viewing a Grid/Graph displayed as a grid, page 197.*

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td>$8,647,238</td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td>$11,517,606</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$14,858,864</td>
</tr>
</tbody>
</table>
• **Graph**: Displays the data visually like a standard MicroStrategy graph report, as shown below. For details, see *Viewing a Grid/Graph displayed as a graph, page 198.*

![Graph Example](image)

• **Grid and Graph**: Displays both grid and graph reports simultaneously, as shown below. For details, see *Viewing a Grid/Graph as a grid and a graph at the same time, page 198.*

![Grid and Graph Example](image)

You can use a Grid/Graph as a type of summary for a group or the entire document, because the data displayed in it is aggregated to the level of the document section in which the Grid/Graph is placed. If the Grid/Graph is in one of the Group Header or Group Footer sections, it limits the data displayed in it to only that which is included in that group.
For example, a document is grouped by Region, and you place a Grid/Graph in the Region Header section. If Region contains three values (Midwest, Northeast, and Northwest), the Grid/Graph aggregates and displays only Midwest data in the Midwest Region Header, only Northeast data in the Northeast Region Header, and only Northwest data in the Northwest Region Header. The following sample Grid/Graph is for the Northeast region.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>De La Torre</td>
<td>Sandra</td>
<td>Northeast</td>
<td>$607,895</td>
<td>$93,100</td>
<td>$514,795</td>
</tr>
<tr>
<td>Kelly</td>
<td>Laura</td>
<td>Northeast</td>
<td>$2,350,720</td>
<td>$357,994</td>
<td>$1,992,726</td>
</tr>
<tr>
<td>Kieferson</td>
<td>Jack</td>
<td>Northeast</td>
<td>$564,933</td>
<td>$87,470</td>
<td>$479,463</td>
</tr>
<tr>
<td>Sawyer</td>
<td>Leanne</td>
<td>Northeast</td>
<td>$2,411,912</td>
<td>$368,219</td>
<td>$2,043,693</td>
</tr>
<tr>
<td>Sonder</td>
<td>Melanie</td>
<td>Northeast</td>
<td>$295,108</td>
<td>$43,925</td>
<td>$251,183</td>
</tr>
<tr>
<td>Yager</td>
<td>Beth</td>
<td>Northeast</td>
<td>$2,303,847</td>
<td>$350,024</td>
<td>$1,953,823</td>
</tr>
</tbody>
</table>

You can use a Grid/Graph to display a subset or view report, which is a report containing objects that are part of the report’s definition but are not displayed on the grid or graph. For details, see Using a view report or base report as a dataset, page 74.

This chapter describes how to add Grid/Graphs to documents and how to work with them:

- Adding a Grid/Graph to a document, page 170
- Selecting and viewing a Grid/Graph, page 196
- Editing data in a Grid/Graph, page 201
- Formatting Grid/Graph containers, page 207
- Adding title bars to Grid/Graphs, page 211
- Quick switch for Grid/Graphs, page 215
- Using view filters on Grid/Graphs, page 217
- Linking a Grid/Graph to its underlying report, page 229
- Merging column and row headers in a grid, page 232
- Displaying attribute and attribute form headers in a grid, page 233
- Drilling in Grid/Graphs, page 238
- Enabling interactive Grid/Graphs for MicroStrategy Web, page 244
Adding a Grid/Graph to a document

A Grid/Graph is a container that is placed in a document and which displays a standard MicroStrategy grid or graph report. A Grid/Graph can be directly associated with one dataset report or with multiple dataset reports. The data from the reports is used to populate the Grid/Graph.

Before you can place objects from multiple dataset reports on a single Grid/Graph, you must have the Import Table from Multiple Data Sources privilege.

A Grid/Graph can be placed anywhere in a document except the Detail section. (Since controls in the Detail section are repeated once per row of the dataset, the Grid/Graph would be repeated on each row.)

You can add a Grid/Graph to a document in any of the following ways:

- If the document already contains the dataset report that will populate the Grid/Graph with data, then do one of the following:
  - Create a Grid/Graph that includes all the objects of the report, whether they appear on the report grid or in the Report Objects pane. Any view filters on the report are not applied to the Grid/Graph.
  - Create a Grid/Graph that looks like the report itself—the report formatting is copied and only those objects displayed on the report grid are copied onto the Grid/Graph. Any view filters on the report are applied to the Grid/Graph.

  If the report formatting changes or objects are added to or deleted from the report, the Grid/Graph in the document does not change. To link the Grid/Graph to the report, create the Grid/Graph as a shortcut (see below).

  Both of these procedures are included in To add a Grid/Graph, page 172.

- If the document does not contain the dataset report, then you can add a dataset and a Grid/Graph simultaneously. For steps, see Adding a Grid/Graph and a new dataset simultaneously, page 175.

- You can create a Grid/Graph that contains objects from multiple dataset reports. For steps and information on how the datasets are joined, see Adding a Grid/Graph that uses multiple datasets, page 178.

- You can create an empty Grid/Graph, or placeholder, which you then populate with data from a dataset report. The placeholder can display as a grid or as a graph, and you can select the type of graph to display. For
You can use Grid/Graph placeholders to create document templates with formatted Grid/Graphs that do not contain any data.

- You can create a Grid/Graph as a shortcut. A shortcut is linked to the dataset report itself, which means that any changes (such as formatting) made to the dataset report are passed to the Grid/Graph in the document. You cannot edit a Grid/Graph shortcut. For information on what you can do with shortcuts, including formatting and unlinking, and steps, see Adding a Grid/Graph as a shortcut, page 191.

If a Grid/Graph is not linked to the dataset report as a shortcut, changes made to the dataset report are not passed to the Grid/Graph. For example, the Revenue metric values on a report are displayed in blue font. That report is used as the dataset report for a Grid/Graph in a document. Later, the font of the Revenue metric values on the report is changed to green. The color of the Revenue values on the Grid/Graph in the document does not change.

If the Grid/Graph is linked as a shortcut, the color of the Revenue values would change when the Revenue values on the report were changed.

If an object is removed from the dataset report, that object is also automatically removed from the Grid/Graph in the document, regardless of whether or not the Grid/Graph is linked as a shortcut.

**Grid/Graphs and automatic target maintenance for selectors**

Selectors allow a user to display different metrics or different elements of attributes, custom groups, or consolidations in a Grid/Graph (the target of the selector). Targets can be automatically maintained in a layout. This means that when you add a Grid/Graph, the Grid/Graph is the target of all selectors in the same panel or document section as the Grid/Graph. For more information about automatically maintaining targets for selectors, including steps to enable and disable the functionality, see the Dashboards and Widgets Creation Guide.

**Prerequisites**

- This procedure assumes that the document contains the dataset report that will populate the Grid/Graph with data.
To add a Grid/Graph

1. In MicroStrategy Web, open the document in Design Mode.

2. Do one of the following:

<table>
<thead>
<tr>
<th>To Create</th>
<th>Follow These Steps</th>
</tr>
</thead>
</table>
| An empty Grid/Graph that is not displayed in the PDF or in Express Mode  | From the Insert menu, select one of the following, and then click and drag in the section where you want to place the Grid/Graph:  
   • To create an empty grid, select Grid.  
   • To create an empty graph, point to Graph, and then select the graph type.  
   An empty Grid/Graph is a placeholder; you can populate it later with data from a dataset report. For steps, see Editing data in a Grid/Graph, page 201. |
| A Grid/Graph containing all the objects on a dataset report               | 1. Click in the document section where you want to add the Grid/Graph.  
   2. Right-click the dataset in the Dataset Objects panel and select Add to Section without formatting.  
   Any view filters are ignored and all objects on the report, whether they are on the grid or only in the Report Objects pane of the report. |
| A Grid/Graph with several dataset objects on it                           | 1. Add an empty Grid/Graph, as described above.  
   2. Select an object in the Dataset Objects panel, and then drag and drop it in the empty Grid/Graph. Repeat for each dataset object. |
| A Grid/Graph containing objects from multiple dataset reports             | 1. Add an empty Grid/Graph, as described above.  
   2. Select an object in the Dataset Objects panel, and then drag and drop it in the empty Grid/Graph. Repeat for each dataset object.  
   The dataset source for the Grid/Graph is determined by the last object added to the Grid/Graph.  
   For more detailed steps, and information on how the datasets are joined, see Adding a Grid/Graph that uses multiple datasets, page 178. |
You can place a Grid/Graph anywhere in a document except the Detail section. Since controls in the Detail section are repeated once per row of the dataset, the Grid/Graph would be repeated on each row.

3 The Grid/Graph is added. Its default display is as a grid (a standard MicroStrategy grid report with rows and columns of attributes and metrics), unless you added an empty graph or a graph report with formatting. You can change the display by selecting one of the following view options:

- **Graph**: Right-click the Grid/Graph, point to View Mode, and select **Graph View**. The width and height are automatically set to fixed.

- **Grid**: Right-click the Grid/Graph, point to View Mode, and select **Graph View**. The width is set to fit to contents and the height is fixed.

- Grid and graph: Right-click the Grid/Graph, point to View Mode, and select **Grid and Graph View**. To control the placement of the grid relative to the graph, select the **Layout** category from the Properties

### Table: To Create

<table>
<thead>
<tr>
<th>To Create</th>
<th>Follow These Steps</th>
</tr>
</thead>
</table>
| A Grid/Graph that:  
  - Copies the formatting of the report  
  - Contains only those objects displayed on the report grid (versus those in Report Objects but not on the report grid) | 1 Click in the document section where you want to add the Grid/Graph.  
  2 Right-click the dataset in the Dataset Objects panel and select Add to Section with formatting.  
Any view filters on the report are applied to the Grid/Graph. Only the objects on the report grid are displayed on the Grid/Graph.  
If the formatting of the report used as a dataset changes, the formatting of the Grid/Graph does not change. If you want the formatting to change, use a shortcut instead.  
**Note**: This method allows you to use a subset or view report as a dataset. For background information on subset reports, see Using a view report or base report as a dataset, page 74. |
| A Grid/Graph linked to the dataset as a shortcut | 1 Click in the document section where you want to add the Grid/Graph shortcut.  
  2 Right-click the dataset in the Dataset Objects panel and select Add to Section as Shortcut.  
The resulting Grid/Graph is linked to the source report, so that any changes made to the source report are passed to the Grid/Graph in the document.  
To edit the dataset report in the Grid/Graph, you must first unlink the Grid/Graph shortcut; for steps, see To unlink a linked Grid/Graph shortcut, page 194. |
and Formatting dialog box, then select an option from the Grid Position drop-down list.

After a Grid/Graph has been added to the document, you can:

- Add additional objects to the Grid/Graph. See Editing data in a Grid/Graph, page 201 for steps.

- Enable quick switch between graph view and grid view for end users. For a description of quick switch and steps, see Quick switch for Grid/Graphs, page 215.

- Display a title bar, which allows MicroStrategy Web users to minimize and maximize the Grid/Graph. It also helps identify the Grid/Graph in all views. For examples and steps, see Adding title bars to Grid/Graphs, page 211.

- Resize the Grid/Graph. For steps, see Selecting and viewing a Grid/Graph, page 196.

- Create a view filter to filter the data that is displayed in the Grid/Graph. For examples and steps, see Using view filters on Grid/Graphs, page 217.

- Change the dataset, which provides the data displayed on the Grid/Graph. For steps, see Changing datasets in Grid/Graphs, page 195.

- Enable drilling on the data in the Grid/Graph. For information on drilling and steps, see Drilling in Grid/Graphs, page 238.

- Format different parts of the Grid/Graph:
  - Format the Grid/Graph container (the object that displays the grid or graph report within the document) to change settings such as name, position, size, borders, and background of the object displaying the report grid or graph. See Formatting Grid/Graph containers, page 207 for steps.

  - Edit the Grid/Graph, to change settings on the grid or graph report, such as row and column formatting, graph style, and sorting. See Selecting and viewing a Grid/Graph, page 196 for steps.

  - Format the title bar to affect how the title bar is displayed, such as the font, background, and border. See Formatting Grid/Graph containers, page 207 for a comparison of formatting the container and the title bar, and steps.

Formatting affects the Grid/Graph on the document; it does not change the original report. Similarly, any changes made to the original report,
such as formatting a metric or changing the graph type, are not propagated to the Grid/Graph, unless the Grid/Graph is a shortcut. If an object is removed from the original report, that object is also removed from the Grid/Graph in the document, regardless of whether or not the Grid/Graph is linked as a shortcut. For more information on linking Grid/Graphs as shortcuts, see Adding a Grid/Graph as a shortcut, page 191.

Adding a Grid/Graph and a new dataset simultaneously

If the report that will populate the Grid/Graph with data has not been added to the document yet, you can add a new dataset report and a Grid/Graph to the document at the same time.

To add a dataset and a Grid/Graph simultaneously

1. In MicroStrategy Web, open the document in Design Mode.
2. From the Insert menu, select Report.
3. Click and drag in the section where you want the Grid/Graph. The Select Dataset dialog box opens.

You can place a Grid/Graph anywhere in a document except in the Detail section. Since controls in the Detail section are repeated once per row of the dataset, the Grid/Graph would be repeated on each row.

4. Locate and select the report to add to the document. This dataset report also provides the data for the new Grid/Graph.
5. Select whether or not to use the formatting of the report:
   - To create a Grid/Graph that includes all the objects of the report, whether they appear on the report grid or in the Report Objects pane, clear the Add with formatting check box. Any view filters on the report are not applied to the Grid/Graph. The default Grid/Graph formatting is applied to the Grid/Graph.
   - To create a Grid/Graph that looks like the report itself (the report formatting is copied and only those objects displayed on the report grid are copied onto the Grid/Graph), select the Add with formatting
check box. Any view filters on the report are applied to the Grid/Graph.

6 Click **OK** to return to the document.

A new Grid/Graph is displayed in the document, and the dataset report is displayed in the Datasets pane.

### Adding an empty Grid/Graph

An empty Grid/Graph is a Grid/Graph without a dataset report to populate the Grid/Graph with data. An empty Grid/Graph serves as a placeholder. The Grid/Graph placeholder is not displayed when the document is viewed as a PDF or in Express Mode, until you add a dataset report to it. For steps to add dataset reports to empty Grid/Graphs, see *Adding a dataset to an empty Grid/Graph, page 177*.

Empty Grid/Graphs can save time by allowing you to create a document template containing Grid/Graph placeholders but no dataset reports. You can then use the template to create several different documents, each with specific dataset reports and Grid/Graphs populated by those dataset reports.

The formatting of the empty Grid/Graph is retained when you add a dataset report to the Grid/Graph. This allows you to format all Grid/Graphs identically in documents that are created based on a template, regardless of the formatting on the underlying dataset reports.

To format a Grid/Graph placeholder, populate it with data, format it, and then remove the data. The formatting is retained on the placeholder. To format the rows and columns of a Grid/Graph, edit the Grid/Graph and then format it. For steps, see *Selecting and viewing a Grid/Graph, page 196*.

You can also copy the formatting from the report. If you are creating a template, each Grid/Graph can be formatted differently, depending on the formatting in the original reports.

---

**To add an empty Grid/Graph to a document**

1 In MicroStrategy Web, open the document in **Design Mode**.
2 Do one of the following:

- To add a placeholder that displays as a grid, select Grid from the Insert menu.
- To add a placeholder that displays as a graph, point to Graph on the Insert menu, and select the graph style. For descriptions of the various graph styles, see the Advanced Reporting Guide.

3 Click and drag in the section where you want the Grid/Graph placeholder.

You can place a Grid/Graph placeholder anywhere in a document except in the Detail section. Since controls in the Detail section are repeated once per row of the dataset, the Grid/Graph would be repeated on each row.

A new Grid/Graph placeholder is displayed as an empty Grid/Graph in the document. You need to add a dataset to the Grid/Graph placeholder to populate it with data, as described below.

## Adding a dataset to an empty Grid/Graph

You can add a dataset report to an empty Grid/Graph by either dragging an existing dataset report to the Grid/Graph placeholder, or by adding a new dataset report to the Grid/Graph placeholder.

The data on the selected dataset report (either new or existing) is used to populate the Grid/Graph placeholder.

### To add an existing dataset to an empty Grid/Graph

1 In MicroStrategy Web, open the document in Design Mode.

2 Do one of the following:

- To retain the formatting of the report, drag and drop the name of the dataset report from the Datasets pane to the Grid/Graph placeholder.
- To use the formatting of the Grid/Graph placeholder, hold down the SHIFT key while dragging and dropping the dataset report’s name from the Datasets pane to the Grid/Graph placeholder.
When the document is executed, the Grid/Graph is populated with data from the selected dataset report. For details on formatting the Grid/Graph, see *Adding an empty Grid/Graph, page 176.*

---

**To add a new dataset to an empty Grid/Graph**

1. In MicroStrategy Web, open the document in **Design Mode**.

2. Click the **Add Dataset** icon on the Grid/Graph placeholder (an empty Grid/Graph). The Select Dataset dialog box opens.

3. Locate and select the dataset report to provide the data for the Grid/Graph.

   ![Warning] You can select a report that is already used as a dataset on the document, or you can select a report that is not included on the document.

4. Select whether or not to use the formatting of the report:
   - To include all the objects of the report, whether they appear on the report grid or in the Report Objects pane, clear the **Add with formatting** check box. Any view filters on the report are not applied to the Grid/Graph. The default Grid/Graph formatting is applied to the Grid/Graph.
   - To copy the report formatting and include only those objects displayed on the report grid, select the **Add with formatting** check box. Any view filters on the report are applied to the Grid/Graph.

5. Click **OK** to return to the document.

The dataset report is added to the Datasets pane. When the document is executed, the Grid/Graph is populated with data from the selected dataset report. For details on formatting the Grid/Graph, see *Formatting Grid/Graph containers, page 207.*

**Adding a Grid/Graph that uses multiple datasets**

Objects from multiple datasets can be displayed in a single Grid/Graph. For example, a document contains two datasets. The Regional Revenue dataset contains Region and Revenue, while the Regional Profit dataset contains Region and Profit. The original datasets are displayed in the two Grid/
Graphs on the top, with their dataset names displayed in the title bar. The Grid/Graph on the bottom contains data from both datasets.

The title bar on the bottom Grid/Graph also displays its dataset name—Regional Profit. Although the data comes from both datasets, Profit, which comes from the Regional Profit dataset, was added to the Grid/Graph last. If Revenue, from the Regional Revenue dataset, was added after Profit, the Grid/Graph’s dataset would be set to Regional Revenue.

To show the dataset name in the Grid/Graph title bar, display the title bar but do not add a name for the Grid/Graph. For detailed steps, see *Adding title bars to Grid/Graphs, page 211*.

The dataset (or data source) of a Grid/Graph that uses multiple datasets is determined by the last object added to the Grid/Graph. For example, the Category attribute and Revenue metric from Dataset1 are dragged onto a blank Grid/Graph. The Grid/Graph’s data source is therefore defined as Dataset1. If you place the Region attribute from Dataset2 on the Grid/Graph, the data source changes to Dataset2. If you delete an object from the Grid/Graph, the data source does not change. If you delete an object from the Grid/Graph, the data source does not change. Only the addition of an object updates the source for the Grid/Graph; removing or deleting an object does not. You can also change the data source; see *Changing datasets in Grid/Graphs, page 195* for steps.
To allow a single Grid/Graph to contain objects from multiple datasets, you must have the Import Table from Multiple Data Sources privilege. For steps to create a Grid/Graph that uses multiple datasets, see *Adding a Grid/Graph with multiple datasets, page 190*.

By default, a project allows Grid/Graphs to contain objects from multiple datasets. However, you can change the project configuration settings to require that all objects in a single Grid/Graph come from a single dataset. For steps, see *Determining whether Grid/Graphs can use multiple datasets, page 58*.

**Primary and secondary datasets: Same attributes, different metrics**

Because the two datasets in the example above contain data for the same attributes, the data can be joined and information for all metrics and all attribute elements can be displayed.

The Regional Revenue dataset is replaced on the document by the Northern Revenue dataset, which is filtered to include only the Northeast and Northwest regions. The new document is shown below. Notice that all the regions are still included in the Grid/Graph that uses both datasets (renamed
to Combined Grid/Graph), but revenue amounts are available only for Northeast and Northwest.

The Regional Profit dataset is replaced on the document by the Southern Profit dataset, which is filtered to include only the South, Southeast, and Southwest regions. Because the datasets do not contain the same attributes, the Combined Grid/Graph has holes in its data, as shown below:

By default, both datasets are primary datasets. All of the elements from a primary dataset are displayed, as shown in the example above. Specifying the
join behavior of a dataset as either primary or secondary specifies which datasets determine the attribute elements that appear in the results.

Southern Profit is changed to a secondary dataset. Elements from a secondary dataset is displayed only if they also appear in a primary dataset. Because the southern regions are not in the Northern Revenue dataset, they are not displayed in the Combined Grid/Graph, as shown below. Profit is not displayed for the northern regions because that data does not exist in either dataset.

If both datasets are changed to be secondary datasets, the Combined Grid/Graph is blank because none of the attribute elements appear in a primary dataset. This scenario is shown below:

Having the same attributes in multiple datasets can result in blank data or an entirely blank Grid/Graph. This especially occurs if different filters on the same attribute are applied to the datasets. If you add a selector on the shared attribute, end users can be confused about which attribute elements are displayed in the selector and which in the target Grid/Graph. A slicing selector shows only the items available in the target, while a filtering selector shows all the items available in all the datasets. While you design your document and datasets, keep these differences in mind. For examples of
selectors on an document that contains multiple datasets, see the
Dashboards and Widgets Creation Guide.

In the Dataset Objects pane, any attributes common to multiple
datasets are displayed with a blue icon, as Category is in the example
shown below:

For a more detailed explanation of primary and secondary datasets, see
Working with multiple dataset reports, page 51 and Defining a dataset as
primary or secondary, page 60. Although the examples in that section use
text fields, the same principles apply to Grid/Graphs.

**Resolving metrics used in multiple datasets: Same
attributes, different metrics**

In the examples above, the datasets used different metrics. If the same
metric exists in more than one dataset, the Grid/Graph's data source
determines which metric is used.

For example, the Regional Revenue report contains Region and Revenue.
The Northern Revenue report also contains Region and Revenue, filtered for
Northeast and Northwest. Both reports are used as datasets on a document.
Region from the Regional Revenue dataset and Revenue from the Northern
Revenue dataset are placed into a single Grid/Graph, as shown below. The
data source of the combined Grid/Graph is set to the Northern Revenue
dataset automatically, based on the metric, and indicated by the title bar,
which displays the data source automatically. The combined Grid/Graph displays only Northeast and Northwest.

Change the data source of the combined Grid/Graph to Regional Revenue, and all the regions, with their metric values, are displayed. The Grid/Graph’s data source is determining which metric and attribute is being used.

Change the data source of the combined Grid/Graph to none. Without a data source, the Grid/Graph cannot determine which metric to use, so no metric
values are displayed. Because Region initially came from the Regional Revenue dataset, all the regions are displayed, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
</tr>
<tr>
<td>South</td>
<td>$5,369,280</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

Setting the data source of the combined Grid/Graph to none allows you to see the elements from all the datasets.

**Joining multiple datasets in a Grid/Graph: Different attributes, different metrics**

A document contains the following datasets:

- Revenue by Category: Category attribute and Revenue metric
- Regional Profit: Region attribute and Profit metric

These datasets do not have any attributes or metrics in common. The Combined Grid/Graph combines Category and Revenue from the Revenue by Category dataset with Region and Profit from the Regional Profit dataset, as shown below. The Revenue amounts can be calculated at the Category level, since the data exists in the Revenue by Category dataset report. The Profit amounts cannot be calculated at the Category level, because the data exists only at the Region level. However, the Profit amounts can be
calculated and displayed at the Region level in the Combined Grid/Graph—they are repeated for each Category in a particular Region.

If you switch the positions of the attributes on the Combined Grid/Graph, at first glance it appears that the metric calculations have changed. The order in which they are presented has changed, but not the actual calculations. The revenue for Books - Central is still $2,640,094, while the profit is still
$764,323. Now, all the same Revenue amounts are grouped together, instead of the same Profit amounts as in the previous example.

If you remove Region from the Combined Grid/Graph, the Profit amounts are all the same—the total profit. (Totals were added to the individual Grid/Graphs for comparison.) This occurs because the Profit data exists only at the
Region level. Revenue amounts are calculated for each category, since the Revenue data exists at the Category level.

<table>
<thead>
<tr>
<th>Category</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$2,640,094</td>
</tr>
<tr>
<td>Electronics</td>
<td>$24,391,303</td>
</tr>
<tr>
<td>Movies</td>
<td>$4,098,943</td>
</tr>
<tr>
<td>Music</td>
<td>$3,893,367</td>
</tr>
<tr>
<td>Total</td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>

Similarly, if Category had been removed instead of Region, the Profit amounts would be calculated for each region, while the Revenue amounts would all display as the total shown on the Revenue by Category Grid/Graph.

The Revenue by Category dataset is replaced by the same dataset filtered for payments made with Visa and Mastercard only. Notice that the Revenue amount has decreased in the Revenue by Category Grid/Graph, as well as the
Combined Grid/Graph. Profit is unaffected, since the filter has not been applied to the Regional Profit dataset.

Notice that, unlike a Grid/Graph that uses datasets with the same attribute, this Grid/Graph can calculate metric data for all the attributes and metrics, in multiple combinations, in the datasets.

For more examples of how datasets are joined, see *Joining multiple datasets: Examples, page 65*. Although text fields are used in the examples, the same join behavior applies to Grid/Graphs.

**View filters on a Grid/Graph with multiple datasets**

A view filter on a Grid/Graph places conditions on attributes and metrics which restrict the amount of data displayed on the Grid/Graph. A view filter on a Grid/Graph with multiple datasets can include any objects on the Grid/Graph, regardless of the Grid/Graph’s data source.

For background information on view filters, including steps to create them, see *Using view filters on Grid/Graphs, page 217*. For an example of a view
filter on a Grid/Graph with multiple datasets, see View filters in documents with multiple datasets, page 219.

Thresholds on a Grid/Graph with multiple datasets

Thresholds are special formatting that is automatically applied to data in a Grid/Graph, when the data meets a specified value. The special formatting means that document recipients can easily see which data is likely to be important for making business decisions.

A threshold on a Grid/Graph with multiple datasets can include any objects on the Grid/Graph, regardless of the Grid/Graph’s data source.

For background information on thresholds, including steps to create them, see Formatting conditional data in documents, page 307. For an example of thresholds on a Grid/Graph with multiple datasets, see Conditional formatting on a document with multiple datasets, page 313.

Adding a Grid/Graph with multiple datasets

Prerequisites

- You must have the correct privileges:
  - To view Grid/Graphs that use objects from multiple datasets, you must have the Execute Report that Uses Multiple Data Sources privilege.
  - To create Grid/Graphs that use objects from multiple datasets, you must have the Import Table from Multiple Data Sources privilege.
- The project must allow Grid/Graphs to use multiple datasets, as explained in Determining whether Grid/Graphs can use multiple datasets, page 58.
- The document must contain the datasets to be used in the Grid/Graph.

To add a Grid/Graph that uses multiple datasets

1. In MicroStrategy Web, open the document in Design Mode.
Add an empty Grid/Graph

2 Do one of the following:

- To add a placeholder that displays as a grid, select **Grid** from the **Insert** menu.
- To add a placeholder that displays as a graph, point to **Graph** on the **Insert** menu, and select the graph style. For descriptions of the various graph styles, see the *Advanced Reporting Guide*.

3 Click and drag in the section where you want the Grid/Graph placeholder. A new Grid/Graph placeholder is displayed as an empty Grid/Graph in the document.

You can place a Grid/Graph placeholder anywhere in a document except in the Detail section. Since controls in the Detail section are repeated once per row of the dataset, the Grid/Graph would be repeated on each row.

Add objects to the Grid/Graph

4 Select an object in the Dataset Objects panel, and then drag and drop it in the empty Grid/Graph. Repeat for each dataset object needed on the Grid/Graph.

The dataset (or data source) of the Grid/Graph that uses multiple datasets is determined by the first object added to the Grid/Graph. If you add a metric to the Grid/Graph, the data source is changed to the dataset that the metric comes from.

Adding a Grid/Graph as a shortcut

If you add a Grid/Graph to a document as a shortcut, the Grid/Graph is linked to the original report. Any changes made to that report, such as formatting a metric or changing the graph type, are automatically passed to the Grid/Graph in the document. You cannot edit the Grid/Graph in the document unless you unlink it by removing the shortcut. Editing options include adding a view filter, formatting rows and columns, sorting, changing the graph style, modifying graph titles, and so on. (For a complete list of editing options, see *Selecting and viewing a Grid/Graph, page 196*.)

In a Grid/Graph added as a shortcut, you can:

- Add a title bar (for steps, see *Adding title bars to Grid/Graphs, page 211*)
• Format the Grid/Graph container and the title bar (for instructions, see Formatting Grid/Graph containers, page 207)

• View the Grid/Graph as a grid, a graph, or both a grid and a graph (for instructions, see Viewing a Grid/Graph displayed as a grid, page 197, Viewing a Grid/Graph displayed as a graph, page 198, and Viewing a Grid/Graph as a grid and a graph at the same time, page 198)

• Specify Grid/Graph settings, such as position, size, grid overflow, and quick switch (for instructions, see Formatting Grid/Graph containers, page 207)

The Shortcut option in the Property List is a quick indicator of whether a Grid/Graph is a shortcut.

You can unlink a Grid/Graph shortcut, if you no longer want changes made to the original report to be passed to the Grid/Graph in the document. Unlinking removes the shortcut and creates a Grid/Graph in its place. For the procedure, see To unlink a linked Grid/Graph shortcut, page 194.

If you want to replace the shortcut with data from a different dataset, you can replace the dataset in the document. The formatting, filter, and report objects of the shortcut are automatically changed. For instructions and a description of the effect that replacing the dataset has on the document, see the Desktop Help.

You do not have to create a new Grid/Graph to use shortcuts; you can instead link an existing Grid/Graph to a dataset report. For instructions, see To link an existing Grid/Graph as a shortcut, page 195.
Both Grid/Graphs shown below use the same dataset report, Yearly Revenue. The one on the right (Grid/Graph 2) is linked to the original report as a shortcut, while the one on the left (Grid/Graph 1) is not.

Change the graph type of the Yearly Revenue report from vertical bar to horizontal bar. Save the report. When you execute the document again, as shown below, Grid/Graph 1 still displays as a vertical bar graph, but Grid/Graph 2 is now a horizontal bar graph, because it is a shortcut Grid/Graph and therefore changes to the dataset report are automatically passed to the shortcut Grid/Graph in the document.
A Grid/Graph added as a shortcut allows a document to contain an object prompt in a Grid/Graph. An object prompt on the template of a dataset report allows users to select which objects to include in the report. Grid/Graphs cannot use object prompts, unless you add the Grid/Graph as a shortcut.

Even when a shortcut is used, the object prompt does not appear in the Datasets pane; you cannot add it to the document as a separate object. When the document is executed, the object prompt is displayed and its answers are shown in the document results. This occurs just as if you had executed the dataset report as a stand-alone report. For more details on prompts in documents, see *Using prompts in documents, page 488.*

**To add a Grid/Graph as a shortcut**

1. In MicroStrategy Web, open the document in **Design Mode.**
2. In the Layout area, click in the section where you want to place the Grid/Graph.
   - You can place a Grid/Graph anywhere in a document except in the Detail section. This is because controls in the Detail section are repeated once per row of the dataset, and the Grid/Graph would be repeated on each row.
3. Right-click the dataset report in the Datasets pane and select **Add to Section as Shortcut.**
   - If the dataset report uses an Intelligent Cube, this option is unavailable.

**To unlink a linked Grid/Graph shortcut**

1. In MicroStrategy Web, open the document in **Design Mode.**
2. Right-click the Grid/Graph shortcut to unlink, and select **Properties and Formatting.** The Properties and Formatting dialog box opens.
3. From the left, click **Layout.**
4. In the Grid area, clear the **Shortcut** check box. The Grid/Graph shortcut is unlinked.
5 Click **OK** to return to the document.

---

**To link an existing Grid/Graph as a shortcut**

1 In MicroStrategy Web, open the document in **Design Mode**.

2 Right-click the Grid/Graph, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, click **Layout**.

4 In the Grid area, select the **Shortcut** check box. The Grid/Graph is linked to the report listed in the Data Source field.

5 Click **OK** to return to the document.

---

**Changing datasets in Grid/Graphs**

You can change the dataset displayed in a Grid/Graph at any time.

**Prerequisite**

This procedure assumes that:

- You have added a Grid/Graph to the document. See *To add a Grid/Graph, page 172*.
- The document contains multiple datasets. See *Adding, changing, or removing a dataset, page 48*.

---

**To change the dataset of a Grid/Graph**

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2 Right-click the Grid/Graph to modify, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the list on the left, select **Layout**.
4 To change the dataset used to populate the Grid/Graph, select a different dataset from the **Data source** drop-down list in the Grid area.

5 Click **OK** to apply the changes.

### Selecting and viewing a Grid/Graph

#### Selecting a Grid/Graph

A Grid/Graph has several modes or states of selection.

---

**To select and edit a Grid/Graph**

When the Grid/Graph is not selected and your cursor is not over it, it displays without handles or the Select/Move and Add Dataset icons. This normal view is shown below.

![Normal view of a Grid/Graph](image)

When you click the Grid/Graph, the Grid/Graph container is selected. The Select/Move and Add Dataset icons display in its top-left corner, as shown below.

![Selected view of a Grid/Graph](image)
You can resize the Grid/Graph by dragging the resizing handles. You can also move the Grid/Graph by clicking the Select/Move icon and dragging the Grid/Graph.

If a selected Grid/Graph does not resize, it may be locked. A locked Grid/Graph cannot be resized or moved. To unlock it, see Locking and unlocking controls, page 162.

When you edit the Grid/Graph, you can add objects to it, format rows and columns, sort, add totals or subtotals, select a different autostyle for the grid, format the graph, assign thresholds, and change various column settings. For details, see Editing data in a Grid/Graph, page 201.

Editing changes the grid report or graph report as displayed in the Grid/Graph in the document; it does not change the original report. For this reason, if the Grid/Graph is linked to the original report as a shortcut, you cannot edit the Grid/Graph. You can format the Grid/Graph control within the document, whether it is a shortcut or not. For steps, see Formatting Grid/Graph containers, page 207, which discusses borders, title bars, and quick switch, among other options. For steps to unlink a Grid/Graph shortcut so that it is converted to standard Grid/Graph, and more information on shortcuts in general, see Adding a Grid/Graph as a shortcut, page 191.

**Viewing a Grid/Graph displayed as a grid**

When you add a Grid/Graph to a document, it is displayed as a grid (a standard MicroStrategy grid report with rows and columns of attributes and metrics) by default. If the display mode is changed, you can set it to display as a grid again.

---

**To view a Grid/Graph as a grid**

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click the Grid/Graph, point to View Mode, and select Grid View.
3. Click anywhere outside of the Grid/Graph so that the Grid/Graph is no longer selected.
**Viewing a Grid/Graph displayed as a graph**

When you insert a Grid/Graph into a document, it is displayed as a grid (a standard MicroStrategy grid report with rows and columns of attributes and metrics) by default. You can choose to display it as a graph, which shows the data visually as in a standard MicroStrategy graph report.

---

**To view a Grid/Graph as a graph**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Right-click the Grid/Graph, point to **View Mode**, and select **Graph View**.
3. Click anywhere outside of the Grid/Graph so that the grid is no longer selected.

**Viewing a Grid/Graph as a grid and a graph at the same time**

When you insert a Grid/Graph into a document, it is displayed as a grid (a standard MicroStrategy grid report with rows and columns of attributes and metrics) by default. You can choose to display the Grid/Graph as both a grid and a graph (which displays the data visually as in a standard MicroStrategy graph report) at the same time.

You can also specify how the grid and graph reports are laid out in the document, including what percentage of space each report takes up. For steps, see *Specifying the layout for a Grid/Graph displayed as both a grid and a graph, page 199.*

---

**To view a Grid/Graph as a grid and a graph simultaneously**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Right-click the Grid/Graph, point to **View Mode**, and select **Grid and Graph View**.
3. Click anywhere outside of the Grid/Graph so that it is no longer selected.
Specifying the layout for a Grid/Graph displayed as both a grid and a graph

You can specify the layout for a Grid/Graph displayed as both a grid and graph. That means that you can determine how the grid and the graph share the space available in the Grid/Graph. The grid and graph can be placed either side by side, or above and below each other by specifying the grid's location relative to the graph. You can also control the relative sizes of the grid and the graph, by specifying the ratio of the size of the grid to the size of the graph.

For example, the following Grid/Graph is displayed as both a grid and a graph. It is shown in Design View, so that you can focus on the grid and graph objects, rather than the data. The default settings were not altered, so the grid is placed below the graph, and each occupies half the space of the Grid/Graph.

Since the Grid position is set to Bottom, the Grid area percent setting, which is set to 50 by default, specifies the height ratio. Change the Grid area percent to 25. Now the graph occupies 75% of the height of the Grid/Graph container while the grid only uses 25%, as shown below.
If you change the Grid position to Left or Right, the Grid area percent setting represents the width percentage. If you specify the Grid position as Right, without adjusting the Grid area percent, the Grid/Graph displays as shown below.

The grid uses 25% of the width of the window and is placed to the right of the graph.

The following procedure re-creates the last sample shown above, with the grid to the right, at 25%.
To specify the layout for a Grid/Graph displayed as both a grid and a graph

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Right-click the Grid/Graph and select Properties and Formatting. The Properties and Formatting dialog box opens.

3. On the left, select Layout.

4. From the View drop-down list, select Graph and Grid View.

5. From the Grid position drop-down list, select Right, to display the grid to the right of the graph.

6. By default, the grid and graph share the control’s window equally. Change Grid Area to 25, so that the grid uses 25% of the width of the Grid/Graph window.

7. Click OK to save your changes and return to the document.

Editing data in a Grid/Graph

You can add dataset objects to an empty Grid/Graph container, and you can edit the data that is displayed in the Grid/Graph container, such as formatting rows and columns of a grid report, sorting data, formatting the legends or axis titles of a graph report, and so on.

Editing a dataset report on a document changes only the grid or graph dataset in the document; it does not change the original report. To format the Grid/Graph container that the dataset report is placed in, see Formatting Grid/Graph containers, page 207, which discusses borders, title bars, backstyle, and quick switch, among other formatting options.

Because editing changes the grid or graph in the document, not the original report, then if the Grid/Graph is linked to the original report as a shortcut, you cannot edit the Grid/Graph data. You can format the Grid/Graph container, whether it is a shortcut or not. For steps, see Formatting Grid/Graph containers, page 207, which discusses borders, title bars, and quick switch, among other formatting options. For steps to unlink a Grid/Graph shortcut, and more information on shortcuts in general, see Adding a Grid/Graph as a shortcut, page 191.
Adding objects to a Grid/Graph

If you create an empty Grid/Graph in the document, you need to populate it with objects. These objects are the attributes, consolidations, custom groups, hierarchies, and metrics in a dataset report. The easiest method to add objects is if the Grid/Graph is in grid mode and the document is in Design or Editable Mode.

You can add additional objects to a Grid/Graph that already contains objects. By default, a Grid/Graph can contain objects from a single dataset report. If you have the Import Table from Multiple Data Sources privilege and your project allows it, you can combine objects from different dataset reports in the same Grid/Graph. For steps, see Adding a Grid/Graph that uses multiple datasets, page 178.

You can select which attribute forms to add to the Grid/Graph. If you use an attribute form that is later removed from the original report, that attribute form is no longer displayed on the Grid/Graph in the document. If all the attribute forms used on the Grid/Graph are removed from the original report, the Grid/Graph displays the attribute ID. If the attribute itself is removed from the original report, it is also removed from the Grid/Graph.

To add attributes, metrics, and other objects to a Grid/Graph

1  In MicroStrategy Web, open the document in Design Mode.

2  Drag objects from the Dataset Objects panel to the Grid/Graph and drop them as required. Use the following guidelines:

   • You can combine objects from different datasets in the same Grid/Graph if your project is configured to allow multiple datasets in a single Grid/Graph.

   • If the object creates a text field on top of the Grid/Graph, the object was not added to the Grid/Graph correctly. Undo the addition by pressing CTRL+Z and try again.

   • You can select which attribute forms to add to the Grid/Graph.
Editing data in a Grid/Graph displayed as a grid

When you edit the data inside a Grid/Graph displayed as a grid, you can:

- Change the formatting of various rows and columns, such as hiding or displaying the column or row headings
- Change the sorting, as well as define totals or subtotals
- Select a different autostyle for the grid, assign thresholds, apply banding to rows or columns, and change various column settings (such as removing the word “Metrics” from the Grid/Graph)
- Create derived metrics
- Create shortcut metrics

These options also apply to the grid part of a Grid/Graph that is displayed as a grid and a graph.

To edit data in a Grid/Graph displayed as a grid

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Select the Grid/Graph to edit.

   If the Grid/Graph is a shortcut, you cannot edit it because it is linked to the dataset report. (For details, see Editing data in a Grid/Graph, page 201.) A message appears, allowing you to choose whether to unlink the shortcut. If you click OK, changes made to the dataset report are no longer passed to the dataset in the Grid/Graph you selected.

3. To change the Autostyle for the whole grid, select a new Autostyle from the Grid toolbar.

4. To format a part of the data in the Grid/Graph, right-click the object in the grid and select Properties and Formatting. The Properties and Formatting dialog box opens. For details, see Formatting Grid/Graph containers, page 207. To save your changes and return to the document, click OK.

5. To move an object, right-click the object in the grid, select Move, and then choose the direction to move.
To insert a derived metric:

a. From the **Data** menu, select **Insert New Metric**. The Insert New Metric dialog box opens.

b. Create the derived metric, as described in *Creating, editing, and deleting derived metrics, page 134*.

c. Click **OK** to return to the document.

To create a shortcut metric:

a. Right-click the column(s) or row(s) for which to create a new metric, select **Insert Metric**, and then select one of the following:

   ▪ Percent-to-total
   ▪ Transformation
   ▪ Rank

b. Create the shortcut metric. For steps, see the *MicroStrategy Web Help*.

To sort the data in the grid:

a. Right-click the object to sort the Grid/Graph by, point to **Sort**, and select either **Ascending** or **Descending**.

b. For advanced sorting, right-click the object to sort by and select **Sort Grid**. The Sort dialog box opens. For details, see *Sorting records in a document, page 409*. Click **OK** to save your changes and return to the document.

To add subtotals, right-click the Grid/Graph and select **Edit Totals**. The Subtotals dialog box opens. Select the subtotal function, position, and whether to total by position or across level. For instructions, see the *MicroStrategy Web Help*. Click **OK** to save your changes and return to the document.

To change the width of a column, switch to **Editable Mode** if you are in Design Mode. Resize the column by dragging and dropping the column’s handle.

To hide column and/or row headings:

a. Right-click the Grid/Graph and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
b From the left, select **Grid**.
c To hide row headings, clear the **Show** check box under **Rows**.
d To hide column headings, clear the **Show** check box under **Columns**.
e Click **OK** to return to the document.

12 The grid can be displayed in a static version of outline mode, which displays the rows and columns in a summarized, high-level outline. Users cannot collapse or expand any of the rows. To display the grid in outline mode:

a Right-click the Grid/Graph and select **Properties and Formatting**.
   The Properties and Formatting dialog box opens.
b On the left, select **Grid**.
c Select the **Outline** check box in the View area.
d Click **OK** to return to the document.

13 Banding groups rows or columns by color to enhance readability and, in some cases, identify attributes or attribute elements meeting certain criteria. To display banding, do the following:

a Right-click the Grid/Graph and select **Properties and Formatting**.
   The Properties and Formatting dialog box opens.
b From the left, select **Grid**.
c Select the **Show Banding** check box.
d Click **OK** to return to the document.

**Editing data in a Grid/Graph displayed as a graph**

Editing a Grid/Graph displayed as a graph provides many of the same options that editing a graph report does. When you edit a Grid/Graph displayed as a graph, the menus and toolbar change to reflect report options rather than document options. For example, you can change:

- Graph style
- Color palette
- Legends
• Graph options such as riser shape, layout type, and location of data labels
• Axis formatting
• Titles

These options also apply to the graph part of a Grid/Graph viewed as both a grid and a graph.

---

**To edit data in a Grid/Graph displayed as a graph**

1. In MicroStrategy Web, open the document in **Editable Mode**.

2. Select the Grid/Graph to edit.

   If the Grid/Graph is a shortcut, you cannot edit it because it is linked to the dataset report. (For details, see *Editing data in a Grid/Graph, page 201.*) A message appears, allowing you to choose whether to unlink the shortcut. If you click **OK**, changes made to the dataset report are no longer passed to the dataset in the Grid/Graph you selected.

3. To change the graph type and sub-type, select them from the two drop-down lists on the **Graph** toolbar.

4. To format a part of the Grid/Graph, right-click the Grid/Graph and select **Format**. The Format: Graph dialog box opens.

   • To apply a rounded effect, use font anti-aliasing, and adjust the maximum categories and series, select **General** on the left.

   • To change graph options such as titles and series colors, select **Format** on the left.

     ▪ You can select whether to hide or display legends by selecting **Format** from the first drop-down list and **Legend** from the second drop-down list. Select the **Show** check box to display the legend. From the **Position** drop-down list, select where to display the legend.

   • To customize the format of each axis in the graph, select **Axes** on the left.

   • To save your changes and return to the document, click **OK**.

For details on each option in the dialog box, see the *MicroStrategy Web Help*. 
Editing data in a Grid/Graph displayed as a grid and a graph

When you edit a Grid/Graph, you can modify both the grid portion and the graph portion. For information on editing the grid, see Editing data in a Grid/Graph displayed as a grid, page 203. For information on editing the graph, see Editing data in a Grid/Graph displayed as a graph, page 205.

Formatting Grid/Graph containers

Formatting a Grid/Graph changes the formatting of the Grid/Graph container, not the data displayed in it. To change the formatting of the data displayed in the Grid/Graph, such as bolding attribute names or changing the color of bar graph risers, you must edit the Grid/Graph. For steps to edit a Grid/Graph, see Selecting and viewing a Grid/Graph, page 196.

To format a Grid/Graph container, for example, you can format the border around the Grid/Graph to change its color or make it appear three-dimensional. Border options include 3D borders and drop shadows. Background formatting options include transparent backgrounds and gradient colors. You can also add tooltips or a title bar, determine grid overflow, and set up quick switching between grid view and graph view.

When you add a new Grid/Graph container, the initial formatting of the Grid/Graph is determined by the control default, but you can change any of the formatting options. A control default specifies the default formatting for a particular type of control. For more information on control defaults, see Defining default formatting for control types: control defaults, page 255.

Formatting suggestions for a Grid/Graph container

The following list provides some useful formatting suggestions for Grid/Graphs.

- Make the Grid/Graph appear three-dimensional, like a button, with the 3D effect. For examples and steps, see Applying a 3D effect, page 263.

- Let the content behind the Grid/Graph show through by setting the backstyle to transparent. You can also allow a fill color to cover what is behind the Grid/Graph by setting the backstyle to opaque. For examples and steps, see Using a transparent or opaque backstyle, page 261.
• In a Grid/Graph that is used as a selector to control other Grid/Graphs, the background for items selected in the Grid/Graph is automatically chosen to provide contrast with the Grid/Graph's background, by default. You can specify the background color for the selected items. The color is displayed in Flash Mode and Express Mode in MicroStrategy Web. For examples and steps, see *Formatting the background of selected items in Grid/Graphs used as selectors, page 208*.

• “Float” the Grid/Graph over the background by using a drop shadow. For examples and steps, see *Applying a drop shadow, page 265*.

• Create a gradual color change by blending two colors using gradient colors on the Grid/Graph. For examples and steps, see *Using gradient colors, page 267*.

• Display pop-up text with a tooltip when a user positions the cursor over the Grid/Graph in MicroStrategy Web. The tooltip can provide extra information, such as an expanded description of the dataset report. For examples and steps, see *Creating a pop-up tooltip, page 270*.

• Display a Grid/Graph to other document designers in Design Mode while hiding it from users viewing the document in other modes. For examples and steps, see *Hiding a control, page 272*.

• Allow users to minimize and maximize the Grid/Graph in Web, or view the Grid/Graph's underlying dataset, with a title bar. The title bar also displays a title, which helps identify the Grid/Graph. Title bars provide documents with a portal grid mode and help you create a dashboard look and feel. For examples and steps, see *Adding title bars to Grid/Graphs, page 211*.

• Quickly change the display of a Grid/Graph from graph to grid and back with the Quick switch button. For examples and steps, see *Quick switch for Grid/Graphs, page 215*.

• Enable a transition animation for Flash Mode in MicroStrategy Web. A transition animation is a visual transition that occurs when a Grid/Graph is first displayed in Flash Mode. Examples are Blur, Fade, and Iris. For more information, see the *Dashboards and Widgets Creation Guide*.

---

**Formatting the background of selected items in Grid/Graphs used as selectors**

A Grid/Graph can be used as a selector to control other Grid/Graphs. (For an introduction to selectors, see the *Dashboards and Widgets Creation Guide*.)
By default, the background for items selected in the Grid/Graph is automatically chosen to provide contrast with the Grid/Graph's background, but you can specify the color for the selected items. The color is displayed in Flash Mode and Express Mode in MicroStrategy Web.

For example, a document contains two Grid/Graphs. The one on the left, which is displayed as a grid, shows revenue by region. Region is used as a selector, targeting the Grid/Graph on the right, which is displayed as a graph. The graph shows revenue by category and region. When a region is selected in the grid, the graph is updated to display data for that region only.

By default, the grid's background is set to transparent, and the background for selected items is set to automatic. In Flash Mode, the grid is displayed automatically with a white background (transparent to the section’s background, which is white). The selected item (Central) is displayed in blue to provide contrast, as shown below:
If you change the grid's background for selected items to dark gray, the selected item's background is dark gray in Flash Mode, as specified, and the grid's background is still automatically displayed in white, as shown below:

In all other modes except Express Mode, the background of the selected item is automatically defined to provide contrast with the Grid/Graph's background. This example appears in blue in all other modes, as shown in the first example above.

**Prerequisite**

- The following steps assume that the document contains a Grid/Graph used as a selector. For steps to create it, see the *Dashboards and Widgets Creation Guide*.

---

**Formatting the background of selected items in a Grid/Graph used as a selector**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Right-click the Grid/Graph container and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, select **Color and Lines**.
4. From the **Color** palette, select the background color of the Grid/Graph by doing one of the following:
   - To apply the default background color (transparent), click **No Fill**.
• To apply a solid background color, select the background color from the palette. You can access additional colors by clicking More Colors.

• To apply a color gradient, click Gradients. The Gradients dialog box opens. For images that show gradients, see Using gradient colors, page 267.

  a From the Color 1 palette, select the first color to use for the gradient.

  b From the Color 2 palette, select the second color to use for the gradient.

  c Select the Horizontal or Vertical option to determine the direction in which two colors are blended together, then select a shading style.

  d Click OK to return to the Properties and Formatting dialog box.

5 When the Grid/Graph is used as a selector to control other Grid/Graphs, you can specify the background color used to display selected items in the Grid/Graph. From the Selection Color palette, select the background color for items that are selected by the user by doing one of the following:

  • To apply the default selection color, click Automatic.

  • To apply a solid selection color, select the color from the palette. You can access additional colors by clicking More Colors.

6 Click OK to apply your changes.

Adding title bars to Grid/Graphs

A title bar on a Grid/Graph displays the title of the report associated with the Grid/Graph. A title bar allows users to better identify an object on the document, for example, a Grid/Graph focused on regional marketing efforts. Icons in the title bar allow the user to minimize and maximize the window containing the Grid/Graph. The title bar appears at the very top of the Grid/Graph, as shown in the example below.

You can format the title bar independently of the Grid/Graph itself. You can format the font and background of the title bar, including transparent backgrounds and gradient colors.
The following sample shows a Grid/Graph with a title bar showing the name of the report. The font of the title bar has been set to Comic, size 9. The background of the title bar is shaded from black to white, using gradient colors. The Grid/Graph has a 3D border, which makes the Grid/Graph appear three-dimensional, like a button.

![Grid/Graph Example](image)

Title bars allow you to quickly achieve a dashboard look in your documents. If you include several Grid/Graphs with title bars in a document, you can create the feel of a portal. The Grid/Graphs can all be displayed, or a user can minimize the ones that are not relevant at the moment to focus on a particular Grid/Graph.

A title bar:

- Displays the title of the report by default, although you can replace it with your own text. For a Grid/Graph that uses multiple datasets, displaying the report title can help identify which dataset is used as the data source of the Grid/Graph.
- Is displayed in all views/modes for both Desktop and Web.
- Lets users minimize and maximize the Grid/Graph.
- Lets users quickly access menu options to format and edit the Grid/Graph (in Editable Mode and Interactive Mode). Menu options include sorting and adding subtotals, among others.
- Lets users open the dataset report used in the Grid/Graph using Zoom In (in Editable Mode and Interactive Mode).
- Lets users export the Grid/Graph to an Excel spreadsheet or a PDF file (in Express Mode).
- Lets the designer determine the initial display of the window: normal, minimized, or maximized.

---

**To add a title bar to a Grid/Graph**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2 Right-click the Grid/Graph and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, select **General**.

4 Select the **Show Title Bar** check box.

5 The **Title** field is blank by default. If you leave it blank, the name of the dataset report will automatically be displayed in the title bar when the end user executes the document. To display a different title, type the new text in the **Title** field.

   For a Grid/Graph that uses multiple datasets, displaying the report title can help identify which dataset is used as the data source of the Grid/Graph.

6 To change the initial display height and width of the Grid/Graph, select one of the following from the **Display State** drop-down list:

   - **Minimized**: Only the title bar is initially displayed when the document is first opened. The user can maximize the Grid/Graph, and can also restore it to its original size or position.
   
   - **Maximized**: When the document is first opened, the size of the Grid/Graph is initially displayed spanning the entire document section in which it is located. The user can minimize the Grid/Graph, and can also restore it to its original size or position.

7 To specify the height of the title bar itself, from the left, select **Layout**. Type the height in the **Title Height** field.

8 To format the background fill of the title bar:

   a Select **Colors and Lines** from the left. The Colors and Lines options are displayed.

   b Select **Grid Container** in the drop-down list on the left.

   c Select **Title** in the drop-down list on the right.

   d From the **Color** drop-down list, do one of the following:

      - To shade the title bar with a solid fill color, select the desired color.

      - To shade the title bar with a color gradient, select **Gradient**. For images that show gradients, see Using gradient colors, page 267.

      - To allow what is behind the title bar to show through, select **No Color**.
9 Click **OK** to apply the changes and close the dialog box.

### Allowing the background of the Grid/Graph to show through a transparent title bar

If you set the background of the title bar to transparent, the background fill of the Grid/Graph shows through. For example, note that the title bar in the following Grid/Graph is shaded, left to right, from black to white.

![Grid/Graph example](image)

If you change the background of the title bar to Transparent and select a dark gray for the background of the Grid/Graph container, you can see the dark grey of the container at the right of the Grid/Graph, as well as in the title bar, in the sample below.

![Grid/Graph example](image)

#### To use a transparent title bar for a Grid/Graph

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. Right-click the Grid/Graph and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3. If the title bar is not displayed on the Grid/Graph:
   a. From the left, select **General**.
   b. Select the **Show Title Bar** check box.
   c. Click **Apply**.
4. From the left, click **Colors and Lines**.

5. In the list on the right, select **Title**.

6. From the **Color** drop-down list, select **No Fill**.

7. Click **OK** to return to the document.

**Quick switch for Grid/Graphs**

In MicroStrategy Web, a user can quickly switch a Grid/Graph between Graph view and Grid view with the click of a button, when the Quick switch option is enabled. The Graph view and Grid view are both loaded when the document is initially viewed. The document may initially load more slowly, but it switches between the views quickly since a request to the Web server does not occur.

This quick switch option is ideal for Report Services (RS) dashboards, which are generally smaller and less data-intense than standard documents. For more information on RS dashboards, see the *Dashboards and Widgets Creation Guide*.

**Quick switch in MicroStrategy Web**

The Quick switch button is displayed in MicroStrategy Web only, in both Interactive Mode and Editable Mode. The button to perform the switch is located at the top of the Grid/Graph, as shown below.
Quick switch in Desktop

The Quick switch button is available in MicroStrategy Web only; you cannot use it in Desktop. In PDF View in Desktop, the Grid/Graph is displayed as either a grid or a graph, depending on the View mode option. When you export a document to Excel or view it as a PDF, the last view displayed (Grid or Graph) is used.

Enabling quick switch

To enable quick switch, the Grid/Graph must be displayed as either a grid or a graph. If the Grid/Graph displays as both a grid and a graph, quick switch is not available.

If you enable quick switch, the Height mode and Width mode settings are automatically set to Fixed; the Fit to contents option is disabled. This ensures that the graph or grid will fill 100% of the size specified for the Grid/Graph container. The Grid/Graph container is the object that holds the actual Grid/Graph, as opposed to the optional title bar. (For an example of a title bar, see Adding title bars to Grid/Graphs, page 211.) Therefore, you should check that the height and width are correct when you enable quick switch.

To enable quick switch for a Grid/Graph

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click Grid/Graph and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. From the left, click Layout.
4. Ensure that View is either Graph or Grid. If View is set to Grid and graph, the Quick Switch check box is not available.
5. Select the Quick Switch check box.
6. Click OK to return to the document.
Using view filters on Grid/Graphs

A view filter on a Grid/Graph in a document consists of conditions on attributes and metrics which restrict the amount of data displayed on the Grid/Graph. You can use view filters to help reduce the number of datasets used to build a document that contains multiple Grid/Graphs, when all of the Grid/Graphs could share a single dataset with the use of multiple filters.

These view filters are local to the document. This means that a view filter does not affect the report results, only the Grid/Graph displayed on the document. A view filter created on a report is ignored in the document, so that all the data from the report is used in the document. For more information, see Using a view report or base report as a dataset, page 74.

For example, a document contains revenue and profit information for different regions. You can create a report with revenue and profit metrics, then create copies of it, applying a different regional filter to each copy. If you have 10 regions, then 10 reports must be created and maintained. Each report must be added to the document as a dataset.

In contrast, view filters allow you to create one report and add it once to the document as a dataset report. Next, add multiple Grid/Graphs using the same dataset. Apply a different view filter, for each region, to the various Grid/Graphs. Now all the Grid/Graphs share a single dataset. This reduces maintenance and execution time, since only one dataset report has to be created and maintained, and only one dataset report has to be executed when the document is viewed.

You can also use view filters for custom sorting, formatting for individual rows, and custom subtotals. To continue with the regional revenue example above, you might need to see the regions in the following order: Northeast, Southeast, Northwest, Southwest, and Mid-Atlantic. To do this, create five Grid/Graphs on a document. Apply a view filter for Northeast to the first Grid/Graph, for Southeast to the second, and so on.

Similarly, to apply a different format to each row (for each region) in the document, add one Grid/Graph for each region, apply a view filter on region to the Grid/Graph as described above, and then format each Grid/Graph as needed. For example, the Northeast region can be displayed in red while Southeast appears in blue. This process can be used to create custom banding on a document.

Information on editing the dataset information in a Grid/Graph can be found in Editing data in a Grid/Graph, page 201.
You can also use view filters to create custom subtotals, such as an Eastern region subtotal and a Western region subtotal, for example. Add a Grid/Graph, apply a view filter for Northeast and Southeast, and enable subtotals for the Grid/Graph. Repeat the process with another Grid/Graph, setting the view filter to Northwest and Southwest. To enable subtotals, edit the Grid/Graph by double-clicking it, then select **Grand Totals** from the **Data** menu.

The resulting custom subtotal document is shown below, with column headers turned off for the second Grid/Graph. To do this, edit the Grid/Graph, then select **Options** from the **Grid** menu. On the **General** tab of the Grid Options dialog box, clear the **Show column headers** check box.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td></td>
<td>$8,554,415</td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,951</td>
<td>$336,675</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td>$10,794,366</td>
<td>$1,637,407</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
<td>$266,986</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
<td>$561,331</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td>$5,455,319</td>
<td>$826,317</td>
</tr>
</tbody>
</table>

If a Grid/Graph is a shortcut, you cannot create a view filter because the Grid/Graph is linked to the original report. The view filter option is not available until you unlink the report (see *To unlink a linked Grid/Graph shortcut, page 194* for instructions). If you unlink the report, the Grid/Graph is converted from a shortcut to a standard Grid/Graph, and any changes made to the original report are no longer passed to the Grid/Graph in the document. For information on what actions are allowed in shortcuts, see *Adding a Grid/Graph as a shortcut, page 191*.

View filters can filter the Grid/Graph based on metric qualifications as well as attribute qualifications. For example, the following Grid/Graph displays Revenue, Cost, and Profit values for all regions:

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
<td>$4,265,043</td>
<td>$764,323</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
<td>$3,779,531</td>
<td>$673,084</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$8,554,415</td>
<td>$7,253,683</td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
<td>$1,494,202</td>
<td>$266,986</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,280</td>
<td>$4,582,324</td>
<td>$806,956</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,951</td>
<td>$1,903,276</td>
<td>$336,675</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
<td>$3,132,800</td>
<td>$561,331</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,752</td>
<td>$3,319,225</td>
<td>$583,538</td>
</tr>
</tbody>
</table>
Create a view filter that contains two qualifications:

- Revenue > $5,000,000
- Profit < $1,000,000

When the view filter is applied to the Grid/Graph, only two regions, Central and South, met the qualifications and are displayed, as shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
<td>$4,265,043</td>
<td>$764,323</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,280</td>
<td>$4,582,324</td>
<td>$806,956</td>
</tr>
</tbody>
</table>

Multiple qualifications in view filters

To create more sophisticated filters, you can add multiple qualifications to the same Grid/Graph. For example, if your dataset report contains customer information, you can create qualifications on region and age to display only those customers in the Northeast and Southeast who are older than 73 or younger than 19.

By default, multiple qualifications are joined with the AND operator, but you can change the operator to AND NOT, OR, or OR NOT. You cannot change the logical operator between two metric qualifications if all of the following are true:

- Both qualifications are metric qualifications.
- The metric qualifications use two different metrics (for example, Revenue in Qualification 1 and Profit in Qualification 2).
- The metric qualifications are not metric-to-metric qualifications, but instead compare the metrics to numeric values.

View filters in documents with multiple datasets

If a document contains multiple datasets, a view filter on a Grid/Graph can include any objects from any of the datasets, regardless of whether the Grid/Graph uses that dataset.
For example, a document contains two datasets, Regional Revenue and Regional Profit. A Grid/Graph is displayed for each dataset, with the data source displayed in the title bar, as shown below:

Create a view filter on the Regional Revenue Grid/Graph. Filter on the Profit metric greater than 500,000, as shown below:

The results are shown below. Notice that Northwest and Southeast are no longer included in the Regional Revenue Grid/Graph, since their profit amounts are below $500,000.

If the datasets do not contain the same attributes, you can still create a view filter that includes any object from any dataset on the document. For
example, a document contains two datasets, Regional Revenue and Category Profit. Create a Grid/Graph for each dataset, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$6,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
</tr>
<tr>
<td>South</td>
<td>$5,389,280</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,238,951</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

Create a view filter on the Category Profit Grid/Graph, for Revenue less than $5,000,000. When the view filter is applied, Category Profit no longer contains any data, as shown below:

To process the view filter, Revenue is aggregated on the Category Profit Grid/Graph. Revenue is available on the document only at the level of Region, which is not available on the Category Profit dataset. Therefore, Revenue aggregates to the level of all regions, calculating the same value for each row of the Category Profit Grid/Graph. This value is $35,023,708, which exceeds the view filter, and therefore no data is returned. Adding the Revenue metric to the Category Profit Grid/Graph displays the aggregated Revenue amount, to help explain how the view filter is calculated, as shown below:

<table>
<thead>
<tr>
<th>Category</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$569,278</td>
<td>$35,023,708</td>
</tr>
<tr>
<td>Electronics</td>
<td>$4,289,603</td>
<td>$35,023,708</td>
</tr>
<tr>
<td>Movies</td>
<td>$254,698</td>
<td>$35,023,708</td>
</tr>
<tr>
<td>Music</td>
<td>$189,044</td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>
If you add a view filter on Profit greater than $500,000 to the Regional Revenue Grid/Graph, the Regional Revenue Grid/Graph does not change, as shown below:

The view filter works the same way. Profit is aggregated on the Regional Revenue Grid/Graph at the level of all categories. This value is $5,293,624, as shown below, which meets the view filter limit, so all rows are displayed.
View filters in Grid/Graphs that use multiple datasets

A Grid/Graph can display data from more than one dataset. The view filter on this type of Grid/Graph can also include any objects on the Grid/Graph.

For example, a document contains two datasets, Regional Revenue and Regional Profit. A Grid/Graph is displayed for each dataset, with the data source displayed in the title bar. Another Grid/Graph, named Regional Revenue and Profit, combines the data from both datasets, as shown below:
Create a view filter on the Regional Revenue and Profit Grid/Graph for Revenue less than $5,000,000 and Profit greater than $500,000. The results are shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,094</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,330,732</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
<td>$296,986</td>
</tr>
<tr>
<td>South</td>
<td>$5,389,280</td>
<td>$806,956</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td>$336,675</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
<td>$581,331</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
<td>$533,538</td>
</tr>
</tbody>
</table>

**Metrics in rows and columns**

A report cannot contain metrics in both the rows and the columns, but you can simulate this scenario using view filters on multiple Grid/Graphs in a single document. The document shown below uses the Customer Count and Order Count metrics on the rows, while the Current and Last Month columns calculate the counts for the current month and the previous month. View filters on the Grid/Graphs filter for the Books category in the first set of data and Electronics in the second set.

<table>
<thead>
<tr>
<th>Books</th>
<th>Electronics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Count</td>
<td>Current</td>
</tr>
<tr>
<td></td>
<td>1,187</td>
</tr>
<tr>
<td>Order Count</td>
<td>4,639</td>
</tr>
</tbody>
</table>

The dataset reports for this document are shown below. The metrics are on the rows and the Category attribute is on the column. The data of the first
dataset is in bold font while that of the second dataset is italicized to help you distinguish the source of the data when it is combined in the document.

<table>
<thead>
<tr>
<th>Metrics</th>
<th>Category</th>
<th>Books</th>
<th>Electronics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Count</td>
<td></td>
<td>1,187</td>
<td>992</td>
</tr>
<tr>
<td>Order Count</td>
<td></td>
<td>4,639</td>
<td>2,872</td>
</tr>
</tbody>
</table>

Create a document with the two datasets and combine their data with text fields, as shown in the following diagram, which is a representation of the actual document. The data in bold font is from the first dataset, italicized data is from the second dataset, and plain text is static text fields created on the document. The boxes represent the different view filters applied to the data.

**Creating, editing, and deleting view filters**

You can:

- Create a new view filter (see below)
- Edit an existing view filter by changing the operator or the value that the object is compared to (see page 227)
- Remove a condition from an existing view filter or delete an entire view filter (see page 228)
Creating a view filter

Prerequisites

- You must own a MicroStrategy OLAP Services license to create view filters.
- The document must contain at least one Grid/Graph. The Edit View Filter option is available only when the document contains a Grid/Graph.

To create a view filter in a Grid/Graph

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Right-click a Grid/Graph and select Edit View Filter. The View Filter dialog box opens.

   If the Grid/Graph is a shortcut, you cannot create a view filter because the Grid/Graph is linked to the dataset report. The Edit View Filter option is not available. You can unlink the report (for instructions, see To unlink a linked Grid/Graph shortcut, page 194), but then changes made to the dataset report are no longer passed to the Grid/Graph in the document.

3. Click Add Condition to create a new qualification for the new view filter.

4. From the Filter On drop-down list, select the attribute or metric on which to base the qualification.

5. Do one of the following to select the qualifications used in the view filter:

   - To create an attribute qualification:
     a. Click the Qualify option.
     b. From the first drop-down list, select the attribute form or ID to qualify on.
     c. From the next drop-down list, select the appropriate operator (Greater than, Equals, Ends with, and so on).
     d. Specify the value to compare the attribute to. You can either type a value in the field, or click the arrows in front of Select Attribute, and then select the attribute form from the drop-down list.
• To use a list of attributes:
  a Click the **Select** option.
  b From the first drop-down list, select **In List** or **Not In List** to
determine whether the Selected list of elements are to be included
or excluded from the view filter.
  c Select elements from the **Available** list and click the right arrow to
add them to the **Selected** list. (To select multiple elements, press
CTRL and click.) To return an element from the **Selected** list back
to the **Available** list, select the element and click the left arrow.

• To create a metric qualification:
  a From the first drop-down list, select the operator (**Greater than,**
**Equals**, and so on).
  b Specify the value to compare the metric to. You can either type a
value in the field, or click the arrows in front of **Select Metric** and
select the metric from the drop-down list.

6 Do one of the following:

• To apply the view filter to the Grid/Graph and return to the View
Filter dialog box, click the **Apply** check mark icon.

• To discard your current view filter conditions and return to a blank
Edit View Filter dialog box, click the **Cancel** icon. Repeat the
appropriate steps above to start a new qualification.

7 To add another qualification to the selected Grid/Graph, repeat the
appropriate steps above.

8 To apply the view filter (s) to the selected Grid/Graph and close the dialog
box, click **OK**. The newly created view filter is applied when the document
is viewed in Interactive Mode, Editable Mode, Flash Mode, or Express
Mode.

**Editing a view filter**

You can change the operator or the value that the attribute or metric is
compared to. You cannot change the attribute or metric on which to qualify.
To edit a view filter in a Grid/Graph

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Right-click a Grid/Graph and select Edit View Filter. The View Filter dialog box opens with each view filter condition displayed.

3 Click the underlined text of the view filter, and make changes to the view filter conditions.

4 Apply the view filter to the Grid/Graph and return to the View Filter dialog box by clicking the Apply check mark icon.

5 To edit another qualification, repeat the appropriate steps above.

6 When you are finished making changes to the view filters, click OK to return to the document. The updated view filter is applied when the document is viewed in Interactive Mode, Editable Mode, Flash Mode, or Express Mode.

Deleting a view filter

You can delete the entire view filter or separate conditions.

To delete a view filter in a Grid/Graph

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Right-click a Grid/Graph and select Edit View Filter. The View Filter dialog box opens with each view filter condition displayed.

3 To delete a single condition, click the Delete icon next to the view filter condition to delete.

4 To delete all view filter conditions, click Clear All.

5 Click OK to apply the changes to the Grid/Graph and close the dialog box.
Linking a Grid/Graph to its underlying report

In Interactive Mode and Editable Mode, a user can execute a Grid/Graph’s data source report by clicking the Zoom In icon. (The data source provides the data for the Grid/Graph; it is the report on which the Grid/Graph is based.)

You can mimic this behavior for Express Mode and Flash Mode, by linking a text field to the data source.

The following document sample shows a Grid/Graph and its associated link in Express Mode. The text field is underlined, indicating that the text is clickable. You can click the text to run the linked report. When you hover your cursor over the link, a drop-down icon is displayed. Click the icon to display all the links for the text field. In this case, there is only one link. When you create a link, the text that you put into the URL display text field is displayed in the list of links.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
<td>$4,265,043</td>
<td>$764,323</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
<td>$3,779,531</td>
<td>$673,084</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$8,554,415</td>
<td>$7,253,683</td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
<td>$1,494,202</td>
<td>$265,986</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,280</td>
<td>$4,582,324</td>
<td>$805,956</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,951</td>
<td>$1,903,276</td>
<td>$336,675</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
<td>$3,132,800</td>
<td>$561,331</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
<td>$3,319,225</td>
<td>$583,538</td>
</tr>
</tbody>
</table>

When the link is clicked, the dataset report for the Grid/Graph is executed. A portion of the resulting displayed report is shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zernicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
<tr>
<td></td>
<td>Inglis</td>
<td>Walter</td>
<td>$229,439</td>
<td>$194,851</td>
<td>$34,588</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
<td>$188,010</td>
<td>$33,368</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$209,634</td>
<td>$178,331</td>
<td>$31,303</td>
</tr>
</tbody>
</table>
Steps are below to create a link to a Grid/Graph’s data source.

- If you change the Grid/Graph’s data source, you must change the link as well. The data source link in Interactive Mode and Editable Mode is changed automatically when the Grid/Graph’s data source changes.

For information on linking images, text fields, or objects in a Grid/Graph to a different report or document, or linking an image or text field to a web page, see Chapter 6, Linking from Documents.

**Prerequisites**

- The document contains a Grid/Graph. For steps, see Adding a Grid/Graph to a document, page 170.

- You know the name of the Grid/Graph’s data source. To identify it, complete the following steps:
  
  a Right-click the Grid/Graph and select Properties and Formatting. The Properties and Formatting dialog box opens.
  
  b Click Layout in the list of categories on the left.
  
  c The name of the report is displayed in the Data source field.

---

**To add a link from a Grid/Graph to its dataset report**

1 In MicroStrategy Web, open the document in Design Mode.

2 From the Insert menu, select Text.

3 In the Layout area, click in the section where you want to place the link.

4 Type the name of the Grid/Graph’s underlying dataset in the text field to help the user identify the target of the link.

5 Right-click the text field and select Edit Links.

6 **To define the link**

   Type a name for the link in the URL display text field. The name should be descriptive as it is displayed when the user right-clicks the text field to choose from a list of links.
7 Select **Run this report or document** and click the browse button (...) to find and select the underlying dataset report.

**To apply prompt answers for a target report that contains prompts**

8 The box below Run this report or document contains a list of the prompts included in the target report (the underlying dataset). Select a prompt from the box.

9 Select one of the following prompt answer methods from the drop-down list. For examples of each prompt answer method, see *Specifying how prompts are answered in the target, page 427*.

- **Answer with the same prompt from the source**: Select this option if you want to use the same prompt answers for both the source report and the target report. This option requires that both the source and target document use the same prompt.

- **Prompt user**: Select this option if you want the user to type prompt answers after he clicks the link to run the target report.

- **Answer with an empty answer**: Select this option if you want to ignore the prompt in the target report. The prompt is not answered. This option requires that the prompt in the target is not required. If the prompt in the target is required, the user is prompted to provide an answer.

- **Use default answer**: Select this option if you want the prompt in the target to use the default answer provided by the prompt’s designer. This option requires that a default answer is defined for the prompt in the target.

- **Answer dynamically**: Select this option if you want to answer the prompt using the object selected in the source. This option is only available for attribute element prompts and value prompts.

- **Answer using current unit**: Select this option if you want to answer the prompt using the object selected in the source. This option is only available for hierarchy prompts.

- **Answer using all valid units**: Select this option if you want to answer the prompt in the target with any object to the left of or above the object that the user selects in the source document. This method passes all pertinent selections in the source, rather than just the selection made for the link. This option is available only for hierarchy prompts.

10 Repeat the step above for each prompt in the target report.
To specify the prompt answer method for prompts not in the list

11 Any other prompts are those prompts that are not in the target report when you are creating the link. For example, these prompts can include prompts added to the target at a later time. By default, the Prompt user answer method is selected for these prompts, but you can change the method. To do this, select Any other prompts in the list.

12 Select a prompt answer method from the list; these are the only methods available for the Any other prompts option. For examples of each answer method, see Specifying prompt answers for any other prompts not listed, page 435.

- Answer with the same prompt from the source
- Prompt user (default)
- Answer with an empty answer
- Use default answer

13 Select the Open in new window check box to have the target report open in a new window. This allows the target and the source documents to be visible simultaneously. If this check box is cleared, the target report opens and replaces the source document.

14 Click OK to save your link and return to the source document.

To unlink a Grid/Graph from its underlying report

1 In MicroStrategy Web, open the document in Design Mode.

2 Right-click the text field that contains the link from the Grid/Graph to its underlying dataset, and click Delete. The link is removed.

Merging column and row headers in a grid

You can merge row headers or column headers in the following ways:

- Merge any row headers that are repeated. All headers displaying the same value are automatically merged into one header. For example, a grid displays sales by merchandise type, payment method, and total amount sold. If there is a row for each merchandise type for each method of
payment, all headers corresponding to a merchandise type can be merged into one.

- Merge any column headers that are repeated. For example, if three metrics on the grid are related to Sales, do you want all three columns to have Sales in the header, or do you want to merge these column headers into a single header? If merged, Sales appears only once for the three related columns.

**To merge or unmerge the column or row headers of a grid**

1. In MicroStrategy Web, open the document that contains the grid in **Design** or **Editable Mode**.
2. Right-click the grid, then select **Properties and Formatting**.
3. From the left, select **Grid**. Under Headers, choose from the following:
   - To merge row or column headers, select the **Merge** check box in either or both the Rows and Columns areas.
   - To unmerge row or column headers, clear the **Merge** check box in either or both the Rows and Columns areas.
4. Click **OK** to apply the changes.

**Displaying attribute and attribute form headers in a grid**

You can format the display of column or row headings (headers) for attributes and attribute forms in a grid. For example, you can choose to have a header containing the attribute form name automatically displayed above each attribute form shown in the grid, or have a single header automatically displayed for each attribute in the grid, with each header containing only the attribute name. The following images depict examples of each way in which you can choose to have attribute and attribute form headers displayed.
You can have a header containing the attribute name automatically displayed for each attribute in the grid.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aaby</td>
<td>7796 $3,104</td>
</tr>
<tr>
<td>Aadland</td>
<td>1874 $3,814</td>
</tr>
<tr>
<td>Aadland</td>
<td>3771 $2,378</td>
</tr>
<tr>
<td>Aadland</td>
<td>4432 $4,508</td>
</tr>
<tr>
<td>Aafedt</td>
<td>7923 $1,064</td>
</tr>
<tr>
<td>Aagesen</td>
<td>1930 $2,580</td>
</tr>
<tr>
<td>Aalgard</td>
<td>3345 $1,551</td>
</tr>
<tr>
<td>Aamdt</td>
<td>7832 $786</td>
</tr>
<tr>
<td>Aarestad</td>
<td>2306 $1,857</td>
</tr>
<tr>
<td>Aarnink</td>
<td>7570 $1,657</td>
</tr>
</tbody>
</table>

You can have a header containing the attribute name and attribute form name automatically displayed above each attribute form shown in the grid.

<table>
<thead>
<tr>
<th>Customer Last Name</th>
<th>Customer First Name</th>
<th>Customer ID</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aaby</td>
<td>Allen</td>
<td>7796</td>
<td>$3,104</td>
</tr>
<tr>
<td>Aadland</td>
<td>Miko</td>
<td>1874</td>
<td>$3,814</td>
</tr>
<tr>
<td>Aadland</td>
<td>Warner</td>
<td>3771</td>
<td>$2,378</td>
</tr>
<tr>
<td>Aadland</td>
<td>Constant</td>
<td>4432</td>
<td>$4,508</td>
</tr>
<tr>
<td>Aafedt</td>
<td>Wendy</td>
<td>7923</td>
<td>$1,064</td>
</tr>
<tr>
<td>Aagesen</td>
<td>Bink</td>
<td>1930</td>
<td>$2,580</td>
</tr>
<tr>
<td>Aalgard</td>
<td>Kenney</td>
<td>3345</td>
<td>$1,551</td>
</tr>
<tr>
<td>Aamdt</td>
<td>Stacy</td>
<td>7832</td>
<td>$786</td>
</tr>
<tr>
<td>Aarestad</td>
<td>Benjamin</td>
<td>2306</td>
<td>$1,857</td>
</tr>
<tr>
<td>Aarnink</td>
<td>Marian</td>
<td>7570</td>
<td>$1,657</td>
</tr>
</tbody>
</table>

You can have a header containing the attribute form name automatically displayed above each attribute form shown in the grid.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>ID</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aaby</td>
<td>Allen</td>
<td>7796</td>
<td>$3,104</td>
</tr>
<tr>
<td>Aadland</td>
<td>Miko</td>
<td>1874</td>
<td>$3,814</td>
</tr>
<tr>
<td>Aadland</td>
<td>Warner</td>
<td>3771</td>
<td>$2,378</td>
</tr>
<tr>
<td>Aadland</td>
<td>Constant</td>
<td>4432</td>
<td>$4,508</td>
</tr>
<tr>
<td>Aafedt</td>
<td>Wendy</td>
<td>7923</td>
<td>$1,064</td>
</tr>
<tr>
<td>Aagesen</td>
<td>Bink</td>
<td>1930</td>
<td>$2,580</td>
</tr>
<tr>
<td>Aalgard</td>
<td>Kenney</td>
<td>3345</td>
<td>$1,551</td>
</tr>
<tr>
<td>Aamdt</td>
<td>Stacy</td>
<td>7832</td>
<td>$786</td>
</tr>
<tr>
<td>Aarestad</td>
<td>Benjamin</td>
<td>2306</td>
<td>$1,857</td>
</tr>
<tr>
<td>Aarnink</td>
<td>Marian</td>
<td>7570</td>
<td>$1,657</td>
</tr>
</tbody>
</table>

You can choose to have a header automatically displayed for each attribute form in the grid. Only the header for the first attribute form for each attribute
includes the attribute name. All other headers contain the attribute form name only.

You can choose to automatically display either headers for each attribute or each attribute form depending on the number of attribute forms visible in the grid for each attribute.

- You can have a single header automatically displayed for each attribute in the grid, with each header containing only the attribute name. The grid in the first image above contains the Customer attribute, for which the Last Name, First Name, and ID attribute forms are each shown in a separate column. In this example, the designer of the grid has chosen to have the attribute name automatically displayed in the header of each attribute in the grid, so the header for the Customer attribute is displayed as Customer.

- You can have a header automatically displayed for each attribute form in the grid, with each header consisting of the attribute name followed by the attribute form name. For example, in the second image above, the headers for the Last Name, First Name, and ID attribute forms are
displayed as Customer Last Name, Customer First Name, and Customer ID, respectively.

- You can have a header automatically displayed for each attribute form in the grid, with each header consisting of only the attribute form name. In the third image above, the headers for the Last Name, First Name, and ID attribute forms are displayed as Last Name, First Name, and ID, respectively.

- You can have a header automatically displayed for each attribute form in the grid and include the attribute name only in the header for the first attribute form for each attribute. In the fourth image above, the Last Name attribute form is the first attribute form displayed for the Customer attribute, and its header is therefore displayed as Customer Last Name. The remaining attribute forms are displayed using the attribute form name only: First Name and ID, respectively.

- You can choose to automatically display either headers for each attribute or each attribute form depending on the number of attribute forms visible in the grid for each attribute. If only one attribute form is shown in the grid for an attribute, the attribute is displayed with a header containing the attribute’s name. If more than one of the attribute’s forms are visible in the grid, each attribute form is displayed with a header containing the attribute name followed by the attribute form name.

In the fifth image above, both the Region and Customer attributes have been added to the grid. Because the Region attribute is displayed using a single attribute form, it is displayed with a header containing the attribute name, Region. On the other hand, three attribute forms are displayed for the Customer attribute, so a header is displayed for each attribute form: Customer Last Name, Customer First Name, and Customer ID, respectively.

**Prerequisites**

- This procedure assumes that you have already created a document containing the grid whose attributes and attribute form headers you want to display.

- The Show Attribute Form Names option in the Grid Display preferences in Web must be set to Read from Report. For steps to modify user preferences in Web, see the MicroStrategy Web Help.
To display attribute and attribute headers in a grid

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Right-click the grid, then select Properties and Formatting. The Properties and Formatting dialog box opens.

3. From the left, click Grid.

4. From the Show attribute form names drop-down list, select one of the following (images and detailed descriptions of each option are above):
   - To have the attribute name automatically displayed in the header of each attribute in the grid, select Off (default). No attribute form names are included in the grid, as shown in the first example image above.
   - To have a header automatically displayed for each attribute form in the grid, with each header consisting of the attribute name followed by the attribute form name, select On. For an example, see the second image in the section above.
   - To have a header automatically displayed for each attribute form in the grid, with each header consisting of only the attribute form name, select Form name only. For an example, see the third image in the section above.
   - To have a header automatically displayed for each attribute form in the grid and have the attribute name included only in the header for the first attribute form for each attribute, select Show attribute name once. The remaining attribute forms are displayed using the attribute form name only, as shown in the fourth example image above.
   - To automatically display either headers for each attribute or each attribute form depending on the number of attribute forms visible in the grid for each attribute, select Automatic. If only one attribute form is shown in the grid for an attribute, the attribute is displayed with a header containing the attribute's name. If more than one of the attribute's forms are visible in the grid, each attribute form is displayed with a header containing the attribute name followed by the attribute form name. See the fifth image above for an example.

5. Click OK to apply your changes.
Drilling in Grid/Graphs

Drilling on a Grid/Graph in a document is similar to drilling on a report. Drilling allows users to look at specific data at levels other than that of the originally displayed Grid/Graph. It allows users to retrieve more information after the document has been executed. The new data is obtained by requerying the database at a different attribute or fact level. For an introduction to drilling, see the Basic Reporting Guide.

Before a user can drill on a Grid/Graph in a document, you must enable drilling for the Grid/Graph. Steps to enable or disable drilling for a Grid/Graph are below.

When you enable drilling, you can define whether users can only drill within the dataset report or drill anywhere. You can also define whether subtotals on the parent report are also displayed on the drilled-to report. And you can define the join type of the drill attributes to determine how the data is calculated on the drilled-to report. For details on these two options, see Inheriting subtotals and defining join type, page 241.

For information on how drilling works with links and selectors in Grid/Graphs, see How links, drilling, and selectors work together, page 446.

Drill maps determine what happens when an object is drilled on. You can create and edit the drill maps for a Grid/Graph. For more information on drill maps, see the Advanced Reporting Guide.

You can determine drilling behavior by clicking Preferences at the top of any page in MicroStrategy Web, then clicking Drill mode on the left. You can set such preferences as whether the drilled-to report/document opens in a new window or replaces the drilled-from report/document in the old window. For details on all options, click Help.

To enable or disable drilling in a Grid/Graph

1  In MicroStrategy Web, open the document in Design or Editable Mode.

2  Right-click the Grid/Graph and select Properties and Formatting. The Properties and Formatting dialog box opens.

3  From the left, select Grid.
In the Drilling area, select one of the following from the **Drill options**
drop-down list:

- To disable drilling, select **No drilling**.
- To allow users to only drill using objects that are within the dataset
  report, select **Drill within**. Only the drill paths from the drill maps that
  are included in the dataset report but not already on the report grid
  are shown to the user. For example, you can drill from Year only down
  to Quarter in the example shown below. You cannot drill further down
  to Day because Day is not included in the dataset.

Drilling within the dataset report can be used to reduce the paths from
those that are defined in the drill map. It does not include paths that
are not defined in the drill map, even if an attribute in the dataset does
not have a drill path.

- To allow users to drill on attributes other than those available in the
  dataset, select **Drill anywhere**. By default, when you enable drilling in
  a Grid/Graph, users can drill anywhere. If the dataset does not have a
  custom drill map, the drill paths in the project drill map are used.
  Drilling anywhere allows the user to view associated data within the
  same attribute or across attributes, whether at the same level, a higher
  level, or a lower level. For example, even though only Year and
  Quarter are included in the dataset, the other attributes in the Time
hierarchy can be drilled to because the Grid/Graph allows drilling anywhere, as shown below.

You can enable users to automatically drill on another grid or graph (the target) when they drill on the grid or graph that is currently selected (the source). This is called synchronized drilling. For example, a grid containing profit data across several product categories targets a graph displaying inventory data. If a user drills to Subcategory in the grid, the graph will automatically be updated to display inventory data drilled to the Subcategory level.

Select grids or graphs from the Available list and click > to add them to the Selected list. When users drill on the source grid or graph, each of the grids or graphs added to the Selected list will also be updated. The Drill Options setting must be set to Drill Within.

The Keep parent while drilling option determines whether the original object (the object that the user drills on) appears in the destination report. For example, if a user drills from State to City when Keep parent is selected, State remains on the destination report. If the Keep parent option is not selected, the parent attribute is removed. The same drill would result in a destination report with City but not State.

By default, whether or not the parent attribute is retained in the drilled-to report, is determined by the setting in the report definition. To override this setting, click Preferences at the top of any page, click Drill Mode on the left, and select Yes or No from the Keep parent while drilling drop-down list.

The Keep thresholds while drilling option determines whether a threshold set in the original report is still displayed in the destination
report (after the drill). For example, a threshold is defined to bold revenue values greater than $1 million. If a user drills from Store to Employee when the **Keep thresholds** option is selected, any revenue value over $1 million is shown in bold font. If the option is not selected, none of the revenue values are bolded.

By default, whether or not thresholds are retained in the drilled-to report, is determined by the setting in the report definition. To override this setting, click **Preferences** at the top of any page, click **Drill Mode** on the left, and select **Yes** or **No** from the **Keep thresholds while drilling** drop-down list.

8 Click **OK** to save the changes and return to the document.

If you have enabled drilling, consider the display modes that are available for users of the document. A user can drill on a Grid/Graph in the following display modes in MicroStrategy Web:

- **Flash Mode**: In Flash Mode, users can drill only to report objects within the dataset report that are not included in the Grid/Graph. If all objects within the dataset report are displayed in the Grid/Graph, no drilling options are displayed. If drilling is disabled in Flash Mode, you can enable it by allowing data manipulations, as described in *Enabling filtering, drilling, and moving objects for Grid/Graphs in Flash Mode*, page 247. Whether drilling in Flash Mode is disabled or enabled by default depends on the document template that the document was created with.

- **Express Mode**: In Express Mode, users can drill only on the default drill path of an attribute. This is defined when a drill map is created. For instructions to create a drill map, see the *Advanced Reporting Guide*.

You can enable or disable specific display modes for end users; see *Determining display for end users*, page 337.

**Inheriting subtotals and defining join type**

You can determine whether a subtotal in the original report is displayed in the destination report (after the drill). By default, whether the subtotal is kept is determined by the drill path.

You can select the attributes that appear in the destination reports while drilling, as well as specify the join types for these attributes. The join type defines how the attributes in the destination reports are joined, and thus it affects how data is calculated on the drilled-to report. For details and
examples showing how attribute joins affect report results, see the Advanced Reporting Guide.

These options must be set using MicroStrategy Desktop.

---

**To inherit subtotals and define join type when drilling**

2. Double-click the Grid/Graph to enter Edit mode.
3. From the Data menu, select Grid Data Options.
4. On the left, expand General and select Drilling.
5. Select the Enable report drilling check box.
6. The Inherit subtotals from parent option determines whether the subtotal is inherited from the original report. Select one of the following:
   - **Default**: Whether the subtotal is inherited from the parent is determined by the drill path.
   - **Yes**: Inherits the subtotal from the parent report unless all of the following are true:
     - The subtotals are calculated by group.
     - The object being drilled from is the same as the group being subtotaled.
     - The Keep parent while drilling option is not selected.
7. Setting the join type allows you to place conditions on the data selected for display in the report. An inner join includes only the data common to all the elements in the join, whether that data is tables or metrics. An outer join includes all of the data in all of the elements.
   
   To select the attributes that appear in the destination reports while drilling, and to specify the join types for these attributes, click Drill Attributes Join Type. For details, click Help.
8. Click OK to save your changes and return to the document.
Determining how null and zero metric values are displayed

You can determine how to display or hide rows and columns in a grid that consist only of null or zero metric values. You can have MicroStrategy hide the rows and columns in the following ways:

- Hide rows and columns that consist only of null metric values
- Hide rows and columns that consist only of zero metric values
- Hide rows and columns that consist only of null or zero metric values (default)

Once you have defined how MicroStrategy hides null and zero metric values in the grid, you can quickly show or hide rows or columns in the grid using the Hide Nulls/Zeros option in the Data menu, as described below, or by clicking the Hide Nulls/Zeros icon in the Data toolbar.

Prerequisite

- The following procedure assumes that you have already created a grid in a document.

To determine how null and zero metric values are displayed or hidden in a grid

1. Open the document in Editable Mode.
2. Right-click the grid, then select Properties and Formatting. The Properties and Formatting dialog box opens. From the left, click Grid.
3. To determine how MicroStrategy hides null and zero metric values in the grid, select the Hide Null/Zero Toggle Behavior check box. From the drop-down list, select one of the following:
   - To hide rows and columns that consist only of null or zero metric values, select Hide Nulls or Zeroes (default).
   - To hide rows and columns that consist only of null metric values, select Hide Nulls Only.
• To hide rows and columns that consist only of zero metric values, select **Hide Zeros Only**.

4 Click **OK** to apply your changes, then click the grid to select it.

5 To determine whether null and zero metric values are displayed or hidden in the grid, from the **Data** menu, select one of the following:

• To hide rows and columns containing null metric values, zero metric values, or both as defined in the steps above, select the **Hide Nulls/Zeros** option.

• To display all rows and columns in the grid, including those that consist only of null or zero metric values, clear the **Hide Nulls/Zeros** option.

---

**Enabling interactive Grid/Graphs for MicroStrategy Web**

You can specify how a MicroStrategy Web user interacts with Grid/Graphs in Flash Mode and Express Mode in MicroStrategy Web.

• A user can sort and pivot data in Grid/Graphs, as described in *Sorting and pivoting in Grid/Graphs in Flash Mode and Express Mode*, page 245. A user can also drill to the default drill path in Express Mode.

  ▪ You can disable sorting and pivoting in all the Grid/Graphs of a specific document; for instructions, see *Disabling sorting and pivoting for Grid/Graphs in Flash Mode and Express Mode*, page 246. This also disables drilling in Express Mode.

• In Flash Mode, a user can manipulate data in Grid/Graphs, such as clicking links to other documents or reports, filtering by attribute elements or metrics, and grouping by attributes. For instructions, and a complete list of data manipulations, see *Enabling filtering, drilling, and moving objects for Grid/Graphs in Flash Mode*, page 247.

These data manipulations are available in Flash Mode only; in Express Mode, the user can sort, pivot, drill, and use links.

Whether sorting/pivoting and the pop-up menu are enabled or disabled by default depends on the document template that the document was created with.
Sorting and pivoting in Grid/Graphs in Flash Mode and Express Mode

In Flash Mode and Express Mode, users can sort and pivot data in a Grid/Graph displayed as a grid or as both a grid and a graph. A user can:

- Sort data in ascending or descending order
- Pivot data to change:
  - The relative position of a row or column
  - A row into a column
  - A column into a row

In Flash Mode, users sort or pivot data using a floating toolbar. This floating toolbar is displayed when a user hovers the cursor over the columns of a Grid/Graph, as shown in the image below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Eierkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$126,778</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$916,048</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Morrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$622,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td></td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
</tbody>
</table>

The ▲ icon in the toolbar sorts the data in ascending order, while the ▼ icon sorts in descending order. These arrows ◂ ◄ ◄ ◄ ◄ pivot the data.

In Express Mode, users sort or pivot data using a pop-up menu, as shown below:
For more detailed instructions to sort and pivot, see the *Document and Dashboard Analysis Guide* or the *MicroStrategy Web Help*.

Whether sorting/pivoting is enabled or disabled by default depends on the document template that the document was created with. For instructions, see *Enabling interactive Grid/Graphs for MicroStrategy Web, page 244* and *Disabling sorting and pivoting for Grid/Graphs in Flash Mode and Express Mode, page 246*. Disabling sorting and pivoting also disables drilling in Express Mode.

You can also enable additional interactive data manipulations to be performed in Flash Mode, such as filtering or grouping data in a grid. For more information, see *Enabling filtering, drilling, and moving objects for Grid/Graphs in Flash Mode, page 247*.

### Disabling sorting and pivoting for Grid/Graphs in Flash Mode and Express Mode

In Flash Mode and Express Mode, users can sort and pivot data in Grid/Graphs using a toolbar (Flash Mode) or pop-up menu (Express Mode). You disable this functionality by hiding the toolbar and pop-up menu. Whether sorting/pivoting and the pop-up menu are enabled or disabled by default depends on the document template that the document was created with.

Disabling sorting and pivoting also disables drilling in Express Mode.

---

**To disable sorting and pivoting for Grid/Graphs in Flash Mode and Express Mode**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. From the left, select **Document**.
4. Clear the **Enable sorting and pivoting on grids in Express and Flash Modes** check box.
5. Click **OK** to return to the document.
Enabling filtering, drilling, and moving objects for Grid/Graphs in Flash Mode

In Flash Mode, a user can sort and pivot data on a Grid/Graph by default. You can enable a pop-up menu so that users can quickly access the additional data manipulations listed below:

- Sorting data in a row or column
- Sorting data using multiple conditions (advanced sorting)
- Pivoting a row or column
- Filtering data:
  - Based on the value of a metric
  - Based on a list of attribute elements
  - To include only the data for a selected attribute element
  - By excluding data for a selected attribute element
- Clearing filtering conditions to display all data
- Moving an attribute to the first row or the first column
  The attribute is moved to the far left of the rows or the top of the columns on the Grid/Graph, the data is sorted by the attribute, and the row/column header cells are merged.
- Adding or removing report objects to display in the Grid/Graph
  Only objects in the Grid/Graph’s dataset report can be added to the Grid/Graph.
- Drilling within the Grid/Graph’s dataset report
  Drilling lets users view report data at levels other than that displayed in the Grid/Graph. A user can only drill to report objects within the dataset report that are not included in the Grid/Graph. If all objects within the dataset report are displayed in the Grid/Graph, no drilling options are displayed. For background information on drilling, see Drilling in Grid/Graphs, page 238.
- Opening a linked report or document
  A link is a connection in a document to another document or report. For background information on links and steps to add a link to a document, see Chapter 6, Linking from Documents.
These manipulations are performed directly in Flash Mode and applied to Grid/Graphs displayed as grids or as both grids and graphs.

If this additional interactivity is enabled, MicroStrategy Web users can access a pop-up menu when they hover the cursor over a Grid/Graph in Flash Mode. The pop-up menu, shown below, displays the various data manipulation options.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$764,3</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$673,0</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>$1,300,7</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td>$200,3</td>
<td></td>
</tr>
<tr>
<td>South</td>
<td>$806,9</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$336,8</td>
<td></td>
</tr>
<tr>
<td>Southwest</td>
<td>$581,3</td>
<td></td>
</tr>
<tr>
<td>Web</td>
<td>$583,5</td>
<td></td>
</tr>
</tbody>
</table>

This pop-up menu is available in Flash Mode in MicroStrategy Web only; you cannot access it in Desktop. For instructions on using it in MicroStrategy Web, see the MicroStrategy Web Help or the Document and Dashboard Analysis Guide. Whether sorting/pivoting and the pop-up menu are enabled or disabled by default depends on the document template that the document was created with.

**To enable data manipulations for Grid/Graphs in Flash Mode**

1. In MicroStrategy Web, open the document in Design or Editable Mode.
3. From the left, select Document.
4. Select the Enable sorting and pivoting on grids in Express and Flash Modes check box.
5 Select the **Enable additional interactivity on grids in Flash Mode** check box.

This check box is available only if **Enable sorting and pivoting on grids in Express and Flash Modes** is selected. When **Enable additional interactivity on grids in Flash Mode** is selected, the pop-up menu replaces the sorting and pivoting toolbar in Flash Mode.

6 Click **OK** to return to the document.
Introduction

When you add a new control to a document, its initial formatting is determined by the default formatting for that type of control. Each control type (text field, image, rectangle, and so on) has a default set of formatting (called a control default). For information on control defaults, including how to apply them and how to change them, see Defining default formatting for control types: control defaults, page 255.

You can change the formatting of each control as desired. You can determine a document’s appearance by formatting either its controls (text fields, lines, sections, and so on) or the entire document. Another method to format all controls of the same type in a single way, or to format all documents in a single way, is to use an Autostyle, which is a saved set of formatting that can be applied to all controls of a given type or to a set of documents so that they all have the same look and feel.

For formatting ideas, see Formatting suggestions, page 252.

Different types of controls have different formatting options. For example, you can set the font color and size for a text field, but those options are not
relevant to a rectangle or line. The formatting options available for each control type, and for the document as a whole, include the following:

- *Formatting using predefined formats (Autostyles), page 258*
- *Formatting text fields, page 273*
- *Formatting HTML containers, page 281*
- *Formatting lines and rectangles, page 284*
- *Formatting images, page 287*
- *Formatting document sections, page 288*
- *Adding watermarks to documents, page 326*. Watermarks are faint designs or text appearing in the background of the document, typically to identify or decorate pages.
- *Formatting the border or background of a document or layout, page 325*
- *Formatting Grid/Graph containers, page 207*
- *Formatting conditional data in documents, page 307*
- *Determining display for end users, page 337*
- *Formatting a document for exporting or printing, page 342*

### Formatting suggestions

The following list provides some useful formatting suggestions:

- The transparent backstyle lets you see what is behind a control. The opaque backstyle covers what is behind a control or colors a control. For examples and steps, see *Using a transparent or opaque backstyle, page 261*.
- Borders, including 3D effect and drop shadows, set off or define a control. Use a 3D effect to make a control appear three-dimensional, like a button. Use a drop shadow to “float” a control on top of the background. For examples and steps, see *Applying a 3D effect, page 263* and *Applying a drop shadow, page 265*.
• Gradient colors allow you to blend two colors in a gradual color change in the background of a control.

  For examples and steps, see *Using gradient colors, page 267.*

• Create and use custom colors.

• Tooltips display pop-up text when a user positions the cursor over a control in MicroStrategy Web. Tooltips can provide extra information, such as the full company name in the tooltip of the company logo.

  For examples and steps, see *Creating a pop-up tooltip, page 270.*

• You can display text in a text field vertically (up and down the page) rather than horizontally. Vertical text is displayed in all MicroStrategy Web display modes and when the document is exported to Excel.

  For examples and steps, see *Displaying text vertically, page 279.*

• You can designate a control to be hidden when the document is viewed as a PDF. This allows the information to be visible to other document designers but not to users viewing the document as a PDF (for example, in Interactive Mode, Editable Mode, and Express Mode in MicroStrategy Web). For instance, you could include a note in a hidden text field about the source of data.

  For examples and steps, see *Hiding a control, page 272.*

### Methods for formatting a control

When you add a new control, its formatting is determined by the control default for that type of control. Each control type (text field, image, rectangle, and so on) has a control default, which contains a full set of formatting options to specify the default format. You can also change the default formatting.

Two interfaces are available to use to define formatting. Which interface you use depends on your personal preference and what options you want to change. The Properties and Formatting dialog box is generally the easiest method to start with, as it contains all the options of the other interfaces and it appears on the same screen as the document’s Layout area, where most formatting is performed.
Formatting interfaces are listed in the table below.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Available Options</th>
<th>How to Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting toolbar</td>
<td>Easy access to basic formatting options such as:</td>
<td>1 In MicroStrategy Web, open the document in <strong>Design Mode</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Font, alignment, colors, borders, currency type and decimal places, borders,</td>
<td>2 Select the control to be formatted.</td>
</tr>
<tr>
<td></td>
<td>background fill, font color</td>
<td>3 Click <strong>Format</strong> on the menu bar. The Formatting toolbar appears below the menu tabs.</td>
</tr>
<tr>
<td>Properties and Formatting</td>
<td>• General settings of the control, such as its name</td>
<td>1 In MicroStrategy Web, open the document in <strong>Design Mode</strong>.</td>
</tr>
<tr>
<td>Formatting dialog box</td>
<td>• Layout settings, such as position, title height, and grid options</td>
<td>2 To format an individual control on a document, right-click the control to be formatted and select <strong>Properties and Formatting</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Flash</td>
<td>3 To format document-wide settings, from the <strong>Format</strong> menu, select <strong>Properties and Formatting</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Font</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Color and lines</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Effects, including 3D borders and drop shadows</td>
<td></td>
</tr>
</tbody>
</table>

For descriptions of each option on each interface, see the *MicroStrategy Web Help*.

**Copying and pasting formatting**

One way to format a control is to copy and paste the formatting. After you have formatted a control in a particular way, you can copy that formatting to other controls of the same type. You cannot copy formatting between objects of different types. For example, you cannot paste a rectangle’s formatting onto a text field, because the two types do not have the same formatting settings.

You cannot copy formatting between two Grid/Graph containers. You can create an Autostyle and apply it to multiple Grid/Graphs to apply the same formatting to all of them. For steps to create and use Autostyles, see *Formatting using predefined formats (Autostyles), page 258*.

**To copy and paste formatting**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2 Select the control with the desired formatting and click the **Copy** icon on the Standard toolbar.

3 Select the control(s) to copy the formatting to.
   
   The selected controls must be the same type as the control that you copied the formatting from.

4 Right-click the selected control(s) and choose **Paste Format**.

**Defining default formatting for control types: control defaults**

A control default is a set of formats that is applied to a specific type of control (text fields, HTML containers, and so on). There is one control default for each control type. All controls of that type therefore display uniform formatting.

When you create a new object, the object is automatically formatted by the control default for its control type. You can then change the formatting of that object to suit your needs. You can also change the default formatting for a control type by changing the control default.

A control default exists for document sections, but is applied only when a new group header or group footer is created, not when additional sections are added. For details, see *Control defaults for document sections, page 257*.

For example, the control default for text fields specifies that the font of all new text fields is Arial size 10 and black. Create two new text fields, Text1 and Text2, as shown below:

The text in both controls is displayed according to the control default, with Arial size 10 and black formatting. Format Text1 as Courier New size 14 and light blue. Set the control default to use Text1’s format. Create a third text field, Text3. It is automatically formatted like Text1 (Courier New size 14 and
light blue), as shown below, because you have defined the new formatting to be the new default formatting for the text field type of control:

Notice that the format of Text2 did not change. When you change the control default, existing controls are not affected, because the control default is not linked to any existing controls in the document. Only controls created after the control default formatting is changed will reflect the new default formatting. If you want an existing control to be formatted in the same way as the control default, you can manually apply the control default to an existing control.

For example, select Text2 and apply the control default. It is now formatted like Text1 and Text3, with Courier New size 14 and light blue.

Control defaults are not used when you copy and paste a control or when you duplicate a control. The formatting of the copied or duplicated control is copied or duplicated along with the control itself.

Control defaults can include any formatting setting, such as font color, background color, borders, and so on, that applies to the control type.

For Grid/Graphs, the control default affects only the report Autostyle. (A report Autostyle is a set of predefined formats used for reports and for Grid/Graphs in documents; a report Autostyle is different than a document Autostyle, discussed in Formatting using predefined formats (Autostyles), page 258. For information on report Autostyles, see the Basic Reporting Guide.)

Default grid Autostyles are another way to define the control default for Grid/Graphs. A default grid Autostyle applies to all layouts of a multi-layout document.

To define the default formatting for a control type

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Format a control as you want the default formatting for this control type to look.
3 Right-click it and select **Set Control Defaults**. All new controls of that control type are formatted using the control default formatting.

You can apply the control default to existing controls of the same control type. For steps, see *Applying default formatting to a control or document section*, page 257.

### Control defaults for document sections

Document sections, although not a control type, have a control default. The control default includes all the settings of the document section, such as background color, height, and page breaks.

You can format a document section, set it as the control default for sections, and apply the control default to any existing section. The control default is automatically applied to new group sections, but not when you insert additional sections, as described below:

- When you create a new group, a Group Header section and a Group Footer section are created. These sections are formatted according to the control default for document sections.

- When you insert a new document section, the new section is formatted the same as the section to which it is added. For example, if you add a section below the Detail Header, the new section is formatted like the Detail Header.

For steps to group a document, see *Grouping records in a document*, *page 374*. For steps to add sections, see *Adding sections in documents*, *page 39*.

### Applying default formatting to a control or document section

If you change the control default formatting, existing controls are not affected, because the control default is not linked to any existing controls in the document. If you want the format of an existing control to be consistent with new controls, you can apply the control default to the existing control to change its formatting. You can also use a control default for document sections in the same way, by setting the control default and then applying it to an existing document section.
This is also helpful when you create a number of controls of the same type, format one as desired, and want to apply the same formatting to existing controls as well as to any new ones that you create later.

You can also use copy and paste formatting to copy formatting between existing objects. For information and instructions, see *Copying and pasting formatting*, page 254.

---

**To apply default formatting to a control or document section**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. Right-click the control or document section and select **Apply Control Default**.
   - If you are applying the control default to a grid report, select **Apply Control Default** from the **Format** menu.

   The control or section is formatted with the control default formats.

---

**Formatting using predefined formats (Autostyles)**

An Autostyle is a collection of formatting settings. The settings are saved based on each control type. You can apply an Autostyle to a document or control to change its formatting or appearance. If you have a document with a look or style that you want other documents to have, you can create an Autostyle for the document, or for specific controls on the document, and then efficiently apply the same look or style to other documents by applying the Autostyle to the other documents/controls.

When you apply an Autostyle to another document, the system copies formatting information from the Autostyle onto the target document. It replaces formatting settings for all document sections and controls (including Grid/Graphs) on the target document with the corresponding settings in the Autostyle. If the target document has a section or control for which there is no corresponding document section or control on the original document, it applies the default format for the control type. If an Autostyle has multiple controls of the same type in one section, the format of the first control of this type in that section is used.

You can create your own Autostyles or use the Autostyles provided by MicroStrategy. A document Autostyle is different from a report Autostyle. A document Autostyle is a document object and can only be
applied to documents. A report Autostyle is an Autostyle object and can be applied to reports and to grids within documents. Both types of Autostyles contain formatting information. For each preconfigured report Autostyle, a matching document Autostyle exists.

For a multi-layout document, an Autostyle is applied only to the current layout, not the entire document. For background information on multi-layout documents, including which settings apply to the document as a whole or to individual layouts, see Creating multi-layout documents, page 476. If the Page Header and Page Footer are shared among layouts, any formatting changes applied to those sections are applied throughout the document. Page Headers and Page Footers are shared by default (for steps to change that, see Using a separate Page Header and Page Footer for a layout, page 484). For descriptions and examples of the Page Header and Footer, see Page Header, page 31 and Page Footer, page 36.

Creating and saving a document Autostyle

To create a document Autostyle, apply the formatting that you want to a document’s controls and sections, then save the document in the AutoStyles folder whose path is as follows:

```
project name\Public Objects\AutoStyles
```

Documents saved in the AutoStyles folder are still documents, and not Autostyle objects.

Saving the Autostyle document in the AutoStyles folder allows you to select the Autostyle document when you create a document using the Document Wizard. An Autostyle document saved elsewhere is not available to the Document Wizard.

If you save documents in any other location, such as the My Objects folder, for example, you can still apply them as Autostyles to other documents through the Document Editor.

Applying an Autostyle

The following steps show you how to apply an Autostyle to a document, how to apply an Autostyle to a Grid/Graph control, and how to assign a default Autostyle to all Grid/Graph controls within a document. When you assign a default Autostyle to all controls in a document, all Grid/Graphs you insert into the document are automatically formatted according to the default Autostyle.
You can use an Autostyle provided by MicroStrategy or one that you created yourself. Applying an Autostyle pastes the formatting information from one document to another. It changes the formatting of all the sections and controls of the target document in one action. For a multi-layout document, an Autostyle is applied only to the current layout, not the entire document, as described in *Formatting using predefined formats (Autostyles), page 258*.

Use Desktop to apply a document Autostyle; use either Desktop or Web to apply a Grid/Graph Autostyle.

---

**To apply an Autostyle to a document**

1. Open the target document using the Document Editor in Design View.
2. If the document contains multiple layouts, click the tab of the layout to modify.
3. From the **Format** menu, select **Apply Autostyle**. The Select Autostyle dialog box opens.
4. Locate and select the Autostyle to apply to the document.
   - Autostyle documents created by MicroStrategy are available in the Public Objects\AutoStyles directory. User-created Autostyle documents may be located in this folder as well, but could have been saved in another folder instead.
5. Click **OK**. The formatting is applied to the document.

---

**To apply an Autostyle to a Grid/Graph**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Select a Grid/graph in the document.
3. From the **Autostyles** drop-down list on the Grid/Graph toolbar, select an autostyle. The formatting from the autostyle is applied to the selected grid. The Autostyles drop-down is shown below:
To assign a default autostyle to all Grid/Graph controls in a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
3. From the left, select Other.
4. Select an Autostyle from the Default Grid Autostyle drop-down list.
5. Click OK to apply the changes.

Using a transparent or opaque backstyle

The backstyle governs whether the background of the control is transparent or opaque.

- A transparent backstyle allows you to see what is behind the control.
- An opaque backstyle covers what is behind the control. It also allows the fill color of the control to be seen.

In the document sample below, the text field labeled Transparent has the backstyle set to transparent, while the other two text fields use the opaque backstyle. As described above, the transparent backstyle allows the gray background to show through, while opaque covers up the background with the fill color of the text field.

The difference between the two text fields that use the opaque backstyle lies in the way the backstyle setting is changed. For the text field labeled Opaque, the backstyle setting was set to opaque, so the default background color (white) displays. For the “Fill” text field, the background color was changed from the default of white. This automatically changes the backstyle to opaque.

You can apply a backstyle to the following types of controls:
• Grid/Graphs: The backstyle applies to any part of the Grid/Graph container that is not covered by the grid or graph report displayed inside the Grid/Graph container. For example, the background of the Grid/Graph container in the following sample is a dark gray. Because the Grid/Graph container is longer than the grid report inside it, the bottom of the Grid/Graph is dark gray.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,250</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,951</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

The background of a Grid/Graph is visible when the Grid/Graph container is larger than the report displayed inside it. This occurs when all of the following conditions are met:

- The Grid/Graph is displayed as a grid report.
- The Height mode and Width mode are set to Fixed, not Fit to contents. This allows the specified Height and Width settings to be used. (For steps to size a Grid/Graph, see Sizing controls, page 161.)

The background of a Grid/Graph can be formatted as a single color, a gradient, or as transparent, to allow what is behind the selector to show through.

• HTML containers using HTML tags: For an HTML container using a URL (iFrame), the backstyle is overwritten by the website displayed by the URL.
• Panel stacks, title bars, and panels
• Rectangles and rounded rectangles
• Selectors
• Text fields
To apply a transparent or opaque backstyle

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Add one of the controls listed above.
3. Right-click the control and select Properties and Formatting. The Properties and Formatting dialog box opens.
4. From the left, select Color and Lines.
5. In the object list at the top of the dialog box, select the part of the control to format.
6. In the Fill area, from the Color drop-down list, select No Color.
7. Click OK to apply your changes and return to the document.

Applying a 3D effect

You can make most types of controls appear three-dimensional, with a raised or sunken border around the control. For example, you can make a text field look like a button.

In the document sample below, the text field at the top has a regular border around it, without a 3D effect. The text field on the lower left is outset, and looks like a button. This is the raised 3D effect. In contrast, the text field on the lower right is inset, and looks like a pushed button. This is the sunken 3D effect.
You can also determine the thickness of the 3D border around the control. In the sample above, the 3D border is set to 4 points for the text field on the left. The one on the right is set to 2 points.

The 3D effect border settings take precedence over any existing border. If you later disable the 3D effect, the original border settings are restored.

You can use the 3D effect on the following types of controls:

- Grid/Graph containers (except the title)
- HTML containers
- Images
- Panel stacks (except the title. All panels in the stack use the same 3D effect.)
- Rectangles (for rounded rectangles, they appear only in Flash Mode in MicroStrategy Web)
- Selectors
- Text fields

---

**To apply a 3D effect to a control**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Add one of the controls listed above.
3. Right-click the control and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. From the left, select **Effects**.
5. Select the **Enable 3D Borders** check box.
6. From the **Effect** drop-down list, select one of the following to determine the type of 3D effect to apply:
   - **Raised**, to outset the text like a button.
   - **Sunken**, to inset the control like a pushed button.
7 In the **Weight** field, type a number to determine the thickness to which the 3D effect is applied to the borders. Enter larger numbers to apply a thicker and more noticeable border. In general, numbers between 1-20 should accommodate your design requirements.

8 Select the **Enable Drop Shadows** check box to apply a shadow to the control.

9 Use the **Distance** slider to adjust the distance of the drop shadow from the control.

10 Click **OK** to apply your changes to the control and return to the document.

## Applying a drop shadow

You can apply a drop shadow to a rectangle, which causes the rectangle to appear to float above the background. In the document sample below, the rectangles on the top use drop shadows, while the rectangle on the bottom does not.

You can adjust the offset of the drop shadow to make the rectangle appear deeper. For example, the rectangle on the top left has a depth of two points, while the top right rectangle is set to five points. Acceptable values for the offset range from 1 to 20.

You can use the transparent format along with the drop shadow format. (For steps to apply the transparent format, see *Using a transparent or opaque backstyle, page 261.*) The rectangles in the sample above are transparent, so the content behind the rectangles shows through. The lines of the drop shadows are behind the rectangles, so they show through the rectangle. The drop shadows are displayed as rings, because only the border of a rectangle
can cast a shadow; the body of a rectangle is transparent and does not cast shadows.

In contrast, the grey rectangle shown below is opaque; the drop shadow does not show through the rectangle itself. It is displayed below and to the right of the rectangle. Also, the drop shadow is a solid rectangle, not a ring as displayed above. Since the rectangle itself is opaque, it casts a full shadow.

You can use drop shadows on the following types of controls:

- Grid/Graph containers
- HTML containers
- Images
- Lines
- Panel stacks (all panels in the stack use the same drop shadow settings)
- Rectangles and rounded rectangles
- Selectors
- Text fields

---

**To apply a drop shadow to a control**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Add one of the controls listed above.
3. Right-click the control and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. From the left, select **Effects**.
5. Select the **Enable Drop Shadows** check box.
6. Use the slider to adjust the thickness of the drop shadow.
7 Click **OK** to apply the changes to the control and return to the document.

**Using gradient colors**

Gradient colors blend two colors to create a gradual color change in the background of a control. You can select the two colors, as well as the direction of the blending. In the document sample below, the rectangles on the bottom use gradient colors, while the rectangle on the top uses a single, solid color.

Notice that the direction of the color change is different in the two rectangles with gradient colors. The left rectangle blends grey into white from top to bottom, while the right rectangle blends left to right (the default).

The direction is called the Gradient Variant, and you can choose from the following directions:

- Left to right
- Right to left
- Top to bottom
- Bottom to top

Three-way or mirror gradients blend the colors from the middle of the control out to the edges. One color is applied in the center of the control and the other to the edges of the control, then the two colors are blended. The two halves of the control are identical, as though a mirror was placed along the
center of the control. You can blend colors horizontally or vertically, as shown in the rectangles below, by specifying the Gradient Variant:

Three-way gradients are displayed only in Flash Mode. They are displayed as non-mirrored gradients in other Web display modes and in Desktop. In non-Flash modes, a horizontally centered gradient is displayed as a Left to right variant, and a vertically centered gradient is displayed as a Top to bottom variant.

You can use gradient colors on the following types of controls:

- Grid/Graphs
- HTML containers using HTML tags
  
  For an HTML container using a URL (iFrame), the gradient color is overwritten by the website displayed by the URL.
- Panel stacks (each panel in a panel stack can have an individual color scheme)
- Rectangles and rounded rectangles
- Selectors and title bars
- Sections
- Text fields
- Graph reports (see the Graphing chapter in the Advanced Reporting Guide)

To apply gradient colors to a control

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Add one of the controls listed above.
3 Right-click the control and select Properties and Formatting. The Properties and Formatting dialog box opens.

4 From the left, select Color and Lines.

5 In the Fill area, from the Color drop-down list, select Gradients. The Gradients dialog box is displayed.

6 Select the two colors in which to create a gradient from the Color 1 and Color 2 drop-down lists.

7 In the Shading Styles area, select the direction of the shading and then select a variant.
   • You can select a mirror-like gradient to apply to objects displayed in Flash Mode. To do so, select the Flash-only variant.

8 Click OK to apply the changes and return to the document.

Creating and using custom colors

Any custom colors you create are saved in the User Palette at the bottom of the Advanced Color Picker, so you can share and re-use the new colors across different documents or across reports.

The user palette holds up to eight colors. If you add a ninth color, it replaces the first color added to the palette. The user palette does not display until you add a custom color.

To create and save a custom color

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Select a control and then open the color picker in any of the following ways:
   • On the Format toolbar, click the drop-down arrow next to the Fill Color, Line Color, or Text Color icons.
   • In the Properties and Formatting dialog box, select Color and Lines on the left. Click the drop-down arrow next to the Color option.
In the Properties and Formatting dialog box, select **Font** on the left. Click the drop-down arrow next to the **Color** option.

3 In the color picker, select **More Colors**. The Advanced Color Picker dialog box opens.

4 Define the custom color:
   a Click the color matrix on the right or enter the hexadecimal codes for **Hue**, **Saturation**, and **Brightness**. You can also define the color by typing the hexadecimal code for the required color in the **Hex** field.
   b Click **Apply**. The color is added to the User Palette area of the dialog box.
   c Click **OK**. Depending on how you accessed the Advanced Color Picker, you may need to click **OK** again to return to the document.

## Creating a pop-up tooltip

A tooltip is pop-up text that is displayed when a user positions the cursor over a control in MicroStrategy Web. You can use tooltips to provide extra information, such as the full company name in the tooltip of the company logo, or to provide a fuller, descriptive name of a metric when space in the report requires a shortened version. Tooltips are displayed only when a document is viewed in Flash mode.

For example, in the grid report below, a tooltip is displayed when you pass your cursor over a bubble in the graph. In this case, the tooltip lets a document analyst know that he or she is looking at the data bubble for the
Electronics product category. It also lists the exact profit margin value for that category.

You can use tooltips on the following types of controls:

- Grid/Graphs
- HTML containers
- Images
- Lines
- Panel stacks (all panels in the panel stack display the same tooltip)
- Rectangles and rounded rectangles
- Selectors
- Text fields

**To add a tooltip to a control**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Add one of the controls listed above.
3. Right-click the control and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. From the left, select **General**.
5 Type the pop-up text in the **Tooltip** field. You can type any of the following:

- Static text, such as The Company, Inc.
- Data fields from the dataset reports, such as the Region attribute. Type the object name inside braces { } to indicate that it is a data field rather than static text.
- Auto text codes, such as the document name or the dataset report name. Type the auto text code within braces { }. For lists of the auto text codes, see *Auto text codes for document information, page 90* and *Auto text codes for dataset report information, page 91*.

6 Click **OK** to apply the changes and return to the document.

To view the tooltip, open the document in Flash Mode and position the cursor over the text.

---

**Hiding a control**

You can display information to other document designers in Design Mode, while hiding it from users viewing the document in all other views and modes. For instance, you can include a note in a text field about the source of data. You then hide the text field.

You achieve this by placing the content that you want to hide into a control, and then hiding that control. You can hide entire sections of a document.

You can hide the following types of controls:

- Grid/Graphs
- Images
- Lines
- Panel stacks
- Rectangles and rounded rectangles
- Selectors
- Text fields
The steps in the following procedure create the sample shown above. You can adapt these steps to hide other control types. In addition, Desktop Help contains instructions for hiding each control type, as well as by using a specific interface.

**To hide a control for all modes except Design Mode**

1. In MicroStrategy Web, open the document in **Design Mode**.
2. Add one of the controls listed above.
3. Right-click the control that you want to hide and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. From the left, select **General**.
5. Clear the **Visible** check box. This control will not be displayed in Interactive Mode, Editable Mode, Express Mode, or Flash Mode, although it will continue to be visible in Design Mode.
6. To view the results, switch out of Design Mode to a different mode.

**Formatting text fields**

Text fields in a document can contain static text, data fields, auto text codes, or combinations of these text types. When you add a new text field, its formatting is determined by the control defaults, but you can change any of the formatting options. The following list provides some useful formatting suggestions:

- Make the text field appear three-dimensional, like a button, with the 3D effect. For an example and steps, see *Applying a 3D effect, page 263*.
- Let the content behind the text field show through by setting the backstyle to transparent. You can also allow a fill color to cover what is behind the text field by setting the backstyle to opaque. For steps and an example, see *Using a transparent or opaque backstyle, page 261*.
- “Float” the text field above the background by using a drop shadow. For an example and steps, see *Applying a drop shadow, page 265*.
• Create a gradual color change by blending two colors using gradient colors. For an example and steps, see *Using gradient colors, page 267*.

• Display pop-up text when a user positions the cursor over the control in MicroStrategy Web with a tooltip. The tooltip can provide extra information, such as an expanded description of a metric. For an example and steps, see *Creating a pop-up tooltip, page 270*.

• Set Number formatting options such as decimal spaces, currency symbols, time formats, zip code formats, and so on, as described in *Formatting numbers, page 277*.

• Display information to other document designers in Design Mode while hiding it from users viewing the document in all other modes. For instance, you can include a note in a text field about the source of data. For an example and steps, see *Hiding a control, page 272*.

• Change text layout options such as word wrap and padding to control how the text is displayed within the borders of the text field. For a list of the available options, see *Formatting text position in a text field, page 278*.

• You can display text vertically (up and down the page) rather than horizontally. Vertical text is displayed in all MicroStrategy Web display modes and when the document is exported to Excel. For an example of vertical text and steps, see *Displaying text vertically, page 279*.

• Determine how to display the text when it is larger than the dimensions of the text field. A scroll bar can be provided. Scroll bars are displayed in Express Mode and Interactive Mode in MicroStrategy Web, and when a document is exported to HTML. For examples and steps, see *Displaying scroll bars in text fields, page 276*.

To edit the text inside a text field, see *Editing the text in a text field, page 87*.

### Formatting text field options

Text field options define the text field. Examples of these options include name of the text field control, position, and size.

#### To format text field options

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2 Right-click the text field to be formatted, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, select **General**.

4 Type a **Name**, which is used to identify the text field.

5 In the **Tooltip** field, type the text to display when a user positions the cursor over the text field in MicroStrategy Web. You can use tooltips to provide extra information about the text field. See *Creating a pop-up tooltip, page 270* for details.

6 Determine whether or not the text field is visible when a user views the document, by selecting or clearing the **Visible** check box. The text field always remains visible in Design Mode, regardless of this setting. For details, see *Hiding a control, page 272*.

7 To specify that the text field is a hyperlink, complete the following steps:
   a Select the **Is hyperlink** check box.
   b Type the destination of the hyperlink in the **Hyperlink** field. This field is only available when the **Is hyperlink** check box is selected.
   c Determine where the hyperlink destination opens, by choosing one of the following:
      - To open the destination in a new window, select the **Open in new window** check box.
      - To open the destination in the same window, replacing the document, clear the **Open in new window** check box.

8 From the left, select **Layout**, to change the position and size of the text field.

9 In the **Left** field, type the amount of distance between the left edge of the text field and the left border of the section.

10 In the **Top** field, type the amount of distance between the top edge of the text field and the top of the section.

11 To determine whether or not the control is locked in its current position in the document, select or clear the **Locked** check box. If this option is selected, the control cannot be moved or resized.

12 In the **Width** field, type the width of the text field.
13 To determine the height of the text field, do one of the following:

- To specify a static height that does not change, select **Fixed** and type the height in the field.

- To allow the height to dynamically expand to the height of the contents of the text field, select **Fit to contents**.

14 To determine how to display the text when it is larger than the dimensions of the text field, select one of the following **Text overflow (HTML)** options:

- To display only the text that can fit within the size of the text field, select **Clip**.

- To display a scroll bar to allow a user to view all of the text, select **Scroll**. The scroll bar is displayed for Express Mode and Interactive Mode. The scroll bar is most useful with fixed heights.

15 Click **OK** to save your changes and return to the document.

### Displaying scroll bars in text fields

A scroll bar can be displayed for a text field, if the text does not fit in within the size of the text field. For example, if the height of a text field is fixed, the text field does not expand to fit the contents. Only the text that can fit within the size of the text field is displayed; in other words, the text is clipped. Clipped text is shown in the text field at the top of the document sample below.

```
Revenue_Metric_Prompted

metric_Prompted_for_Region
```

Alternatively, a scroll bar can be displayed, so that a user can scroll through all of the text. This option is shown in the text field at the bottom of the document sample above. Notice that the scroll bar has been moved to the right, to show the end of the text.

Scroll bars are displayed in Express Mode and Interactive Mode in MicroStrategy Web, and when the document is exported to HTML.
Use the **Text overflow (HTML)** setting to determine how to display the text when it is larger than the dimensions of the text field, as described below.

---

**To clip text or display scroll bars in text fields**

1. Open a document using the Document Editor in Design View.
2. Right-click the text field to display scroll bars for, and select **Properties**. The Properties dialog box opens.
3. Click the **Layout** tab.
4. Select one of the following from the **Text overflow (HTML)** drop-down list:
   - To display only the text that can fit within the size of the text field, select **Clip**.
   - To display a scroll bar to allow a user to view all of the text, select **Scroll**.
   - The scroll bar is most useful when the **Height mode** is set to **Fixed**.
5. Click **OK** to return to the document.

---

**Formatting numbers**

Number formatting options include decimal spaces, currency symbols, time formats, zip code formats, and so on. For example, the text fields in the following document sample have different number formats applied to them. The one on the left is a date in the MM/DD/YYYY format, while the one in
the middle, another date, is in the Month Date, Year format. The text field on the right is a number formatted as currency, with no decimal.

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/2006</td>
<td>January 1, 2006</td>
<td>$13,475</td>
</tr>
<tr>
<td>01/02/2006</td>
<td>January 2, 2006</td>
<td>$11,689</td>
</tr>
<tr>
<td>01/03/2006</td>
<td>January 3, 2006</td>
<td>$17,406</td>
</tr>
<tr>
<td>01/04/2006</td>
<td>January 4, 2006</td>
<td>$10,287</td>
</tr>
</tbody>
</table>

Text fields are the only control type to allow number formatting.

To set number formatting for a text field

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click a text field and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. On the left, under Format, select Number.
4. Select a number format option, such as Currency or Date. An example of the number category and additional options are displayed on the right.
5. Specify the options, such as the number of decimal places for the Currency format or the date format type.
6. Click OK to return to the document.

Formatting text position in a text field

Text display settings control how the text is displayed within the borders of the text field. They include the following options:

- **Horizontal alignment**: Controls how the text is aligned horizontally within the control boundaries. The options are centered, left-aligned, right-aligned, or justified. By default, text fields are left-aligned.
• **Word wrap**: Determines whether the text is displayed on a single line or multiple lines within the control boundaries. By default, the text field wraps words to multiple lines.

• **Text direction**: Controls the orientation of the text within the text field. The options are horizontal, 90 degrees (text is displayed from bottom to top), and -90 degrees (text is displayed from top to bottom). By default, text fields are horizontally oriented. For examples of text direction, see *Displaying text vertically, page 279*.

• **Padding**: Defines the space between the text and the borders of the text field. You can specify different amounts of padding between the text and each side of the text field (top, bottom, left, and right). For an example of padding, see *Text padding, page 280*.

Text fields are the only control type that let you specify word wrap and text direction. For the title bars of panel stacks and Grid/Graphs, you can specify padding and both horizontal and vertical alignment. For steps to format a Grid/Graph, see *Formatting Grid/Graph containers, page 207*; for steps to format a panel stack, see the *Dashboards and Widgets Creation Guide*.

### Displaying text vertically

Text is usually displayed horizontally so that it runs across the page. You can change the orientation of the text fields so that the text can be displayed vertically, or up and down the page, as shown below:

- Horizontal
- Vertical: 90 degrees
- Vertical: -90 degrees

A text field can be turned:

• 90 degrees, which displays the text from bottom to top, as shown above by the text “Vertical: 90 degrees”

• -90 degrees, which displays the text from top to bottom, as shown above by the text “Vertical: -90 degrees”

Vertical text is displayed in all MicroStrategy Web display modes and when the document is exported to Excel. To display vertical text in Flash Mode in
MicroStrategy Web, the fonts must be embedded and SWF files must be included in the document, as described in *Embedding fonts for Flash Mode, page 341.*

The Firefox browser does not display vertical text.

---

**To display text vertically**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Select the text field to be formatted.
3. From the **Format** menu, select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. From the left, click **Alignment**.
5. Set **Text Direction** to either:
   - **90 degrees**, to display the text from bottom to top
   - **-90 degrees**, to display the text from top to bottom
   The Alignment category also allows you to specify padding (the space between the text and the borders of the text field) and alignment within the text field. For examples of padding, see *Text padding, page 280*; for a description of the text display settings, see *Formatting text position in a text field, page 278.*
6. Click **Apply**.
7. Click **OK** to return to the document.

---

**Text padding**

Padding defines the space between the text and the borders of the text field (left, right, top, and bottom).

For example, the **Top padding** setting defines the space between the text and the top border of the text field. For the horizontal text field shown below, it is set to 10. All other padding values remain at the default of one. The height mode is set to fixed, so that the text field does not expand or contract to fit the contents.
In the vertical text field on the right, the **Text direction** is set to **90 Degrees** to display the text field vertically. **Top padding** still defines the space between the text and the top border of the text field.

---

**To pad text**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Create a text field (from the **Insert** menu, select **Text**). Add the text field to any section of the document.
3. Right-click in the text field and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. On the left, expand **Format** and select **Alignment**.
5. In the **Padding** area, type a measurement value in the **Left**, **Top**, **Right**, and **Bottom** fields.
6. Click **OK** to return to the document.

---

**Formatting HTML containers**

You can display real-time information from the web within your document. For example, you can display a stock ticker running in real time, or your favorite financial page from the web that is updated in real time.

You achieve this real-time display by creating an HTML container and adding it to your document. The real-time information is displayed within the HTML container. An HTML container can contain either of the following:

- The URL of a website (known as an iFrame) to display the website within the document
- Text and HTML tags to display formatted content in the document
For examples and steps to create HTML containers, see *Displaying real-time web and other HTML content: HTML containers, page 142*.

HTML containers can be displayed in the following modes in MicroStrategy Web: Express Mode, Editable Mode, and Interactive Mode.

When you insert an HTML container into a document, its formatting is initially determined by the control defaults. You can change any of the formatting options for the new HTML container.

Formatting options, such as borders and background colors, apply to the HTML container itself, not to anything placed inside the container. Examples for formatting the HTML container include 3D borders and background colors, as shown in the first sample below, and drop shadows, as shown in the second sample.

```
This HTML container contains **text and HTML codes**. It is formatted to have a raised 3D border and a gray background.

The HTML container below is an iFrame, with a link to a website. It is formatted to have a drop shadow.
```

The formatting of actual content inside the HTML container is determined by either the HTML tags or the website displayed by the URL.

The following list provides some useful formatting suggestions for all HTML containers.

- Make an HTML container appear three-dimensional, like a button, with the 3D effect. For steps, see *Applying a 3D effect, page 263*.

- “Float” the HTML container above the background by using a drop shadow. For steps, see *Applying a drop shadow, page 265*.

- Display pop-up text when a user positions the cursor over the HTML container in MicroStrategy Web. The pop-up text is called a tooltip, and can provide extra information, such as a description of a website. For an example of a tooltip and steps to create them, see *Creating a pop-up tooltip, page 270*. 
The following list provides formatting suggestions for the HTML text type of HTML container:

- Allow the content behind the HTML container to show through by setting the backstyle of the HTML container to transparent. You can also allow a fill color to cover what is behind the HTML container by setting the backstyle to opaque. For an example and steps, see *Using a transparent or opaque backstyle, page 261.*

- Create a gradual color change by blending two colors using gradient colors. For an example and steps, see *Using gradient colors, page 267.*

- Format the font of the text displayed by the HTML container. Font format options include the font type, size, and color, as well as whether it is bolded or italicized. For steps, see *Formatting text fields, page 273.*

  This font formatting is overwritten by any font formatting provided by the HTML tags, as explained below.

The formatting of the content inside the HTML container is determined by either the HTML tags or the website displayed by the URL. For an HTML container that contains HTML tags, any font formatting not specified in the HTML tags is provided by the MicroStrategy formatting options.

For example, the following HTML container contains HTML tags. The HTML tags do not apply to the text until the document is displayed in MicroStrategy Web. The HTML tags format the first line as a heading 2. The second line is displayed in a blue Courier font by the HTML tags. The third line does not use any HTML tags. The object uses a black Tahoma font and the Forecolor option is the color of the font.

The same HTML container is displayed below (as seen in Express Mode in MicroStrategy Web). The second line is displayed in a blue Courier font (as defined by the HTML tag), unlike the black Tahoma font of the other lines (which use the font settings defined for the HTML container). The first line is bolded and displayed in a larger font than the other lines because of the h2
HTML tag. The other lines display in the font size indicated for the HTML container.

### The HTML tag h2 displays this as a heading

The HTML style tag displays this paragraph in Courier blue

This paragraph does not use any HTML tags

The font formatting for an HTML container applies only to HTML containers that use HTML tags. For example, the following HTML container is an iFrame, using a URL to display a website. The font is defined to display as an italicized gray.

The same HTML container is displayed below in Express Mode in MicroStrategy Web. The website determines how the text is displayed. In this case, it is black and not italicized.

### Formatting lines and rectangles

When you insert a shape into a document, its initial formatting is determined by the control defaults. You can change any of the formatting options.
The following list provides some useful formatting suggestions:

- Make a rectangle appear three-dimensional, like a button, with the 3D effect. For rounded rectangles, 3D effects appear in Flash Mode in MicroStrategy Web. For an example and steps, see Applying a 3D effect, page 263.

- Allow the content behind the rectangle to show through by setting the backstyle to transparent. You can also allow a fill color to cover what is behind the rectangle by setting the backstyle to opaque. For an example and steps, see Using a transparent or opaque backstyle, page 261.

- “Float” the rectangle or rounded rectangle above the background by using a drop shadow. Lines do not use drop shadows. For an example and steps, see Applying a drop shadow, page 265.

- Create a gradual color change by blending two colors using gradient colors. You can apply gradient colors to rectangles and rounded rectangles. For an example and steps, see Using gradient colors, page 267.

- Display pop-up text when a user positions the cursor over the shape in MicroStrategy Web with a tooltip. The tooltip can provide extra information, such as an expanded description of a metric. You can use tooltips on rectangles, rounded rectangles, and lines. For an example and steps, see Creating a pop-up tooltip, page 270.

- Display a shape to other document designers while hiding it from users viewing the document in Interactive Mode, Editable Mode, and Express Mode in MicroStrategy Web. For an example and steps, see Hiding a control, page 272.

- Control how rounded corners are displayed for rounded rectangles in Flash Mode. You can define the radius and select whether rounded corners are displayed for the top corners or all four corners. For an example, see Controlling the display of rounded corners in Flash Mode, page 285.

**Controlling the display of rounded corners in Flash Mode**

Rounded corners are used on rounded rectangles and panel stacks in documents. This section focuses on rounded rectangles, although the settings are the same for panel stacks. For specific information on rounded corners on panel stacks, including examples and a procedure, see the Dashboards and Widgets Creation Guide.
The rounded rectangles shown below are displayed in Flash Mode in MicroStrategy Web.

The rounded corners settings apply to Flash Mode only. In PDF View or other Web display modes, rounded corners display as square, right-angle corners. That is, rounded rectangles and rectangles look the same in PDF View and in all Web display modes except Flash Mode.

You can control how rounded corners are displayed for rounded rectangles in Flash Mode by:

- Defining the radius, which sets how round the corners are. A larger radius produces a more rounded corner. The range is 1-20.
- Selecting whether rounded corners are displayed for the top corners only or all four corners.

In the document sample above, the corners of the left rectangle are more rounded than those on the right rectangle. The corner radius of the left rectangle is set to 10, while the right rectangle has a corner radius of four (the default). Notice also that the right rectangle has rounded corners on the top only, while all four corners of the left rectangle are rounded.

The following procedure re-creates the sample. See the Desktop Help for steps to perform all types of formatting for rectangles and rounded rectangles.

**To control the display of rounded corners in Flash Mode**

1. Open a document using the Document Editor in Design View.
2. Add two rounded rectangles, as shown in the sample above. To add a rectangle:
   a. Click the arrow next to the Rectangle icon in the toolbar, and select Rounded Rectangle.
   b. Click and drag in the desired section of the Layout area to create the rectangle.
3. Select the rectangle on the left.
In the Property List: Appearance section, set Rounded corner radius to 10.

The range for the corner radius is 1 to 20. Higher numbers produce a more rounded corner, while lower numbers produce a straighter corner.

Select the rectangle on the right.

In the Property List: Appearance section, set Top corners only to True.

To view the effect, open the document in Flash Mode in MicroStrategy Web.

Formatting images

When you insert an image into a document, its formatting is initially determined by the control default. You can change the formatting.

The following list provides some formatting suggestions:

- Make an image appear three-dimensional, like a button, with the 3D effect. For an example and steps, see Applying a 3D effect, page 263.
- “Float” the image above the background by using a drop shadow. For an example and steps, see Applying a drop shadow, page 265.
- Display pop-up text when a user positions the cursor over the image in MicroStrategy Web with a tooltip. The tooltip can provide extra information, such as an expanded description of a metric. For an example and steps, see Creating a pop-up tooltip, page 270.
- Display an image to other document designers while hiding it from users viewing the document in Interactive Mode, Editable Mode, and Express Mode in MicroStrategy Web. For an example and steps, see Hiding a control, page 272.
Formatting document sections

You can format each document section individually. Your formatting choices include:

- Whether to hide or display document sections. For examples and steps, see *Hiding or displaying sections for a finished document, page 289*.

- Formatting the background color of each document section. For steps, see *Formatting the background color of document sections, page 293*.

- Displaying the detail sections horizontally across the page. Detail sections include the Detail Header, Detail Footer, and Detail. You can display all three sections horizontally or just the Detail section horizontally. For examples and steps, see *Displaying sections horizontally, page 293*.

- Changing the size of document sections. You can define a document section as a set size that does not vary, or as a variable size that grows or shrinks within set limits. For examples and steps, see *Changing the size of a section, page 296*.

- Specifying whether the entire contents of a document section are repeated on the next horizontal page when a section spans multiple pages. This is generally used with Grid/Graphs, particularly those with uncertain widths, so that the grid or graph report is labeled on every page that it stretches to. For examples and steps, see *Repeating information horizontally, page 302*.

- Specifying whether a header or footer section is repeated on each page of a document. By default, the controls in any repeating section are displayed on each page of the document, but you can specify that a control is not displayed the last time that the document section is displayed. Use this feature to display text such as "Continued on next page" on every page except the last page. For steps and an example, see *Repeating information on each page, page 303*.

- Specifying how page breaks within document sections are handled. If a document section begins in the middle of a page and spans multiple pages, the remainder of the section can be printed on the same page, or the section can start on the next page. This can help keep column labels with the data they identify. For examples and steps, see *Keeping the contents of a section together, page 306*.

- Specifying how row heights are determined when the document is exported to Excel. You can choose to have all the rows be the same height or to allow Excel to automatically adjust the row height to fit the data. For
steps and an example, see *Allowing Excel to automatically change row height*, page 370.

## Hiding or displaying sections for a finished document

By default, all the sections of a document are displayed to users in all views in Desktop and in all modes in MicroStrategy Web. However, if a document section is empty and does not contain any controls, that section is not displayed to users.

You may not want an end user, or a certain group of end users, to be able to view particular document sections. For example:

- As a designer, you want to work only in a single large section, such as in a Report Services (RS) dashboard, thus using all the available space in the Document Editor. This one section is displayed to all users in all views. For more details and steps, see *Hiding a section from users and designers*, page 290.

- You create a number of documents that should have specific sections hidden. To simplify and standardize the documents, you can create a template that hides those sections. You can then use the template to create the documents, and by default only the selected sections are displayed. For more details and steps, see *Hiding a section from users and designers*, page 290.

- A section contains information that makes sense in a printed document but not in one displayed in MicroStrategy Web. For example, the Page Footer section in a document contains page numbers. You can hide the Page Footer in all MicroStrategy Web modes but display it in the resulting PDF. The section is still displayed in Design Mode. For more details and steps, see *Displaying a section in the PDF only*, page 291.

- A section contains data that is displayed only when a specific condition is met. This scenario uses conditional formatting, which is described in *Formatting conditional data in documents*, page 307, and the Visible option, which is described in *Hiding a control*, page 272.

- A section contains internal notes about the source of the data and when to run the document. You do not want users to see this information; only document designers should be able to view it. The section must be hidden when the document is viewed as a PDF and in all MicroStrategy Web modes except Design Mode. For an example and steps, see *Hiding a control*, page 272. Although the example discusses controls specifically, hiding a section works the same way.
Hiding a section from users and designers

As a designer, you may want to work in a single large section, such as in a Report Services (RS) dashboard, thereby optimizing your workspace by using all the available space in the Document Editor. This one section is displayed to all users in all views. All other sections are hidden from users in the finished document and from you in Design View/Mode.

Displaying a single section can be practical when designing RS dashboards (an RS dashboard is a visually intuitive and interactive display of data that summarizes key business indicators for a status check), since RS dashboards are typically only one page long.

A quick way to create a document with only one section displayed is to use the Blank Dashboard template as the starting point for your RS dashboard. The single section on the template is defined as being 6.5 inches high. For details of the Blank Dashboard template and information on RS dashboards in general, see the Dashboards and Widgets Creation Guide.

You can select which sections to display and which to hide. For example, you need to create a number of documents that should have specific sections hidden. To simplify and standardize the documents, create a template that hides those sections. You can then use the template to create the documents, and by default only the selected sections are displayed. For steps to create and use templates, see Creating a document using another document as a template, page 20.

As a designer, you may want to temporarily display only the specific sections that you are editing right now. Rather than hide sections from users, you should expand and collapse sections as described in Collapsing and expanding document sections for design purposes, page 37.

Note the following:

- You cannot hide all the sections; at least one section must be displayed.
- For a multi-layout document, a section that is hidden in all views in one layout is not automatically hidden in the other layouts. You can hide and display different sections for different layouts. Use the steps below to hide or display sections in different layouts. For background information on multi-layout documents, see Creating multi-layout documents, page 476.
To hide or display sections to users and designers

1. In MicroStrategy Web, open the document in Design or Editable Mode.


3. Choose Sections from the Layout Properties area.

4. Clear the check box for any section that you want to hide. You cannot hide all the sections; at least one section must be displayed.

5. If a section is hidden but should be displayed, select its check box.

6. Click OK to return to the document. Only the selected sections are displayed.

Displaying a section in the PDF only

A document section can contain information that makes sense in a printed document but not in one displayed in MicroStrategy Web. For example, the Page Footer section in a document contains page numbers. You can hide the Page Footer in all MicroStrategy Web modes but display it when the document is viewed as a PDF. The section is still displayed in Design View in both Desktop and MicroStrategy Web, as well as in Flash Mode in Web.

The following image shows a document in PDF View in Desktop, displaying page numbers at the top of the page.
The next image shows the same document in Express Mode in Web. Notice that the page numbers are not displayed.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>De Le Torre:Sandra</td>
<td>$607,895</td>
</tr>
<tr>
<td>Northeast</td>
<td>Kelly:Laura</td>
<td>$2,350,720</td>
</tr>
<tr>
<td>Northeast</td>
<td>Keiferson:Jack</td>
<td>$584,933</td>
</tr>
</tbody>
</table>

The **Visible in Web View Mode** option, which controls this behavior, is available only for the Document Header/Footer, Layout Header/Footer, and Page Header/Footer sections.

---

**To determine whether or not a section displays in the PDF only**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. If the document contains multiple layouts, click the tab of the layout to change.

3. Right-click any blank area of the document section to hide in Web, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.
   - Only the Document Header/Footer, Layout Header/Footer, and Page Header/Footer sections can be displayed in the PDF while hidden in MicroStrategy Web.

4. From the left, select **General**.

5. Do one of the following:
   - To display the document section in the PDF only, clear the **Visible in Web View mode** check box.
   - To display the document section in all modes in Web as well as in the PDF, select the **Visible in Web View mode** check box.

6. Click **OK** to save your changes and return to the document.
Formatting the background color of document sections

You can format the background color of each section in a document.

To apply a background color to a section

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click any blank area of the section, then select Properties and Formatting. The Properties and Formatting dialog box opens.
3. From the left, select Color and Lines.
4. From the Color palette, select a color to apply to the section by doing one of the following:
   - To select a solid color, click the color in the palette.
   - To access additional color options, select More Colors.
   - To apply gradient colors to the section, select Gradients. Gradients blend two colors to create a gradual color change in the background of the section. For examples and images, see Using gradient colors, page 267.
5. Click OK to save your changes.

Displaying sections horizontally

By default, all sections are displayed and printed vertically in a document. The Detail Header is displayed below the Document Header, the Detail is displayed below the Detail Header, and so on, as described in Understanding and working with document sections, page 28.

The detail sections can be displayed horizontally across the page. The Detail Header is displayed next to the Detail, followed by the Detail Footer, in a horizontal row across the page. Detail sections include the Detail Header, Detail Footer, and Detail. You can display all three sections horizontally or just the Detail section horizontally.

For example, the following document presents the monthly revenue for 2006 in two columns down the page, showing the default vertical display. Notice
the extra white space on the right side of the paper. The title Monthly Revenue is displayed in the Detail Header, while Month and Revenue are placed in the Detail section.

### Monthly Revenue

<table>
<thead>
<tr>
<th>Jan 2006</th>
<th>$502,224</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feb 2006</td>
<td>$610,056</td>
</tr>
<tr>
<td>Mar 2006</td>
<td>$570,376</td>
</tr>
<tr>
<td>Apr 2006</td>
<td>$599,718</td>
</tr>
<tr>
<td>May 2006</td>
<td>$667,888</td>
</tr>
<tr>
<td>Jun 2006</td>
<td>$710,181</td>
</tr>
<tr>
<td>Jul 2006</td>
<td>$694,057</td>
</tr>
<tr>
<td>Aug 2006</td>
<td>$748,848</td>
</tr>
<tr>
<td>Sep 2006</td>
<td>$871,390</td>
</tr>
<tr>
<td>Oct 2006</td>
<td>$800,501</td>
</tr>
<tr>
<td>Nov 2006</td>
<td>$855,613</td>
</tr>
<tr>
<td>Dec 2006</td>
<td>$1,008,381</td>
</tr>
</tbody>
</table>

Displaying the Detail section horizontally displays the monthly revenue across the page, as shown in the document sample below. The Revenue metric was moved below Month, to present a half year of data across a single sheet of paper.

### Monthly Revenue

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>$502,224</td>
<td>$610,056</td>
<td>$570,376</td>
<td>$599,718</td>
</tr>
<tr>
<td>$694,057</td>
<td>$748,848</td>
<td>$871,390</td>
<td>$800,501</td>
</tr>
</tbody>
</table>
The following image shows the same document in Design View/Mode. The Detail Header contains the title, while the Detail section contains Month and Revenue. The Detail section is displayed horizontally.

You can also display a group horizontally, as described in Displaying a group horizontally, page 389.

Horizontally displayed sections have additional options to control the horizontal width. For a list of settings and a width sizing example, see Changing the horizontal width of a section, page 299.

To display and print detail sections horizontally

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click the Detail Header, Detail, or Detail Footer section and select Grouping Properties. The Detail Grouping Properties dialog box opens.
3. To horizontally render only the Detail section, select the Render Detail Horizontally check box.
4. To horizontally render all the detail sections, select the Render Detail Header and Footer Horizontally check box. The Render Detail Horizontally check box is automatically selected as well.
5. Click OK.
Changing the size of a section

While designing a document, you can drag the lower boundary of a section to make it larger or smaller. By default, when you view a document as a PDF, its sections expand to fit the controls that they contain. They do not shrink when the controls are smaller than the section size. You can change this default behavior, so that the section is only as big as necessary to display all the information in the section.

You can define a section as a set size that does not vary, or as a variable size that grows or shrinks within set limits. For steps to change the size of a section, see *To change the size of a section, page 298*.

For example, the Detail Header section of a document contains column header labels. You want to provide white space as part of this section, so that it does not shrink beyond a minimum size. You can make the section half an inch tall by dragging the section’s border, or by setting the **Height** option to **.5**, and then clearing the **Height can shrink** option.

An example of this is shown below.

Notice that the labels are less than half an inch from the top of the Detail Header. If the **Can shrink** option was selected, the labels would print right above the Detail. Instead, there is a buffer of white space between the labels and the data of the document:
Use the following settings with the steps below to achieve some common goals:

- **Fit to size**: Use the following settings to have the size of the section adjust automatically to the contents, without waste of space:
  - Height can grow: Selected
  - Height can shrink: Selected
  - Max height: 0 (zero)

- **Fixed height**: Use the following settings to have the height of the section remain the same, regardless of its contents:
  - Height: Desired size of the section
  - Height can grow: Cleared
  - Height can shrink: Cleared

- **Grow to a defined maximum height**: Use the following settings to have the height of the section adjust automatically to its contents but not exceed the set maximum:
  - Height can grow: Selected
  - Height can shrink: Selected
  - Max height: Maximum size of the section

- **Shrink to a minimum height**: Use the following settings to have the height of the section adjust automatically to its contents but not shrink below the set minimum:
  - Height: Minimum size of the section
  - Height can grow: Selected
  - Height can shrink: Cleared
  - Max height: 0 (zero)

- **Vary within a set range**: Use the following settings to have the height of the section adjust automatically to its contents but not exceed the set maximum nor shrink below the set minimum:
  - Height: Minimum size of the section
  - Height can grow: Selected
  - Height can shrink: Cleared
Max height: Maximum size of the section

To change the size of a section

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Select the section to resize. To do this, select either the bar containing the section’s name, or click inside the section in a blank area (not on a control).
3. From the Format menu, select Properties and Formatting. The Properties and Formatting dialog box opens.
4. From the left, select Layout.
5. Set the Height of the section in inches.

When exported to HTML, a document section uses the Height setting, regardless of other settings. For example, the height of a document section is defined as 1.5 inches, the maximum height as 10, and Can grow is selected. The data in the document section is longer than 1.5 inches. When exported to HTML, the document section is only 1.5 inches high, and the data is cut off. This occurs because the exact height cannot be determined during HTML rendering. To allow all the data to be displayed, specify a more accurate Height setting.

6. Set any of the following options. Examples are provided above to achieve specific design goals.

- **Height can grow**: Determines whether the section height can expand to fit its contents. Affects all display modes and PDF export. Clear this check box to decrease the time it takes to execute the document.

- **Height can shrink**: Determines whether the section height can shrink to fit its contents. Affects all display modes and PDF export. Clear this check box to decrease the time it takes to execute the document.

- **Max height**: Maximum size of the section. The height of the section adjusts automatically to its contents, but it will not exceed the set maximum. If Maximum Height is less than Height, the section is displayed with a fixed height equal to the Height setting. Zero (0) indicates that there is no height limit.

- **Hide if empty**: Determine whether the section is displayed if it has no content, regardless of how the Can Shrink option is set. By default,
this check box is selected. If the check box is cleared, the section displays according to the size settings, even if the section does not contain any data.

7. Click **OK** to save your changes and return to the document.

### Changing the horizontal width of a section

A horizontally displayed section prints horizontally across a page and therefore needs additional **Size** settings to control the horizontal size. These settings are:

- **Width**
- **Width can grow**
- **Width can shrink**
- **Maximum width**

You can define a horizontally displayed section as a set width that does not vary, or as a variable width that grows or shrinks within set limits according to the size of its content.

For example, to use a specific width, type the size in the **Width** option. Set the **Width can grow** and **Width can shrink** options to **False**.

The width should not be smaller than the right-most edge of the controls in the section. This ensures that controls are displayed regardless of their position.

To adjust the width to the contents automatically, without wasting space, set **Max width** to zero. Set the **Width can grow** and **Width can shrink** settings to **True**.

For general information on horizontally displayed sections, including examples and instructions, see *Displaying sections horizontally, page 293*.

### Section width sizing example

The document shown below contains the text field “Monthly Revenue” in the Detail Header, with the Month attribute and the Revenue metric in the Detail
section. The Detail section is displayed horizontally and is set to a width of 1.8.

### Monthly Revenue

<table>
<thead>
<tr>
<th>Jan 2006</th>
<th>Feb 2006</th>
<th>Mar 2006</th>
</tr>
</thead>
<tbody>
<tr>
<td>$502,224</td>
<td>$610,056</td>
<td>$570,376</td>
</tr>
</tbody>
</table>

The amount of space between the months is too large, so you want to reduce the space between them. You could adjust the size of the Detail section until you find the correct fit, or you can adjust the width to the contents automatically. To do the latter, set **Max width** to zero, and select both **Width can grow** and **Width can shrink**. The columns of months and revenue amounts are now close together, and more data fits across the page, as shown below.

### Monthly Revenue

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>$502,224</td>
<td>$610,056</td>
<td>$570,376</td>
<td>$599,718</td>
<td>$667,888</td>
<td>$718,181</td>
<td>$694,057</td>
</tr>
</tbody>
</table>

---

To change the size of a horizontally displayed section in a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Select the horizontal section to resize. To do this, select either the bar containing the section’s name, or click inside the section in a blank area (not on a control).
3. From the **Format** menu, select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. From the left, select **Layout**.
5. Set the **Height** of the section in inches.

   When exported to HTML, a document section uses the **Height** setting, regardless of other settings. For example, the height of a document section is defined as 1.5 inches, the maximum height as 10, and **Can grow** is selected. The data in the document section is longer than 1.5 inches. When exported to HTML, the document section is only 1.5 inches high, and the data is cut off. This occurs
because the exact height cannot be determined during HTML rendering. To allow all the data to be displayed, specify a more accurate **Height** setting.

6 Set any of the following options. Examples are provided in *Changing the size of a section, page 296* to achieve specific design goals.

- **Height can grow**: Determines whether the section height can expand to fit its contents. Affects all display modes and PDF export. Clear this check box to decrease the time it takes to execute the document.

- **Height can shrink**: Determines whether the section height can shrink to fit its contents. Affects all display modes and PDF export. Clear this check box to decrease the time it takes to execute the document.

- **Max height**: Maximum size of the section. The height of the section adjusts automatically to its contents, but it will not exceed the set maximum. If Maximum Height is less than Height, the section is displayed with a fixed height equal to the Height setting. Zero (0) indicates that there is no height limit.

- **Hide if empty**: Determine whether the section is displayed if it has no content, regardless of how the Can Shrink option is set. By default, this check box is selected. If the check box is cleared, the section displays according to the size settings, even if the section does not contain any data.

7 Set the **Width** of the section in inches.

8 Set any of the following options:

- **Width can grow**: determines whether the section width can expand to fit its contents. Affects all display modes and PDF export.

- **Width can shrink**: determines whether the section width can shrink to fit its contents. The section width does not change in Design Mode.

- **Max width**: defines the maximum width for the section. Zero (0) indicates that there is no width limit.

9 If you are working in the Properties dialog box, click **OK** to return to the document.
Repeating information horizontally

When a section spans multiple pages, you can specify whether or not the entire contents of the section are repeated on the next horizontal page. This setting is generally used with Grid/Graphs displayed as grid reports, particularly those with uncertain widths, so that you are not sure of the number of pages that the Grid/Graph will extend to.

You can also repeat information on each page of a document; for instructions, see Repeating information on each page, page 303.

For example, a document contains a Grid/Graph, and you want to be sure that the data on it is labelled, even if it wraps to the next page. Enable the Repeat horizontally option so that the Grid/Graph will be labeled on every page that it stretches to. If multiple Grid/Graphs are placed on the same document, this setting can help a user easily identify which Grid/Graph is which.

To create the sample document below, an additional section is added within the Detail Header section. (For information on adding sections, see Adding sections in documents, page 39.) Label text is placed in the first section and the Repeat horizontally check box is selected for that section. A Grid/Graph displayed as a grid is placed in the second section. When the Grid/Graph wraps to the second page, the label text is repeated to identify the Grid/Graph. In this case, the Grid/Graph is so wide that it extends six pages horizontally. The bottom part of the Grid/Graph begins on page seven, as shown in the following sample pages.
To repeat information horizontally

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2 Right-click the section to repeat and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, select **Layout**.

4 In the **Page Break** area, select the **Repeat horizontally** check box.

### Repeating information on each page

You can specify that a header or footer section repeats on each page of a document, to include information that needs to be displayed on every page.
This setting is available for all header and footer sections, except the Page Header and Page Footer.

By default, the controls in any repeating section are displayed on each page of the document, but you can specify that a control is not displayed the last time that the document section is displayed. Use this scenario to display text such as "Continued on next page" on every page except the last page.

Repeating on every page applies when the document is exported to a PDF.

You can also repeat information horizontally, which specifies whether the entire contents of the selected section are repeated on the next horizontal page when a section spans multiple pages. The setting is generally used with Grid/Graphs displayed as grid reports, particularly those with uncertain widths - that is, when you are not sure of the number of pages that the grid report will extend to. For instructions, see Repeating information horizontally, page 302.

For example, a document grouped by year displays revenue data for every item. When printed, the document is 100 pages long. You want to ensure that users reading the document know that the information is continued on the next page. To do this, add a text field in the Document Footer. (Use the Document Footer because the document is grouped by year and a yearly subtotal is displayed in the Year Group Footer. The Document Footer displays after the group footers.) Specify that the Document Footer repeats on each page, but set the text field to print only in repeating sections. This
ensures that the text is printed on every page except the last. The first and last page of the document are shown below:

<table>
<thead>
<tr>
<th>2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 Places to Go While Still Young at Heart</td>
</tr>
<tr>
<td>Art As Experience</td>
</tr>
<tr>
<td>The Painted Word</td>
</tr>
<tr>
<td>Hirschfeld on Line</td>
</tr>
<tr>
<td>Adirondack Style</td>
</tr>
<tr>
<td>Architecture : Form, Space, &amp; Order</td>
</tr>
<tr>
<td>50 Favorite Rooms</td>
</tr>
<tr>
<td>500 Best Vacation Home Plans</td>
</tr>
<tr>
<td>Blue &amp; White Living</td>
</tr>
</tbody>
</table>

*Continued on next page*

<table>
<thead>
<tr>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simply The Best</td>
</tr>
<tr>
<td>90 Degrees &amp; Rising</td>
</tr>
<tr>
<td>Aretha Franklin's 30 Greatest Hits</td>
</tr>
<tr>
<td>Never Say Never</td>
</tr>
<tr>
<td>2011</td>
</tr>
</tbody>
</table>

**To repeat information on every page**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Right-click the footer section to modify and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, select **Layout**.
4 In the PDF area, select the Repeat on each page check box.

5 Click OK to return to the document.

6 By default, each control in a repeated section is displayed on every page. To display a control on every page except the last page, do the following:
   a Right-click the control to modify and select Properties and Formatting. The Properties and Formatting dialog box opens.
   b From the left, select Layout.
   c In the Position area, select the Show only in repeated sections check box.
   d Click OK to return to the document.

Keeping the contents of a section together

When a page break occurs within a document section, the remainder of the section is printed on the next page. To print the section on a single page, use the Keep together setting. If the section cannot fit on one page, it starts on a new page and continues printing on the following pages.

You can use this option to keep column labels in text fields with the data fields that they identify. If the column labels of a section are stranded at the bottom of a page, with the corresponding data at the top of the next page, apply the Keep together setting to that section.

You can also keep data for a group together. For steps, see Keeping the data in a group together on a page, page 398.

To keep the contents of a section together on a page

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Right-click the section you want to modify and select Properties and Formatting. The Properties and Formatting dialog box opens.

3 From the left, select Layout.

4 In the Page Break area, select the Keep together check box.
Formatting conditional data in documents

Thresholds and conditional formatting are special formatting that is applied to data automatically, when the data meets a specified value. The special formatting means that document recipients can easily see which data is likely to be important for making business decisions. You can have specific controls in your document formatted depending on predefined criteria that you specify. You can use:

• Thresholds to change the format of data cells in your report or Grid/Graph.

• Conditional formatting to change the format of controls such as text fields, images, sections, and so on in your document.

For example, a document contains customer order information. Any customers with an order over $100 in the past three months can be displayed in italicized blue font, to ensure that they receive special promotions. Any customers who live in a particular city can be displayed in a bold red font, so that they can receive a notice about a new store opening there.

You can use conditional formatting to format a control in the following ways:

• Hide the control

• Format the control in a particular way, for example, display profit values greater than $1,000,000 in bold text

• Replace the control with text, such as Goal Met for units sold greater than 50,000

• Replace the control with a symbol, such as a diamond for sales above $100,000

• Replace the control with an image, such as a corporate logo for costs below $50,000

Whether you can replace data with text, an image, a quick symbol, or by hiding the control, depends on the type of control that is selected when you
begin to create your conditional format. The following table lists the control types and the types of conditional formatting available for each.

<table>
<thead>
<tr>
<th>Control Type</th>
<th>Conditional Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>• Hide object</td>
</tr>
<tr>
<td></td>
<td>• Formatting: Borders</td>
</tr>
<tr>
<td>Line</td>
<td>• Hide object</td>
</tr>
<tr>
<td></td>
<td>• Formatting: Line style, color, and weight</td>
</tr>
<tr>
<td>Rectangle</td>
<td>• Hide object</td>
</tr>
<tr>
<td></td>
<td>• Formatting: Background color; Line style, color, and weight</td>
</tr>
<tr>
<td>Text field</td>
<td>• Hide object</td>
</tr>
<tr>
<td></td>
<td>• Replacement text and symbols</td>
</tr>
<tr>
<td></td>
<td>• Formatting: All formatting settings</td>
</tr>
<tr>
<td>Section</td>
<td>• Hide object</td>
</tr>
<tr>
<td></td>
<td>• Formatting: Background color</td>
</tr>
<tr>
<td>Grid/Graph</td>
<td>• Replacement text, symbols, and images</td>
</tr>
<tr>
<td></td>
<td>• Formatting: All formatting settings</td>
</tr>
</tbody>
</table>

You can apply conditional formatting (or thresholds) to an object in a Grid/Graph, but the method is slightly different. For information on creating thresholds in reports, see the Basic Reporting Guide.

You can create alerts to notify users when a metric or attribute on a report meets a specific threshold condition. For information to create mobile or email alerts, see the Basic Reporting Guide.

When you create conditional formatting, you define two parts: the condition, and the formatting that will be applied to the control when the conditions are met. The data that meets the condition is considered to be data that has passed the threshold of the condition. Once the data passes the threshold, formatting is automatically applied to the control, or the control can be hidden, or replaced by text, symbols, an image, and so on.
For example, the following document contains cost, profit, and revenue by region and employee, and is grouped by region.

**Region: Northeast**

<table>
<thead>
<tr>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>De Le Torre: Sandra</td>
<td>$507,695</td>
<td>$514,795</td>
<td>$93,100</td>
</tr>
<tr>
<td>Kelly: Laura</td>
<td>$2,350,720</td>
<td>$1,992,726</td>
<td>$357,994</td>
</tr>
<tr>
<td>Kieferson: Jack</td>
<td>$584,933</td>
<td>$497,463</td>
<td>$87,470</td>
</tr>
<tr>
<td>Sawyer: Leanne</td>
<td>$2,411,912</td>
<td>$2,043,693</td>
<td>$368,219</td>
</tr>
<tr>
<td>Sonders: Melanie</td>
<td>$295,108</td>
<td>$251,183</td>
<td>$43,925</td>
</tr>
<tr>
<td>Yager: Beth</td>
<td>$2,303,847</td>
<td>$1,953,823</td>
<td>$350,024</td>
</tr>
</tbody>
</table>

**Region: Mid-Atlantic**

<table>
<thead>
<tr>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bernstein: Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td>Brown: Vernon</td>
<td>$131,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
</tbody>
</table>

The document needs to provide a quick summary of the profit information, so the profit data must be replaced with a green diamond if the profit is
$100,000 or greater, and a red hexagon if it is less. The final document looks like the following:

<table>
<thead>
<tr>
<th>Region: Northeast</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee</strong></td>
</tr>
<tr>
<td>De Le Torre Sandra</td>
</tr>
<tr>
<td>Kelly: Laura</td>
</tr>
<tr>
<td>Kieferson: Jack</td>
</tr>
<tr>
<td>Sawyer: Leanne</td>
</tr>
<tr>
<td>Soden: Melanie</td>
</tr>
<tr>
<td>Yager: Beth</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region: Mid-Atlantic</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Employee</strong></td>
</tr>
<tr>
<td>Bernstein: Lawrence</td>
</tr>
<tr>
<td>Brown: Vernon</td>
</tr>
</tbody>
</table>

This example uses a metric from the dataset report in the condition. You can also use derived metrics, summary metrics, and attributes in the condition. For examples, see Derived metrics, summary metrics, and attributes in conditional formatting, page 310.

You can create criteria for conditional formatting by qualifying data based on a metric or an attribute. Derived metrics and summary metrics can be used to create conditional formatting; calculated expressions cannot.

**Derived metrics, summary metrics, and attributes in conditional formatting**

Conditional formatting can use derived metrics and summary metrics in the condition definition. For example, the following document contains cost, profit, and revenue by region and employee, and is grouped by region. A summary metric for the average profit is displayed in the Region Header. For
regions with an average profit less than $100,000, the region name appears in a box.

<table>
<thead>
<tr>
<th>Region: Central</th>
<th>Average Profit: $191,081</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Revenue</td>
</tr>
<tr>
<td>Ellerkamp:Nancy</td>
<td>$847,227</td>
</tr>
<tr>
<td>Gale:Loren</td>
<td>$1,569,290</td>
</tr>
<tr>
<td>Torrison:Mary</td>
<td>$1,590,350</td>
</tr>
<tr>
<td>Zenlicka:George</td>
<td>$822,500</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region: Mid-Atlantic</th>
<th>Average Profit: $84,135</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Revenue</td>
</tr>
<tr>
<td>Bernstein:Lawrence</td>
<td>$1,060,632</td>
</tr>
<tr>
<td>Brown:Vernon</td>
<td>$331,735</td>
</tr>
<tr>
<td>Corcoran:Peter</td>
<td>$325,147</td>
</tr>
<tr>
<td>Folks:Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td>Hollywood:Robert</td>
<td>$1,026,874</td>
</tr>
<tr>
<td>Ingles:Walter</td>
<td>$229,439</td>
</tr>
<tr>
<td>Smith:Thomas</td>
<td>$221,379</td>
</tr>
<tr>
<td>Young:Sarah</td>
<td>$209,534</td>
</tr>
</tbody>
</table>

You can also use attributes as the condition. For example, you want to identify employees who work in the North (that is, either the Northeast or Northwest region). The condition definition is Region In list {Northeast, Northwest}.
In the following sample, the Northeast employees are highlighted, but not the Mid-Atlantic employees. If any Northwest employees were displayed in the sample, their names would be highlighted as well.

<table>
<thead>
<tr>
<th>Region: Northeast</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>De Le Torre Sandra</td>
<td>$607,895</td>
<td>$514,795</td>
<td>$93,100</td>
</tr>
<tr>
<td></td>
<td>Kelly Laura</td>
<td>$2,350,720</td>
<td>$1,992,726</td>
<td>$357,994</td>
</tr>
<tr>
<td></td>
<td>Keifer John</td>
<td>$84,933</td>
<td>$497,463</td>
<td>$87,470</td>
</tr>
<tr>
<td></td>
<td>Sawyer Leanne</td>
<td>$2,411,912</td>
<td>$2,043,693</td>
<td>$368,219</td>
</tr>
<tr>
<td></td>
<td>Sonder Melanie</td>
<td>$295,108</td>
<td>$251,103</td>
<td>$43,925</td>
</tr>
<tr>
<td></td>
<td>Yager Beth</td>
<td>$2,303,847</td>
<td>$1,953,823</td>
<td>$350,024</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region: Mid-Atlantic</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bernstein Lawrence</td>
<td>$1,060,631</td>
<td>$901,702</td>
<td>$158,930</td>
<td></td>
</tr>
<tr>
<td>Brown Vernon</td>
<td>$331,733</td>
<td>$280,504</td>
<td>$51,231</td>
<td></td>
</tr>
</tbody>
</table>

## Conditional formatting on selector totals

Selectors provide Report Services (RS) dashboards with interactivity, allowing each user to change how he sees the data. A selector can change several things in a panel stack, including panels, the focus of a Grid/Graph, or dynamic text fields when the text field is a reference to an object on a report. Selectors that contain attribute elements, custom group elements, or consolidation elements as selector items can also include an option to display totals. The total is calculated for all the selector items. A user can choose whether to display specific elements at the same time, or the totals.

If the control you are formatting is the target of a selector, you can specify whether to apply conditional formatting to the control only when metrics are selected in the selector, or for both metrics and totals. For example, a document contains the Region attribute and the Revenue metric on a panel stack. The panel stack is targeted by a selector, which allows a user to choose the region to display in the panel stack. The selector includes the option to display the total, which is calculated for all the regions. The conditional
formatting on the Revenue metric displays low revenue in red and high revenue in green. The conditional formatting can be applied to either the regional revenue values only by applying it to the metric, or to both the regional revenue values and the total value. You can select these options in the Advanced Thresholds Editor; for steps, see *Creating a conditional format or threshold based on multiple metrics or attributes, page 319.*

For steps to show totals in a selector, see the *Dashboards and Widgets Creation Guide.*

**Conditional formatting on a document with multiple datasets**

If a document contains multiple datasets, a threshold on a Grid/Graph can include any objects from any of the datasets, regardless of whether the Grid/Graph uses that dataset. (Conditional formatting on a Grid/Graph is referred to as a threshold.)

For example, a document contains two datasets, Regional Revenue and Regional Profit. A Grid/Graph is displayed for each dataset. Another Grid/Graph, named Regional Revenue and Profit, combines the data from both datasets, as shown below. Region and Revenue come from the Regional Revenue dataset, and Profit from the Regional Profit dataset.
Create a threshold on the Regional Revenue and Profit Grid/Graph that replaces Revenue amounts less than $5,000,000 with a red arrow. Create another threshold that replaces Profit amounts greater than $500,000 with a green arrow. The results are shown below:

![Regional Revenue and Profit Grid/Graph](image)

For steps to create a Grid/Graph that uses multiple datasets, see *Adding a Grid/Graph that uses multiple datasets, page 178*.

If a Grid/Graph uses data from a single dataset, you can create a threshold using a metric from another dataset. To continue with the previous example, create a threshold on the Regional Revenue Grid/Graph. This threshold uses
the Profit metric from the Regional Profit dataset, although the Grid/Graph uses the Regional Revenue dataset as its data source.

The results are shown below. The Revenue amount is replaced with a green diamond if the region's Profit is greater than $500,000.

For steps to add multiple datasets to a document, see *Adding, changing, or removing a dataset, page 48.*
Creating a conditional format or threshold based on a single metric

You can easily define conditional formats and thresholds based on a single metric. You can use the thumb in the horizontal slider bar to specify range-based conditions for your data such as greater than, less than, between, and so on.

For example, if you want all revenue values over $40,000 formatted in red, with an Arial font, you can create and format a simple threshold for that range. On the same report, you can have all revenue values below $10,000 appear as an image of an arrow pointing down.

Note the following:

- To create a conditional format or threshold based on an attribute, see Creating a conditional format or threshold based on multiple metrics or attributes, page 319.
- You can create alerts to have the software notify users with an email or text message when a metric or attribute on a report meets a specific threshold condition. For information to create mobile or email alerts, see the Basic Reporting Guide.

You can also create a conditional metric or threshold based on multiple metrics or attributes. For details, see Creating a conditional format or threshold based on multiple metrics or attributes, page 319.

To create a conditional format or threshold based on a single metric

1. In MicroStrategy Web, open a document in Design or Editable Mode.

2. Right-click the control to format in the document layout area. Depending on the type of control you select, proceed as follows:
   
   • A report or Grid/Graph: Point to Thresholds and then select Visual. The Visual Threshold Editor opens.
   
   • A text field, image, section, and so on: Point to Conditional Formatting and then select Visual. The Visual Conditional Formatting Editor opens.
To specify the qualifications

3 Depending on the type of control that you selected above, follow the appropriate steps below:

• For a report or Grid/Graph:
  a From the Thresholds for drop-down list, select the metric for which to create the threshold. The list includes all the metrics defined for the report.
  b Click Type, and from the Type drop-down list, select the type of condition you want to use for the threshold. For example, if you want to define Daily Revenue greater than $40,000, select Value from the drop-down list. This ensures that the threshold is based on an actual value, in this case $40,000. If you want to define a threshold for the Top 5% of Daily Revenue, select Highest %.
  c From the Based on drop-down list, select the metric on which to base the qualification. For example, to ensure that the conditional format highlights Daily Revenue values over $40,000, select Daily Revenue from the drop-down list.
  d Click the Apply check mark.

• For a text field, image, section, and so on:
  a From the Based on drop-down list, select the metric on which to base the qualification. For example, to ensure that the threshold highlights Daily Revenue values over $40,000, select Daily Revenue from the drop-down list.

4 In the Enter Value field, type the number for which you want to define the threshold or conditional format, then click the Apply check mark. Drag the thumb over the horizontal slider bar to adjust the value as necessary.

5 To add a new condition, click the Add Threshold icon. A thumb is added to the horizontal slider bar. Add a new value in the Enter Value field, or move the thumb to define a value for the condition.

Add and shift additional thumbs as necessary. For example, if you want a threshold to display blue font for all values above one million, and green font for all values below 20,000, you must have two thumbs on the horizontal slider bar, one representing data greater than one million and another representing data less than 20,000.
To specify the formatting

6 Do one of the following:

- Drag the cursor over the thumb to format. In the pop-up menu that opens, select the **Format** icon. The Format dialog box opens.

- Double-click a specific area of the horizontal bar to format that range of values. The Format dialog box opens.

7 Specify a name for the threshold or conditional format in the **Name** field.

8 Depending on the control type you are applying the conditional formatting to, you can replace data with text, an image, a symbol, or hide the control. For a table that lists the conditional formatting available for all control types, see *Formatting conditional data in documents*, page 307. Select the **Replace Data** check box and select one of the following from the drop-down list:

- **Replace text**: Replace the normally displayed data with any text you specify. For example, a document shows the financial values of various sales opportunities. For those sales opportunities that have been lost, you might display the word LOST in red, rather than displaying the financial value.

  If you select this option, type the text with which to replace the values in the corresponding text field.

- **Quick symbol**: Replace the normally displayed data with a common symbol. For example, a document shows the financial contribution of various sales groups to overall sales office activity. For the monthly trend column, you can show either a green plus (+) or a red minus (-) symbol to represent positive or negative contribution trends.

  If you select this option, select the symbol with which to replace the values from the corresponding drop-down menu.

- **Image**: Replace the normally displayed data with an image, such as an arrow or a green dot. You can specify the path to the image by typing the address using one of the following:

  - Absolute path: The default, for example, C:/images/img.jpg

  - Relative to HTML Document directory: A relative path from the document directory where the image is stored, for example, images/img.jpg
On the network: A path on your local area network, which is in a UNC (Universal Naming Convention) format, for example, //machine_name/shared_folder/img.jpg

On the web: A URL to an image file, for example, http://www.microstrategy.com/images/img.jpg

- **Hide**: Hide the control. For example, a document shows an image if the number of units sold is less than a specified value. You can hide this image if the units sold is greater than or equal to the target value.

Make selections in the Font, Number, Alignment, and Color and Lines tabs to change the font, color, alignment, and other options to apply to data that meets the defined condition. Click **Help** for details on all the options. The text sample on the left of the threshold pop-up menu shows an example of the formatting you specified for the threshold or conditional format.

Click **OK** to apply changes and return to the document. If the **Auto-Apply changes** check box is selected, your formatted data or control is already visible on your document.

### Creating a conditional format or threshold based on multiple metrics or attributes

You can create a conditional format or threshold based on multiple metrics or attributes. Each conditional format or threshold can contain multiple conditions, and each condition is based on a metric or attribute. This allows you to define very specific conditions.

For example, you can format the font color of Cost values of employees based on the geographical region they belong to. The threshold contains multiple conditions, where each condition specifies a font color for a particular region.

You can create alerts to notify users when a metric or attribute on a report meets a specific threshold condition. For information to create mobile or email alerts, see the *Basic Reporting Guide*.

---

**To create a conditional format or threshold based on multiple metrics or attributes**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2 Right-click the control you want to format in the document layout area. Depending on the type of control you select, proceed as follows:

- For a report or Grid/Graph:
  a Point to **Conditional Formatting**, then select **Advanced**. The Visual Conditional Formatting Editor opens.
  b From the drop-down list at the top left, select the metric that you want to apply the formatting to.

- For a text field, image, section, and so on: Point to **Conditional Formatting**, then select **Advanced**. The Conditional Formatting dialog box opens.

**To specify the qualifications**

3 From the Filter On drop-down list, select the attribute or metric on which to base the threshold or conditional format.

4 Follow the appropriate steps below depending on whether you are basing the condition on a metric or an attribute:

- If you are creating a condition based on a metric:
  a Select a comparison operator such as Greater Than or Less Than.
  b Type a value in the field on the right, or click **Select Metric** to choose another metric to compare the original metric to.
  c Click the **Apply** check mark to create the new threshold or conditional format.

- If you are creating a condition based on an attribute, do one of the following:
  a To define your condition by typing specific attribute form values:
    a Select the **Qualify** option.
    b From the drop-down list on the left, select the attribute form on which to base the condition. For example, you can qualify the condition based on the attribute element’s ID form, one of its description forms, or the DATE if the attribute is time-based.
    c From the next drop-down list, select a comparison operator such as Greater Than or Less Than. The operators available for a selection depend on the attribute form you chose above.
    d Do one of the following:
– To compare the attribute form to a specified value, type the value in the field.

– To compare the first attribute form to a second attribute form, click Select Attribute, then select the second attribute form from the drop-down list.

e Click the Apply check mark to create the new threshold or conditional format.

To define your condition by selecting attribute elements from a list:

a Choose the Select option.

b From the drop-down list on the left, select In List or Not In List. If you select Not In List, then the attribute elements in the Selected list will not be included in the condition.

c Move attribute elements from the Available list to the Selected list. Elements in the Selected list are included in the condition.

To search for a specific element, use the Search for field. Select the Match case check box to return only items that match the upper and lower cases you typed in the Search for field. For examples of searches, click Help.

d Click the Apply check mark to create the new threshold or conditional format.

5 To add more conditions to a threshold or conditional format, select the threshold or conditional format, click the Add Condition icon on the toolbar, and repeat the appropriate steps above to define each condition. For example, you can change the formatting of the names of employees who belong to the Northeast region and have a revenue of more than $30,000. You must create a threshold with two conditions, one condition for selecting employees from the Northeast region and another for selecting employees with revenue greater than $30,000.

6 It can be convenient to make a copy of a threshold or conditional format if you plan to create similar thresholds in the document. To copy a threshold or conditional format, select the threshold or conditional format and click the Copy icon on the toolbar. Then click the Paste icon on the toolbar.
To specify the formatting

To specify how data that meets the defined condition is formatted, click the threshold or conditional format, then click the Cell Formatting icon on the toolbar. The Format dialog box opens.

Specify a name for the threshold or conditional format in the Name field.

Depending on the control type you are applying the conditional formatting to, you can replace data with text, an image, a symbol, or hide the control. For a table that lists the conditional formatting available for all control types, see Formatting conditional data in documents, page 307. Select the Replace Data check box and select one of the following from the drop-down list:

- **Replace Text**: Replace data with any text you specify. For example, a document shows the financial values of various sales opportunities. For those sales opportunities that have been lost, you can display the word LOST in red, rather than displaying the financial value. A common use of this option is to display the word EMPTY when a data value is null. If you select this option, type the text with which to replace the values in the corresponding text field.

- **Quick Symbol**: Replace the normally displayed data with a common symbol. For example, a document shows the financial contribution of various sales groups to overall sales office activity. For the monthly trend column, you might show a green plus + and a red minus - symbol to represent positive and negative contribution trends. If you select this option, select the symbol with which to replace the values from the corresponding drop-down list.

- **Image**: Replace the normally displayed data with an image, such as an arrow or a green dot. You can specify the path to the image by typing the address using one of the following:
  - Absolute path: The default, for example, C:/images/img.jpg
  - Relative to HTML Document directory: A relative path from the document directory where the image is stored, for example, images/img.jpg
  - On the network: A path on your local area network, which is in a UNC (Universal Naming Convention) format, for example, //machine_name/shared_folder/img.jpg
  - On the web: A URL to an image file, for example, http://www.microstrategy.com/images/img.jpg
• **Hide**: Hide the control. For example, a document shows an image if the number of units sold is less than a specified value. You can hide this image when the units sold is greater than or equal to the target value.

10 Make selections in the Font, Number, Alignment, and Color and Lines tabs to change the font, color, alignment, and other options for data that meets the defined condition. Click **Help** for details on each option.

11 Click **OK** to apply the changes.

12 To determine whether a background color is applied to graphs in which thresholds are met, select the **Enable Thresholds on Graph** icon.

13 To determine how to apply conditional formatting if the control you are formatting is the target of a selector, select one of the following options on the toolbar:

- To apply conditional formatting only when metrics are selected in the selector, click the **Format metrics only** icon.

- To apply conditional formatting for both metrics and the Total option, click the **Format metrics and subtotals** icon.

14 To add additional conditions to a threshold or conditional format, click the **Add Threshold** icon, then follow the appropriate steps above to define each threshold or conditional format.

15 Click **OK** to apply the new threshold or conditional format to the document.

Once you create a conditional threshold, you can allow users to decide whether or not to display conditional formats. See *Displaying or hiding conditional formatting, page 323*.

**Displaying or hiding conditional formatting**

Once you create a conditional format, you can allow users to choose to display it or hide it. A disabled conditional format is replaced by the values.

If the document is a multi-layout document and you hide or display conditional formatting for the entire document, all layouts have conditional formatting displayed or hidden.
To allow users to display or hide all conditional formatting in a document

1. In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2. Right-click any control that has conditional formatting applied to it, point to Conditional Formatting, then select Advanced. The Conditional Formatting Editor opens.

3. Select the Allow user to toggle conditional formatting on and off check box. This check box is cleared by default.

4. Click OK to apply the changes.

Users can now open the Data toolbar and click the Toggle Conditional Formatting icon to display or hide all conditional formatting in the document.

Deleting a threshold or its conditions

You can delete conditions within a threshold, and you can delete thresholds. Steps are below to perform all of these tasks.

To delete a condition or a threshold

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Right-click the control you want to format in the document layout area, point to Conditional Formatting, then select Advanced. The Conditional Formatting dialog box opens.

3. Do any of the following:
   • To delete a threshold, select the threshold and select the Delete Threshold icon on the toolbar.
   • To delete all thresholds, click the Delete All Thresholds icon.
   • To add an additional condition to a threshold, select the threshold and select the Add Condition icon.
To clear the conditions from a threshold, select the threshold and select the Clear Conditions icon.

4 Click OK to save the changes to the document.

Formatting the border or background of a document or layout

You can format the border or background of a document for a more professional-looking presentation. The document’s border extends around the printable area on each page of the document. The two pages of the sample document displayed below show a document border.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>De Le Torre:Sandra</td>
<td>$93,100</td>
</tr>
<tr>
<td>Northeast</td>
<td>Kelly:Laura</td>
<td>$357,994</td>
</tr>
<tr>
<td>Northeast</td>
<td>Kieferson:Jack</td>
<td>$87,470</td>
</tr>
<tr>
<td>Northeast</td>
<td>Sawyer:Leanne</td>
<td>$368,219</td>
</tr>
<tr>
<td>Northeast</td>
<td>Sonder:Melanie</td>
<td>$43,925</td>
</tr>
<tr>
<td>Northeast</td>
<td>Yager:Beth</td>
<td>$350,024</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein:Lawrence</td>
<td>$158,930</td>
</tr>
</tbody>
</table>

While the sample document border shown above is a thin black line around the entire border, other border line options include thick, hairline, dotted, dashed, and double. You can change the color of the border. You can also apply the border to one or more sides of the document.

If the document contains multiple layouts, you can format the border and background of each layout.
To format the border and background of a document or layout

1. In MicroStrategy Web, open the document in Design or Editable Mode.


3. From the left, select Color and Borders.

4. From the Fill drop-down list, select a color for the background of the entire document.

5. To format the borders, select one of the following options from the Borders area:
   - None: Select this to remove the entire border.
   - All: Select this to display borders for all sections of the document.
   - Custom: Select this to customize borders using the drop-down lists.

6. Click OK to apply the changes and return to the document.

* The section color takes precedence over the document/layout color. For steps to define the color of a document section, see Formatting the background color of document sections, page 293.

Adding watermarks to documents

A watermark is a faint design appearing in the background of a page. A watermark typically identifies or decorates pages. Examples include the word Confidential stamped on every page or a business logo appearing in the background of every page. If the document contains multiple layouts, the watermark appears in every page of every layout. Watermarks in documents can be either text or an image.

Watermarks are placed within the margins of the document; they do not extend to the edge of the page.

- In a text watermark, the text is automatically cropped if it extends past the document margins.
For an image watermark, the image is automatically centered on the page. As with images placed elsewhere on a document, the image file must be stored so that it is available to both the Intelligence Server and to the designers of the document. For details, see *Inserting images in a document, page 151*.

Watermarks are displayed in the exported PDF only; they are not shown in any other views or modes in Desktop and MicroStrategy Web.

A watermark is a document backdrop. Whatever you print on the page appears on top of the watermark. Therefore, any object that is not transparent prints over or hides the watermark. If you want a watermark to show through a grid or graph report in a Grid/Graph container, set the background of the Grid/Graph cells to transparent. The background of a text field, rectangle, and so on must be transparent to allow the watermark to show through them.

The Human Resources Analytic Module contains a report on salaries above the industry range. The following document uses that report as its dataset, and includes the word “Confidential” as a watermark across the page. The watermark text is displayed behind the other text.
The following document contains more than one page, and the image watermark is shown on all the pages. The image watermark is centered on the page.

Project watermarks vs. document watermarks

You can define watermarks at both the project level and document level:

- A project watermark allows you to have the same watermark, such as a business logo, on every document in the project. A project watermark is also applied to reports when they are exported to PDF. You create project watermarks in MicroStrategy Desktop. Project watermarks are displayed in both Desktop and MicroStrategy Web.


For example, most documents display your business logo; however, internal documents need to be marked “Confidential”. Since a project watermark is overwritten by a document watermark by default, you can create a project watermark that uses the logo, but allow documents to overwrite the project watermark. For each internal document, create a document watermark with the text “Confidential”.
You can also choose to enable or disable document watermarks, to control whether project watermarks can be overwritten. This allows you to create a variety of watermarks for different purposes.

The following table describes how to achieve various results. Project-level settings are defined in Desktop; document-level settings can be defined in either Desktop or MicroStrategy Web.

<table>
<thead>
<tr>
<th>Document Results</th>
<th>Project-Level Settings</th>
<th>Document-Level Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>All documents in the project display the same watermark</td>
<td>• In Desktop, define the project watermark by clearing the <strong>Allow documents to overwrite this watermark</strong> check box</td>
<td>Not applicable</td>
</tr>
<tr>
<td>• Most documents in the project display the same watermark  • All other documents in the project do not display a watermark</td>
<td>• In Desktop, define the project watermark by selecting the <strong>Allow documents to overwrite this watermark</strong> check box</td>
<td>In Desktop or Web, do one of the following:  • For documents that display a watermark, select <strong>Use project watermark</strong>  • For documents without watermarks, select <strong>No watermark</strong></td>
</tr>
<tr>
<td>• Specific documents in the project have individual watermarks  • All other documents in the project display the same watermark</td>
<td>• In Desktop, define the project watermark by selecting the <strong>Allow documents to overwrite this watermark</strong> check box</td>
<td>In Desktop or Web, do one of the following:  • For the specific documents, define the document watermark  • For other documents, select <strong>Use project watermark</strong></td>
</tr>
<tr>
<td>• Specific documents in the project have individual watermarks  • All other documents in the project do not display a watermark</td>
<td>In Desktop, do the following:  • Select <strong>No watermark</strong>  • Select the <strong>Allow documents to overwrite this watermark</strong> check box</td>
<td>In Desktop or Web, do one of the following:  • For the specific documents, define the document watermark  • For other documents, select <strong>Use project watermark</strong></td>
</tr>
<tr>
<td>Each document has an individual watermark</td>
<td>In Desktop, do the following:  • Select <strong>No watermark</strong>  • Select the <strong>Allow documents to overwrite this watermark</strong> check box</td>
<td>In Desktop or Web, define a document watermark for each document</td>
</tr>
<tr>
<td>No documents display a watermark</td>
<td>In Desktop, do the following:  • Select <strong>No watermark</strong>  • Clear the <strong>Allow documents to overwrite this watermark</strong> check box</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>
Reports use the project watermark when they are exported to PDF.

Creating a project watermark

A project watermark is used on all documents in the project, except for any documents that have a document-level watermark. The project watermark is also applied to reports when they are exported to PDF. Project watermarks are created in Desktop.

To ensure that the project watermark is used on all documents in the project, you can disable document watermarks. For steps, see Disabling document watermarks for all documents in the project, page 336.

To create a project watermark for documents and reports

1. In Desktop, right-click your project and select Project Configuration. The Project Configuration Editor opens.

2. Expand the Project Definition category, then select Document and Reports.

3. Click Watermark. The Watermark dialog box opens.

4. A watermark can display either text or an image. Perform one of the following sets of steps, depending on whether you want to create a text watermark or an image watermark:

   • To create a text watermark:
     
     a. Select Text watermark.
     
     b. In the Text field, type the text to display as the watermark, up to 255 characters.
     
     c. To change the appearance of the text, click Format, which opens the Font tab of the Format Cells dialog box. You can select the font, size, color, and so on. For details on any of the options, click Help. Click OK when you have made your selections.

     By default, the watermark uses the font size defined in the Format Cells dialog box. To allow the font size to automatically adjust to fill the layout, select the Size font automatically check box. This can be useful if the document contains both portrait and landscape pages.
d To fade the watermark to ensure that the document/report information is legible through the watermark, select the **Washout** check box.

Any object that has a fill color, including a white fill, covers the watermark. If you want a watermark to show through a grid or graph report on the document, set the background of the Grid/Graph container’s cells to transparent. The background of a text field, rectangle, and so on must be transparent to allow the watermark to show through these objects.

e By default, the text is printed diagonally across the page. To print it horizontally instead, select **Horizontal** in the **Orientation** area.

- To create an image watermark:

  The image file must be available to both the Intelligence Server and to the designers of the document. For details, see *Inserting images in a document, page 151*.

  a Select **Image watermark**.

  b Click … (the **Browse** button) next to the Source field. The Image Source dialog box opens.

  c Do one of the following to select and preview the image file:

    – Type the path and file name of the image in the text field. Click **Preview**.

    – Click … (the **Browse** button) and select the image file. The preview area automatically displays the image.

  d Click **OK**.

  e By default, the image is automatically resized to fit within the document/report margins while retaining the image’s aspect ratio. To scale the image manually, select a percentage from the **Scale** drop-down list. The image is scaled to the selected percentage of its original size.

5 Click **OK** to return to the Project Configuration Editor.

6 To have all documents display this project watermark, clear the **Allow documents to overwrite this watermark** check box. If it remains selected, documents in this project can have their own watermarks, which overwrite the project watermark.

7 Click **OK** to return to Desktop.
Hiding a project watermark for a specific document

A project may have a watermark that is suitable for most documents. However, you may have a specific document in the project that you do not want to display any watermarks on. To achieve this, use the steps below to set the specific document’s watermark to no watermark. Because document watermarks overwrite project watermarks by default, the document setting overrides the project setting and no watermarks are displayed for this document.

To hide a project watermark for a specific document

Check that document watermarks are enabled

1. In Desktop, right-click your project and select Project Configuration. The Project Configuration Editor opens.
2. Expand the Project Definition category, then select Document and Reports.
3. Ensure that the Allow documents to overwrite this watermark check box is selected. This allows you to define document watermarks that overwrite the project watermark.

Create a blank document watermark

4. In Desktop, open the document in Design View.
   You can also create a blank document watermark in Web, by selecting No watermark for the document watermark.
7. Click Format in the Watermark area. The Watermark dialog box opens.
8. Select No watermark.
9. Click OK to return to the document.
Creating document watermarks

By default, document watermarks are enabled and overwrite any project watermark that has been created. If you do not create a document watermark, the project watermark, if any, is used on the document.

This procedure affects the entire document, including all layouts of a multi-layout document.

You can use either Desktop (see page 334) or MicroStrategy Web (see below) to create a document watermark. Instructions for both follow.

To create a document watermark using MicroStrategy Web

1. In MicroStrategy Web, open the document in Design or Editable Mode.
3. From the left, select Watermark.
4. A watermark can display either text or an image. Perform one of the following sets of steps, depending on whether you want to create a text watermark or an image watermark:
   - To create a text watermark:
     a. From the Watermark drop-down list, select Text watermark.
     b. In the Text field, type the text to display as the watermark, up to 255 characters.
     c. To change the appearance of the text, click Format, which opens the Font Formatting dialog box. You can select the font, size, color, and so on. Click OK when you have made your selections.
     d. By default, the watermark uses the font size defined in the Font Formatting dialog box. To allow the font size to automatically adjust to fill the layout, select the Size font automatically check box. This can be useful if the document contains both portrait and landscape pages.
     e. To fade the watermark to ensure that the document information is legible through the watermark, select the Washout check box.
By default, the text is printed diagonally across the page. To print it horizontally instead, select Horizontal from the Orientation drop-down list.

To create an image watermark:

1. From the Watermark drop-down list, select Image watermark.
2. The image file must be available to both the Intelligence Server and to the designers of the document. For details, see Inserting images in a document, page 151.
3. Type the path and file name of the image in the Source field.
4. By default, the image is automatically resized to fit within the document margins while retaining its aspect ratio. To scale the image manually, select a percentage from the Scale drop-down list.

5. Click OK to return to the document.

To create a document watermark using Desktop

1. In Desktop, open the document in Design View.
4. Click Format in the Watermark area. The Watermark dialog box opens.
5. Perform one of the following sets of steps, depending on whether you want to create a text watermark or an image watermark:
   - To create a text watermark:
     a. Select Text watermark.
     b. In the Text field, type the text to display as the watermark, up to 255 characters.
     c. To change the appearance of the text, click Format, which opens the Font tab of the Format Cells dialog box. You can select the font, size, color, and so on. Click OK when you have made your selections.
d By default, the watermark uses the font size defined in the Format Cells dialog box. To allow the font size to automatically adjust to fill the layout, select the **Size font automatically** check box. This can be useful if the document contains both portrait and landscape pages.

e To fade the watermark to ensure that the document information is legible through the watermark, select the **Washout** check box.

Any object that has a fill color, including a white fill, covers the watermark. If you want a watermark to show through a Grid/Graph, set the background of the Grid/Graph’s cells to transparent. Similarly, the background of a text field, rectangle, and so on must be transparent to allow the watermark to show through these objects.

f By default, the text is printed diagonally across the page. To print it horizontally instead, select **Horizontal** from the **Orientation** drop-down list.

• To create an image watermark:

The image file must be available to both the Intelligence Server and to the designers of the document. For details, see *Inserting images in a document, page 151*.

a Select **Image watermark**.

b Click … (the Browse button) next to the Source field. The Image Source dialog box opens.

c Do one of the following to select and preview the image file:

– Type the path and file name of the image in the text field. Click **Preview**.

– Click … (the Browse button) and select the image file. The preview area automatically displays the image.

d By default, the image is automatically resized to fit within the document margins while retaining its aspect ratio. To scale the image manually, select a percentage from the **Scale** drop-down list.

The Washout option is not available for an image watermark, as you can achieve the same result by creating the image using faded or dim colors.

6 Click **OK** to return to the document.
Disabling document watermarks for all documents in the project

By default, document watermarks are enabled, meaning that they overwrite the project watermark. If you want all documents to use the project watermark and not have their own watermarks, use the steps below to disable document watermarks for all documents in the project.

Document watermarks are disabled using Desktop.

---

To disable document watermarks

1. In Desktop, right-click your project and select **Project Configuration**. The Project Configuration Editor opens.

2. Expand the **Project Definition** category, then select **Document and Reports**.

3. Clear the **Allow documents to overwrite this watermark** check box.

4. Click **OK** to return to Desktop.

Disabling all watermarks

If you do not want to allow any watermarks on any documents in the project, disable all watermarks. To do this, set the project watermark to no watermark and disable document watermarks, using Desktop. Both steps are included in the following procedure.

Setting the project watermark to no watermark also removes watermarks from reports.

---

To disable all watermarks (for documents and reports)

1. In Desktop, right-click your project and select **Project Configuration**. The Project Configuration Editor opens.

2. Expand the **Project Definition** category, then select **Document and Reports**.
3  Click **Watermark**. The Watermark dialog box opens.

4  Select **No watermark**.

5  Click **OK** to return to the Project Configuration Editor.

6  Clear the **Allow documents to overwrite this watermark** check box.

7  Click **OK** to return to Desktop.

---

**Determining display for end users**

Designers can control which display modes users can view a document in. You can also define which display mode the document opens in, when it is first executed.

Analysts can run a document in a variety of displays, including Express Mode, Interactive Mode, and Flash Mode. For descriptions of the display modes, see *Display modes in MicroStrategy Web, page 2*. The steps below let you define display modes available to users, and which display mode a document opens in by default.

To enable Flash Mode, a project administrator must ensure that Flash Mode is enabled in the project, as described in the *Web Administrator Help*, under *Project Defaults*. An individual document designer or analyst can disable Flash Mode on his machine if he knows that Flash is not installed or does not want to use Flash. To do this, select **Preferences** at the top of MicroStrategy Web, select **Report Services** on the left, and select to enable or disable Flash Mode.

---

**To select document display modes available to users and determine a default**

1  In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2  From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.

3  From the left, select **Document**.

4  To make a mode available in the document, in the Run Modes area, select the check box in the **Available display modes** column for that display mode.
mode. Options are described below, from allowing users the least control over changing the document to giving them the most control over changing the document:

- **Express**: Express Mode allows you to view the results of the document without allowing formatting or manipulating the data; this view is similar to a static PDF file. This mode provides better performance than all other modes, but the document is not interactive.

- **Flash**: Flash Mode allows you to view the results of the document and access features provided by Adobe Flash, such as interacting with widgets, using selectors to flip through the panels in a panel stack or display different attribute elements or metrics in a Grid/Graph, and sorting grid reports and pivoting report objects on them.

- **Interactive**: Interactive Mode allows you to view the results of the document, format the grids and graphs, sort grid reports and pivot report objects on them. You can resize rows and columns, add totals, and use selectors to flip through panels in a panel stack or display different attribute elements or metrics in a grid or graph report. This mode is optimized for Report Services (RS) dashboard viewing.

5 Clear the check boxes for any display modes that you do not want users to have access to. For a table comparing all display modes (including display modes intended for document designers), see *Display modes in MicroStrategy Web, page 2*.

6 Save a display mode as the default by selecting it from the **Run by default** as drop-down list.

7 Click **OK** to apply the changes and return to the document. The next time the document is executed, only the display modes you selected are available.

### Letting users switch between grid and graph: Quick Switch

You can determine whether users can quickly switch (using a single click) between the grid view and graph view of a report in a document. (A report in a document is displayed in a Grid/Graph.)

If you enable **Quick Switch**, the Height and Width options for the Grid/Graph are automatically set to **Fixed**. The *Fit to Contents* option is disabled. This ensures that the graph or the grid will fill 100% of the size specified for...
the Grid/Graph. Therefore, you should view the final document to check that the height and width are correct after you enable Quick Switch.

**Prerequisite**

- The display mode of the Grid/Graph must be set to either **Graph** or to **Grid** before Quick Switch can be enabled. If the View option on the Layout tab of the Properties dialog box is set to **Grid and Graph**, the Quick Switch option is not available.

- If the Grid/Graph was originally designed to display as a grid report, ensure that the report meets the minimum object requirements to be successfully displayed as a graph. For requirements for all graph types, see the *Advanced Reporting Guide*. This will prevent formatting issues when users switch between grids and graphs.

---

**To enable Quick Switch for a Grid/Graph**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Click the Grid/Graph to select it.
3. From the **Format** menu, select **Properties and Formatting**. The Properties and Formatting dialog box opens.
4. On the left, select **Layout**.
5. In the **Grid** area, select the **Quick Switch** check box. This ensures that a Quick Switch button appears at the top of the selected Grid/Graph and users can click it to quickly change between the grid and graph version of a report.

---

**Hiding the floating grid toolbars in Flash Mode**

When you hover the cursor over the column headings of a grid report in Flash Mode, a small floating toolbar is displayed.
The toolbar allows users to sort or pivot a column of data. By default, this toolbar is displayed in documents in Flash Mode, but you can ensure that this toolbar will not display in a document.

To hide the floating grid toolbar in Flash Mode

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. From the left, select **Document**.
4. Clear the **Show floating grid toolbars in Flash** check box.
5. Click **OK** to apply the changes and return to the document.

Allowing a document to be refreshed automatically in Express Mode

You can allow a document to be refreshed automatically, and select the length of time between refreshes. Refreshing a document provides real-time monitoring to ensure that the document cache is still valid. Automatic refresh is helpful if the document’s data is frequently updated.

Document refresh applies to documents displayed in Express Mode and on iPhone, iPad, and Android devices. When document refresh is enabled, a user can pause and resume automatic document refreshing in Express Mode.

To enable automatic document refreshing

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. From the left, under the Document Properties section, click **Advanced**.
4. Select the **Automatically Refresh** check box. In the field, type the amount of time, in seconds, to wait before each refresh.
Embedding fonts for Flash Mode

Before you view the document in Flash Mode in MicroStrategy Web, fonts must be embedded if the document contains any of the following:

- Anti-alias support
- Vertical text
- Graph labels rotated 45, 90, or 180°

If the font used for one of these features is not embedded, anti-alias is not used or the text is displayed horizontally.

The font definitions, such as Tahoma and ComicSans, are contained in SWF files. For example, these files can include the font types that support vertical text and font anti-aliasing in Flash Mode. For examples of vertical text, see Displaying text vertically, page 279.

To embed fonts for Flash Mode

1. Open the document in Design View in the Document Editor in Desktop.
3. Select Flash from the list of categories on the left.
4. In the Embed the following fonts field, enter the relative path and the name of the SWF file, such as .\swf\Tahoma.swf. Separate multiple files with a comma.
5. Click OK to return to the document.
Formatting a document for exporting or printing

You can control how the document is displayed and printed. This ensures that the end result (the printed document) appears as you want it to. These settings include:

- **Pagination**: You can control when a new page should start and when page numbering restarts. For details and steps, see *Adding page breaks and numbering pages, page 343*.

- **Page setup options**: You can control the display and printing of page margins, paper size, orientation (landscape or portrait), and scaling. For details and steps, see *Modifying page setup options, page 346*.

- **Horizontal overflow**: You can specify whether controls that extend beyond the width of a single page are printed on the next sheet of paper (the default setting) or on the same page. For examples and steps, see *Controlling horizontal overflow, page 350*.

- **Font embedding**: You can ensure that the fonts selected in the Document Editor are used to display and print the PDF, even on machines that do not have the original fonts installed. For more details and steps, see *Embedding fonts in PDFs, page 353*.

- **Graph resolution**: You can use bitmaps or vector graphs. Vector graphs are smaller than bitmaps and therefore reduce the size of the PDF, while still providing good quality printed graphs. Bitmaps allow background patterns, rectangular gradients, texture backgrounds, and picture backgrounds. If the PDF uses bitmaps, you can also select whether to use draft quality, which uses a lower resolution to reduce the size of the PDF. For details and steps, see *Changing graph resolution in PDFs, page 355*.

- **Bookmarks**: You can create bookmarks in the PDF, to allow quick access to specific areas of the file. You can specify that the bookmarks are hidden when the PDF opens, to maximize the amount of space for the document. The user can then display and use the bookmarks. For examples and steps, see *Including or hiding bookmarks in PDFs, page 356*.

  Bookmarks cannot be created if the document is not grouped. For information on grouping a document, see *Grouping records in a document, page 374*. 
• **Table of contents**: You can create an interactive table of contents as the first page of the PDF. For examples and steps, see *Including interactive tables of contents in PDFs, page 358*.

  A table of contents can be created only if a document has multiple layouts and/or is grouped. For more information on multi-layout documents, see *Creating multi-layout documents, page 476*. For information on grouping a document, see *Grouping records in a document, page 374*.

After you set up a document to be exported or printed successfully as a PDF, you can then refine the location or size of controls on the document to ensure that it looks exactly the way that you want it. For steps, see *Arranging controls on a document, page 156*.

### Adding page breaks and numbering pages

In a document, you can determine when a new page should start and how the page numbers print. For example, you can have a page break before each new section and have page numbering restart at 1 for each section. This section provides steps for:

- *Adding a page break to a document, page 343*
- *Adding page numbers to a document, page 344*

### Adding a page break to a document

You can add page breaks to a document to signify the beginning of a new document section.

For example, to create a cover page, use the Document Header section to display the title and author, inserting a page break after the Document Header. To print each Detail section on a separate page, add page breaks after each section. To print the Detail Header and Detail Footer separately from the Detail section, use the **Before and after section** setting.

You can also add page breaks between groups. For more information, see *Adding a page break for a group, page 396*. 
To add a page break to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Select the section to print or display on a new page. To do this, click in a blank area in the section.

3. Right-click the section and select Properties and Formatting. The Properties and Formatting dialog box opens.

4. On the left, select Layout.

5. From the Force New Page drop-down list in the PDF area, select how you want the page break to occur:
   - None: Does not insert a page break. The section continues immediately after the previous section.
   - Before section: Causes the page break to occur before the section begins.
   - After section: Causes the page break to occur at the end of the section.
   - Before and after section: Inserts the break both before the section and after it.

6. Click OK to save your changes and return to the document.

Adding page numbers to a document

By default, a document does not have any page numbers printed on it. You can add them anywhere you want in the document, although page numbers are typically placed in the Page Header or Page Footer sections.

Auto text codes related to pagination, such as Page Number and Total Page, apply when the document is viewed in PDF or printed. For more information on auto text codes, see Displaying document and dataset report information: Auto text codes, page 88.
To add page numbers to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Expand the document section where you want the page number, by clicking the plus sign next to the section name.

3. From the Insert menu, select Auto Text, and then select Page Number. The text field is inserted at the top left corner of the selected section, but you can reposition it.

4. You can add the total number of pages in the document. From the Insert menu, select Auto Text, and then select Total Pages. The text field is inserted at the top left corner of the selected section, but you can reposition it.

5. Click the Apply icon.

6. To print a label such as “Page 1 of 8”, do the following:
   a. Click Text on the toolbar.
   b. In the section you expanded above, click where you want the label. A blank text field is inserted.
   c. In the text field, type Page, followed by a space.
   d. From the Insert menu, select Auto Text, and then select Page Number.
   e. Type a space, then type of, then type another space.
   f. From the Insert menu, select Auto Text, and then select Total Pages.
   g. Click anywhere outside of the text field to stop editing it.
   h. Click Text on the toolbar.
   i. In the section you expanded, click where you want the page number to be located. The new text field is inserted.
   j. Type any text and/or codes in the text field. The code for page number is {&PAGE}. The code for the total number of pages in the document is {&NPAGES}. 
Modifying page setup options

You can modify the document's appearance before printing to ensure that the end result (the printed document) appears as desired. You can modify options such as paper size, borders, section display, and horizontal overflow.

Horizontal overflow specifies whether controls that extend beyond the width of a single page are printed on the next sheet of paper (the default setting) or on the same page. For examples and steps, see Controlling horizontal overflow, page 350.

For a multi-layout document, each layout can have different page setup options. For more information on multi-layout documents, including which options apply to the document as a whole or to individual layouts, see Creating multi-layout documents, page 476.

To modify the page setup options

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 If the document contains multiple layouts, click the tab of the layout whose printing options you want to modify.
3 From the Home menu, select Page Setup. The Properties dialog box opens.
4 On the left, select Page.
5 To change the paper size, select the new size, such as Letter or Legal, from the Paper Size drop-down list. This option alters the values for both Width and Height.
6 You can change the Width or Height of the page. These settings take priority over the Paper Size and Orientation settings. If you increase Width or Height beyond the Paper Size setting, then Paper Size and Orientation automatically adjust accordingly.
7 You can change the paper orientation to either Portrait (default) or Landscape. This option alters the values for both Width and Height.
8 By default, the document is scaled to 100% (full size). You can change this by doing one of the following:
To increase or decrease the scale of the document, select **Adjust to** and then enter the scale percentage.

To scale the document to a specific number of pages, select the **Fit to** option. You can then set both the number of pages wide, for horizontal scaling, and tall, for vertical scaling. The Fit to option ensures that the document fits within the parameters, but it does not increase the size of the document. If the document is already smaller than the set width and height, it will not be expanded.

To apply the scaling to the Page Header and Footer sections, select the **Scale page header/footer** check box. If the check box is cleared (default), the contents of the Page Header and Footer sections are printed at the size specified in the Property List, regardless of the scaling percentage applied to the rest of the document.

**Horizontal fit** specifies how to handle overflow content that does not fit on a single horizontal page. Horizontal fit specifies whether controls that extend beyond the width of a single page are printed on the next sheet of paper or on the same page. This option determines whether controls are printed left to right on multiple pages or immediately below each other on the same page.

By default, the overflow is printed on the next page. To print the overflow on the same page, select **Below** from the **Overflow** drop-down list. For examples of horizontal fit, see *Controlling horizontal overflow*, page 350.

To define page margins, do the following:

a. On the left, click **Margins**.

b. To change the distance between the top of the page and the top of the document or the top of the border, enter the new measurement in **Top**.

c. To change the distance between the bottom of the page and the bottom of the document or the bottom of the border, enter the new measurement in **Bottom**.

d. To change the distance between the left side of the page and the left side of the document or the left edge of the border, enter the new measurement in **Left**.

e. To change the distance between the right side of the page and the right side of the document or the right edge of the border, enter the new measurement in **Right**.
12 When all changes are complete, click OK to apply the changes and return to the document.

**Printing a document on a single page**

You may have a document that contains so many columns and/or rows that it prints on multiple pages, but the document needs to fit on a single page. Depending on the content, you can try any of these solutions:

- Decreasing the font size of the text, by right-clicking the control and selecting **Properties and Formatting**. Select **Font** from the list on the left, and select a smaller font in the **Size** field.

- Scaling the document to fit on a single page, by selecting **Document Properties** from the **Format** menu. Select **Page** from the list on the left. Click **Fit to**, and then type 1 in the next two fields, to fit the document to one page wide by one page tall.

  If the document is grouped, you can combine scaling with the **Page break between groups** option in the Grouping Properties dialog box. This option fits each group onto a single page, and helps when the document is too big to fit on a single page.

For example, a document contains nine columns of data and is grouped by Country. Printed at full size, the document is two pages across and two pages
long, for a total of four pages. The document can be scaled to fit on a single page, as shown below:

You can also use the **Page break between groups** option to apply **Fit to Page** scaling to separate groups instead of applying it to the whole document. For example, a document grouped by region contains nine columns. Each region is two pages in width and two pages in length, but should print on a single page. The **Page break between groups** option forces a page break between each region. Since the document cannot then be
fit on a single page, the page scaling is applied to each group. Shown below are the first two pages of the document.

### Controlling horizontal overflow

If the controls on a document extend beyond the width of a single page, the controls that overflow are printed on the next page. You can change this default setting to allow the overflow to print on the same page. Instead of printing the controls left to right on multiple pages, the controls are printed immediately below each other on the same page.
For example, the following document is wider than the page size, so by default it is split onto two pages, as shown below:

### Page 1

<table>
<thead>
<tr>
<th>Category</th>
<th>Month</th>
<th>Region</th>
<th>Cost</th>
<th>Last Month’s Cost</th>
<th>Profit</th>
<th>Last Month’s Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronics</td>
<td>Jan 2007</td>
<td>Northeast</td>
<td>$115,163</td>
<td>$143,667</td>
<td>$28,800</td>
<td>$24,966</td>
</tr>
<tr>
<td>Electronics</td>
<td>Feb 2007</td>
<td>Northeast</td>
<td>$119,720</td>
<td>$115,163</td>
<td>$29,873</td>
<td>$28,806</td>
</tr>
<tr>
<td>Electronics</td>
<td>Mar 2007</td>
<td>Northeast</td>
<td>$124,887</td>
<td>$119,720</td>
<td>$31,335</td>
<td>$29,873</td>
</tr>
<tr>
<td>Electronics</td>
<td>Apr 2007</td>
<td>Northeast</td>
<td>$126,520</td>
<td>$124,887</td>
<td>$24,515</td>
<td>$31,336</td>
</tr>
</tbody>
</table>

### Page 2

<table>
<thead>
<tr>
<th>Revenue</th>
<th>Last Month’s Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>$143,971</td>
<td>$168,633</td>
</tr>
<tr>
<td>$149,593</td>
<td>$143,971</td>
</tr>
<tr>
<td>$156,223</td>
<td>$149,593</td>
</tr>
<tr>
<td>$151,035</td>
<td>$156,223</td>
</tr>
</tbody>
</table>
If you want to see the figures for each row on the same page, change the overflow setting to **Below**. The part of the section that would have printed on page two is now printed on page one, directly beneath the first part:

<table>
<thead>
<tr>
<th>Category</th>
<th>Month</th>
<th>Region</th>
<th>Cost</th>
<th>Last Month’s Cost</th>
<th>Profit</th>
<th>Last Month’s Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronics</td>
<td>Jan 2007</td>
<td>Northeast</td>
<td>$115,163</td>
<td>$143,667</td>
<td>$28,808</td>
<td>$24,956</td>
</tr>
<tr>
<td></td>
<td>$143,971</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>Feb 2007</td>
<td>Northeast</td>
<td>$119,720</td>
<td>$115,140</td>
<td>$29,873</td>
<td>$28,808</td>
</tr>
<tr>
<td></td>
<td>$149,593</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>Mar 2007</td>
<td>Northeast</td>
<td>$124,087</td>
<td>$115,720</td>
<td>$31,336</td>
<td>$29,873</td>
</tr>
<tr>
<td></td>
<td>$156,222</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electronics</td>
<td>Apr 2007</td>
<td>Northeast</td>
<td>$128,520</td>
<td>$124,887</td>
<td>$24,515</td>
<td>$31,336</td>
</tr>
<tr>
<td></td>
<td>$151,035</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Horizontal overflow setting applies to all sections of the document because it is set at the document level.

You can designate a different horizontal overflow for each layout of a multi-layout document. For details on multi-layout documents, see *Creating multi-layout documents, page 476*.

**To control horizontal overflow**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Home** menu, select **Page Setup**. The Properties dialog box opens to the Page section.
3. From the **Overflow** drop-down list, select one of the following:
   - **Next Page**: Horizontal overflow is printed on the next page.
   - **Below**: Horizontal overflow is printed on the next page.
4. Click **OK** to apply the changes.
Embedding fonts in PDFs

Embedding fonts ensures that the original fonts selected in the Document Editor are used to display and print the PDF, even on machines that do not have the original fonts installed. No font substitutions are made.

Embedding fonts allows you to:

- Use language fonts other than Simplified Chinese, Traditional Chinese, English, Japanese, Korean, and Western European in PDFs
- Provide a true Unicode environment, where one document contains different languages
  
  Font embedding is not required if the only languages used are Simplified Chinese, Traditional Chinese, Japanese, or Korean, and the matching language fonts are used instead of a Unicode font.

- Create PDFs containing Simplified Chinese, Traditional Chinese, Japanese, or Korean characters for any machine, even one without the corresponding Acrobat Reader language pack
  
  Acrobat Reader cannot display bookmarks in the correct language font unless the corresponding language pack is installed on the user’s machine. The remainder of the PDF will display and print the languages correctly. This Acrobat Reader requirement applies to all languages other than English and Western European.

- Create truly portable PDFs to email and to publish on the web, even if you do not have control over the machines that will display and print the PDFs
  
  For a MicroStrategy Web user to view the embedded fonts, the fonts must be installed on the Intelligence Server machine.

- Bullets, thresholds, and any other objects that require special fonts are displayed correctly if the PDF is displayed on a Kindle or Nook. For more best practices on designing documents for the Kindle or Nook, see Best practices: Designing documents for Kindle and Nook, page 16.

Considerations before you embed fonts include:

- Embedded fonts may create a larger PDF, because the file now includes extra font data and encoding tables. Additionally, single-byte languages use two bytes.

- Embedded fonts require a longer generation time for the PDF, since the file is larger and extra processing is needed to embed the fonts.
• Embedded fonts create a larger memory footprint due to the number of fonts, the number of embedded characters, and the size of the PDF output.

The **Embed fonts in PDF** setting in the steps below ensures that if the fonts used in the document are available on the machine that generates the PDF, the fonts are embedded in the PDF. When you execute a document in Desktop, the PDF is generated by that client machine. When you execute a document in MicroStrategy Web, the PDF is generated by the Intelligence Server machine.

If you edit a document containing embedded fonts on a machine that does not have those fonts installed, a Windows default font is displayed instead. For example, this scenario can occur when you create a document and embed fonts for Japanese. In this case, the Japanese fonts are installed on that machine and the Intelligence Server used for the project. Another user views the document on a different machine that does not have Japanese fonts. The document displays correctly because you embedded the fonts. If that user edits the document, the Japanese characters are displayed in the font that Windows selects as the closest match to the missing font. If this occurs, do not change the font selections, which are set to blank automatically, so that they will continue to display correctly in the PDF.

The solution is to install the font on any machine that is used to edit the document.

This procedure affects the entire document, including all layouts of a multi-layout document. For more information on multi-layout documents, see *Creating multi-layout documents, page 476.*

---

**To embed fonts in a PDF**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. On the left, select **Export**.
4. In the PDF area, select the **Embed fonts in PDF** check box.
5. Click **OK** to return to the document.
Changing graph resolution in PDFs

By default, graphs are generated using vector graphs, which are much smaller than bitmaps and reduce the size of the PDF. They also provide good quality resolution for printed graphs.

You can use bitmaps (.bmp) if you want to use any of the following, which are not supported by vector graphs:

- Background patterns (only the background color of the pattern is used)
- Rectangular gradients (linear and circular gradients are supported; rectangular gradients are converted to circular gradients)
- Texture and picture backgrounds (a solid white background is applied)

If bitmaps are generated instead of vector graphs, you can generate them using a lower resolution, or draft quality. This reduces the size of the PDF and impacts the printed quality of the graphs, but generally not the quality of the on-screen graph images.

This procedure affects the entire document, including all layouts of a multi-layout document. For more information on multi-layout documents, see Creating multi-layout documents, page 476.

To change the graph resolution in PDFs

1. In MicroStrategy Web, open the document in Design or Editable Mode.
3. On the left, select Export.
4. In the PDF area, select the Use bitmaps for graphs check box.
5. To use a lower resolution for bitmap graphs and reduce the size of the PDF, select the Use draft quality for graphs check box.
6. Click OK to return to the document.
7. To view the PDF, click the PDF icon on the Standard toolbar.
Including or hiding bookmarks in PDFs

Bookmarks identify parts of a PDF, allowing quick access to specific areas of the file. Bookmarks are displayed in the PDF in a tree format, creating a table of contents as a navigation aid. A link is included for each element of each grouping field in the document.

Bookmarks are automatically created when a document is grouped or contains multiple layouts. For steps to group a document, see Grouping records in a document, page 374. For steps to create a multi-layout document, see Creating multi-layout documents, page 476.

For example, a document is grouped by Region and then Employee. The PDF is created with bookmarks, as shown in the following sample.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Amount 1</th>
<th>Amount 2</th>
<th>Amount 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>De Le Torre,Sandra</td>
<td>$514,795</td>
<td>$93,100</td>
<td>$607,895</td>
</tr>
<tr>
<td></td>
<td>Kelly,Laura</td>
<td>$1,992,725</td>
<td>$357,994</td>
<td>$2,350,720</td>
</tr>
<tr>
<td></td>
<td>Kieferson,Jack</td>
<td>$497,463</td>
<td>$87,470</td>
<td>$584,933</td>
</tr>
<tr>
<td></td>
<td>Sawyer,Leanne</td>
<td>$2,043,693</td>
<td>$366,219</td>
<td>$2,411,912</td>
</tr>
<tr>
<td></td>
<td>Sonder,Melanie</td>
<td>$251,183</td>
<td>$43,925</td>
<td>$295,108</td>
</tr>
<tr>
<td></td>
<td>Yager,Beth</td>
<td>$1,953,023</td>
<td>$350,024</td>
<td>$2,303,847</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein,Lawrence</td>
<td>$901,702</td>
<td>$158,930</td>
<td>$1,060,632</td>
</tr>
</tbody>
</table>

When bookmarks are created, the bookmark panel is automatically shown when the PDF is viewed. You can choose to hide the bookmark panel initially to maximize the amount of space for the document. Users can display bookmarks at any time. You can also choose to not generate the bookmarks if, for example, the PDF includes an interactive table of contents (see Including interactive tables of contents in PDFs, page 358).
If the document will be viewed on a Nook, include bookmarks so that a user can quickly access a specific section of the document. On the Nook, bookmarks are displayed in the PDF in a tree format, creating a table of contents as a navigation aid.

For more information on using bookmarks in PDFs, consult the product documentation for Acrobat Reader.

These procedures affect the entire document, including all layouts of a multi-layout document. For examples and steps, see Creating multi-layout documents, page 476.

---

**To include bookmarks in PDFs**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. On the left, select **Export**.
4. In the **PDF** area, select the **Include bookmarks in PDF** check box.
5. Ensure that the **Show bookmarks in PDF** check box is selected, so that the bookmarks are displayed.
6. Click **OK** to return to the document.
7. To view the PDF, click the **PDF** icon on the Standard toolbar. The PDF displays bookmarks.

---

**To hide bookmarks in a PDF**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. On the left, select **Export**.
4. In the **PDF** area, clear the **Show bookmarks in PDF** check box. This option is unavailable if the **Include bookmarks in PDF** check box is cleared.
5 Click **OK** to return to the document.

6 To view the PDF, click the **PDF** icon on the Standard toolbar. The bookmark panel is not automatically displayed.

---

**To specify that bookmarks are not generated**

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2 From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.

3 On the left, select **Export**.

4 In the **PDF** area, clear the **Include bookmarks in PDF** check box.

5 Click **OK** to return to the document.

6 To view the PDF, click the **PDF** icon on the Standard toolbar. The PDF does not display bookmarks.

---

**Including interactive tables of contents in PDFs**

A table of contents allows a user to quickly access specific areas of the PDF. In the exported PDF, users can click a label or page number to jump to that area. An entry is created in the table of contents for each element of each grouping field and, if the document contains multiple layouts, each layout.

You can create a table of contents only if a document has multiple layouts and/or is grouped. For steps to group a document, see *Grouping records in a document, page 374*. For details on multi-layout documents, see *Creating multi-layout documents, page 476*.

Tables of contents are displayed in exported PDFs in MicroStrategy Web and in PDF View in Desktop.

Examples are provided below for a table of contents in a grouped document, in a multi-layout document, and in a grouped multi-layout document.
The table of contents in a grouped document: Example

For example, a document is grouped by region and includes a table of contents. When you view the document as a PDF, the first page of the PDF is the table of contents. The entries in the table of contents are the regions, as shown below. A user can click a region (such as Central) or a page number to jump to that region in the PDF.

The page number is displayed as the Roman numeral i (in the toolbar at the top of the image), while the data begins on page 1. The table of contents is inserted at the beginning of the document and is not included in the page numbering of the document itself.

In the above example, the title “Table of contents” was added and the font was formatted. (Steps to add a title and change the font are included below.) The example below shows the default appearance of the table of contents:
The table of contents in a multi-layout document: Example

For example, a document contains the following three layouts, listed in order:

- Revenue by Category (1)
- Regional Revenue (2)
- Yearly Revenue (3)

This document contains a table of contents. By default, it is displayed on the first page of the PDF, as shown below:

```
Table of Contents

Revenue by Category (1) ........................................... 1
Regional Revenue (2) .............................................. 7
Yearly Revenue (3) .................................................. 13
```

Each of the three layouts is listed in the table of contents. Change the table of contents to display before the second layout, Regional Revenue (2). Now the PDF displays the Revenue by Category (1) layout, followed by the table of contents shown below, which contains information for the last two layouts only:

```
Table of Contents

Regional Revenue (2) .............................................. 7
Yearly Revenue (3) .................................................. 13
```

Changing the location of the table of contents is useful when you want to include a cover page before the table of contents.
The table of contents in a grouped multi-layout document: Example

If your document contains layouts and groups, the table of contents displays both, as shown in the PDF below. The layouts are the top level entries, while the groups are shown within each layout.

Table of Contents

<table>
<thead>
<tr>
<th>Revenue by Category (1)</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>1</td>
</tr>
<tr>
<td>Electronics</td>
<td>2</td>
</tr>
<tr>
<td>Movies</td>
<td>3</td>
</tr>
<tr>
<td>Music</td>
<td>4</td>
</tr>
<tr>
<td>Regional Revenue (2)</td>
<td>7</td>
</tr>
<tr>
<td>Central</td>
<td>7</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>7</td>
</tr>
<tr>
<td>Northeast</td>
<td>8</td>
</tr>
<tr>
<td>Northwest</td>
<td>9</td>
</tr>
<tr>
<td>South</td>
<td>9</td>
</tr>
<tr>
<td>Southeast</td>
<td>10</td>
</tr>
<tr>
<td>Southwest</td>
<td>11</td>
</tr>
<tr>
<td>Web</td>
<td>11</td>
</tr>
<tr>
<td>Yearly Revenue (3)</td>
<td>13</td>
</tr>
<tr>
<td>2005</td>
<td>13</td>
</tr>
<tr>
<td>2006</td>
<td>14</td>
</tr>
<tr>
<td>2007</td>
<td>16</td>
</tr>
</tbody>
</table>

Creating a table of contents

To include an interactive table of contents in a PDF

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 From the Tools menu, select Document Properties. The Properties dialog box opens.
3 On the left, select Table of Contents.
4 Select the Include Table of Contents check box.
5 To display a title for the table of contents, enter the text in the Title field. If the Title field is blank, the title will be displayed as Table of Contents.
6 From the Align drop-down list, specify the text alignment to use to display the title. The options are Left (default), Center, and Right.
7 To format the title of the table of contents using the formatting options selected for the entries in the table of contents, select the Inherit Formatting From Body check box.

8 To format the font that is used to display the title, in the Font section, click the Format icon. The Font Formatting dialog box opens. Select the appropriate font formatting options such as the font type, font size, color, and so on. A preview of your selected font formatting is shown in the Sample area. Click OK when you have made your selections. This option is only available if the Inherit Formatting From Body option is selected.

9 From the Fill Color palette, select a color to apply to the background of the title. To access additional colors, click More Colors. This option is only available if the Inherit Formatting From Body option is selected.

10 To format the font used to display the entries in the table of contents, in the Body section, click the Format icon. The Font Formatting dialog box opens. Select the appropriate font formatting options such as the font type, font size, color, and so on. A preview of your selected font formatting is shown in the Sample area. Click OK when you have made your selections.

11 From the Fill Color palette, select a color to apply to the background of the entries. To access additional colors, click More Colors.

12 You can specify the amount of indentation to apply to entries in the table of contents. In the Left and Right fields, type the amount of space to display between the left and right borders of the table of contents and the entries.

13 From the Style drop-down list, select the line style to use to display the border around the table of contents.

14 From the Color palette, select the line color to use to display the border around the table of contents. To access additional colors, click More Colors.

15 In the Weight field, type the line thickness to use to display the border.

16 By default, tab leaders are shown. Tab leaders are a series of dots connecting the item with the page number. To disable them, clear the Show tab leader check box.

17 To include the page header and footer on the table of contents page in the exported PDF, select the Include Page Header/Footer check box. This check box is cleared by default.
18 If the document contains multiple layouts, the **Before layout** drop-down list is available. By default, the table of contents is displayed before the first layout, but you can select a different layout from the list.

19 Click **OK** to return to the document.

20 To view the PDF, click the **PDF** icon on the Standard toolbar.

## Formatting a document for export

Exporting allows you to send data to other applications such as Microsoft Excel or Adobe Flash. You can:

- Export data to a Microsoft Excel spreadsheet for further manipulation and use.
  
  Before you export to Excel, see *Best practices: Designing documents for Excel, page 15* for tips to create a document that will display correctly when it is exported to Excel.

  For steps to export documents to Excel, see the *Document and Dashboard Analysis Guide*.

- Export a Report Services (RS) dashboard to a Flash file, so that users can view the Flash content and interact with it off-line, without using MicroStrategy. The Flash file is a fully interactive, stand-alone Flash RS dashboard.

  For more information and steps to export documents to Flash files, see the *Document and Dashboard Analysis Guide*.

- Export the document to a PDF file, and keep the file open in a separate window outside of the Document Editor. You can then return to the Document Editor, switch to Design View, and edit the document, while keeping a copy of the PDF open to refer to.

  For steps to open the PDF in a separate window, see the *Document and Dashboard Analysis Guide*.

Before you can export a document, you must select the formats that the document can be exported to. For steps, see *Selecting available export formats, page 364.*
For export to Excel, HTML, and PDF, you can specify default exporting options, or you can allow users to be prompted to make these choices. These options are described below:

- If your document is grouped, you can choose to export the entire document or only the selected group element. Page-by allows you to view the document by a selected group element. For information on grouping, including examples, see Grouping records in a document, page 374; for more information on page-by, including examples, see Using page-by on a document, page 403.

- If your document contains multiple layouts, you can choose to export the entire document or only the current layout. For more information on how layouts are exported to Excel, see Exporting multi-layout documents, page 486.

For detailed instructions, see Specifying default export options, page 365.

Before you export a document that contains multi-code page translations, such as English and Japanese, to PDF, the fonts for labels, Grid/Graph objects, and so on should be set to a Unicode font such as Arial Unicode MS. This allows all characters to be shown by default when a user changes the metadata language.

### Selecting available export formats

Before you can export a document, you must select the formats the document can be exported to.

This procedure affects the entire document, including all layouts of a multi-layout document. For more information on multi-layout documents, see Creating multi-layout documents, page 476.

<table>
<thead>
<tr>
<th>To select the available export formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In MicroStrategy Web, open the document in Design or Editable Mode.</td>
</tr>
<tr>
<td>2 From the Tools menu, select Document Properties. The Properties dialog box opens.</td>
</tr>
<tr>
<td>3 On the left, select Document.</td>
</tr>
<tr>
<td>4 In the Run Modes area, select the format(s) in which the document can be exported:</td>
</tr>
</tbody>
</table>
• **Excel**: This allows the user to export the document to Microsoft Excel in .xls format. After the document is exported, the content of the document is displayed using the default settings in Microsoft Excel. The document does not retain the structure and format as it appears in MicroStrategy Web.

• **HTML**: This allows the user to export the document to an HTML editor or browser in .html format. After the document is exported, it is displayed in an HTML page. The document retains its structure and format as it appears in MicroStrategy Web.

• **Flash**: This allows the user to export the document to an Adobe Flash file in .mht format. After the document is exported, it retains its structure and format as it appears in MicroStrategy Web. Users must have Adobe Flash installed on their machine to view the exported file in Flash.

• **PDF**: This allows the user to export the document to an Adobe PDF viewer in .pdf format. After the document is exported, it retains its structure and format as it appears in MicroStrategy Web.

You can save any of these export formats as the default export format, by selecting the format in the **Run by default as** drop-down list.

Click **OK** to apply your selections.

### Specifying default export options

You can set default export options:

• **That apply to Excel only**

  These options affect images that are displayed in Excel. They include the graph format and whether to embed images.

  A document section setting also affects the row height of the Excel spreadsheet. You can choose to have all the rows be the same height or to allow Excel to automatically adjust the row height to fit the data. For instructions and an example, see *Allowing Excel to automatically change row height, page 370*.

• **That apply to PDF only**

  These options include graph resolution, embedded fonts, bookmarks, and interactive tables of contents.

• **That apply to Excel, HTML, and PDF**
These include how to export grouped documents and multi-layout documents, and whether to prompt users who export documents.

Instructions follow for all of the default export options.

---

**To set default export options**

This procedure affects the entire document, including all layouts of a multi-layout document. For more information on multi-layout documents, see *Creating multi-layout documents, page 476.*

1. Open the document in Design View in the Document Editor.

2. From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.

3. Select **Export**.

4. For a multi-layout document, select whether to **Export:**
   - **All layouts**, which exports all the layouts in the document (If the document will be viewed on a Kindle or Nook, select **All layouts** so that the Kindle or Nook user can see all the data.)
   - **Current layout**, which exports only the layout being viewed

5. For a grouped document, select whether to export the entire document or only the selected group element:
   - To export the entire document, select the **Expand page-by** check box. (If the document will be viewed on a Kindle, select **Expand page-by** so that the Kindle user can see all the data.)
   - To export only the selected group element, clear the **Expand page-by** check box.

6. Select whether to prompt the user to choose what to export.
   - To prompt the user, select the **Prompt user on export** check box. The prompts allow the user to select whether to export all layouts or just the current layout of a multi-layout document, and whether to export
the entire document or only the selected group element of a grouped document.

If Prompt user on export is selected, but either of the following is true, the user is not prompted, and the Export and Expand page-by settings set above are used:

- The document has one layout and no grouping.
- The document has one layout, is grouped, and the page-by selections are set to all.

To disable prompting, clear the Prompt user on export check box. The Export and Expand page-by options set above are used when the document is exported.

- To prompt the user, select the Prompt user on export check box.

Specifying Excel export options

The following steps apply to documents exported to Excel only.

7 To embed images so that a user can see the image when he opens the Excel file on another computer that does not have a network connection, select the Embed images check box.

Image embedding is available only in Excel 2003 or later.

8 Select whether to Use live Excel charts or Use embedded bitmaps as the Graph format.

For a description of how these settings interact to display images, see Displaying images in Excel, page 368.

Specifying PDF export options

The following steps apply to documents exported to PDF only.

9 Select whether to Include bookmarks in the PDF. Bookmarks are generated for each element of each grouping field in the document, creating a table of contents for the PDF. If the document is not grouped, no bookmarks are generated. For more information on bookmarks, including examples, see Including or hiding bookmarks in PDFs, page 356.

10 If you include bookmarks, select the Show bookmarks in PDF check box, so that the bookmarks are displayed when the PDF is viewed. If the
check box is cleared, the bookmarks can still be generated but they are not displayed automatically when the PDF opens.

11 Select whether to **Embed fonts in the PDF**, which determines whether the original fonts chosen in the Document Editor are used to display and print the PDF, even on machines that do not have those fonts installed. This ensures the portability of the PDF. For more information on this setting, including advantages and disadvantages, *Embedding fonts in PDFs, page 353*.

The fonts must be installed on the Desktop machine to ensure that the document is rendered correctly when creating and editing the document. The setting above ensures that if the fonts used in the document are available on the machine that generates the PDF, the fonts are embedded in the PDF. When you execute a document on Desktop, the PDF is generated by that client machine. When you execute a document in MicroStrategy Web, the PDF is generated by the Intelligence Server machine.

12 By default, graphs are generated using vector graphs, which are smaller than bitmaps and reduce the size of the PDF. They also improve the quality of printed graphs. Select the **Use bitmaps for graphs** check box to generate graphs using bitmaps instead. For more information, including when to use bitmaps or vector graphs, see *Changing graph resolution in PDFs, page 355*.

13 If you use bitmaps, you can select whether to **Use draft quality**, which determines whether bitmap graphs are generated using a lower resolution, thus reducing the size of the PDF. The quality of the graph images on the screen is generally not affected, but the quality of the printed graphs is impacted.

14 Click **OK** to save your selections and return to the document.

If the document is grouped, you can specify how to break between groups. For example, you can place each page in a separate Excel worksheet in the same Excel workbook. For instructions and samples, see *Specifying that groups are exported to separate Excel worksheets, page 401*.

**Displaying images in Excel**

Before you export a document to an Excel spreadsheet, you can select whether to:
• **Embed images.** If you embed images, a user can see the image when he opens the Excel file on another computer that does not have a network connection.

Image embedding is available only in Excel 2003 or later.

• **Use live Excel charts** or **Use embedded bitmaps** for the graph format. Live Excel charts ensure a smaller export size and integrate fully with Excel. However, they support fewer graph settings than MicroStrategy does. The following graphs appear differently in Excel than in MicroStrategy:
  
  - All 3D graphs
  - Box Plot
  - Bubble
  - Funnel
  - Gantt
  - Gauge
  - Hi Low
  - Histogram
  - Horizontal Area
  - Horizontal Bar
  - Horizontal Line

These settings work together to determine how images are displayed in Excel.

• To display embedded graphs:
  
  - Set **Graph format to Use embedded bitmaps.** The **Embed images** check box does not affect whether embedded graphs are displayed.

• To display live charts:
  
  - Set **Graph format to Use live Excel charts** and clear the **Embed images** check box.

• To embed images other than graphs:
  
  - Select the **Embed images** check box.
For instructions, see *Specifying default export options, page 365.*

**Allowing Excel to automatically change row height**

When you export a document that contains a Grid/Graph to Excel, some of the data can be too long to fit inside an Excel cell. For example, the items “100 Places to Go While Still Young at Heart” and “Cabin Fever: Rustic Style Comes Home” are too long for the Item column in the following Excel spreadsheet, which was exported from a document. The text wraps within the cell, but the row is too short and cuts off the text.

![Excel spreadsheet example](image)
If this occurs, you can allow Excel to dynamically and automatically resize. The result is shown below, where the two rows are now tall enough to display the full text.

![Example table with resized rows](image)

By default, the height of all rows are the same, to conserve the same layout that you created in the document. To modify the behavior, change the **Automatically fit rows** option to **True**. This option applies to a single document section.

---

**To allow Excel to automatically change row height for a section**

1. Open a document in the Document Editor.
2. In the Layout area, select the document section to modify.
3. From the **Format** menu, select **Properties**. The Properties dialog box opens.
4. Click the **Layout** tab.
5. Select the **Automatically fit rows** check box.
6. Click **OK** to return to the document.
GROUPING AND SORTING RECORDS IN A DOCUMENT

Introduction

This section describes procedures for grouping and sorting records in a MicroStrategy Report Services document.

When you group records in a document, you set up the document’s hierarchy and therefore its inherent sort order for the data displayed in the document. You can sort a group in either ascending or descending order. You can also choose how to sort the detail records of the document. You can use page-by to interactively display groups on separate pages when the document is viewed as a PDF. This chapter provides examples and steps for these goals.

- Grouping records in a document, page 374
- Using page-by on a document, page 403
- Sorting records in a document, page 409
Grouping records in a document

Grouping records together helps people who read the document to understand the data better. Grouping the data sets up a type of hierarchy within the document, and an inherent or implied sort order for the data. The data is first sorted by the leftmost field in the Grouping panel, then by the next field, and so on. To reorder the grouping, you can move the fields in the Grouping panel.

In the following example, the Sales by Region dataset has Region, Year, Category, and Subcategory attributes, and it has the Units Sold and Revenue metrics in it. This is shown below as it appears in the Dataset Objects panel of the Document Editor.

If you drag and drop all the dataset objects to the document’s Layout area in the order they appear, and add headings to label the controls, the document looks like the following:

<table>
<thead>
<tr>
<th>Category</th>
<th>Region</th>
<th>Subcategory</th>
<th>Year</th>
<th>Revenue</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronics</td>
<td>Northeast</td>
<td>Audio Equipment</td>
<td>2006</td>
<td>$232,999</td>
<td>994</td>
</tr>
<tr>
<td>Electronics</td>
<td>Northeast</td>
<td>Cameras</td>
<td>2006</td>
<td>$330,208</td>
<td>740</td>
</tr>
<tr>
<td>Electronics</td>
<td>Northeast</td>
<td>Computers</td>
<td>2006</td>
<td>$129,691</td>
<td>1,120</td>
</tr>
<tr>
<td>Electronics</td>
<td>Northeast</td>
<td>Electronics - Misc.</td>
<td>2006</td>
<td>$307,503</td>
<td>871</td>
</tr>
<tr>
<td>Electronics</td>
<td>Northeast</td>
<td>TVs</td>
<td>2006</td>
<td>$247,640</td>
<td>1,006</td>
</tr>
<tr>
<td>Electronics</td>
<td>Northeast</td>
<td>Video Equipment</td>
<td>2006</td>
<td>$323,496</td>
<td>714</td>
</tr>
</tbody>
</table>

If you want the document to be grouped first by Region, and then by Year within Region, first ensure that the Grouping panel is displayed. Then drag Region from the Dataset Objects panel onto the Grouping panel. Next, drag and drop Year onto the Grouping panel.
With these changes, the document groups first by Region, and then by Year, as shown in the following image:

<table>
<thead>
<tr>
<th>Year:</th>
<th>2006</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Subcategory</td>
</tr>
<tr>
<td>Electronics</td>
<td>Audio Equipment</td>
</tr>
<tr>
<td>Electronics</td>
<td>Cameras</td>
</tr>
<tr>
<td>Electronics</td>
<td>Computers</td>
</tr>
<tr>
<td>Electronics</td>
<td>Electronics - Miscellaneous</td>
</tr>
<tr>
<td>Electronics</td>
<td>TVs</td>
</tr>
<tr>
<td>Electronics</td>
<td>Video Equipment</td>
</tr>
<tr>
<td>Year:</td>
<td>2007</td>
</tr>
<tr>
<td>Category</td>
<td>Subcategory</td>
</tr>
<tr>
<td>Electronics</td>
<td>Audio Equipment</td>
</tr>
<tr>
<td>Electronics</td>
<td>Cameras</td>
</tr>
</tbody>
</table>

The ascending sort order of both Region and Year comes from the default sort order of these attributes. You can change the sort order. For steps, see *Sorting records in a document, page 409.*

For more information on the default sort of attributes, see the *Advanced Reporting Guide.*

You can select attributes, consolidations, and custom groups as grouping fields.

You can select which grouping fields to sort, the sorting criteria (what to sort by), and the sorting order (ascending or descending). Any object in the Grouping panel can be sorted. For steps, see *Sorting records in a document, page 409.*

When a user views a grouped document, drop-down lists are displayed to allow the user to select which elements, or subsets of data, to display. You can select which attribute forms are displayed in the list, and the order of the forms, as described in *Displaying forms in a group, page 379.*
Grouping and PDF bookmarks and table of contents

Each element of each grouping field automatically becomes a bookmark in the PDF. You can disable automatic generation of bookmarks. For steps, see *Including or hiding bookmarks in PDFs, page 356*.

If you choose to include a table of contents in the PDF, each element of each grouping field is listed as an entry in the table of contents.

Grouping and multi-layout documents

You group each layout of a multi-layout document independently of other layouts. By default, a user’s grouping selections apply only to the current layout. You can specify that the grouping selection is retained when a user switches layouts in MicroStrategy Web, if the new layout contains the same grouping field as the original layout. For instructions to retain the grouping selection, see *Applying grouping selections to the current layout or all layouts, page 399*. For more information on multi-layout documents, including which settings apply to the document as a whole or to individual layouts, see *Creating multi-layout documents, page 476*.

Grouping and page-by

By default, page-by is enabled for all the grouping fields in the document. Page-by is the ability to select grouping elements for display when the document is viewed as a PDF or in HTML. For more information, see *Using page-by on a document, page 403*.

Determining grouping order

Use these steps to set up a grouping order. To change grouping order, see *Changing the grouping order in a document, page 377*.

To determine grouping order in a document

1. In MicroStrategy Web, open a document in Design or Editable Mode.
2. If the document contains multiple layouts, click the tab of the layout to modify.
3 From the **Tools** menu, select **Grouping**. The Grouping panel opens above the Layout area.

4 Right-click the object in the Dataset Objects panel, and select **Add to Grouping**. The object is added to the Grouping panel. Data is first sorted by the leftmost field in the Grouping panel, then by the next field, and so on.

Once document data is grouped, you can set up data display according to several factors:

- When a user views a grouped document, drop-down lists are displayed to allow the user to select which elements, or subsets of data, to display. You can select which attribute forms are displayed in the list, and the order of the forms. For steps, see *[Displaying forms in a group, page 379]*.

- You can determine how totals are displayed. For steps, see *[Showing totals for a group, page 380]*.

### Changing the grouping order in a document

Moving a grouping field can affect whether the group of data is displayed vertically (Detail sections are displayed below the Group Header) or horizontally (Detail sections are displayed next to the Group Header, running horizontally across the page). All groups of data to the right of a horizontally displayed group must be horizontal; a document cannot contain a horizontally displayed group followed by a vertically displayed group. For the rules that govern this behavior, see *[Changing the grouping order of horizontally displayed groups, page 393]*.

When you change the grouping order, the header and footer sections of the corresponding attribute also change positions. For example, in the following image, the document is grouped by Category, and then Region. The Category Header precedes the Region Header.
When the grouping fields are switched, the Region Header precedes the Category Header, as shown below:

![Diagram showing Region and Category headers]

**Prerequisite**

- You can change the grouping order only when the document is grouped by more than one field.

---

**To change the grouping order**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. If the document contains multiple layouts, click the tab of the layout to modify.
3. From the **Tools** menu, select **Grouping**. The Grouping panel opens above the Layout area.
4. In the Grouping panel, do one of the following:
   - Right-click the grouping field to move, point to **Move**, and then select **Right** or **Left**.
   - Drag the grouping field right or left. A placeholder indicates where it will be placed. Drop it in its new location.

---

**Deleting a grouping field in a document**

If you no longer want to group data by a particular field, you can delete it. This also removes the corresponding header and footer sections of the document, including their entire contents such as text fields, lines, rectangles, images, and so on.
To delete a grouping field

1. In MicroStrategy Web, open a document in Design or Editable Mode.

2. From the Tools menu, select Grouping. The Grouping panel opens above the Layout area.

3. In the Grouping panel, do one of the following:
   - Drag and drop the grouping item to the Dataset Objects panel or click the Remove icon next to the grouping item. To display the Remove icon, select the Pivot Buttons option from the Tools menu.
   - Right-click the grouping item and select Remove.

Displaying forms in a group

When a user views a grouped document, drop-down lists are displayed to allow the user to select which elements, or subsets of data, to display. You can select which attribute forms are displayed in the list, and the order of the forms.

For example, a document is grouped by employee. By default, the employee's last name and first name are displayed, separated by a colon. You can re-arrange the attribute forms, to have the first name displayed before the last name. You can display only the ID, or display the ID and then the last name.

To display forms in a group

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. If the document contains multiple layouts, click the tab of the layout to group.

3. If the document is not already grouped, add a group, as described below:
   a. From the Tools menu, select Grouping. The Grouping panel opens above the Layout area.
   b. Right-click the object in Dataset Objects, and select Add to Grouping. The object is added to the Grouping panel.
4 In the Grouping panel, right-click the group, point to Attribute Forms, and select Custom. The Attribute Forms dialog box opens.

5 From the Available list, select the forms to display, and click the Add arrow to move them to the Selected list.

6 To change the order of the forms, select a form and click the Move down or Move up arrow to position it.

7 Click OK to return to the document.

**Showing totals for a group**

After you add a group to a document, you can allow totals to be displayed for that group. For example, the following document is grouped by Year, with a total displayed for all years:

![Grouped document example](image)

The document above shows the end result of group totals.

Other types of totals can also be displayed for users, including grand totals. For example, a document displays a Grid/Graph containing the Year attribute and Revenue metric. The document is grouped by Year. When the document is viewed as a PDF, a user can select a year and display a Grid/Graph with the data for that year, as shown below:

![Year Metrics example](image)
Alternatively, the user can display a single Grid/Graph for all the years, by selecting **All**, as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Year Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td>$9,647,236</td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td>$11,517,006</td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td>$14,858,864</td>
<td></td>
</tr>
</tbody>
</table>

Page-by allows you to display the various years or all years; for more information on page-by, see *Using page-by on a document, page 403*. If the user needs the total of all the years in the Grid/Graph, you can allow the Year group to show a Total option in the PDF. You do not need to edit the report or the Grid/Graph. When viewed as a PDF, a Total option is added to the page-by. When a user selects it, the total revenue of all the years is displayed, as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year Metrics</td>
<td>Revenue</td>
</tr>
<tr>
<td>Total</td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>

When a user selects **All** in the PDF, all the years and the total are displayed, as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Year Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>(All)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2006</td>
<td>$9,647,236</td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td>$11,517,006</td>
<td></td>
</tr>
<tr>
<td>2008</td>
<td>$14,858,864</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>

If you disable page-by, the user cannot change the page-by from the All option in the PDF. The document always displays as shown above, with all the years and the group total. For steps to disable page-by, see *Enabling page-by, page 407*. 
To show totals for a group

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. If the document contains multiple layouts, click the tab of the layout to modify.

3. If the Grouping panel is not displayed, from the Tools menu, select Grouping. It displays above the Layout area.

4. In the Grouping panel, right-click the grouping field to total, and select Grouping Properties. The Grouping Properties dialog box opens.

5. Select the Show option for Total check box.

6. Click OK.
Group totals and sorting

The group total is not affected by sorting. For example, a document contains the Year and Region attributes, as well as the Revenue metric. Group totals are displayed, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>2005</th>
<th>2007</th>
<th>2008</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$1,293,634</td>
<td>$1,667,004</td>
<td>$2,068,728</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$1,140,008</td>
<td>$1,510,592</td>
<td>$1,794,014</td>
</tr>
<tr>
<td>Northeast</td>
<td>$2,246,294</td>
<td>$2,870,291</td>
<td>$3,437,529</td>
</tr>
<tr>
<td>Web</td>
<td>$471,477</td>
<td>$1,031,392</td>
<td>$2,399,894</td>
</tr>
<tr>
<td>Total</td>
<td>$5,151,414</td>
<td>$7,087,280</td>
<td>$9,700,465</td>
</tr>
</tbody>
</table>
If you sort region in descending order, Web appears at the top but Total remains at the end of the document, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>2006</th>
<th>2007</th>
<th>2008</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web</td>
<td>$471,477</td>
<td>$1,031,392</td>
<td>$2,399,894</td>
</tr>
<tr>
<td>Southwest</td>
<td>$1,002,000</td>
<td>$1,243,847</td>
<td>$1,447,384</td>
</tr>
<tr>
<td>Central</td>
<td>$1,293,634</td>
<td>$1,667,004</td>
<td>$2,068,728</td>
</tr>
<tr>
<td>Total</td>
<td>$2,768,011</td>
<td>$3,942,243</td>
<td>$5,916,006</td>
</tr>
</tbody>
</table>

For information on sorting a group, including steps, see *Sorting records in a document, page 409*.

**How group totals impact metric calculation on Grid/Graphs**

Metric values in a Grid/Graph in the Group Header or Group Footer are calculated at the level of:

- The objects on the Grid/Graph AND
- All higher-level groups in the dataset report of the Grid/Graph, not including the current group

Higher-level groups are those groups to the left of the current group. If any of the higher-level groups is set to Total, then that object is excluded from the calculations on the Grid/Graph.

For example, a document is grouped by:

- Year
• Region
• Category

A Grid/Graph containing the Income Bracket attribute and the Revenue metric is placed in the Category Group Header section. All the groups have group totals enabled. The document is set to display the following when viewed as a PDF:

• Year = 2006
• Region = South
• Category = Books

The revenue values in the Grid/Graph are calculated for the various income brackets in the South region in 2006 for books, as shown below.

Change Category to Total. In the document sample below, the revenue amounts have increased. This is because all categories, not just books, are now included in the revenue calculation.
If you add Category to the Grid/Graph and re-execute the document, the revenue values are the same as in the previous example, and Category displays as Total in the Grid/Graph, as shown below.

<table>
<thead>
<tr>
<th>Category</th>
<th>Income Bracket</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Under 20K</td>
<td>$114,441</td>
</tr>
<tr>
<td></td>
<td>20-30K</td>
<td>$76,418</td>
</tr>
<tr>
<td></td>
<td>30-40K</td>
<td>$70,301</td>
</tr>
<tr>
<td></td>
<td>40-50K</td>
<td>$273,708</td>
</tr>
<tr>
<td></td>
<td>50-60K</td>
<td>$215,116</td>
</tr>
<tr>
<td></td>
<td>60-70K</td>
<td>$202,511</td>
</tr>
<tr>
<td></td>
<td>70-80K</td>
<td>$168,186</td>
</tr>
<tr>
<td></td>
<td>80-90K</td>
<td>$100,886</td>
</tr>
<tr>
<td></td>
<td>90-100K</td>
<td>$102,970</td>
</tr>
<tr>
<td></td>
<td>Over 100K</td>
<td>$82,235</td>
</tr>
</tbody>
</table>

If you remove Category from the Grid/Graph and set Year to Total, the revenue values in the Grid/Graph are calculated for the various income brackets in the South region, as shown below. All years and all categories are included in the calculations. If the Grid/Graph displayed Year or Category, their page-by selections would show as Total.

<table>
<thead>
<tr>
<th>Category</th>
<th>Income Bracket</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Under 20K</td>
<td>$436,959</td>
</tr>
<tr>
<td></td>
<td>20-30K</td>
<td>$356,222</td>
</tr>
<tr>
<td></td>
<td>30-40K</td>
<td>$276,627</td>
</tr>
<tr>
<td></td>
<td>40-50K</td>
<td>$1,043,643</td>
</tr>
<tr>
<td></td>
<td>50-60K</td>
<td>$748,614</td>
</tr>
<tr>
<td></td>
<td>60-70K</td>
<td>$751,026</td>
</tr>
<tr>
<td></td>
<td>70-80K</td>
<td>$546,718</td>
</tr>
<tr>
<td></td>
<td>80-90K</td>
<td>$446,900</td>
</tr>
<tr>
<td></td>
<td>90-100K</td>
<td>$384,027</td>
</tr>
<tr>
<td></td>
<td>Over 100K</td>
<td>$316,574</td>
</tr>
</tbody>
</table>

If the Grid/Graph is moved from the Category Group Header to the Region Header, the metric values are calculated differently. When Region is set to All, you cannot change Category. The revenue values are calculated for the
various income brackets in 2006, as shown below. All regions and all categories are included in the calculations.

The Region has been added to help identify the different Grid/Graphs.

**How group totals impact metric calculation in text fields**

Metric values in a Group Header or Group Footer are calculated at the level of all higher-level groups. Higher-level groups are those groups to the left of the current group (the group creating the grouping section).

The document in this example contains text fields and metrics, and is grouped by Year, Region, and Category.

All the groups have group totals enabled. The Year Header section displays the year selected in the page-by, the Region Header section displays the
region, and the Category Header displays the category and the Revenue metric. The image below shows the document in Desktop.

The document is set to the following for viewing as a PDF:

- Year = 2006
- Region = South
- Category = All

The document, as shown below, now displays the revenue for each category, as well as a total (because group totals are enabled). For the group total, the dynamic text field for Category is replaced by the word Total. For each category, the revenue is calculated for the selected year and selected region. For the category total, the revenue is calculated at the region level, for the selected year (that is, all categories for South in 2006).

If you switch Category to Total, only one line item, the category total, is displayed. The revenue includes all categories for only the South region and
2006. The total shown below is the same as the total in the previous document sample.

![Table with values: Year 2006, Region South, Category Total, $1,415,767]

If you change Year to Total and Category to All, the revenue calculated is for the South, for all years, and for each category. The revenue amount for category total is much higher than the previous sample, because it contains all years, not just 2006.

![Table with values: Year Total, Region South, Category All, revenue for each category]

These examples demonstrate that metric values in a Group Header or Group Footer are calculated at the level of all higher-level groups. Higher-level groups are those groups to the left of the current group (the group creating the grouping section).

### Displaying a group horizontally

By default, groups are displayed vertically in a document. This means that the detail sections are displayed below the Group Header. For example, a document is grouped by Year. The Detail section includes revenue and profit...
information by region. Displaying the group vertically yields the following document:

<table>
<thead>
<tr>
<th>Year</th>
<th>Central</th>
<th>Mid-Atlantic</th>
<th>Northeast</th>
<th>Northwest</th>
<th>South</th>
<th>Southeast</th>
<th>Southwest</th>
<th>Web</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$1,293,634</td>
<td>$1,140,008</td>
<td>$2,246,294</td>
<td>$480,476</td>
<td>$1,415,767</td>
<td>$596,631</td>
<td>$1,002,990</td>
<td>$471,477</td>
</tr>
<tr>
<td></td>
<td>$196,301</td>
<td>$171,354</td>
<td>$339,961</td>
<td>$71,118</td>
<td>$216,542</td>
<td>$89,567</td>
<td>$149,986</td>
<td>$69,301</td>
</tr>
</tbody>
</table>

For certain documents, displaying and printing the group horizontally is desired. When displayed horizontally, the detail sections are displayed next to the Group Header, running horizontally across the page.

The example given above, if displayed horizontally, shows a row containing the year, and then, for each region, the Region, Revenue, and Profit. When the document is viewed as a PDF, it displays as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Central</th>
<th>Mid-Atlantic</th>
<th>Northeast</th>
<th>Northwest</th>
<th>South</th>
<th>Southeast</th>
<th>Southwest</th>
<th>Web</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$1,293,634</td>
<td>$1,140,008</td>
<td>$2,246,294</td>
<td>$480,476</td>
<td>$1,415,767</td>
<td>$596,631</td>
<td>$1,002,990</td>
<td>$471,477</td>
</tr>
<tr>
<td></td>
<td>$196,301</td>
<td>$171,354</td>
<td>$339,961</td>
<td>$71,118</td>
<td>$216,542</td>
<td>$89,567</td>
<td>$149,986</td>
<td>$69,301</td>
</tr>
</tbody>
</table>

When being designed, the document with horizontal display looks like the following in Desktop:

The sections within the group are turned sideways and listed horizontally, across the page. These horizontally rendered sections are the Group Header and Footer (in this case, Year), the Detail Header, the Detail, and the Detail Footer. They are displayed in the same order as when shown vertically. The Page and Document sections are still listed vertically.

You can also change the orientation of only the lower level detail sections. In the following sample, the Detail Header, Detail, and Detail Footer are
displayed horizontally while the Group Header and Group Footer are displayed vertically:

<table>
<thead>
<tr>
<th></th>
<th>Central</th>
<th>$1,292,634</th>
<th>$196,301</th>
<th>Mid-Atlantic</th>
<th>$1,400,000</th>
<th>$171,354</th>
<th>Northwest</th>
<th>$2,246,294</th>
<th>$339,961</th>
</tr>
</thead>
</table>

You can also display the Detail Header and Detail Footer vertically while keeping the Detail section horizontal. A document does not have to be grouped to allow these sections to be displayed horizontally. For information on displaying sections horizontally without groups, see *Displaying sections horizontally, page 293.*

Horizontally displayed sections have additional options to control the horizontal width. For more information, see *Changing the horizontal width of a section, page 299.*

**Prerequisite**

- This procedure assumes that the document is already grouped.

---

**To display a group horizontally**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Grouping**. The Grouping panel is displayed.
3. In the Grouping panel, right-click the grouping field to display horizontally, and select **Grouping Properties**. The Grouping Properties dialog box opens.
4. Select the **Render the object name horizontally** check box.
5. Click **OK** to apply the changes and return to the document.
Adding more grouping fields to horizontally displayed groups

When you add another grouping field, its location in the Grouping panel controls whether it is displayed and printed horizontally or vertically, as described below:

- All groups to the right of a horizontally displayed group display horizontally. Therefore, if you add the field to the right of a horizontally repeating group, the new group is displayed horizontally.

- If you add the field to the left of all horizontally displayed groups, the new group is displayed vertically.

For example, continuing with the previous example, add Region to the right of Year in the Grouping panel. The Region Header and Region Footer sections are displayed horizontally, as shown below:
If you add Region to the left of Year instead, the Region Header and Region Footer are displayed vertically, as shown below:

If you then add Category between Region and Year in the Grouping panel, Category is displayed vertically. This occurs because Category is to the left of the horizontally displayed group.

**Changing the grouping order of horizontally displayed groups**

If you move a group on the Grouping panel, thereby changing the grouping order, only the moved group changes its orientation. This means that, if you move a horizontally displayed group, that group can become vertically displayed, if necessary, but the orientation of no other groups change. If you move a vertically displayed group, that group can become horizontally displayed, if necessary, but no other orientation changes.

All groups to the right of a horizontally displayed group must be horizontal; a document cannot contain a horizontally displayed group followed by a vertically displayed group.

If you move a horizontally displayed group, its orientation depends on the orientation of the groups to its right. The following rules determine whether it remains horizontal or changes to vertical:

- If you move a **horizontally** displayed group to the **left**, and if **all groups to the right are horizontal**, then the moved group remains **horizontal**.
And if at least one group to the right is vertical,
Then the moved group is rendered vertically

- If you move a horizontally displayed group to the right,
  - All groups to the right must be horizontal by definition,
  
  So the moved group remains horizontal

If you move a vertically displayed group, its orientation depends on the orientation of the groups to its left. The following rules determine whether it remains vertical or changes to horizontal:

- If you move a vertically displayed group to the right,
  - And if all groups to the left are vertical,
    Then the moved group remains vertical
  
  - And if at least one group to the left is horizontal,
    Then the moved group is displayed horizontally

- If you move a vertically displayed group to the left,
  - All groups to the left must be vertical by definition,
  
  So the moved group is displayed vertically

For example, a document is grouped by Year, Region, and Category, left to right. Year is displayed vertically; Region and Category are displayed horizontally, as depicted in the following table:

<table>
<thead>
<tr>
<th>Year</th>
<th>Region</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Region</td>
<td>Category</td>
</tr>
</tbody>
</table>

You move Category all the way to the left, past Year. Category becomes vertical, because a group to the right (Year) is vertical. The result is shown below.

<table>
<thead>
<tr>
<th>Category</th>
<th>Year</th>
<th>Region</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
You move Year to the right, after Region. Year becomes horizontal, because all groups to the right of a horizontal group must be horizontal.

You move Region to the left, before Category. Region becomes vertical, because a group to the right (Category) is vertical.

### Hiding Group Header and Group Footer sections

For each grouping field, you can specify whether the Group Header and/or Group Footer sections are displayed. For example, a document is grouped by Region and State. You want to display a header for each state, to identify the state. You also want a footer for each state, with various metrics totaled at the state level. You want to display a header for each region to identify the region, but you do not need a footer related to Region. To do this, you can hide the footer section for Region.

By default, a Group Header section and a Group Footer section are displayed for each grouping item.
To hide a Group Header or Group Footer section

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. In the Grouping panel, right-click the grouping field for which you want to hide the header or footer and select Grouping Properties. The Grouping Properties dialog box opens.

3. To hide the header section, clear the Show name of object header check box.

4. To hide the footer section, clear the Show name of object footer check box.

5. Click OK to apply the changes.

Adding a page break for a group

You can add page breaks whenever a new group begins. For example, if your document is grouped by Region, you may want each region to start printing on a new page. Add a page break for the Region Header section in the Layout area of the document.

You can use page breaks between groups and fit to page scaling to print each group on a single page. For more information on print scaling, see Modifying page setup options, page 346. For examples of these settings in use, see Printing a document on a single page, page 348. You can also add page breaks between sections. For more information, see Adding a page break to a document, page 343.

Options related to pagination apply when the document is viewed as a PDF.

To add a page break for a group

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. In the Grouping panel, right-click the grouping field for which you want the page break, and select Grouping Properties. The Grouping Properties dialog box opens.
3 Select the **Page break between groups** check box.

4 Click **OK** to apply the changes and return to the document.

## Resetting page numbers for each group

If you intend to restart page numbering for a group’s new section, use the Restart page numbering and Page break between groups settings.

This also changes the value of the auto text code for total page numbers `{&NPAGES}`, which is normally the total number of pages in the document, to the number of pages in that group’s section. (For details on auto text code, see *Adding dynamic data to a document, page 83*.)

For example, if you have an eight-page document with no grouping, the `{&NPAGES}` code resolves to 8 (page 1 of 8, 2 of 8 .. 8 of 8). But if you group the document by Region, then add a page break and restart numbering for it, the `{&NPAGES}` code resolves to the number of pages in each Region’s individual section. So, if the Region has the following sections, the pages in each section are numbered as follows:

Southeast 2 (page 1 of 2, 2 of 2)

Mid-Atlantic 2 (1 of 2, 2 of 2)

Northwest 3 (1 of 3, 2 of 3, 3 of 3)

Northeast 1 (1 of 1)

Properties related to pagination apply to when the document is viewed as a PDF.

---

**To reset page numbering for a group**

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2 In the Grouping panel, right-click the grouping item and select **Grouping Properties**. The Grouping Properties dialog box opens.

3 Select the **Page break between groups** check box.

4 Select the **Restart page numbering** check box.
5 Click **OK** to apply the changes and return to the document.

**Repeating a Group Header section on another page**

If all of the data within a group cannot fit on one page and you want the group’s header information to print on all overflow pages, use the Repeat on each page setting.

---

**To repeat a Group Header section on each page**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Format** menu, select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. On the **Layout** tab, in the **PDF** area, select the **Repeat on each page** check box.
4. Click **OK** to apply the changes and return to the document.

**Keeping the data in a group together on a page**

You may want to keep a page break from occurring within a group, which includes everything from its Group Header to its Group Footer and all the content in between. To do this, define that the group is kept together. If the group does not fit entirely on a page, it starts on a new page and any overflow prints on successive pages.

You can also keep data for a section together in a similar manner. For more information, see *Keeping the contents of a section together*, page 306.

---

**To keep a group together on a page**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. In the Grouping panel, right-click the grouping field for the group that you want to keep together and select **Grouping Properties**. The Grouping Properties dialog box opens.
3 In the PDF area, select the **Keep group together** check box.

4 Click **OK** to apply the changes and return to the document.

### Applying grouping selections to the current layout or all layouts

By default, a user’s grouping selections apply only to the current layout. You can specify that the grouping selection is retained when a user switches layouts in MicroStrategy Web, if the new layout contains the same grouping field as the original layout.

For example, a document contains two layouts. Both are grouped by Region. When a user opens the document in Interactive Mode, Layout 1 is displayed, showing only Northeast’s revenue. The user selects South in the page-by drop-down list. Layout 1 now displays South’s revenue, as shown below:

![Layout 1 with South selected](image)

When the user switches to Layout 2, the page-by is set to Northeast, the same as the initial view of the original layout, Layout 1. The grid report on Layout 2 displays all the employees for the Northeast, as shown below:

![Layout 2 with Northeast](image)
You can change the document to apply the grouping selection to all layouts. In Layout 1, the user again selects South in the page-by list, before switching to Layout 2. Layout 2 now displays all the employees for the South in the graph report, as shown below:

### Prerequisites

- The following procedure assumes that the document:
  - Contains multiple layouts. For steps, see *Creating a multi-layout document, page 482*.
  - The multiple layouts are grouped by the same grouping field. (Only layouts with the same grouping field are affected by this setting.) For steps, see *Grouping records in a document, page 374*.

### To apply grouping selections to all layouts in a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. On the left, under Document Properties, click **Advanced**.
4. By default, grouping selections apply only to the current layout. To apply grouping selections to all layouts that contain the same grouping field, select the **Apply grouping selection to all layouts** check box.
5. Click **OK** to apply the changes and return to the document.
Specifying that groups are exported to separate Excel worksheets

When you export a grouped document to Excel, you may want to place each element (or page) of a grouping field in its own worksheet, in the same Excel workbook. By default, all elements/pages are exported to the same Excel worksheet.

For example, a document is grouped by Region. When it is exported to Excel, all the regions are included in the same worksheet, as shown below. The Excel workbook contains only one tab, named Regional grouping (the document name).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Central</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Ellerkamp: Nancy</td>
<td>$1,169,245</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Gale: Loren</td>
<td>$2,262,146</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Torrison: Mary</td>
<td>$2,364,993</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Zemlicka: George</td>
<td>$1,116,549</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Mid-Atlantic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Bernstein: Lawrence</td>
<td>$5,295,910</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Brown: Vernon</td>
<td>$1,803,732</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Corcoran: Peter</td>
<td>$1,709,388</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Folks: Adrienne</td>
<td>$5,708,091</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Hollywood: Robert</td>
<td>$5,272,618</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Ingles: Walter</td>
<td>$1,013,388</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Smith: Thomas</td>
<td>$1,183,056</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Young: Sarah</td>
<td>$1,192,641</td>
<td></td>
</tr>
</tbody>
</table>

If you specify instead that each group is exported to a separate worksheet, the same document looks like the following after being exported to Excel:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Central</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Ellerkamp: Nancy</td>
<td>$1,169,245</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Gale: Loren</td>
<td>$2,262,146</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Torrison: Mary</td>
<td>$2,364,993</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Zemlicka: George</td>
<td>$1,116,549</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The displayed worksheet lists only those employees in the Central region. Each region has its own tab, labeled with the document name and a number (1 of 8, 2 of 8, and so on).

If you add Call Center to the grouping panel, to the right of Region, when you export the document to Excel, each Call Center is placed in its own worksheet, as shown below:

![Image of Excel file with grouped data]

The Excel file contains 15 tabs now, one for each Call Center.

If you change the grouping settings of Region so that regions are not exported to separate worksheets, the exported file looks like the following:

![Image of Excel file with ungrouped data]

Now only one worksheet is created. When a group is exported to a single worksheet, any of its sub-groups (which are groups to the right of it in the Grouping panel) must also be exported to a single worksheet.
To export a group to separate Excel worksheets

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. If the document contains multiple layouts, click the tab of the layout that you want to modify.

3. In the Grouping panel, right-click the grouping item and select Grouping Properties. The Grouping Properties dialog box opens.

4. Select the Sheet break between groups check box.

   This option is not available if there is a group to the left of the selected group and either of the following is true:
   - The group to the left of the selected group is not defined to export to separate Excel worksheets.
   - The group to the left of the selected group is defined to display horizontally.

5. Click OK to apply changes and return to the document.

To export the document to Excel, click the PDF icon in the toolbar to view the PDF, and then select Export to Excel from the File menu.

For detailed steps to export to Excel, see the Document and Dashboard Analysis Guide.

Using page-by on a document

You can use page-by to interactively display groups on separate pages of the document. This is useful when a document returns a very large set of data in its results. Analysts can use page-by when viewing the document in MicroStrategy Web or when viewing the PDF version of the document.

Page-by allows the end user to select and dynamically display elements from a grouping field as criteria for analysis. The PDF that results from this selection is called a page of the original document. By displaying different criteria for analysis, pages provide an added level of data manipulation and display.
For example, a document displays revenue and profit data and is grouped by Region and then Year. By default, both Region and Year are included in the page-by field at the top of the document. Analysts can select a specific region and year from the page-by field, to display the data for the selected region and year combination. The following sample shows the data for the Northeast region in 2006.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>2006</td>
<td>$339,961</td>
<td>$2,246,294</td>
</tr>
</tbody>
</table>
You can also see the data for all years for a particular region or all data in the document, regardless of region or year. The following sample shows all the data in the document.

Page-by is automatically enabled when you use grouping fields as part of your organization of a document’s data. You can group data based on attributes, consolidations, and custom groups. You cannot page by metrics.

If you display totals for a group, an option named Total is displayed in the drop-down menu for that group when the document is viewed as a PDF. For examples of group totals and steps to display them, see *Showing totals for a group, page 380*. 
You can control how the page-by is exported to Excel or PDF, by choosing whether to export only the current page-by selection or the whole document. For more information, see Formatting a document for export, page 363.

**Page-by on a document with multiple datasets**

If a document has multiple datasets, the elements available in the grouping fields are the elements available in the target (what is being grouped). If the target is filtered, the grouping elements are also filtered.

For example, a document uses two datasets. Both datasets contain Category and Revenue, but one is filtered to include only the Books and Movies categories. The unfiltered dataset is used to create a Grid/Graph (the title bar contains the name of the report). The filtered dataset is the grouping and sorting dataset. The document is grouped by Category. As shown in the example below, you can select any of the categories in the page-by:

![Image of grouping and sorting fields]

If the filtered dataset is used to create a Grid/Graph (notice that the name of the Grid/Graph has changed in the title bar), you can select only Books and Movies, as shown below:

![Image of filtered grouping and sorting fields]

If a Grid/Graph for each dataset is added to the document, you can select any of the categories in the page-by, because the grouping elements come from all of the targets. In this case, the targets are the two Grid/Graphs, which contain all categories. If you select a category that is not included in the
filtered dataset, the corresponding Grid/Graph cannot display the data, as shown below:

![Grouping and Filtered Dataset](image)

### Enabling page-by

If you have used grouping fields to organize data in the document, then by default page-by is enabled for all grouping fields. For steps to use grouping fields, see *Grouping records in a document, page 374*.

The steps below show you how to enable page-by on a grouping field if page-by has previously been disabled.

**To enable page-by**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Grouping**.
3. In the Grouping panel, right-click the grouping field on which to enable page-by and select **Grouping Properties**. The Grouping Properties dialog box opens.
4. From the **Page-by Mode** drop-down list, select one of the following options:
   - **Page-By (Single Element Only)**: Enables page-by for this group, but you cannot display all the elements of the group simultaneously when the document is viewed as a PDF or in HTML. This option is useful for
groups with many elements, when you do not want to display all the elements at one time.

- When a document contains multiple groups, this option is unavailable for the group farthest to the right in the Grouping panel.

- **Page-By (Single Element or All)**: Enables page-by for this group and allows all elements of the group to be displayed simultaneously.

5 Click **Apply** to apply your selections.

## Disabling page-by

By default, page-by is enabled for all the grouping fields in a document. If you disable page-by for a particular grouping field, any fields to the right of it in the Grouping panel are also disabled. You can also leave page-by enabled but prevent the simultaneous display of all the elements. This can be useful for grouping fields that have many elements. For steps, see *Enabling page-by, page 407.*

If you disable page-by for a group that has totals, the group total is still shown but you cannot display totals only. See *Showing totals for a group, page 380* for an example of group totals.

---

**To disable page-by or disable display of all elements**

1 In **MicroStrategy Web**, open the document in **Design** or **Editable Mode**.

2 From the **Tools** menu, select **Grouping**. The Grouping panel is displayed.

3 In the Grouping panel, right-click the grouping field on which to disable page-by, and select **Grouping Properties**. The Grouping Properties dialog box for that grouping field opens.

4 To disable page-by, from the **Page-By Mode** drop-down list, select **No Page-By (All Only)**. Disabling this causes the All option to be disabled when the document is viewed as a PDF.

- Page-by for any grouping fields to the right of the selected field in the Grouping panel is also disabled.

5 Click **Apply** to apply your changes.
Sorting records in a document

A document’s data is sorted according to its group settings, such as whether page-by is enabled. You may want to control its sorting further. The order of the sort keys (the sort-by fields) is defined by the order of the groupings, as described in *Grouping records in a document, page 374.*

For example, you may want to sort the information in the document’s Detail section. If you have a document grouped by Region and Year in the Detail section, you may want to sort the records by Revenue in descending order.

For a document with multiple datasets, you can sort based on objects from the grouping and sorting dataset only.

You can sort each layout of a multi-layout document independently. For more information on multi-layout documents, including which options apply to the document as a whole or to individual layouts, see *Creating multi-layout documents, page 476.*

You can sort consolidations. If the object is a consolidation, an ascending sort displays the elements in the order in which they were defined. Descending order reverses that order.

To sort based on a custom group or consolidation, you must use MicroStrategy Desktop. For details, see the *Desktop Help.*

---

**To sort records and grouping fields in a document**

1. In MicroStrategy Web, open a document in Design or Editable Mode.

2. If the document contains multiple layouts, click the tab of the layout to modify.

3. From the Data menu, select Sort Document. The Sort Document dialog box opens.

4. Perform the appropriate steps below, depending on whether you are sorting records or sorting grouping fields:
   - To sort records in a document:
     a. In the Detail area, from the Sort By drop-down list, select the object to sort. If the Sort By object is an attribute, select the attribute form (such as ID or description) to sort on.
The list contains all attributes and metrics in the grouping and sorting dataset, regardless of where or whether they are placed on the document.

b Select the order in which you want to sort the object.

c From the Then By drop-down lists, specify additional sort objects as necessary. These objects are sorted after the Sort By object.

- To sort grouping fields:
  - In the Grouping area, select Ascending or Descending from the drop-down list adjacent to each grouping field to sort it in that order.

You cannot change the sorting order of an attribute if it is set to Default. To change the order, select the attribute form (such as the ID or DESC) from the drop-down list adjacent to the attribute you want to sort.

5 Click OK to apply the changes and return to the document.
**Introduction**

A link is a connection in a document to another document, a report, or a web page. A link lets an analyst execute another document or report (the target) from a link in the document (the source).

- The link can automatically pass parameters to answer any prompts that are in the target. For example, if a user is viewing a document containing regional sales, he can click a particular region to execute another document that displays sales for the stores in that region.

- The link can automatically pass values chosen in a selector in the source to a selector in the target. A selector allows each user to interact with a Report Services (RS) dashboard to display only the subset of data he is interested in or only specific attribute elements or metrics. For example, the regional sales document also contains a selector for year. The user chooses a specific year in the selector, and then clicks a link to execute another document that displays sales for the months in that year.

For information on selectors, including a more detailed description, examples, and steps to create them, see the Selectors chapter of the *Dashboards and Widgets Creation Guide*. 
• The source document can link to its underlying dataset report, to display profit and cost values as well as sales data.

• The source document can link to a web page that contains economic information about the region.

This chapter explains how to create new opportunities for guided analysis using links.

Creating links in a document

Linking documents is a tool to provide investigative workflows. You can use links to let users navigate from data at one level to different levels of aggregation. For example, a document contains data about salaries and bonuses at the departmental level. One link on department can display a document with information about individual employees, while a second link displays information for the various business units. Another link executes a breakdown by the projects that the department is currently working on. Or you can use an object (such as an attribute element) on a document to trigger the execution of another document or a report that is substantially different from the original document. For example, a user viewing an Employee detail document can click a link to execute a Regional Sales Breakdown document, or click a link on a Profit and Loss report to view a Departmental Summary document.

A link is a connection in a document to another document, a report, or a web page. A link lets an analyst execute another document or report (the target) from a document (the source). The link can pass parameters to answer any prompts that are in the target. The link can also pass selector values from the source to the target.

Compare a link to a hyperlink, which is a connection in a document to a web page. A hyperlink is functional in PDF View in Desktop and in Express Mode in MicroStrategy Web. (A hyperlink is also functional in Interactive Mode and Editable Mode in Web.) For details on hyperlinks, see Defining hyperlinks in documents, page 439.

Different objects on a document can have different links. For example, the Region attribute in a regional revenue document can link to a yearly revenue document, while the Revenue metric can link to a document with revenue forecasts and other key performance indicators.

A link can also connect a text field or an image to a web page. When the document is viewed as a PDF or in MicroStrategy Web, a user can click the
link to navigate to the link’s target, which can open in a new window or open in the same window as the document.

Links can be created and used in the following ways:

- Link from a text field or image to a web page, report, or another document
- Link from an attribute, metric, hierarchy, or object prompt on a Grid/Graph to a report or another document
- Link from a Grid/Graph to its underlying dataset
- Link from a button to a web page, report, or another document
- For widgets, link from an attribute on the widget to a report or another document
- A link can automatically answer prompts in the target in a variety of ways, including using existing prompt answers from the source dataset, using the objects selected in the source dataset, running the prompts, sending a list of elements, and others
- A link can automatically pass the source’s selector choices to the selectors in the target

The following table describes options that allow a user to interact with a document using links. The table helps you to decide what link to create to achieve your goals.

<table>
<thead>
<tr>
<th>Goal</th>
<th>What To Create</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to a web page for a document viewed in Express Mode</td>
<td>A text field or image that is defined as a hyperlink. A user can click a hyperlink on an image or a text field to open a web page. Hyperlinks work in Express Mode, Interactive Mode, and Editable Mode in MicroStrategy Web. See <em>Defining hyperlinks in documents, page 439.</em></td>
</tr>
<tr>
<td>Link to a web page for a document viewed in any mode except PDF View</td>
<td>A link in a text field, a button, or an image. A user can click a link on an image, a button, or a text field to open a web page. Links work in all modes except PDF View in Desktop; for viewing in PDF View, use a hyperlink instead. See <em>Linking to a web page, page 415.</em></td>
</tr>
<tr>
<td>Link to a report or a document with no prompts</td>
<td>A link in an image, a text field, a button, or an object in a Grid/Graph. See <em>Specifying how prompts are answered in the target, page 427.</em></td>
</tr>
<tr>
<td>Goal</td>
<td>What To Create</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td>Link to a report or document that requires prompts to be answered</td>
<td>A link in a text field, an image, a button, or an object on a Grid/Graph. The link contains prompt information. The target document/report contains a prompt and the link contains information to answer that prompt. Information to answer the prompt can therefore be passed from the source document to the target. See <em>Specifying how prompts are answered in the target, page 427</em>.</td>
</tr>
<tr>
<td>Link to a document that contains selectors</td>
<td>A link in a text field, an image, a button, or an object on a Grid/Graph. The link contains selector values. Both the target and source documents contain the same selector, and the link contains the values chosen in the target's selector. The target's selector values are applied to the source's selectors. See <em>Passing selector values from the source to the target, page 438</em>.</td>
</tr>
<tr>
<td>Link a Grid/Graph (not an object on a Grid/Graph) to its underlying dataset</td>
<td>A link in the Grid/Graph to its dataset. In Interactive and Editable Mode, this link is provided automatically. You can use a text field to link a Grid/Graph to its related dataset report for Express and Flash Mode. The text field contains the link that executes the dataset report. See <em>Linking a Grid/Graph to its underlying report, page 229</em>.</td>
</tr>
<tr>
<td>Drill down, up, or across attributes, custom groups, or consolidations in a Grid/Graph</td>
<td>Enable drilling in the Grid/Graph. (A link does not have to be created.) You can drill on a Grid/Graph in Interactive Mode and Editable Mode in MicroStrategy Web. You can drill down, up, or across attributes, custom groups, and consolidations displayed in a Grid/Graph, if drilling is enabled. See <em>Drilling in Grid/Graphs, page 238</em>.</td>
</tr>
<tr>
<td>Interact with panel stacks</td>
<td>Selector. A selector allows the user to: • Change panels in a panel stack • Display different elements of attributes, custom groups, or consolidations in a panel stack using dynamic text fields Selectors are functional in Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web. See the <em>Dashboards and Widgets Creation Guide</em> for steps to create panel stacks and selectors.</td>
</tr>
</tbody>
</table>
For steps to add a link to a document, see *Adding a link to a document*, page 424.

For information on how these options work together, see *How links, drilling, and selectors work together*, page 446.

For documents displayed on mobile devices, you can create links to reports and other documents. You can also create links that interact with applications installed with the mobile device, such as email or text messaging. For examples and steps, see the *Mobile Design and Administration Guide*.

For steps to add a link to a widget, see the *Dashboards and Widgets Creation Guide*.

### Linking to a web page

You can link a text field or an image in a document to a web page. When the document is viewed in MicroStrategy Web, a user can click the link to navigate to the link’s target web page.

If you intend the document to be viewed by users in PDF View in Desktop, use a hyperlink instead of a link. For steps, see *Defining hyperlinks in documents, page 439.*

<table>
<thead>
<tr>
<th>Goal</th>
<th>What To Create</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display different objects on a Grid/Graph</td>
<td>Selector. A selector allows a user to display different metrics or different elements of attributes, custom groups, or consolidations in a Grid/Graph. Selectors are functional in Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web. See the <em>Dashboards and Widgets Creation Guide</em> for steps to create selectors.</td>
</tr>
<tr>
<td>Email, export, or subscribe to a document or report</td>
<td>A link with a URL made up of the object ID and specific link syntax. You type the link URL. The user can click the link to email, export, or subscribe to the target. You need to know the link syntax and find the object ID. See <em>Defining hyperlinks in documents, page 439.</em></td>
</tr>
</tbody>
</table>
For example, you can define a link on a logo. When a user hovers the pointer over the logo, it changes to a hand to indicate the link, as shown below:

![Logo with link](image)

When a user clicks the logo, your home page is displayed.

You can also link a text field to a web page. In the following example, Region is linked to a dummy web site, www.example.com. The various regions are underlined, indicating that a link exists. When a user hovers the cursor over a region, the pointer changes to a hand, also indicating a link. This is shown below, in Interactive Mode in MicroStrategy Web.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp:Nancy</td>
<td>$347,227</td>
</tr>
<tr>
<td>Central</td>
<td>Gale:Loren</td>
<td>$1,569,290</td>
</tr>
<tr>
<td>Central</td>
<td>Torisson:Mary</td>
<td>$1,590,350</td>
</tr>
<tr>
<td>Central</td>
<td>Zemlicka:George</td>
<td>$322,500</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein:Lawrence</td>
<td>$1,060,632</td>
</tr>
</tbody>
</table>

When a user clicks a region, the www.example.com website is displayed.

You can add pop-up text to display information about the link. In the above examples, the pop-up text can display the URL or a description of the website. For steps, see Creating a pop-up tooltip, page 270.
**Multiple links on the same object**

An object in the source document can have more than one link. The same object can be linked to different web pages, or even to reports and documents. One of the links is designated as the default; when a user clicks the object, the default link is used. To access other links, the user right-clicks the object to choose from a list of links. The list of links is available in Interactive Mode and Editable Mode. The default link works in Interactive, Editable, and Flash modes.

You can allow users to view the list of links for Grid/Graphs in Flash Mode by enabling data manipulations. For steps, see *Enabling filtering, drilling, and moving objects for Grid/Graphs in Flash Mode, page 247.*

For example, in the report below, if the user clicks directly on a region, the default link is executed. But if the user right-clicks a region and points to **Links**, a list of all the links for that object is displayed and the user can select which link they want to execute.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bates</td>
<td>South</td>
<td>$1,068,907</td>
<td>$904,996</td>
<td></td>
</tr>
<tr>
<td>Becker</td>
<td>North</td>
<td>$503,234</td>
<td>$430,346</td>
<td></td>
</tr>
<tr>
<td>Bell</td>
<td>South</td>
<td>$1,040,481</td>
<td>$883,441</td>
<td></td>
</tr>
<tr>
<td>Benner</td>
<td>South</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bernstein</td>
<td>Midwest</td>
<td>$441,073</td>
<td>$901,702</td>
<td></td>
</tr>
<tr>
<td>Brown</td>
<td>Midwest</td>
<td></td>
<td>$280,504</td>
<td></td>
</tr>
<tr>
<td>Conner</td>
<td>South</td>
<td>$1,650,742</td>
<td>$1,397,270</td>
<td></td>
</tr>
<tr>
<td>Corcoran</td>
<td>Mid-Atlantic</td>
<td>$325,147</td>
<td>$275,752</td>
<td></td>
</tr>
</tbody>
</table>

**Dynamic text in links**

The target URL can include dynamic text, which changes the URL depending on the data in the document. For example, your company has a website with pages for each region. The link can access the specific page for each region. To do this, include the Region attribute in the URL, as in *http://www.example.com/{Region}.htm.* **Dynamic text must be typed within braces {}**.

Dynamic text can be either:

- A data field (a metric, attribute, and so on) providing data from the dataset
• An auto text code providing information on a setting of the document or dataset, such as the document name or a prompt answer

For more information on the syntax of dynamic data fields, see *Adding dynamic data to a document, page 83*. For more information on the syntax of auto text codes, see *Displaying document and dataset report information: Auto text codes, page 88*.

## Linking to other documents and to reports

You can link to other documents and reports from a text field in a document, from an image in a document, or from objects on a Grid/Graph or widget in a document.

The link connects an object in one document (the source) to another document or a report (the target). You can have the link answer prompts in the target document/report. Answering prompts allows the link to pass information from the source document to the target. For details on how prompts can be answered by a link, with examples, see *Specifying how prompts are answered in the target, page 427*.

You can have the link specify selector values in the target document. Specifying selector values allows the link to pass information from the source to the target. For details on how selector values can be passed in a link, with examples, see *Passing selector values from the source to the target, page 438*.

Links can connect to reports and documents on any level. A regional document can contain a link to its underlying dataset report, which displays profit and cost values as well as sales, all at the regional level. Another link in the same document can execute a document with additional information about the selected region, such as employees, market saturation, and so on.

## Using links as a form of drilling

You do not need to use links to provide drilling from a document’s Grid/Graph. You can enable drilling for a Grid/Graph, which allows users to drill up, down, or across attributes, custom groups, and consolidations displayed in the Grid/Graph; for steps, see *Drilling in Grid/Graphs, page 238*. Links are one way to simulate drilling in a document.

Links can provide drilling in documents, when you define the links to navigate from data at one level to different levels of aggregation. For
example, if a user is viewing a document containing regional revenue, he can click a link on a particular region to execute another document that displays sales for the call centers in that region. Essentially, the user has drilled down from Region to Call Center. The original document is shown below, in Interactive Mode in MicroStrategy Web.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
</tr>
</tbody>
</table>

After the user clicks the link on Central, this document is executed:

<table>
<thead>
<tr>
<th>Call Center</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Milwaukee</td>
<td>$4,182,139</td>
</tr>
<tr>
<td>Fargo</td>
<td>$847,227</td>
</tr>
</tbody>
</table>

The drilling is accomplished by linking to a prompted document and passing prompt answers in the link. For details on passing prompt information, see *Specifying how prompts are answered in the target, page 427*.

A second link on region in the source document can take the user from the regional sales document to another document that displays sales by country. The user has then drilled up from Region to Country. In the following sample, the user has drilled from Central to all countries.

<table>
<thead>
<tr>
<th>Country</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>$31,120,946</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

In previous versions, linking or drilling to reports and documents was accomplished with drill links.

**Linking from a text field**

A text field can be linked to a web page, a report, or another document.

The underlined text in the following document, which is shown in Editable Mode in MicroStrategy Web, indicates the links. Note that both the revenue
data (indicated by the hand pointer in the image) and the metric headers (the text 2005 Revenue, 2006 Revenue, and 2007 Revenue) are linked.

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>2005 Revenue</th>
<th>2006 Revenue</th>
<th>2007 Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Books</td>
<td>$64,368</td>
<td>$83,697</td>
<td>$103,215</td>
</tr>
<tr>
<td>Central</td>
<td>Electronics</td>
<td>$1,393,794</td>
<td>$1,665,319</td>
<td>$2,247,755</td>
</tr>
<tr>
<td>Central</td>
<td>Movies</td>
<td>$85,247</td>
<td>$76,243</td>
<td>$99,515</td>
</tr>
<tr>
<td>Central</td>
<td>Music</td>
<td>$300,306</td>
<td>$356,773</td>
<td>$455,703</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Books</td>
<td>$54,763</td>
<td>$70,210</td>
<td>$85,347</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Electronics</td>
<td>$5,971,153</td>
<td>$7,460,047</td>
<td>$9,134,630</td>
</tr>
</tbody>
</table>

If you click the link indicated by the hand pointer, the following report is executed. It provides data for the selected Region (Central), Category (Books), and Year (2006).

If you click the link on the text 2006 Revenue instead, the following report is executed. It is the same report as the previous report, but contains all regions.
and all categories, but only 2006 data. (Only a portion of the report is shown below.)

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Revenue</th>
<th>Units Sold</th>
<th>Last Year's Revenue</th>
<th>Last Year's Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Books</td>
<td>$93,507</td>
<td>6,178</td>
<td>$84,363</td>
<td>4,139</td>
</tr>
<tr>
<td>Central</td>
<td>Electronics</td>
<td>$1,665,010</td>
<td>4,980</td>
<td>$1,303,704</td>
<td>4,023</td>
</tr>
<tr>
<td>Central</td>
<td>Movies</td>
<td>$76,243</td>
<td>4,947</td>
<td>$85,247</td>
<td>4,153</td>
</tr>
<tr>
<td>Central</td>
<td>Music</td>
<td>$58,773</td>
<td>24,263</td>
<td>$300,306</td>
<td>20,418</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Books</td>
<td>$70,210</td>
<td>4,285</td>
<td>$54,783</td>
<td>3,469</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Electronics</td>
<td>$7,600,047</td>
<td>21,431</td>
<td>$5,871,153</td>
<td>17,351</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Movies</td>
<td>$67,772</td>
<td>4,395</td>
<td>$53,028</td>
<td>3,425</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Music</td>
<td>$84,768</td>
<td>4,285</td>
<td>$51,983</td>
<td>3,513</td>
</tr>
<tr>
<td>Northeast</td>
<td>Books</td>
<td>$88,781</td>
<td>41,212</td>
<td>$820,702</td>
<td>32,933</td>
</tr>
</tbody>
</table>

The source document is shown below in Design View. Text fields on the source document provide the metric data and the header labels. They are underlined to indicate the links.

**Linking from a button**

A button can be linked to a web page, a report, or another document.
The following document, shown in Express Mode in MicroStrategy Web, contains a region selector that targets the Grid/Graph. Central is selected in the selector, so the Grid/Graph displays data for the Central region only.

The document also contains a button to link to the Category Revenue document. The Category Revenue document also contains a region selector that targets a Grid/Graph. When the button is clicked, the selector value (in this case, Central) is passed to the target document, as shown below:

Notice that Central is selected in the selector, and the Grid/Graph displays data only for the Central region, just as in the source document.

For steps to create a button, see the Using Links in Mobile Documents chapter of the Mobile Design and Administration Guide.

**Linking from an attribute in a Grid/Graph**

An object in a Grid/Graph can be linked to either a report or to another document.

The following document, which is shown in Interactive Mode in MicroStrategy Web, links the Region attribute in the Grid/Graph to a report.
called **Revenue Rank with Region prompt**. The links are indicated by the underlined region names. When you hover over a region, the hand pointer appears and the name of the link is displayed in a pop-up, as shown below.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bates</td>
<td>Michael</td>
<td>Southwest</td>
<td>$1,068,907</td>
<td>$163,911</td>
<td>$904,996</td>
</tr>
<tr>
<td>Becker</td>
<td>Kyle</td>
<td>Northwest</td>
<td>$508,234</td>
<td>$77,887</td>
<td>$430,346</td>
</tr>
<tr>
<td>Bell</td>
<td>Caitlin</td>
<td>South</td>
<td>Revenue rank within region</td>
<td>$157,039</td>
<td>$833,441</td>
</tr>
<tr>
<td>Benner</td>
<td>Ian</td>
<td>Southeast</td>
<td>$520,737</td>
<td>$79,664</td>
<td>$441,073</td>
</tr>
<tr>
<td>Bernstein</td>
<td>Lawrence</td>
<td>Mid-Atlantic</td>
<td>$1,060,632</td>
<td>$158,930</td>
<td>$901,702</td>
</tr>
<tr>
<td>Brown</td>
<td>Vernon</td>
<td>Mid-Atlantic</td>
<td>$331,735</td>
<td>$51,231</td>
<td>$230,504</td>
</tr>
</tbody>
</table>

When you click Southwest, the **Revenue Rank with Region prompt** report is executed, as shown below. Notice that only employees in the Southwest are included in the report.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Revenue Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Southwest</td>
<td>Bates</td>
<td>Michael</td>
<td>$1,068,907</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Bell</td>
<td>Caitlin</td>
<td>$1,040,481</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Johnson</td>
<td>Andrew</td>
<td>$445,052</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Schafer</td>
<td>Rose</td>
<td>$408,280</td>
<td>4</td>
</tr>
</tbody>
</table>

This is because the **Revenue Rank with Region prompt** report includes a prompt on Region. The link answers the prompt dynamically, meaning that the object selected in the source (Southwest in this case) is passed to the target report as the prompt answer. Steps to determine how a prompt in the target report/document will be answered, are included in the steps below.

### Linking from an attribute in a widget

A widget is a Flash-based display of the results of a dataset report, providing Report Services (RS) dashboard analysts with a visual and interactive look into their data. The objects on a widget can be linked to either a report or to another document.

For steps to link from widgets, including examples, see the *Dashboards and Widgets Creation Guide*. 

© 2013 MicroStrategy, Inc.
Adding a link to a document

Prerequisites

- The source document and any target reports/documents must be created. The source document must contain the object to link from.

- If the target report/document contains prompts, you must know what types of prompts the targets require and how they will be answered by the link (or by the user). For details on each prompt answer method, see Specifying how prompts are answered in the target, page 427.

- If you want to pass selector values from the source document to the target document, both the source and the target must contain the same selector. This means that either both documents must contain a selector with the same name (such as Region Selector), or both documents must contain a selector that uses the same source object (such as Region).

- If you are linking from an object on a Grid/Graph, the Grid/Graph must be displayed as a grid.

To add a link to a document

1. In MicroStrategy Web, open the document in Design Mode.

2. Open the Link Editor in one of the following ways, depending on what type of object you intend to create the link in:

   - To create a link from a text field, a button, or an image, right-click the object and select **Edit Links**.
     - You can create links to reports, documents, and web pages from text fields, images, and buttons.

   - To create a link from an object on a Grid/Graph or widget, right-click the attribute or metric header in the Grid/Graph and select **Edit Links**.
     - To link from a Grid/Graph, you can create links on attributes, hierarchies, metrics, and object prompts.
     - To link from a widget, you can create links on attributes.
     - You can create links to reports and documents from Grid/Graph objects and widgets.
3 If other links already exist on this document, click the **New** icon to create a new link.

4 Type a name for the link in the **URL display text** field. Since the name appears in the link, it should be descriptive and informative to help users identify the target of the link.

**To define the link**

5 Perform the appropriate steps below, depending on whether you are linking to a web page or to a report/document:

- To link to a web page:
  a If you intend the document to be viewed by users in PDF View in Desktop, use a hyperlink instead of a link. For steps, see *Defining hyperlinks in documents, page 439*.
  b **Select Navigate to this URL.** This option is available only if you selected to create a link from a text field or image.

- To link to a report or document:
  a **Select Run this report or document.**
  b Click the browse button (...) below **Run this report or document** to find and select the target report or document.

**To apply prompt answers to target reports that contain prompts**

6 The box below **Run this report or document** contains a list of any prompts included in the target report/document. Select a target prompt from the box.

7 Select a prompt answer method from the drop-down list. For examples of each prompt answer method, see *Specifying how prompts are answered in the target, page 427*.

- **Answer with the same prompt from the source:** Select this option if you want to use the same prompt answers for both the source report and the target report/document. This option requires that both the source and target documents use the same prompt.

- **Prompt user:** Select this option if you want the user to type prompt answers after he clicks the link to run the target report/document.
• **Answer with an empty answer**: Select this option if you want to ignore the prompt in the target report/document. The prompt is not answered. This option requires that the prompt in the target is not required. If the prompt in the target is required, the user is prompted to provide an answer.

• **Use default answer**: Select this option if you want the prompt in the target to use the default answer defined by the prompt’s designer. This option requires that a default answer is defined for the prompt in the target.

• **Answer dynamically**: Select this option if you want to answer the prompt using the object selected in the source. This option is only available for attribute element prompts and value prompts.

• **Answer using current unit**: Select this option if you want to answer the prompt using the object selected in the source. This option is only available for hierarchy prompts.

• **Answer using all valid units**: Select this option if you want to answer the prompt in the target with any object to the left of or above the object that the user selects in the source document. This method passes all pertinent selections in the source, rather than just the selection made for the link. This option is available only for hierarchy prompts.

8 For each prompt in the target report/document, repeat the step above.

**To specify the prompt answer method for prompts not in the list**

9 Any other prompts are those prompts that are not in the target report/document when you are creating the link. For example, these prompts can include prompts added to the target later. By default, the **Prompt user** answer method is selected for these prompts, but you can change the method. To do this, select **Any other prompts** in the list.

10 Select a prompt answer method from the list; these are the only methods available for the Any other prompts option. For examples of each answer method, see *Specifying prompt answers for any other prompts not listed, page 435*.

• **Answer with the same prompt from the source**

• **Prompt user** (default)

• **Answer with an empty answer**

• **Use default answer**
**To apply selector values to a target document that contains selectors**

11 Choose a selector value method from the **Pass all selector values** drop-down list. For an example of passing selector values, see *Passing selector values from the source to the target, page 438*.

- To match selector values by the selector’s source attribute (that is, the object displayed in the selector), select **Match Selectors by Source Attribute**.

- To match selector values by the name of the selector, select **Match Selectors by Control Name**.

**To define additional links and determine link behavior**

12 Repeat the steps above if you want to create additional links. You can create multiple links on the same object.

13 Select the **Open in new window** check box to have the target report/document open in a new window. This allows the target and the source documents to be visible simultaneously. If this check box is cleared, the target report/document or web page opens and replaces the source document.

14 If the object has more than one link, select the link that you want to make the default link, and click the **Set as Default** icon  

. For details on setting a default link, see *Multiple links on the same object, page 417*.

15 Click **OK** to return to the source document and to save your link.

**Specifying how prompts are answered in the target**

For background information on prompts, see the description of prompt types in *Building Query Objects and Queries* chapter in the *Basic Reporting Guide*. For a more extensive description of each prompt type from an analyst’s perspective, with images of each prompt as it appears to users, see *Answering Prompts and Refreshing Data* chapter of the *Basic Reporting Guide*.

This section describes each prompt answer option for links, with an example. Information is also provided to achieve certain behaviors by combining prompts with specific answer options.
• **Answer with the same prompt from the source.** The same prompt answers that were used to execute the source are used in the target. This option requires that the source and target use the same prompt. If the same prompt does not exist in the source and in the target, the user is prompted to provide an answer when the target is executed.

For example, the Regional Revenue document links regions to another document called Yearly Revenue. The dataset reports of both documents contain the same prompt, which prompts the user to select the regions to display. If you execute the Regional Revenue document and select Mid-Atlantic, Northeast, and Southeast when prompted, you see the results shown below. When you hover the cursor over a region, the link name is displayed.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$3,312,807</td>
<td></td>
</tr>
<tr>
<td>North</td>
<td>Yearly Revenue, $308,120</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$1,643,270</td>
<td></td>
</tr>
</tbody>
</table>

Click Mid-Atlantic to run the link. The Yearly Revenue document displays data for all three regions, as shown below, although you clicked only one region.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>2007</td>
<td>$1,140,008</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2008</td>
<td>$1,518,592</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>2009</td>
<td>$1,794,014</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>2007</td>
<td>$2,246,294</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>2008</td>
<td>$2,970,291</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>2009</td>
<td>$3,437,829</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>2007</td>
<td>$598,681</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>2008</td>
<td>$759,665</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>2009</td>
<td>$883,605</td>
<td></td>
</tr>
</tbody>
</table>

• **Prompt user.** When the target is executed, the user is prompted to provide answers manually.

For example, the Regional Revenue document links regions to a report called Yearly Revenue, which is prompted for regions. Click Mid-Atlantic on the Regional Revenue document to execute the link to the Yearly Revenue report. The regional prompt is displayed, although a region was selected on the source document. The **Prompt user** prompt method does not pass information to the target, so the user must answer the prompts manually.
• **Answer with an empty answer.** The prompt in the target is ignored, which means that the prompt is not answered. No prompt answer is provided from the source and the user is not prompted to provide answers.

The prompt must not be required, because if the prompt is required, the user is prompted to provide an answer when the target report is executed by clicking the link.

The **Answer with an empty answer** method, when used in conjunction with the dynamic prompt answer method, allows a source document to answer one prompt in a target with the user selection, while ignoring any other prompts.

For example, the following document contains a Grid/Graph. The Grid/Graph has Region on the rows, and Category and Revenue in the columns. Region contains a link, as shown in the following image:

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Books</td>
</tr>
<tr>
<td>Central</td>
<td></td>
<td>$376,836</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Selected region, all categories</td>
<td>$518,969</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$646,421</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$129,175</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$408,110</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$170,445</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$280,786</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$292,655</td>
</tr>
</tbody>
</table>

When you click Central, the following report is displayed:

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Revenue per Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Books</td>
<td></td>
<td>$376,836</td>
<td>$94,209</td>
</tr>
<tr>
<td>Central</td>
<td>Electronics</td>
<td></td>
<td>$3,508,062</td>
<td>$876,516</td>
</tr>
<tr>
<td>Central</td>
<td>Movies</td>
<td></td>
<td>$589,357</td>
<td>$147,339</td>
</tr>
<tr>
<td>Central</td>
<td>Music</td>
<td></td>
<td>$557,112</td>
<td>$139,278</td>
</tr>
</tbody>
</table>

Only the selected region (Central) is displayed in the target. All categories are also displayed. The document is linked to a report, rather than another document.
Return to the source document, which contains a link on Category as well, as shown in the following image:

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Category</th>
<th>Revenue</th>
<th>Revenue per Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Books</td>
<td>Electronics</td>
</tr>
<tr>
<td>Central</td>
<td></td>
<td></td>
<td>$376,836</td>
<td>$2,608,862</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td></td>
<td>$337,650</td>
<td>$2,100,397</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td></td>
<td>$646,421</td>
<td>$6,962,709</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td></td>
<td>$129,175</td>
<td>$1,234,860</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td></td>
<td>$406,110</td>
<td>$3,741,763</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td></td>
<td>$170,445</td>
<td>$1,552,007</td>
</tr>
<tr>
<td>Southwest</td>
<td>Books</td>
<td></td>
<td>$280,796</td>
<td>$2,562,060</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td></td>
<td>$292,655</td>
<td>$2,724,922</td>
</tr>
</tbody>
</table>

When the selected link is run, the following report is displayed:

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Revenue per Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Books</td>
<td></td>
<td>$376,836</td>
<td>$34,209</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Books</td>
<td></td>
<td>$337,650</td>
<td>$42,207</td>
</tr>
<tr>
<td>Northeast</td>
<td>Books</td>
<td></td>
<td>$646,421</td>
<td>$107,737</td>
</tr>
<tr>
<td>Northwest</td>
<td>Books</td>
<td></td>
<td>$129,175</td>
<td>$43,058</td>
</tr>
<tr>
<td>South</td>
<td>Books</td>
<td></td>
<td>$406,110</td>
<td>$136,370</td>
</tr>
<tr>
<td>Southeast</td>
<td>Books</td>
<td></td>
<td>$170,445</td>
<td>$44,811</td>
</tr>
<tr>
<td>Southwest</td>
<td>Books</td>
<td></td>
<td>$280,796</td>
<td>$56,159</td>
</tr>
<tr>
<td>Web</td>
<td>Books</td>
<td></td>
<td>$292,655</td>
<td>$292,655</td>
</tr>
</tbody>
</table>

This is the same target report as the other link, but only the selected category (Books) is displayed. All the regions are displayed.

This behavior is possible because the target report contains two prompts, one for Region and one for Category, but the user makes only one selection (a region or a category), yet is not prompted for the other. This is because the prompts in the link definition use different prompt answer methods. The link on region uses the following prompt answer methods:

- Region prompt: Answer dynamically
- Category prompt: Answer with an empty answer

This passes the selected region to the target, to answer the region prompt, and ignores the category prompt. The link on category uses the following prompt answer methods:

- Region prompt: Answer with an empty answer
- Category prompt: Answer dynamically
This passes the selected category to the target, to answer the category prompt, and ignores the region prompt.

- **Use default answer.** The prompt is answered by the default prompt answer for the prompt in the target. If the target prompt does not have a default answer, the **Answer with an empty answer** method is used. In this case, the prompt is not answered, unless it is required, in which case the user is prompted to provide an answer.

For example, continue with the same Regional Revenue document and Yearly Revenue report described above. This time, the **Use default answer** prompt method is used in the link, and the regional prompt has a default answer of Central. When you click Mid-Atlantic on the Regional Revenue document, the Yearly Revenue report displays data for Central.

- **Answer dynamically.** The object selected in the source is passed to the prompt in the target. If this object does not answer the target prompt, the **Answer with an empty answer** method is used. In this case, the prompt is not answered, unless it is required, in which case the user is prompted to provide an answer.

Available only for attribute element prompts and value prompts.

For example, a document contains Employee, Region, and various metrics. Region is linked to a report called Revenue Rank with Prompt on Region. If a user clicks the Southwest region to run the link, Southwest is passed to the target to answer the prompt on region. The report displays data for the Southwest region only. If the user clicks Northwest instead, Northwest is passed to the target and the report displays data for the Northwest region only.

- A hierarchy prompt allows users to select prompt answers from one or more attribute elements from one or more attributes. This prompt gives users the largest number of attribute elements to choose from when they answer the prompt to define their filtering criteria. The **Answer using all valid units** prompt answer method passes selections made on the source document, rather than just the selection made for the link, to the target. To restrict the prompt answer to just the selected attribute element, use the **Answer using current unit** prompt answer method. Like the Answer dynamically method, only the attribute element that is selected is passed to the target.

These two prompt answer methods are available only for hierarchy prompts.

An example using both answer methods is below.

- **Answer using current unit.** The prompt is answered using the object selected in the source. If the user selects an attribute header rather
than a specific attribute element, the **Answer with an empty answer** method is used. In this case, the prompt is not answered, unless it is required, in which case the user is prompted to provide an answer.

- **Answer using all valid units.** Any object to the left of or above the user selection in the source is used as the prompt answer for the target. In other words, this method passes all the selections made on the source, rather than just the selection made for the link. If the user does not select any valid objects (for example, the user selects an attribute header rather than a specific attribute element), the **Empty answer** method is used. That is, the prompt is not answered, unless it is required, in which case the user is prompted.

For example, the following document is used as the source. It contains Year, Region, and Revenue. As shown below, Region contains two links, one that passes the current region only (using the **Answer using current unit** prompt answer method) and another that passes the selected year and region (using the **Answer using all valid units** prompt answer method).

```
<table>
<thead>
<tr>
<th>GROUPING:</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Revenue</td>
</tr>
<tr>
<td>2005 Central</td>
<td>$1,823,715</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td></td>
</tr>
<tr>
<td>2005 Northeast</td>
<td></td>
</tr>
<tr>
<td>2005 Northwest</td>
<td></td>
</tr>
<tr>
<td>2005 South</td>
<td></td>
</tr>
<tr>
<td>2005 Southeast</td>
<td></td>
</tr>
<tr>
<td>2005 Southwest</td>
<td></td>
</tr>
<tr>
<td>2005 West</td>
<td>$720,560</td>
</tr>
<tr>
<td>2006 Central</td>
<td>$2,182,632</td>
</tr>
</tbody>
</table>
```

The source report contains the Geography hierarchy and the Revenue metric. It is filtered by a hierarchy prompt on Geography.

Notice that 2005 and Central are selected in the image above. If you select the Current Year and Region link, 2005 and Central are passed to the target as the prompt answers. This is confirmed in the report filter details, as shown in the report sample below. Only Central is returned,
with a revenue amount ($1,823,715) that matches the revenue amount in the source report.

<table>
<thead>
<tr>
<th>REPORT DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Description:</td>
</tr>
<tr>
<td>Prompt Details:</td>
</tr>
<tr>
<td>Prompt 1: Geography hierarchy</td>
</tr>
<tr>
<td>(Year = 2005) And (Region = Central)</td>
</tr>
<tr>
<td>Report Filter:</td>
</tr>
<tr>
<td>(Year = 2005) And (Region = Central)</td>
</tr>
<tr>
<td>Data rows: 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$1,823,715</td>
</tr>
</tbody>
</table>

If you click the Current Region Only link instead, although 2005 and Central are still selected, only Central is passed as a prompt answer to the target report. The report is filtered by Central only; all years are included. The revenue amount is therefore much higher ($6,912,934 instead of $1,823,715), as shown below.

<table>
<thead>
<tr>
<th>REPORT DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Description:</td>
</tr>
<tr>
<td>Prompt Details:</td>
</tr>
<tr>
<td>Prompt 1: Geography hierarchy</td>
</tr>
<tr>
<td>Region = Central</td>
</tr>
<tr>
<td>Report Filter:</td>
</tr>
<tr>
<td>Region = Central</td>
</tr>
<tr>
<td>Data rows: 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$6,912,934</td>
</tr>
</tbody>
</table>

The valid units for the **Answer using all valid units** answer method are any elements that are to the left of or above the user selection in the
source. For example, add Call Center and Employee to the right of Region in the source report, as shown below.

If you select the Current Region Only link, only Central is displayed on the target report, with the same revenue amount ($6,912,934) as in the previous scenario.

If you select the Current Year and Region link instead, Central is returned, with 2005 revenue only (again, the same as in the previous scenario), as shown below.
The link could be on Call Center instead, as shown in the source report below.

If you click the Year, Region, and Call Center Revenue link, the target report is filtered by these attributes (the selection and the attributes to the left of it), as shown below. Note that the revenue amount ($1,498,233) is less than the amount ($1,823,715) displayed in the previous report that filtered for 2005 and Central. The difference of $325,481 is Call Center Fargo’s 2005 revenue contribution, as shown in the document above.

<table>
<thead>
<tr>
<th>Region</th>
<th>Call Center</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005 Central</td>
<td>Milwaukee</td>
<td>Gale</td>
<td>Loren</td>
<td>$591,805</td>
</tr>
<tr>
<td>2005 Central</td>
<td>Milwaukee</td>
<td>Torisson</td>
<td>Nancy</td>
<td>$608,257</td>
</tr>
<tr>
<td>2005 Central</td>
<td>Fargo</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$325,481</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td>Washington, DC</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,433,104</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td>Washington, DC</td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,504,537</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td>Hollywood</td>
<td>Robert</td>
<td></td>
<td>$1,398,426</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td>Charleston</td>
<td>Brown</td>
<td>Vernon</td>
<td>$473,560</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td>Charleston</td>
<td>Corcoran</td>
<td>Peter</td>
<td>$481,761</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td>Charleston</td>
<td>Ingles</td>
<td>Walter</td>
<td>$254,414</td>
</tr>
<tr>
<td>2005 Mid-Atlantic</td>
<td>Charleston</td>
<td>Smith</td>
<td>Thomas</td>
<td>$230,043</td>
</tr>
</tbody>
</table>

Specifying prompt answers for any other prompts not listed

Any other prompts are those prompts that are not in the target when you are creating the link. These can be either:

- Prompts added to the target after the link is created
- Prompts that are created as the result of an answer to one of the original prompts in the target, such as a prompt-in-prompt answer
These prompts are listed as the **Any other prompt** option in the list of prompts in the Link Editor.

For example, a Regional Revenue document contains a link to another report called Yearly Revenue. When the link was created, Yearly Revenue contained only a prompt for Region. The link uses the Answer dynamically prompt answer mode to answer that prompt, so the region that the user selects to access the link answers the prompt. The user is not prompted when the target is executed. However, after the link was created, a second prompt, for Category, is added to the Yearly Revenue report.

Now a user selects Central in the Regional Revenue document, and clicks the link for Yearly Revenue. The report does not execute immediately, but instead the Category prompt appears. The user must select a category to continue or, since the prompt is not required, can include all categories by clicking Finish. In the sample shown below, the user answered the prompt with the Book and Movie categories.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>2007</td>
<td></td>
<td>$1,293,634</td>
</tr>
<tr>
<td>Central</td>
<td>2008</td>
<td></td>
<td>$1,687,004</td>
</tr>
<tr>
<td>Central</td>
<td>2009</td>
<td></td>
<td>$2,068,723</td>
</tr>
</tbody>
</table>

Because the Category prompt was added after the link was created, the prompt uses the prompt answer method assigned to Any other prompt. Since the creator of the link did not change that method, it is still defined as the default of **Prompt user**.

If you edit the Yearly Revenue link in the Regional Revenue document now, the Category prompt is displayed in the list of prompts. Its prompt answer mode is defined as **Prompt user**, although you can change it. You can also select a different prompt answer mode for Any other prompt.

Change the Category prompt to **Answer with an empty answer**. Change the Any other prompt option to **Use default answer**. Create a prompt on Subcategory, and add the following as default answers:
• Literature
• Cameras
• Comedy
• Rock

Add the new Subcategory prompt to the Yearly Revenue report.

If you re-execute the Regional Revenue document, right-click Central, point to Link, and then select Yearly Revenue, you are not prompted at all. The target is filtered by Region and Subcategory, but not Category, as shown below.

<table>
<thead>
<tr>
<th>Report detail:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Description:</td>
</tr>
<tr>
<td>Prompt 1: Region</td>
</tr>
<tr>
<td>Region = Central</td>
</tr>
<tr>
<td>Prompt 2: Category</td>
</tr>
<tr>
<td>Prompt not answered</td>
</tr>
<tr>
<td>Prompt 3: Subcategory</td>
</tr>
<tr>
<td>Subcategory = Literature, Cameras, Comedy, Rock</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Report Filter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Region = Central) And (Subcategory = Literature, Cameras, Comedy, Rock)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>2007</td>
<td></td>
<td>$17,492</td>
</tr>
<tr>
<td>Central</td>
<td>2008</td>
<td></td>
<td>$22,372</td>
</tr>
<tr>
<td>Central</td>
<td>2009</td>
<td></td>
<td>$29,395</td>
</tr>
</tbody>
</table>

• The Region prompt is answered dynamically (by your selection of Central).
• The Category prompt is ignored and therefore does not show up in the report filter.
• The Subcategory prompt uses the default answers defined in the prompt (Literature, Cameras, Comedy, and Rock).
Passing selector values from the source to the target

A selector allows each user to interact with a Report Services (RS) dashboard to display only the subset of data that he is interested in or only specific attribute elements or metrics. For background information on selectors, see the description of selector types, including examples and steps to create them, in the Selectors chapter in the Dashboards and Widgets Creation Guide.

The selector values that the user chooses in the source document can be passed to the selectors in the target document. For example, the Regional Revenue document contains a selector for Region, so that the user can view revenue for a specific year. The document contains a link to the Category Revenue by Region document, which also contains a Region selector.

Execute the Regional Revenue document and select Central in the selector. Only the Central region, with its revenue, is displayed, as shown below:

![Select a region](image1)

Click the Display Category Revenue for the selected region link. The Category Revenue by Region document is displayed, as shown below.

![Select a region](image2)
The selector is set to Central, the same as the selector in the Regional Revenue document. Only Central’s data is displayed, by category. Notice that the total matches the revenue in the Regional Revenue document.

To pass selector values from the source document to the target document, both the source and the target must contain the same selector. This means that either both documents must contain a selector with the same name (such as Region Selector), or both documents must contain a selector that uses the same source object (the object displayed in the selector, such as Region). When you create a link that passes selector values, you can choose to match the selector values either by the selector name or the source object.

## Defining hyperlinks in documents

A hyperlink connects a text field or an image (the source) to a web page (the target). Hyperlinks are functional in Express Mode in MicroStrategy Web and in PDF View in Desktop. (They are also functional in Interactive Mode and Editable Mode in Web.)

Compare a hyperlink to a link, which is a connection in a document to another document, a report, or a web page. A link can pass parameters to answer any prompts that are in the target. Links are functional in all modes except Express Mode in Web and PDF View in Desktop. For details on links, see *Creating links in a document, page 412*.

For example, you can define a hyperlink on a logo in the Document Header. When a user clicks the logo, your home page is displayed. In PDF View, with the cursor over the logo, the link displays as pop-up text to show the URL, as shown below.

![MicroStrategy logo](http://www.microstrategy.com)

This pop-up text does not display in MicroStrategy Web, but in MicroStrategy Web you can add a tooltip to display the URL or any other information. For more information, see *Creating a pop-up tooltip, page 270*.
Dynamic data fields in hyperlinks

You can insert dynamic data fields in the hyperlink. These data fields are interpreted when the document is run. With dynamic data fields, you can create URLs that are dynamic according to the data in the dataset.

For example, if you have an intranet website with pages for each region, add a data field for the region name. Define the hyperlink by typing braces { } and the name or alias of an object in the dataset. In this example, you type {Region}. For more information on the syntax of dynamic data fields, see Adding dynamic data to a document, page 83.

Users viewing the PDF can click the link and view the intranet page for that region. In the Northeast region on the document it could display as “Region: Northeast” and link to that URL, and for Mid-Atlantic, it could display as “Region: Mid-Atlantic” and link to that URL. A sample is shown below:

<table>
<thead>
<tr>
<th>Region: Central</th>
<th>$5,029,366</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region: <a href="http://www.example.com/Central">http://www.example.com/Central</a></td>
<td></td>
</tr>
<tr>
<td>Region: Northeast</td>
<td>$8,554,415</td>
</tr>
</tbody>
</table>

Emailing, exporting, and subscribing to documents and reports via links

A user can click a link on a document in MicroStrategy Web and, rather than executing the target of the link, the target can be emailed, exported, or subscribed to. You can create a link URL that performs any of the following actions: subscribe to a report or document; email a report or document; export a report or document.

To create a link to email, export, or subscribe to a report or document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. From the Insert menu, select Text, and click and drag in the location where you want to insert the link.
3 Type descriptive and informative text for the link in the text field so that the user knows what action is performed when the link is clicked.

4 Right-click the text field and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

5 Make sure **General** is selected on the left.

6 Under **Navigation**, select the **Is Hyperlink** check box.

7 Type the target URL in the **Hyperlink** field. Use one of the syntaxes from the following table, depending on what action you want to execute when the link is clicked:

<table>
<thead>
<tr>
<th>Action</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>To export a report or document</td>
<td>For reports: <a href="http://MSTRWebURL?evt=3067&amp;reportID=objectID&amp;promptinfo">http://MSTRWebURL?evt=3067&amp;reportID=objectID&amp;promptinfo</a></td>
</tr>
<tr>
<td></td>
<td>For documents: <a href="http://MSTRWebURL?evt=3067&amp;documentID=objectID&amp;promptinfo">http://MSTRWebURL?evt=3067&amp;documentID=objectID&amp;promptinfo</a></td>
</tr>
<tr>
<td>To export a report or document to PDF</td>
<td>For reports: <a href="http://MSTRWebURL?evt=3069&amp;reportID=objectID&amp;promptinfo">http://MSTRWebURL?evt=3069&amp;reportID=objectID&amp;promptinfo</a></td>
</tr>
<tr>
<td></td>
<td>For documents: <a href="http://MSTRWebURL?evt=3069&amp;documentID=objectID&amp;promptinfo">http://MSTRWebURL?evt=3069&amp;documentID=objectID&amp;promptinfo</a></td>
</tr>
<tr>
<td>To email a report or document now</td>
<td>For reports: <a href="http://MSTRWebURL?evt=3037&amp;objectID=objectID&amp;objectType=3&amp;promptinfo">http://MSTRWebURL?evt=3037&amp;objectID=objectID&amp;objectType=3&amp;promptinfo</a></td>
</tr>
<tr>
<td></td>
<td>For documents: <a href="http://MSTRWebURL?evt=3037&amp;objectID=objectID&amp;objectType=55&amp;promptinfo">http://MSTRWebURL?evt=3037&amp;objectID=objectID&amp;objectType=55&amp;promptinfo</a></td>
</tr>
<tr>
<td>To email a report or document based on a schedule</td>
<td>For reports: <a href="http://MSTRWebURL?evt=3036&amp;objectID=objectID&amp;objectType=3&amp;promptinfo">http://MSTRWebURL?evt=3036&amp;objectID=objectID&amp;objectType=3&amp;promptinfo</a></td>
</tr>
<tr>
<td></td>
<td>For documents: <a href="http://MSTRWebURL?evt=3036&amp;objectID=objectID&amp;objectType=55&amp;promptinfo">http://MSTRWebURL?evt=3036&amp;objectID=objectID&amp;objectType=55&amp;promptinfo</a></td>
</tr>
<tr>
<td>To subscribe to a report or document to be delivered to your History List folder</td>
<td>For reports: <a href="http://MSTRWebURL?evt=3034&amp;objectID=objectID&amp;objectType=3&amp;promptinfo">http://MSTRWebURL?evt=3034&amp;objectID=objectID&amp;objectType=3&amp;promptinfo</a></td>
</tr>
<tr>
<td></td>
<td>For documents: <a href="http://MSTRWebURL?evt=3034&amp;objectID=objectID&amp;objectType=55&amp;promptinfo">http://MSTRWebURL?evt=3034&amp;objectID=objectID&amp;objectType=55&amp;promptinfo</a></td>
</tr>
<tr>
<td>To subscribe to a report or document to be delivered to a mobile device</td>
<td>For reports: <a href="http://MSTRWebURL?evt=3134&amp;objectID=objectID&amp;objectType=3&amp;promptinfo">http://MSTRWebURL?evt=3134&amp;objectID=objectID&amp;objectType=3&amp;promptinfo</a></td>
</tr>
<tr>
<td></td>
<td>For documents: <a href="http://MSTRWebURL?evt=3134&amp;objectID=objectID&amp;objectType=55&amp;promptinfo">http://MSTRWebURL?evt=3134&amp;objectID=objectID&amp;objectType=55&amp;promptinfo</a></td>
</tr>
</tbody>
</table>
Replace italicized text in the link URL with the information for your report or document, using the following guidelines:

- **MSTRWebURL** represents the correct base URL syntax for your Web environment. This is the URL path to the Web application’s main controller. Depending on the environment in which Web is deployed, replace this part of the URL syntax with one of the following:
  - for .NET: `Webserver/MicroStrategy/asp/Main.aspx`
  - for J2EE: `Webserver/WebMstr7/servlet/mstrWeb`

- **objectID** represents the ID of the document or report to be executed. To obtain the object ID of a report or document, right-click the report or document and select **Properties**. The object ID is displayed in the Properties dialog box.

- **promptinfo** represents any of the optional prompt information parameters. To automatically answer any prompts in the target report or document, you need to include prompt information parameters at the end of the URL. The `promptinfo` parameter passes information that is used to answer prompts in the target. If you do not include prompt information, the user who clicks the link must answer the prompts in the target report/document. For details to specify prompt information parameters, see [Specifying prompt information parameters in manually created link URLs, page 443](#).

To have the target report or document open in a new window, select the **Open in new window** check box. This allows the target and the source to be visible simultaneously. If this check box is cleared, the target report/document opens and replaces the source document.

Click **OK** to save your changes and return to the source document.
Specifying prompt information parameters in manually created link URLs

Prompt information parameters are added to manually created link URLs. They are used to pass information to answer prompts in the target report or document. Any prompt not answered by the passed information is displayed for the user to answer manually.

If you do not include any prompt information in the link URL, the target report or document is executed normally. If it contains prompts, the user is prompted to answer them.

The prompt information in a link URL can be in any of the following forms:

- List of attribute elements, to pass attribute elements as answers to an element prompt
- Prompt XML, to pass a collection of specific prompt answers from the source to the target
- Message ID of the source document, to pass the prompt answers from the source document

Each is described below.

List of attribute elements

The list of attribute elements allows attribute elements to be passed to the target to answer prompts. For example, a document contains a list of regions and their yearly revenues. Each region is a link that passes the region’s name to a target document. When a user clicks a particular region in the document, another document is executed which displays quarterly revenue and profit values for that region. You can use the following syntax to pass the attribute elements to the target by using auto text codes:

```plaintext
elementsPromptAnswers=  
{&AttributeName@GUID};{&AttributeName@ElementID}
```

where `AttributeName` is the name of the attribute element, such as Region in the above example.

The auto text codes `{&AttributeName@GUID}` and `{&AttributeName@ElementID}` supply the appropriate attribute ID and the attribute element ID of the element clicked. You can either use the auto text codes to supply the IDs at run time or you can manually enter the attribute
ID and attribute element ID. Manually entered codes are processed faster by the system. The syntax for manually entering the IDs is:

```
elementsPromptAnswers=AttributeID;AttributeElementID
```

A useful method to determine the attribute ID and element ID is to create a document with the desired attribute elements and type the auto text codes in a text field. You can then copy the IDs displayed in the text field into the link of your source document.

- Element IDs are generated by the Intelligence Server to uniquely identify each attribute element.

**To pass multiple elements from the same attribute**

To pass multiple elements from the same attribute, list the element IDs separated by a comma, as shown in the following sample. You must enter the element IDs (represented by `AttributeElementID`) manually; the element ID auto text code can only generate one element ID at a time.

```
elementsPromptAnswers=
    AttributeID;AttributeElement1ID,AttributeElement2ID
```

**To pass elements from multiple attributes**

You can pass elements from multiple attributes by using separate parameters for each attribute, joined with an ampersand. An example using Region and Year is shown below:

```
elementsPromptAnswers=
    {&Region@GUID};{&Region@ElementID}&elementsPromptAnswers={&Year@ElementID};{&Year@ElementID}
```

Adobe’s HTML parser requires strict syntax. IF this syntax is not followed, the parser does not display the intended attributes. For details on syntax, see http://livedocs.adobe.com/flex/201/langref/flash/text/TextField.html#htmlText.

**Prompt XML**

Prompt XML represents prompt answers in an XML format. It incorporates dynamic information from the executed source document into the XML string. Prompt XML is useful because it enables prompt answers to be
maintained from the source to the target even when the message ID no longer exists, which can occur if the session is lost.

- The XML cannot be applied unless the prompts in the target are the same physical prompt objects with the same IDs as the prompts in the source document.

- Prompt XML can create a long URL, which shows up in the document when a user hovers over the link. A lengthy URL can be truncated and can produce errors. To avoid this issue, use the document message ID described below if the MicroStrategy session remains open.

The format for prompt XML is:

```
promptsAnswerXML={&PROMPTXML}
```

The auto text code `{&PROMPTXML}` generates the appropriate XML string at run time. You can also manually code the prompt XML, but the format and usage of prompt XML is beyond the scope of this guide. For details, see the Web Software Development Kit, available in the MicroStrategy Developer Library, which is part of the MicroStrategy SDK.

**Message ID**

The message ID uniquely identifies an instance of a report, document, or HTML document. If different users execute the same report, different instances and therefore different message IDs are produced. The message ID allows you to pass the prompt answers from the source document to the target. The format is:

```
originMessageID={&DOCUMENTMESSAGEID}
```

The auto text code `{&DOCUMENTMESSAGEID}` supplies the correct message ID at run time.

You can combine prompt XML and message ID, as long as the destination does not contain nested prompts. If both parameters answer the same prompt, the prompt XML parameter takes precedence over the message ID.

A nested prompt is where the definition of one prompt depends on the answer to another prompt. For example, the first prompt is for category, and the second is for subcategory. The list of subcategories for the second prompt depends on the answer to the first, category prompt. If you use both prompt XML and message ID, when you click the link, the answer to the subcategory prompt is not passed to the destination. Instead, the user is reprompted for subcategory.
How links, drilling, and selectors work together

When an attribute element in a Grid/Graph is underlined, such as Northeast in the example below, a user can click it.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
<td>$764,323</td>
<td>$4,265,043</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>$3,779,531</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td>$7,253,683</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
<td>$266,986</td>
<td>$1,494,202</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$2,239,951</td>
<td>$336,675</td>
<td>$1,903,276</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$3,694,132</td>
<td>$561,331</td>
<td>$3,132,800</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,902,762</td>
<td>$583,538</td>
<td>$3,319,225</td>
</tr>
</tbody>
</table>

Northeast can be underlined because it is any of the following:

- A link (to another document or a report)
- A selector (that displays a different attribute element in a Grid/Graph)
- A drill (to another level of aggregation, as defined by a drill path)
- Any combination of these possibilities

If Northeast is all three (a link, a selector, and a drill), when the user clicks Northeast, it functions as a selector, because you can access the link and the drill from the right-click menu, unlike selectors. When a user clicks Northeast in the example shown above, the graph on the right is updated to
display the values for Northeast, as shown below, because the behavior for clicking Northeast defaulted to selector:

![Image](image.png)

If Northeast has a default link and a drill, the link is executed when Northeast is clicked, as shown below. By definition, a default link is the action that occurs when the link is clicked, so it takes precedence over the drill. In this case, the target document is executed, displaying information about employees in the Northeast region.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td>$764,323</td>
<td>$4,265,043</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>$3,779,531</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,654,415</td>
<td>$1,300,732</td>
<td>$7,253,683</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
<td>$266,986</td>
<td>$1,494,202</td>
</tr>
<tr>
<td>South</td>
<td>$5,399,200</td>
<td>$606,956</td>
<td>$4,602,324</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td>$336,675</td>
<td>$1,903,276</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
<td>$561,331</td>
<td>$3,132,800</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
<td>$583,538</td>
<td>$3,319,225</td>
</tr>
</tbody>
</table>

For more information, including steps and examples, on each of these, see:

- *Specifying how prompts are answered in the target, page 427*
- The *Selectors* chapter in the *Dashboards and Widgets Creation Guide*
- *Drilling in Grid/Graphs, page 238*
TRANSACTION-ENABLED DOCUMENTS

Interacting with data sources

Introduction

MicroStrategy Transaction Services lets you embed write-back functionality into documents for the purposes of decision-making or initiating a transaction. A document designer can create a Transaction Services-enabled document to allow analysts to approve requests, track business activity, and execute business decisions by editing their business data in the document and sending those interactions back to the data sources.

For example, an analyst can view a list of employees with time off requests, choose to accept or reject each request, then update their data to display the new status of each request. In a document displaying a list of products that need to be restocked for a store, an analyst can change the quantity to reorder for each product, then submit their changes.

Analysts can use Transaction Services-enabled documents to interact with the data in Express Mode in MicroStrategy Web, and when viewed on an iPhone, iPad, or Android device with MicroStrategy Mobile.

You must have the Transaction Services product to create and use Transaction Services-enabled documents. Detailed steps to create a transaction-enabled document in MicroStrategy Web are below.
Creating a transaction-enabled document

You create a transaction-enabled document by performing the following high-level steps in MicroStrategy Web:

1. Link a Grid/Graph or the text fields on a panel stack (called a field group) to a Transaction Services-enabled report. Data from the input objects defined in the Transaction Services report is displayed in the Grid/Graph or text fields for users to edit.

2. Link each input object on the Transaction Services report to an attribute form or metric (for Grid/Graphs) or a text field (for text fields on a panel stack).

3. Determine what type of input object control is displayed to users when they view the Transaction Services-enabled document. Analysts use these input object controls to edit the data displayed in a document. For example, users can type text in a text field, turn a switch on and off to specify a numeric value, select a value from a list, and so on.

4. Add an action selector button or link as you design the document. The button or link targets the Grid/Graph or panel stack. When the document is viewed, users can click the button or link to submit, update, or discard their changes to the data. Action selector buttons and links are only displayed in Design, Editable, and Express Mode.

Detailed steps to create a Transaction Services-enabled document are below.

Prerequisites

- You must have the Transaction Services product.
- You must have the Web Configure Transaction privilege.
- This procedure assumes that the Transaction Services report that you want to link to the Grid/Graph or text fields has already been created. This report must contain the input object for each value that you want to allow users to change. For steps to create a Transaction Services report, see the Advanced Reporting Guide.
- This procedure assumes that you have already created a document with one of the following:
  - A Grid/Graph that contains a separate attribute form or metric to link to each input object on the Transaction Services report. Each attribute
form that you want to link to an input object must be visible in the Grid/Graph. To choose the attribute forms displayed for an attribute in the Grid/Graph, right-click the header of the attribute, point to **Attribute Forms**, then select the attribute forms to display. For steps to add a Grid/Graph to a document, see *Adding a Grid/Graph to a document*, page 170.

To allow users to edit the values of attribute forms in a grid, you must place only attributes on the grid’s rows, and only metrics on the grid’s columns.

- Text fields on a panel stack (called a field group). Each input object on the Transaction Services report needs a separate text field. The text fields can contain data, or can be filled in from the input object. For steps to create a panel stack, see the *Dashboards and Widgets Creation Guide*. For steps to create text fields, see *Adding text and data to a document: Text fields*, page 81.

---

**To enable transactions for a document**

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Do one of the following, depending on which type of control that you want to use in the document:

   - To link a Grid/Graph to the Transaction Services report, right-click the Grid/Graph, then select **Configure Transaction**. The Configure Transactions Editor opens.

   - To link the text fields on a panel stack (called a field group) to the Transaction Services report, right-click any text field in the panel stack, then select **Configure Transaction**. The Configure Transactions Editor opens.

     If this is the first control that you have linked in this document, the Select Transaction dialog box opens. Navigate to and select the Transaction Services report to link to. The Configure Transactions Editor opens.

3. Select a Transaction Services report. To do this, click ... (the browse button). Navigate to and select the Transaction Services report to link to.

4. You can choose to automatically recalculate subtotals and derived metrics when a user edits a value in the document, or refresh the values only when the user manually chooses to recalculate the data. This option is
only available for Grid/Graphs linked to a Transaction Services report. Do one of the following:

- To automatically recalculate the subtotals and derived metrics, select the **Automatically recalculate values after data change** check box.
- To recalculate the subtotals and derived metrics manually, clear the **Automatically recalculate values after data change** check box.

5 You can display a row of check boxes beside each row of data in a grid, to allow the user to choose which rows of data to update using the Transaction Services report. This option is only available for grids. This option is only applied to grids in which all attributes are on the rows and all metrics are on the columns. Do one of the following:

- To allow users to select rows of data using the check boxes, select the **Mark rows for selection (tabular grids only)** check box.
- To display data in the grid without the check boxes, clear the **Mark rows for selection (tabular grids only)** check box.

6 You can choose to display an indicator next to grid cells or text fields displayed in the document, to mark the values that the user has changed. Do one of the following:

- To display an indicator next to the changed values, select the **Flag cells/fields with modified data** check box.
- To display the changed values without an indicator, clear the **Flag cells/fields with modified data** check box.

7 When a user chooses to submit his changes to the data, there may be input object controls in which he has made no changes. You can determine whether to submit the contents of all input object controls when the user clicks submit, including those in which the user has made no changes. For example, you can allow users to review content and accept it without making any changes, or check in at a specific time without making any additional comments. To do so, do one of the following:

- To allow users to submit their data without making changes in input objects linked to a grid, select the **Submit unchanged records** check box.
- To allow users to submit their data without making changes in input objects linked to a field group, select the **Allow submission without modification** check box.
A list of each input object in the Transaction Services report is displayed in the Transaction Input column. Perform the following steps for each input object:

a. Do one of the following, depending on which control type to link the report to:
   - To link a Grid/Graph to the Transaction Services report, from the Grid Object drop-down list, select the attribute form or metric to link to the input object.
   - To link the text fields in a panel stack to the Transaction Services report, from the Field drop-down list, select the text field that you want to link to the input object.

b. Choose whether users can edit the value of each input object. Do one of the following:
   - To allow the user to edit the value of the input object, select the Editable check box.
   - To prevent the user from editing the value of the input object, clear the Editable check box.

c. From the Control Style drop-down list, select the type of control to use to display and edit the value of the input object. Select one of the following:
   - The available options may vary depending on the data type of the input object. For information on how each control is displayed in Web or on a mobile device, see Input object controls that support transactions, page 457.
   - To allow users to type a single line of text in a text box, select Text Field.
   - To allow users to type multiple lines of text in a text box, select Text Area.
   - To allow users to turn a switch on or off to specify a numeric value, select Switch.
   - To allow users to choose a specific time, select Time Picker.
   - To allow users to select a date from a calendar, select Calendar.
   - To allow users to rate an item on a numeric scale, select Likert Scale.
– To allow users to choose a value from a list or a group of radio buttons, select **List**.

– To allow users to choose a value on a slider, select **Slider**.

– To allow users to click a button to choose an image, select **Toggle**.

– To allow users to provide an electronic signature, select **Signature Capture**.

– To allow users to select data by incrementing or decrementing a numeric value, select **Stepper**.

– To allow users to scan or manually input a barcode, select **Barcode**.

– To allow users to rate an item using a star rating (for example, rating an item four out of five stars), select **Star Rating**.

To specify the display options for the input object control, click the **Control Properties** icon next to the Control Style drop-down list to expand the Control Properties, then select the appropriate options to format the control. For a list of the options available for each type of control, and steps to format them, see *Input object controls that support transactions, page 457*.

9 Repeat the appropriate steps above to define and format the control that you want to display for each input object.

10 Click **OK** to save your changes and return to the document.

**To create the action selector button or link**

11 From the Insert menu, point to **Selector**, then select one of the following:

- To allow users to click a button to recalculate, discard, or submit their changes, select **Action Selector Button**.

- To allow users to click a link to recalculate, discard, or submit their changes, select **Action Selector Link**.

- You can create a custom selector button by using the link option above, and then placing the link text over an image. For steps to add an image, see the MicroStrategy Web Help.

12 Click the section of the Layout area in which you want to place the selector. Right-click the selector, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.
13 From the left, click **General**, then type the text you want to display on the button or link in the **Display Text** field.

14 By default, a descriptive title bar is displayed for the selector. You can determine whether or not to display the title bar. Do one of the following:

- To display the title bar, select the **Show Title Bar** check box and type the title to display in the field.

- To display the selector button or link without the title bar, clear the **Show Title Bar** check box.

15 From the left, click **Selector**. From the **Action Type** drop-down list, select one of the following:

- To allow the user to submit the changes that they have made to the data in the document, select **Submit**.

- To allow the user to recalculate the values of derived metrics and subtotals, reapply number and date formatting, and update other values calculated by the Analytical Engine, select **Recalculate**.

  MicroStrategy Web does not support using a button or link to recalculate derived metrics displayed in text fields. To allow users to recalculate the values of derived metrics in your Transaction Services-enabled documents, consider displaying your data in a Grid/Graph.

- To allow the user to discard their changes and display the values of the input objects from when they were last submitted, select **Discard Changes**.

16 You can choose to display a message asking for confirmation when a user clicks the action selector button or link. This option is only available if the Action Type is set to **Submit** or **Discard Changes**. Do one of the following:

- To display the confirmation message, select the **Require confirmation** check box.

- To submit or discard changes without displaying a confirmation message, clear the **Require confirmation** check box.

17 You can determine which action MicroStrategy Web performs after a user submits his changes. This option is only available if the Action Type is set to **Submit**. Select one of the following under **Subsequent Actions**:

- To return to the document without performing any additional actions, select the **No subsequent action** option.
• To refresh the display of the document, select the **Refresh the current document** option.

• To run a specific report or document, select the **Run a new report or document** option. Click ... (the browse button), navigate to and select the report or document you want to run, and click **OK**.

18 If you have chosen to have a report or document automatically run after the user submits his changes, you can choose to use the same prompt answers that were chosen in the source document to answer the prompts in the target report/document. To use the same prompt answers, select the **Answer prompts with the same answers as the source** check box. This option requires that both the source and target report/document use the same prompts. The user will still be prompted for any prompts that exist in the target but that do not exist in the source.

19 If you have chosen to have a report or document automatically run after the user submits his changes, you can specify whether the report or document will be executed using data cached on the mobile device. If you choose to have the report or document run without using data cached on the mobile device, the report or document is automatically executed using data cached on the Intelligence Server, if available. If no cached data is available on the mobile device or Intelligence Server, the report or document is executed against the data source. This option is only available if the **Action Type** is set to **Submit** and the **Run a new report or document** option is selected. Do one of the following:

  - You can choose to have the report or document automatically executed against the data source each time it is run, ensuring that the report or document displays the most recent data. To do so, you must disable caching for the report or document. For steps, as well as background information on caching reports and documents displayed on mobile devices, see the *Mobile Design and Administration Guide*.

  • To run the report or document without using data cached on the mobile device, select the **Force Live Execution** check box.

  • To run the report or document using data cached on the mobile device, clear the **Force Live Execution** check box.

20 You can display a custom confirmation message to the user after his changes are submitted. This option is only available if the Action Type is set to **Submit**. Do one of the following:

  • To display a custom message, select the **Display message after submit** check box, then type a confirmation message in the field.
• To apply the user’s changes without displaying a custom message, clear the **Display message after submit** check box.

21 A Transaction Services-enabled document that is pre-cached is run in the background, and its results are stored on the mobile device on which it is executed, improving the speed with which the document is run. You can choose to update document results cached on a mobile device after the user submits his changes, by using the **Invalidate Mobile Device Cache** setting to mark a document’s results as in need of updating.

If the document is defined to be pre-cached, the document will be automatically pre-cached each time the user submits his changes. If the document is not defined to be pre-cached, the document will be automatically executed using data cached on the Intelligence Server the next time the document is run, or executed against the data source if no cached data is available. For background information on pre-caching, see the *Mobile Design and Administration Guide*. This option is only available if the Action Type is set to **Submit**. Do one of the following:

• To have document pre-cached each time the user submits their changes, select the **Invalidate Mobile Device Cache** check box.

• To allow the user to submit their changes without marking the data cached on the mobile device as in need of updating, clear the **Invalidate Mobile Device Cache** check box.

22 By default, the selector button or link automatically targets (updates) each Grid/Graph and panel stack in the section in which the button or link is placed. You can choose the targets of the selector manually instead. To do so, select **Click here**, then use the right arrow to move the Grid/Graph or panel stack to target from the **Available** list to the **Selected** list. For detailed steps, see the *MicroStrategy Web Help*.

23 Click **OK** to save your changes and return to the document.

24 Repeat the appropriate steps above to define each action selector button or link that you want to add to the document.

**Input object controls that support transactions**

You can add the following input object controls to a document, and then format them:

• Barcode Scanner (see *Formatting a Barcode Scanner control*, page 458)
• Calendar (see *Formatting a Calendar control, page 459*)
• Likert Scale (see *Formatting a Likert Scale control, page 460*)
• List (see *Formatting a List control, page 461*)
• Radio List (see *Formatting a Radio List control, page 463*)
• Signature Capture (see *Formatting a Signature Capture control, page 464*)
• Slider (see *Formatting a Slider control, page 464*)
• Star Rating (see *Formatting a Star Rating Control, page 466*)
• Stepper (see *Formatting a Stepper control, page 467*)
• Switch (see *Formatting a Switch control, page 467*)
• Text Area (see *Formatting a Text Area control, page 468*)
• Text Field (see *Formatting a Text Field control, page 469*)
• Time Picker (see *Formatting a Time Picker control, page 472*)
• Toggle (see *Formatting a Toggle control, page 472*)

### Formatting a Barcode Scanner control

The Barcode Scanner style displays as a barcode scanner or numeric keypad on a mobile device. Users can point the mobile device at a barcode to scan it, or enter the barcode number manually using the numeric keypad.

The barcode input control supports barcodes beginning with zero (0) using the text/string data type. Barcodes that begin with a number other than zero are supported as numeric data types.

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450*.

---

### To format a Barcode Scanner control

1. You can require that users scan or enter a barcode before submitting their changes. Do one of the following:
• To require users to scan or enter a barcode before submitting their changes, select the **Input is required** check box.

• To allow users to submit their changes without scanning or entering a barcode, clear the **Input is required** check box.

2 You can match the barcodes against attribute elements. To do so, select the **Match barcode against attribute elements** check box.

## Formatting a Calendar control

The Calendar style displays as:

• A calendar in Web

• Dates on a selectable wheel on a mobile device

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450.*

---

### To format a Calendar control

1 You can require that users specify a value using the input object control before submitting their changes. Do one of the following:

• To require users to specify a value for the control before submitting their changes, select the **Input is required** check box.

• To allow users to submit their changes without specifying a value, clear the **Input is required** check box.

2 To specify the earliest date a user can choose in the calendar, select the **Minimum value** check box, click the calendar, and then select the date.

3 To specify the latest date a user can choose in the calendar, select the **Maximum value** check box, click the calendar, and then select the date.

4 You can allow users to specify a time as well as a date using the Calendar control. To do so, select the **Include time** check box.
Formatting a Likert Scale control

The Likert Scale style displays as a series of radio buttons in Web or on a mobile device. Users can select a radio button to rate an item on a numeric scale. For example, they can specify how satisfied they were with service they received as a value from 1 to 10.

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450*.

**To format a Likert Scale control**

1. You can require that users select a radio button before submitting their changes. Do one of the following:

   - To require users to select a radio button before submitting their changes, select the **Input is required** check box.
   - To allow users to submit their changes without selecting a radio button, clear the **Input is required** check box.

2. You can determine whether users rate an item on a scale of 1 to 5, 1 to 7, or 1 to 10. From the Rating Scale area, select one of the following:

   - To have users select from a scale of 1 to 5, select the **5-level** option.
   - To have users select from a scale of 1 to 7, select the **7-level** option.
   - To have users select from a scale of 1 to 10, select the **10-level** option.

3. In the **Label for Lowest Rating** field, type the explanatory text to display next to the lowest ratings. This text should describe the significance of selecting a low numeric value (for example, “Strongly Disagree”).

4. In the **Label for Highest Rating** field, type the explanatory text to display next to the highest ratings. This text should describe the significance of selecting a high numeric value (for example, “Strongly Agree”).
Formatting a List control

The List style displays as:

- A drop-down list in Web
- A wheel on an iPhone
- A list on an iPad or Android device

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450.*

---

**To format a List control**

1. You can require that users specify a value using the input object control before submitting their changes. Do one of the following:
   - To require users to specify a value for the control before submitting their changes, select the **User must enter a value** check box.
   - To allow users to submit their changes without specifying a value, clear the **User must enter a value** check box.

2. You can display the list automatically when the document is viewed, or display the list only when a user selects its grid cell or text field. Do one of the following:
   - To display the list automatically, select the **Show by default** check box.
   - To display the list when its grid cell or text field is selected, clear the **Show by default** check box.

3. To specify a width for the list, select the **Width** check box. In the field, type the width in inches.

4. You can automatically generate the values displayed in the list, or manually determine the values. If determined manually, you can specify the text displayed for each choice that is presented to the user, and the value to use to update, insert, or delete data. Select one of the following under **Input type**:
   - To display automatically generated values, select **Calculated**.
- Specify the lowest and highest selectable values in the list by typing a value in the **Minimum value** field and the **Maximum value** field.

- To specify the interval displayed between each value in the list, type a value in the **Interval** field. For example, if the minimum value is 0 and the interval is 10, users can specify 0, 10, 20, 30, and so on.

- To use manually entered values, select **Manual**. Perform the following steps for each value:
  - In the **Value** field, type the value to use when the choice is selected.
  - In the **Label** field, type the text to display for the choice.
  - To add choices to the list, click the **Add** icon.
  - To delete a choice from the list, click the **Delete** icon next to the choice.

- By default, when the text field or grid cell of the list is set to a value for which no label is defined in the Control Properties, the list is displayed as blank and no value is selected. You can specify text to display in the list instead. To do so, type the text you want to display in the first field in the **Label** column, next to **Unset**.

- To display a list of attribute elements from a selected attribute, select **Dataset**. Perform the following steps:
  - From the **Source** drop-down list, select the dataset report that contains the attribute you want to use to display the list control.
  - From the **Attribute** drop-down list, select the attribute whose elements you want to use as options in the list.

- You can specify the attribute form MicroStrategy will use to display each attribute element as an option in the list. For example, you can choose to display the ID of each attribute element as an option in the List control. From the **Displayed Forms** drop-down list, select one of the following:
  - To allow MicroStrategy to automatically determine which attribute form to display, select **Automatic**.
  - To manually specify the attribute form you want to use to display options in the list, select the name of the attribute form.

- From the **Writeback Form** drop-down list, select the attribute form to use to update your data. The value of this form will be supplied to the
Transaction Services report when a user selects an attribute element from the list control.

**Formatting a Radio List control**

The Radio List style displays as a group of radio buttons in Web or on a mobile device.

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450*.

---

**To format a Radio List control**

1. From the **Display Style** drop-down list, select **Radio List**.

2. You can require that users select a radio button before submitting their changes. Do one of the following:
   - To require users to select a radio button before submitting their changes, select the **Input is required** check box.
   - To allow users to submit their changes without selecting a radio button, clear the **Input is required** check box.

3. You can determine whether the radio buttons are displayed in a horizontal or a vertical layout. From the **Display Layout** drop-down list, select one of the following:
   - To display the radio buttons in a horizontal layout, select **Horizontal** (default).
   - To display the radio buttons in a vertical layout, select **Vertical**.

4. You can choose to display a specific number of radio buttons per row or column in the control, or display all the radio buttons in a single row or column. Do one of the following:
   - To display a specific number of radio buttons in each row or column, type the number of radio buttons in the **Items Per Row** field.
   - To display all the items in a single row or column, leave the **Items Per Row** field blank.
Formatting a **Signature Capture control**

The Signature Capture style displays as a field in which a user can sign their name on a mobile device.

The Signature Capture input object control stores the user's signature as an image in the `savedImages` folder. For steps to change the location in which images are stored, see the *Administering MicroStrategy Mobile* chapter in the *Mobile Design and Administration Guide*.

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450*.

---

**To format a Signature Capture control**

1. You can require that users provide a signature using the input object control before submitting their changes. Do one of the following:
   
   - To require users to provide a signature for the control before submitting their changes, select the **Input is required** check box.
   
   - To allow users to submit their changes without providing a signature, clear the **Input is required** check box.

2. You can display a horizontal line in the input control, to show the user where to sign their name. Do one of the following:
   
   - To display the horizontal line, select the **Show Guidelines** check box.
   
   - To hide the horizontal line, clear the **Show Guidelines** check box.

---

**Formatting a **Slider control**

The Slider style displays as a slider in Web or on a mobile device.

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450*.
To format a Slider control

1. You can require that users specify a value using the input object control before submitting their changes. Do one of the following:
   - To require users to specify a value for the control before submitting their changes, select the User must enter a value check box.
   - To allow users to submit their changes without specifying a value, clear the User must enter a value check box.

2. You can display the slider automatically when the document is viewed, or display the slider only when a user selects its grid cell or text field. Do one of the following:
   - To display the slider automatically, select the Show by default check box.
   - To display the slider when its grid cell or text field is selected, clear the Show by default check box.

3. To specify a width for the slider in inches, select the Width check box, then type the width in inches. This option is only available if the Show by default check box is cleared.

4. To specify a width for the slider as a percentage of the text box or grid cell it is defined on, type a percentage in the Label Width field. This option is only available if the Show by default check box is cleared.

5. You can automatically generate the values displayed in the slider, or manually determine which values are displayed. If determined manually, you can specify each value displayed. Select one of the following under Input type:
   - To display automatically generated values, select Calculated.
     - To specify the lowest and highest selectable values, type a value in the Minimum value field and in the Maximum value field.
     - To specify the interval displayed between each value in the slider, type a value in the Interval field. For example, if the minimum value is 0 and the interval is 10, users can specify 0, 10, 20, 30, and so on.
• To use manually entered values, select Manual. Type each value in the Values column. Click the Add icon to add fields, or click the Delete icon to delete a value.

Formatting a Star Rating Control

The Star Rating style displays as a row of stars in Web or on a mobile device. Users can click or tap a point on the row to give an item a specific star rating. For example, they can rate an item as four out of five stars.

For steps to navigate to where you can select the following options, see Creating a transaction-enabled document, page 450.

To format a Star Rating control

1 You can require that users click or tap the control before submitting their changes. Do one of the following:

• To require users to click or tap the control before submitting their changes, select the Input is required check box.

• To allow users to submit their changes without clicking or tapping the control, clear the Input is required check box.

2 You can determine the maximum number of stars that users can select when rating an item. Select one of the following next to Maximum Rating Value:

• To allow users to select a maximum of three stars, select the 3-star option.

• To allow users to select a maximum of five stars, select the 5-star option.

• To allow users to select a maximum of ten stars, select the 10-star option.

3 From the Display Style drop-down list, select the style in which to display the control. A preview of each style is displayed in the drop-down list.
Formatting a Stepper control

In Web or on a mobile device, the Stepper style displays as a numeric value placed between an increment icon on the right and a decrement icon on the left. Users can select the increment icon to increase the value displayed or select the decrement icon to decrease the value displayed.

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450.*

To format a Stepper control

1. You can require that users click or tap the control before submitting their changes. Do one of the following:
   - To require users to click or tap the control before submitting their changes, select the **Input is required** check box.
   - To allow users to submit their changes without clicking or tapping the control, clear the **Input is required** check box.

2. To specify the smallest number that a user can select in the Stepper control, type the number in the **Minimum Value** field.

3. To specify the largest number that a user can select in the Stepper control, type the number in the **Maximum Value** field.

4. To specify the interval displayed between each value in the Stepper control, type a value in the **Interval** field. For example, if the minimum value is 0 and the interval is 10, users can specify 0, 10, 20, 30, and so on.

Formatting a Switch control

The Switch style displays as:

- A check box in Web
- An on/off switch or a check box on an iPhone, iPad, or Android device

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450.*
To format a Switch control

1. You can require that users select or toggle the input object control before submitting their changes. Do one of the following:
   - To require users to select or toggle the control before submitting their changes, select the **User must enter a value** check box.
   - To allow users to submit their changes without selecting or toggling, clear the **User must enter a value** check box.

2. To specify the value used for the input object when the switch or check box is in its off position, type the value in the **Off Value** field.

3. To specify the value used for the input object when the switch or check box is in its on position, type the value in the **On Value** field.

4. You can determine whether the control is displayed as a check box or as an on/off switch on mobile devices. Select one of the following:
   - To display the control as a check box on mobile devices, select the **Display as a checkbox on mobile devices** check box.
   - To display the control as an on/off switch on mobile devices, clear the **Display as a checkbox on mobile devices** check box.

Formatting a Text Area control

The Text Area control displays as a text field that provides space for multiple rows of text in Web or on a mobile device.

For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450*.

To format a Text Area control

1. You can require that users specify a value using the input object control before submitting their changes. Do one of the following:
   - To require users to specify a value for the control before submitting their changes, select the **User must enter a value** check box.
• To allow users to submit their changes without specifying a value, clear the User must enter a value check box.

2 You can choose to replace the control with an image and display the control only when the user clicks the image. Select the Show icon when collapsed check box. This option is only available when the Show by default check box is cleared.

3 To display a preview of the text in the Text Area control, select the Preview check box, then type the number of characters to display in the field.

4 To specify a width for the control, type the width in inches in the Width field.

5 To specify the maximum number of characters that can be typed into the text field, type the number of characters in the Maximum Length field.

**Formatting a Text Field control**

The Text Field control displays as a text field consisting of a single row in Web or on a mobile device.

For steps to navigate to where you can select the following options, see Creating a transaction-enabled document, page 450.

---

**To format a Text Field control**

1 You can require that users specify a value using the input object control before submitting their changes. Do one of the following:

• To require users to specify a value for the control before submitting their changes, select the User must enter a value check box.

• To allow users to submit their changes without specifying a value, clear the User must enter a value check box.

2 For text fields based on an input object that contains text, specify the following:

• To specify the minimum number of characters that can be typed into the text field, type the number of characters in the Minimum Length field.
• To specify the maximum number of characters that can be typed into the text field, type the number of characters in the **Maximum Length** field.

3 For text fields based on an input object that contains numeric data, specify the following:

• To specify the smallest number a user can type in the text field, select the **Minimum Value** check box, then type the number in the field.

• To specify the largest number a user can type in the text field, select the **Maximum Value** check box, then type the number in the field.

4 You can choose to have Web automatically verify that the value entered in the text field is in the correct format when a user tries to submit the data. To do so, from the **Validation** drop-down list, select the type of format you want users to use when entering data in the text field. The options available may vary depending on the data type of the input object you are using to create the text field. Select one of the following:

• To allow users to enter text in any format, select **No Validation**.

• To have users enter a phone number in the field, select **Phone Number**.

• To have users enter a zip code in the field, select **US Zip Code**.

• To have users enter a social security number in the field, select **Social Security Number**.

• To have users enter text in a custom format, select **Regular Expression**. In the **Expression** field, type the regular expression you want to use to determine whether the text is in the correct format, using the JavaScript version of the regular expression syntax. For examples, see the table below.

5 You can prevent the password from being displayed on the screen by displaying placeholder characters in place of the password when the user inputs the password into the text field. Do one of the following:

• To use placeholder characters to display the password, select the **Mask text (password)** check box.

• To display the password as the user inputs characters, clear the **Mask text (password)** check box.
The table below contains examples of regular expression syntax you can use to ensure users enter data in the correct format.

<table>
<thead>
<tr>
<th>Type of Format</th>
<th>Regular Expression</th>
<th>Examples of Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>US or Canadian postal code</td>
<td>^((\d{5}-\d{4})</td>
<td>((\d{5})</td>
</tr>
<tr>
<td>UK postal code</td>
<td>^[A-Za-z]{1,2}[\d]{0,1}[A-Za-z]{1,2}d{1,2}([A-Za-z]{1,2})?</td>
<td>s?\d[A-Za-z]{1,2}d{1,2}$</td>
</tr>
<tr>
<td>Indian postal code</td>
<td>^[1-9]{3}\s{0,1}[0-9]{3}$</td>
<td>234675  456001</td>
</tr>
<tr>
<td>International phone number</td>
<td>^+([?:-][0-9] ?){6,14}[0-9]$</td>
<td>+31 20 794 8425  +32 2792 0436</td>
</tr>
<tr>
<td>Swedish phone number (SIS</td>
<td>^((+\d{2}[\d{1,3}[-])</td>
<td>\d{3}[:\d{3}]{2}+))$</td>
</tr>
<tr>
<td>Italian phone number</td>
<td>^([0-9]<em>)</em>-\s?\s?/[0-9]*$</td>
<td>02-123456  02/123456  02 555426</td>
</tr>
<tr>
<td>Email address</td>
<td>^[@‘-.]+0([@‘-.]+).?[@‘-.]{2,4}$</td>
<td><a href="mailto:johndoe@address.com">johndoe@address.com</a>  <a href="mailto:janedoe@mail.org">janedoe@mail.org</a></td>
</tr>
</tbody>
</table>
| URLs, include http, https,      | (mailto\:
:|\(news\(ht|f)tp(s?)\)\:/:|
}{1}\S+ $ | http://www.mstr.com  mailto:jsmith@address.com  ftp://ftp.testserver.com |
| ISBN 10 and ISBN 13 numbers     | ^((97(8|9))\d{9}(/(d|X){1}$ | 0224536779  9780552317248 |
| Time specified in a twelve-hour | ^\+(?:[0-9] ?){6,14}[0-9]$ | +31 20 794 8425  +32 2792 0436 |
| followed by AM or PM            | | 11:00am  9:00 PM  11:59 pm |
| Sixteen-digit credit card       | \d{4}-?\d{4}-?\d{4}-?\d{4}$ | 1234-1234-1234-1234  1234567890123456 |
Formatting a Time Picker control

The Time Picker style displays as:

- An interactive clock in Web
- A wheel-style prompt on a mobile device

For steps to navigate to where you can select the following options, see Creating a transaction-enabled document, page 450.

To format a Time Picker control

Users must have a browser with HTML5 support to view the Time Picker control as an interactive analog clock display. On browsers without HTML5 support, the control is displayed as a digital clock.

1 You can require that users specify a time using the input object control before submitting their changes. Do one of the following:

   - To require users to specify a time for the control before submitting their changes, select the User must enter a value check box.
   - To allow users to submit their changes without specifying a time, clear the User must enter a value check box.

2 Type the time interval to display between each value in the Interval field, in minutes. For example, if the interval is 5, users can select 2:00, 2:05, 2:10, and so on.

Formatting a Toggle control

The Toggle style displays as a button in Web or on a mobile device. Users can click (in Web) or tap (on a mobile device) the button to change its display. For example, in a mobile document designed to allow supervisors to accept or reject time-off requests, you can choose to display a toggle button next to each request. Each toggle button can be displayed as one of three different images:

- An empty circle for requests that have not yet been reviewed
- A check mark for requests that have been approved
- An X mark for requests that have been rejected
Users can then tap the toggle button next to each request until the toggle button is displayed as the image that indicates the correct status of the request.

Continuing with the example above, the toggle button next to a request is first displayed as an empty circle on the mobile device. Tapping the button changes the display of the button to a check mark. Tapping the button again displays the button as an X mark. Tapping the button a third time displays the button as an empty circle, and so on.

Steps to format a Toggle control are below. For steps to navigate to where you can select the following options, see *Creating a transaction-enabled document, page 450*.

---

**To format a Toggle control**

1. You can require that users click or tap the input object control before submitting their changes. Do one of the following:
   - To require users to click or tap the control before submitting their changes, select the **User must enter a value** check box.
   - To allow users to submit their changes without clicking or tapping the control, clear the **User must enter a value** check box.

2. You must define each image that can be used to display the toggle button by specifying the address of the image and the value to assign to each image. This value will be used to represent the image when the user submits their changes. Perform the following steps:
   a. In the **Value** field, type the value you want to use when the image is selected.
   b. Type the location of the image to display in the **Image Source** field. You can specify the location as:
      - An http reference to a central web server machine, such as http://microstrategy/Test/myimage.jpg. *Intelligence Server and Desktop must both be able to access the machine.*
      - A full path to the image on a shared network drive, such as \my_computer\shared\myimage.jpg. *All users, Intelligence Server, Desktop, and the web server must be able to access the drive.*
- A partial path, such as `Images\myimage.jpg`. The image must be copied in all of the following folders: Desktop\Images, Intelligence Server\Images, and Web\Images.

c You can add images to the toggle button by clicking the Add icon. Repeat the appropriate steps above for each image you want to add to the toggle button.

3 To delete an image from the toggle button, click the Delete icon next to the image to delete.

4 By default, when the text field or grid cell on which the toggle button is defined is set to a value for which no image is specified in the Control Properties, the toggle button is displayed as a blank space and no value is selected. You can specify an image to display for the toggle button instead. To do so, type the location of the image (as described above) in the first field in the Image Source column, next to the word Unset.
Introduction

This section describes more advanced things you can do with MicroStrategy Report Services documents. This includes:

- *Creating multi-layout documents, page 476*
- *Using prompts in documents, page 488*
- *Specifying the delivery options available to users subscribing to a document, page 493*
- *Improving document execution performance, page 494*
- *Caching documents, page 502*
- *Portable documents: Reusing documents across projects, page 505*
Creating multi-layout documents


For example, each member of a team of document designers creates complex documents for his own department, such as human resources or finance. The documents must be worked on simultaneously, so that they are finished at the same time. But the documents must be presented as a single document.

The solution is to create a multi-layout document, which means that each document is placed into its own layout within the same document. This creates a “book” of documents. Each layout functions as a separate document, with its own grouping, page setup, and so on, but the layouts are generated into a single PDF document. The pages can be sequentially numbered through all the layouts, and the table of contents shows all the layouts.

In the table of contents shown below, the first-level headings are the different layouts. Each was a separate document that was imported into a single multi-layout document. Note that the pages are numbered sequentially, from the beginning of the document to the end. For steps to import existing documents into a multi-layout document, see Importing layouts into a document, page 483.

| Regional Performance Management Dashboard | ........................................................ | 1 |
| Category Performance Dashboard | ........................................................ | 3 |
| Category Sales and Profit Performance | ........................................................ | 5 |
| Electronics | ........................................................ | 5 |
| Computers | ........................................................ | 7 |
| Central | ........................................................ | 11 |
| Mid-Atlantic | ........................................................ | 15 |
| Northeast | ........................................................ | 19 |
| Northwest | ........................................................ | 23 |
| South | ........................................................ | 27 |
| Southeast | ........................................................ | 31 |
| Southwest | ........................................................ | 35 |

In another example, two documents must be sent as one PDF. The first document contains a wide Grid/Graph that must be printed in landscape view. The second document, which uses a different dataset report, is a narrower document that should be printed in portrait view. If you put them
into the same document, extra blank pages are printed, as shown in the diagram below.

A multi-layout document solves this problem, by combining the two documents into a single document. Each layout has a separate orientation, so that the wider layout can be set to display in landscape, while the narrower layout can be set to display in portrait.

The layouts are displayed as tabs so that users can easily switch between layouts. Tabs are displayed in all modes in MicroStrategy Web.

You can create a cover page for a multi-layout document. The cover page is in its own layout, so that it does not display a page number or any of the information from the rest of the document. The rest of the document is contained in a separate layout from the cover page. The cover page can
display the title of the document, print date, and other information. To print
the page numbers and document title on the remaining pages, place the
information in the second layout's Layout Footer or Layout Header.

**Layout components that can be edited independently**

You can edit the contents of each layout separately, without affecting the
contents on other layouts in the document. For each layout, the following
options can be set independently of other layouts in the document:

- **Grouping and sorting dataset**
  
  If you add more than one dataset to a document, you designate one
dataset as the grouping and sorting dataset. You can group and sort only
by this dataset. Each layout can have its own grouping and sorting
dataset. For steps to change the grouping and sorting dataset, see
*Changing the grouping and sorting dataset for a document, page 51.*

- **Grouping**
  
  Grouping the data sets up a type of hierarchy within the document, and
an inherent or implied sort order for the data. Each layout can be grouped
differently. For steps to group data, see *Grouping records in a document, page 374.*

  By default, a user's grouping selections apply only to the current layout,
but you can specify that the grouping selection is retained when a user
switches layouts in MicroStrategy Web. This setting is applied to all
layouts that contain the same grouping fields. For instructions and an
example, see *Applying grouping selections to the current layout or all
layouts, page 399.*

- **Sorting**
  
  A document's data is first sorted according to its groupings, but you can
control how the records in the Detail section, for example, are sorted. For
steps to determine sorting, see *Sorting records in a document, page 409.*

- **Layout tab**
  
  Each layout has its own tab. Use them to switch between layouts, rename
layouts, and change the order of the layouts. For instructions on each of
these tasks, see *Renaming and formatting layout tabs, page 484.*

- **Document Headers and Footers**
  
  When you add a layout, the Document Header and Document Footer
sections are replaced by the Layout Header and Layout Footer. The
• Layout Header/Footer prints at the beginning/end of the layout. For an introduction to document sections, see *Understanding and working with document sections, page 28*.

• Which sections are displayed and which are hidden in Desktop and in MicroStrategy Web

You can hide or display sections in different views or in all views for a specific layout. The same section in other layouts is not changed, allowing you to hide and display different document sections for different layouts. For details, see *Hiding or displaying sections for a finished document, page 289*.

• Border and background color

You can choose the border and background color for each layout. If the document contains only one layout, the border and background is applied to the entire document. For steps, see *Formatting the border or background of a document or layout, page 325*.

• Incremental fetch

Incremental fetch divides large layouts into pages, thereby loading the data in batches (or blocks) rather than all at the same time. This improves the usability and performance of a large document or layout, by reducing the load and overall memory usage on the web server. If the document contains only one layout, the incremental fetch settings are applied to the entire document. For examples and steps, see *Improving document execution performance, page 494*.

• Paper size, margins, page orientation, scaling, and horizontal fit/overflow

You can modify a document’s appearance before printing to ensure that the printed document appears as desired. Each layout can have different settings; for example, one layout can print landscape while another prints portrait. For steps, see *Modifying page setup options, page 346*.

• Autostyles

An Autostyle is a collection of formatting settings saved for each control type (text fields, lines, and so on). It is applied to individual layouts, not the entire document. If the Page Header/Footer is shared among layouts, any formatting changes applied to those sections are applied throughout the document. See *Formatting using predefined formats (Autostyles), page 258* for details on Autostyles; see *Applying an Autostyle, page 259* for steps to apply an Autostyle to a document.
• Automatic maintenance of selector targets

When targets are automatically maintained, all attribute and metric selectors in the layout automatically target all Grid.Graphs and panel stacks that are in the same panel or document section as the selector. Any new Grid.Graph or panel stack added to the layout is automatically defined as the target of all attribute and metric selectors in the same panel or document section. You cannot change the target of any attribute or metric selector in the layout. For instructions to enable and disable automatic target maintenance, as well as background information about selectors in general, see the Dashboards and Widgets Creation Guide.

Document components that are shared across all layouts

A multi-layout document shares the following with all the layouts it contains:

• Document name

• PDF settings, which include graph resolution, whether to show bookmarks, embedded fonts, and interactive tables of contents

For steps, see Changing graph resolution in PDFs, page 355, Embedding fonts in PDFs, page 353, Including or hiding bookmarks in PDFs, page 356, and Including interactive tables of contents in PDFs, page 358.

Bookmarks, which are links to areas of the PDF, are created by default for a multi-layout document.

• Excel exporting options, such as how to display images in Excel

For instructions on defining the Excel exporting options, see Specifying default export options, page 365.

• General exporting options, such as whether to export all layouts or only the current layout

For information on how multi-layout documents are exported, see Exporting multi-layout documents, page 486. For steps to define export options, see Specifying default export options, page 365.

• Datasets

All the datasets used in any layout in the document are displayed in the Dataset Objects panel, allowing you to use objects from any dataset in any layout. If you delete a dataset, it is deleted from the entire document, not
just the current layout. For information about datasets, see *Using datasets in documents, page 45.*

- **Watermarks**

  A watermark is text or an image that typically identifies or decorates pages. It is a faint design appearing in the background of all pages of all layouts in a document. For steps and examples, see *Adding watermarks to documents, page 326.*

- **Default grid Autostyle**

  A default grid Autostyle defines the default formatting for new Grid/Graphs added to a document. The grid Autostyle is a pre-defined report style and applies to all layouts in the document. For steps, see *Defining default formatting for control types: control defaults, page 255.*

- **Whether conditional formatting is displayed**

  Conditional formatting, which is similar to thresholds in reports, formats specific controls automatically depending on when data fits predefined criteria. A user can show or hide all of a document’s conditional formatting. This applies to all layouts in the document. For steps, see *Displaying or hiding conditional formatting, page 323.* For an introduction to conditional formatting, see *Formatting conditional data in documents, page 307.*

- **Whether users’ grouping selections apply to the current layout or to all layouts in MicroStrategy Web.**

  When a user switches layouts in MicroStrategy web, the current layout’s grouping selection can be applied to the new layout, if the layouts contain the same grouping field. For instructions and an example, see *Applying grouping selections to the current layout or all layouts, page 399.*

- **Page Headers and Footers**

  By default, Page Headers and Page Footers are shared for all layouts, although you can change this setting to have separate page sections for each layout. For details, see *Using a separate Page Header and Page Footer for a layout, page 484.*

This section includes examples of multi-layout documents and steps to perform the following:

- *Creating a multi-layout document, page 482*
- *Importing layouts into a document, page 483*
- *Renaming and formatting layout tabs, page 484*
Creating a multi-layout document

To create a multi-layout document, you add a layout to a document. The steps below describe how to do this.

You can also import an existing document’s layouts into another document; for more information, see Importing layouts into a document, page 483.

To create a multi-layout document

1. In MicroStrategy Web, navigate to a document which will become a layout within the multi-layout document you are creating.

2. Open the document in Design or Editable Mode.

3. From the Insert menu, select Layout. The Insert Layout dialog box opens.

4. Do one of the following to create a new layout:
   - To create a new layout using a Report Services (RS) dashboard template, click the Dashboard Layouts tab, then select a template.
   - To create a new layout using a document template, click the Document Layouts tab, then select a template.
     - You can select the iPhone Map Information Window template to quickly create a blank layout designed for use as an Information Window. (For details on Information Windows, see the Mobile Design and Administration Guide.)
   - To create a new layout using a saved document, click the Browse Documents tab, then select a previously saved document.

5. Click OK. The new layout is added and thus a multi-layout document is created.

For information on renaming the tabs, see Renaming and formatting layout tabs, page 484.

Repeat the appropriate steps above to add as many layouts as desired to the new multi-layout document.
Changing the order of layouts in a document

These steps assume you have already created a multi-layout document.

To change the order of the layouts in a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click a layout tab and select Move Left or Move Right. The tabs are ordered accordingly.

Importing layouts into a document

You can import the layouts of one document into another document. The layouts of the imported document are added to the other document, and datasets that are part of the imported document are copied into the other document.

To import layouts into a document

1. In MicroStrategy Web, open the document into which you want to import layouts, in Design or Editable Mode.
2. From the Insert menu, select Import Layout. The Select a Document dialog box opens.
3. Select the document whose layouts you want to import, then click Open. The Document Editor opens.

The layouts of the selected document are added to the document you started with. If a newly imported layout uses the same name as an existing layout, a number is added to the end of the name, for example, Document (2).
Using a separate Page Header and Page Footer for a layout

By default, the Page Header and Page Footer sections are shared for all layouts in a multi-layout document. This is indicated in the name of the Page Header, as shown below.

![Page Header (shared)](image)

You can use different page sections for each layout. When page sections are no longer shared, any edits you make in a particular Page Header or Page Footer affect only the current layout. Also, the word *(shared)* does not appear in the name of the document section, as shown below:

![Page Header](image)

If you use a separate Page Header and Page Footer for one layout, other layouts can still use a shared Page Header and Page Footer, or they can have their own separate Page Headers and Page Footers.

To use a separate Page Header and Page Footer for a layout

1. In MicroStrategy Web, open the multi-layout document in **Design** or **Editable Mode**.
2. From the **Home** menu, select **Page Setup**. The Page Setup dialog box opens.
3. Select **Layout**.
4. Clear the **Use shared page header/footer** check box.
5. Click **OK** to return to the Document Editor.

Renaming and formatting layout tabs

You can rename the layouts (and therefore the tabs). You can also format the background color of the layout tabs.
To rename a layout

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 Right-click a layout tab and select Rename.
3 Type the new name and press Enter.

To change the background color of a layout tab

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 In the layout, from the Home menu, select Page Setup. The Page Setup dialog box opens.
3 Select Layout.
4 From the Tab color drop-down list, select a background color for the tab.
5 Click OK.

Deleting a layout

When you delete a layout, it is removed from the document. After the layout is removed, the dataset that the layout used remains in the Dataset Objects pane for the multi-layout document. If only one layout remains, the Document Header/Footer replaces the Layout Header/Footer.

To delete a layout from a multi-layout document

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 Right-click the appropriate layout tab and select Delete. The layout is removed.
Exporting multi-layout documents

When you export a document, you send its data to an external software application such as an Excel spreadsheet or to Adobe as a PDF displayed outside of the MicroStrategy Document Editor.

When a multi-layout document is exported to PDF, each layout starts on a new page. When exported to an Excel file, each layout is placed into a separate worksheet. If the PDF will be viewed on a Kindle or Nook, you should expand all layouts so that the user can view all the data.

In Excel 2000, all layouts are exported into one worksheet. Use Excel 2003, Excel XP, and newer versions to export layouts to separate worksheets. If you are exporting layouts in MicroStrategy Web, change the User Preference for Excel Options to Excel XP, Excel 2003, and newer versions. For more information and detailed instructions, see the MicroStrategy Web Help.

Before you export, set the export options to control how the document is exported. You can specify whether to export only the current layout or all the layouts in the document. If you allow users to be prompted when they export a document, they can choose to export all layouts or only the current layout.

All export options, including whether to export all layouts, apply to all layouts in the document. For detailed descriptions of those options, see *Specifying default export options, page 365.*
Exporting to Excel all the layouts of a sample multi-layout document creates the following Excel spreadsheet:

The worksheets are named for the document, not the layouts. The name of the document and the Excel spreadsheet (shown at the top of the image) is multilayout example.xls; the names of the worksheets are “multilayout example, 1 of 2” and “multilayout example, 2 of 2”, as shown in the tabs at the bottom of the image.

If you export only the current layout to Excel, the name of the single worksheet is the name of the document.

When exporting a multi-layout document to PDF, the layouts are displayed as bookmarks by default, whether you export all layouts or only the current layout. You can choose whether or not to include bookmarks in the PDF (see Including or hiding bookmarks in PDFs, page 356).

The following procedure specifies the export options so that all the layouts are exported. For steps to set default export options for Excel, see *Specifying default export options, page 365*.

---

**To export a multi-layout document to Excel**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Format** menu, select **Document Properties**. The Properties dialog box opens.
3. Click **Export**.
4. Select **Export All Layouts**.
   
   For details on the other export options, see *Formatting a document for export, page 363*.
5. Click **OK** to return to the document.
6. From the **File** menu, select **Export to Excel**.
7. Click **OK**. The document opens as an Excel spreadsheet. Be sure to save it before exiting Excel.

---

**Using prompts in documents**

If the dataset in a document has a prompt in it, such as Region or Year, you are prompted for an answer when you view the PDF document for the first time. The prompts, which contain the default answers, are displayed as in any standard MicroStrategy report. After the prompts are answered, the document executes and displays the information according to the answers. Prompts in a document provide rich interactivity, allowing each user to display the data relevant to him.

Even if the same prompt object is used in multiple datasets on a document, you are prompted only once. For example, if you use the prompt named **Select Region** in both Dataset1 and Dataset2, you can see the prompt only once. However, if the prompt Select Region is used in Dataset1 and “Copy of Select Region” (an identical copy, except for the name) is used in Dataset2, you see two prompts.
Prompts in documents act as filters and limit the data that is displayed. These value prompts affect the number of rows of data that are displayed but they do not determine which objects are returned from the data warehouse. This is because the prompt answers are not available in the Design View—that is, the creator of the document does not know the objects that the user will select.

You must perform the following general steps to add a prompt to a document:

- Create and save the prompt. For steps, see the Basic Reporting Guide.
- Add the prompt to a report. For steps, see the Basic Reporting Guide.
- Add the prompted report to the document as a dataset report. For steps, see Adding, changing, or removing a dataset, page 48.

You cannot use a prompt directly on a document or put a prompt into a Grid/Graph on a document—only attributes, consolidations, custom groups, and metrics can be used as data fields from the dataset. Object prompts on templates, which allow a user to select which objects to include in a dataset report, are not supported, unless you add the Grid/Graph as a shortcut.

Even when a shortcut is used, the object prompt does not appear in the Dataset Objects panel; you cannot add it to the document as a separate object. When the document is executed, the object prompt is displayed and its answers are shown in the document results. This occurs just as if you had executed the dataset report as a stand-alone report.

For instructions to add a Grid/Graph as a shortcut, see Adding a Grid/Graph as a shortcut, page 191.

### Specifying whether a document uses default prompt answers when the document is run

You can specify whether to have prompts in a document automatically answered using default prompt answers when the document is run. Providing default answers allows users to execute prompted documents more quickly, because they can simply accept the defaults with a single click and run the document. If default answers are not provided for prompts, users must take the time to answer each prompt question individually, unless answers are not required. The default prompt answer is always displayed.
when a value prompt is used, even if the default prompt answer was cleared and the document is then reprompted.

Default answers are particularly useful if a large percentage of your users will answer the prompt the same way. A common example is a document with a prompt on the Year attribute, from which users can choose the attribute element (for example, 1998, 2005, or 2006) they want to see data for. If many users will choose the current year every time they run the document, then providing the current year as the default answer can save users time.

When you save a document after answering prompts, you can set whether your current prompt answers are saved as part of the document definition. The prompt answers are saved in the document definition and not in the report definition, so the prompt answers used in the document do not affect the report when the report is executed.

When the document is re-executed, one of the following scenarios occurs, depending on which option was selected:

• Prompts are displayed with the saved answers shown as the defaults.
• Prompts are displayed and the user is required to answer them.
• Prompts are not displayed and the saved answers are automatically used to answer the prompts.

Steps are below to define how prompts are answered in a document.

**Prerequisite**

• This procedure assumes that you have already created a prompted document.

---

**To specify whether a document uses default prompt answers**

1. Click the name of the document to run it. The prompt selection page is displayed.

2. Answer the prompts on the prompt selection page. If you want the document to use default prompt answers, select the answers to save as default prompt answers. For detailed steps to answer each type of prompt available, see the *MicroStrategy Web Help*.

3. Click **Run Document**.
4 From the **Home** menu, select **Save As**. The Save As dialog box is displayed.

5 From the Advanced section, select one of the following:

- To use the prompt answers that you selected above as the default prompt answers, select the **Display prompt and use the current answers as the default answers** option. The next time that the document is run, the prompt selection page will be displayed with the default prompt answers automatically selected.

- To save the document without default prompt answers, select the **Display prompt but discard the current answers** option. The prompt selection page will be displayed the next time the document is run, with no default prompt answers automatically selected.

- To use the prompt answers you specified as the default prompt answers and automatically skip the prompt selection page, select the **Do not display prompt and use the current answers as the default answers** option. The next time the document is run, the default prompt answers will automatically be used to answer the prompts and run the document. The prompt selection page will not be displayed to users.

6 Click **OK** to save the document.

### Prompt order in documents

By default, if multiple dataset reports are used on the document:

1 The prompts in the first dataset report are displayed to the user, then the second, and so on.

2 If a prompt is contained in more than one report, the prompt is displayed on the first dataset report only.

Within each dataset report, an ordered list of prompts is constructed using the following rules:

1 All non-prompt application objects (attributes, metrics, and so on) are ordered so that each object appears before its dependents.

2 Each object is replaced with any prompts that it contains.
3 If a prompt contains prompts, those prompts are added to the list immediately above the original prompt. (Prompts within another prompt must be answered before the original prompt can be answered.)

4 The previous step is repeated until each prompt in the report is listed.

5 Any duplicated prompts are eliminated. Each prompt is displayed only one time, and when it first occurs on this list of prompt.

Note the following:

- If prompts are moved within the report filter after the report is first saved, the prompt order is not changed. The order that the prompts are initially saved is used for the default prompt order.

- If the order of the reports in a document is changed, even after the document is first saved, the prompt order is affected. The prompts in the first dataset report are displayed to the user, and then the second, and so on.

Changing the prompt order

You can change the order that prompts are presented when the document is executed. For example, your document contains datasets with Region and Call Center prompts, and you want to answer the prompts in that order. Use the Prompt Ordering dialog box in Desktop to specify that order.

To re-create this example, create the following before beginning the procedure:

- A filter definition prompt on Region
- A filter definition prompt on Call Center
- A report with Region and the Revenue metric, filtered by the Region prompt
- A report with Call Center and the Revenue metric, filtered by the Call Center prompt
- A document including both reports as datasets, with Region, Call Center, and the Revenue metric in the Layout area
To order prompts in a document

1. In Desktop, open the document in Design View in the Document Editor.

   To re-create the example, open the document including both reports as datasets.

2. From the Data menu, choose Prompt Ordering. The Prompt Ordering dialog box opens.

3. Select the prompt to modify and click the up or down arrows to change its order.

4. Once the prompts are in the correct order (for the example, the order is Region and Call Center), click OK to return to the Document Editor.

When you execute the document, the prompts are displayed in the order selected.

Specifying the delivery options available to users subscribing to a document

You can determine which delivery options are available to users subscribing to a specific document. For example, you can specify which delivery schedules can be used to subscribe to the document, or prevent users from subscribing to the document altogether.

If an existing document subscription uses a schedule or document that has been made unavailable for subscriptions, the document will not be delivered.

For general information on subscribing to reports and documents, see the MicroStrategy Web Help. For steps to specify the delivery options available to users subscribing to a report, see the Building Query Objects and Queries, for Designers chapter in the Basic Reporting Guide. Restricting the delivery schedules available when subscribing to a report does not affect the delivery schedules available for documents that use the report as a dataset report.

You can create new schedules in the Desktop Schedule Manager. For steps, see the Scheduling Jobs and Administrative Tasks chapter in the System Administration Guide.
To specify the delivery options available to users subscribing to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.


3. From the left, under Document Properties, select Advanced. Select one of the following options under Schedules for Subscriptions:
   - To prevent users from subscribing to the document, select the Do not allow this document to be scheduled option.
   - To allow users to subscribe to the document using any schedule associated with the MicroStrategy project in which the document is stored, select the Allow users to subscribe to all schedules option.
   - To specify the list of schedules users can select from when subscribing to the document, select the Only allow users to subscribe to schedules in the list below option. Schedules in the Selected list are available to users. Select a schedule from the Available list and click the Add icon to move it to the Selected list.

   Administrators can determine which schedules are included in the Available list. For more information, see the Web Administrator Help.

4. Click OK to apply your changes.

Improving document execution performance

You can improve document execution performance in several ways. The methods described here include disabling automatic resizing of documents, limiting automatic shrinking and growing, and hiding empty document sections, as well as enabling incremental fetch.

Automatic resizing of documents

By default, MicroStrategy Web automatically calculates the width of your document and height of your document’s sections when the document is
executed. This ensures that the document is automatically resized to display all of its content.

If you disable this automatic size adjusting, you can improve the speed at which the document is executed.

This change applies to documents executed in MicroStrategy Web in Editable Mode, Interactive Mode, and Express Mode. Enabling or disabling automatic resizing does not affect how a document is exported to Excel or PDF. When a document is exported to Excel or PDF, it is automatically positioned as far to the right as necessary to effectively display the document.

An administrator can enable or disable automatic resizing on a project-wide basis, using Report Services preferences in the Project Defaults page.

To ensure that document width and height are not resized automatically

1. In MicroStrategy Web, click the MicroStrategy icon at the top of any page and select Preferences. The User Preferences page opens.
2. From the left, select Report Services. The Report Services user preferences are displayed.
3. To ensure that the width of your document is not resized automatically, from the Document Width Mode Calculation drop-down list, select Off.
4. To ensure that the height of sections in your document is not resized automatically, from the Document Section Height Mode Calculation drop-down list, select Off.
5. Click Apply to save your changes.

Limiting shrinking, growing, and empty sections

You can improve the speed at which a document is executed by not allowing document sections to automatically shrink and grow, and by hiding empty document sections.

A document can automatically shrink or grow a given section depending on how much data is returned from the data warehouse. A document will also display all sections of a document, even sections that are empty, unless
empty sections are hidden. Both of these processes take time for the system to perform during document execution.

To disable shrinking and growing, edit a document. In the Properties dialog box, on the Layout tab, clear the Can Shrink and Can Grow check boxes.

To hide empty document sections, edit a document. In the Properties dialog box, on the Layout tab, select the Hide if Empty check box.

**Incremental fetch**

Incremental fetch divides large documents or layouts into pages, thereby loading the data in batches (or blocks) rather than all at the same time. This improves the usability and performance of a large document or layout, by reducing the load and overall memory usage on the web server.

You can define the incremental fetch options in both MicroStrategy Web and in Desktop. Incremental fetch is applied when the document is executed in Editable Mode, Interactive Mode, or Express Mode in MicroStrategy Web. Desktop does not apply incremental fetch to documents.

The blocks of data are defined by the number of objects (the block size) to return at a certain level. If the document or layout is grouped, you can select any group as the level. If it is not, then the block size is applied to the Detail section.

For example, each row in the Detail section of a document contains the Item attribute and several metrics. Incremental fetch is applied, with a block size
of ten. In MicroStrategy Web, only ten rows of items are displayed on a single page, as shown in the document sample below:

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Sales Rank</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 Places to Go While Still Young at Heart</td>
<td>$67,993</td>
<td>98</td>
<td>$17,776</td>
<td>26.14%</td>
</tr>
<tr>
<td>Art As Experience</td>
<td>$23,733</td>
<td>320</td>
<td>$5,485</td>
<td>23.11%</td>
</tr>
<tr>
<td>The Painted Word</td>
<td>$22,323</td>
<td>329</td>
<td>$2,625</td>
<td>11.76%</td>
</tr>
<tr>
<td>Hirschfeld on Line</td>
<td>$50,442</td>
<td>139</td>
<td>$12,289</td>
<td>24.36%</td>
</tr>
<tr>
<td>Adirondack Style</td>
<td>$39,101</td>
<td>219</td>
<td>$10,008</td>
<td>25.59%</td>
</tr>
<tr>
<td>Architecture : Form, Space, &amp; Order</td>
<td>$41,378</td>
<td>215</td>
<td>$10,075</td>
<td>24.35%</td>
</tr>
<tr>
<td>50 Favorite Rooms</td>
<td>$26,502</td>
<td>259</td>
<td>$5,249</td>
<td>23.58%</td>
</tr>
<tr>
<td>500 Best Vacation Home Plans</td>
<td>$17,729</td>
<td>346</td>
<td>$3,679</td>
<td>20.75%</td>
</tr>
<tr>
<td>Blue &amp; White Living</td>
<td>$24,669</td>
<td>309</td>
<td>$5,649</td>
<td>22.90%</td>
</tr>
<tr>
<td>Ways of Seeing</td>
<td>$23,777</td>
<td>319</td>
<td>$5,496</td>
<td>23.11%</td>
</tr>
</tbody>
</table>

The bottom of the document contains page numbers, so that you can navigate to another page to display more information. The document has 36 pages in all.

If the same document is grouped by Call Center, incremental fetch can be applied at the level of Call Center. This time, define the block size as five. Select All for the grouping, and then the incremental fetch is employed. Data for five Call Centers is displayed on a single page. The following image shows a portion of the first page of the document, including the end of the first call
center and the beginning of the next. The document now contains only three pages, not 36.

<table>
<thead>
<tr>
<th>GROUPING:</th>
<th>Call Center: (All)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Boy Is Mine</td>
<td>$1,000 4440 $181 10.14%</td>
</tr>
<tr>
<td>Aretha Franklin’s 30 Greatest Hits</td>
<td>$1,058 4327 $163 15.40%</td>
</tr>
<tr>
<td>Never Say Never</td>
<td>$1,007 4429 $137 13.61%</td>
</tr>
</tbody>
</table>

**Call Center: San Diego**

<table>
<thead>
<tr>
<th>Item</th>
<th>Revenue</th>
<th>Sales Rank</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 Places to Go While Still Young at Heart</td>
<td>$6,003 1254</td>
<td>$1,566</td>
<td>26.09%</td>
<td></td>
</tr>
<tr>
<td>Art As Experience</td>
<td>$2,054 3064</td>
<td>$478</td>
<td>23.18%</td>
<td></td>
</tr>
<tr>
<td>The Painted Word</td>
<td>$1,895 3222</td>
<td>$221</td>
<td>11.65%</td>
<td></td>
</tr>
<tr>
<td>Hirschfeld on Line</td>
<td>$4,415 1780</td>
<td>$1,078</td>
<td>24.40%</td>
<td></td>
</tr>
<tr>
<td>Adirondack Style</td>
<td>$3,690 2109</td>
<td>$919</td>
<td>24.90%</td>
<td></td>
</tr>
</tbody>
</table>

If the group is displayed as a single element only, that group cannot be used as the fetch level, since the document must be displayed with all the grouping elements. You can still apply incremental fetch to the document, but only to the detail section, not to the group. If the document contains another group, which does allow all elements to be displayed, you can apply incremental fetch using that other group. For more information about grouping options, see *Grouping records in a document, page 374.*

If the document or layout is not grouped, incremental fetch can be applied only to the Detail section.

You can also apply incremental fetch to a specific Grid/Graph. For more information, see *Incremental fetch on Grid/Graphs, page 499.*

For steps to apply incremental fetch to a document in Desktop, see the *Desktop Help.*
To apply incremental fetch to a document


2. If the document contains multiple layouts, select the layout to apply incremental fetch to.


4. On the left, under Layout Properties, select Advanced.

5. Select the Enable Incremental Fetch check box.

6. From the Fetch Level drop-down list, select the object to be counted for the incremental fetch level.

   • If the document or layout is grouped, the groups are displayed in the drop-down list. Groups that are displayed as a single element only are not shown on this list.

   • If the document or layout is not grouped or all the groups are displayed as single elements only, the only option is the Detail section.

7. Enter the Block Size, which is the number of objects (of the Fetch Level) that are returned in each block.

8. Click OK to return to the document.

Incremental fetch on Grid/Graphs

Incremental fetch divides large Grid/Graphs into pages, thereby loading the data in batches rather than all at the same time. This improves the usability and performance of a large Grid/Graph, by reducing the load and overall memory usage on the web server. Only a Grid/Graph displayed as a grid can be split into rows or blocks, and therefore incrementally fetched. This includes the grid portion of a Grid/Graph displayed as both a grid and a graph simultaneously.

This setting applies only to the rows, not the columns, of the Grid/Graph.
The batches of data are defined by the number of rows or blocks to return at a time. For example, a Grid/Graph on a document contains 360 rows. Incremental fetch is applied, with the number of rows per page set to 25. Only 25 rows are displayed on a single page of the Grid/Graph. Users can click the page numbers at the bottom of the screen to display more information. The document is shown below in Interactive Mode in MicroStrategy Web:

<table>
<thead>
<tr>
<th>Category</th>
<th>Item</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>100 Places to Go While Still Young at Heart</td>
<td>$67,993</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Art As Experience</td>
<td>$23,733</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Painted Word</td>
<td>$22,323</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hirschfeld on Line</td>
<td>$50,442</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Adirondack Style</td>
<td>$39,101</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Architecture: Form, Space, &amp; Order</td>
<td>$41,378</td>
<td></td>
</tr>
<tr>
<td></td>
<td>50 Favorite Rooms</td>
<td>$26,502</td>
<td></td>
</tr>
<tr>
<td></td>
<td>500 Best Vacation Home Plans</td>
<td>$17,729</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Blue &amp; White Living</td>
<td>$24,568</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ways of Seeing</td>
<td>$23,777</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gonzo, the Art</td>
<td>$41,469</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cabin Fever: Rustic Style Comes Home</td>
<td>$17,571</td>
<td></td>
</tr>
<tr>
<td></td>
<td>American Bungalow Style</td>
<td>$40,985</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Building With Stone</td>
<td>$22,573</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Voyaging Under Power</td>
<td>$19,827</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Working With Emotional Intelligence</td>
<td>$26,733</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Attention to Detail</td>
<td>$24,062</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The 43 Laws of Power</td>
<td>$26,513</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Don't Step in the Leadership</td>
<td>$17,711</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Topgrading</td>
<td>$28,071</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Career Intelligence</td>
<td>$29,257</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cubicle Warfare</td>
<td>$28,062</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Wisdom of Teams</td>
<td>$18,568</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Power to Get In</td>
<td>$26,527</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Don't Sweat the Small Stuff</td>
<td>$22,354</td>
<td></td>
</tr>
</tbody>
</table>

You can also apply incremental fetch to the entire document. For more information, see *Improving document execution performance, page 494.*

You can define the incremental fetch options for Grid/Graphs in either MicroStrategy Web or in Desktop, but incremental fetch is applied only when the document is executed in Editable Mode, Interactive Mode, or Express Mode in MicroStrategy Web. Desktop does not apply incremental fetch to Grid/Graphs.
Incremental fetch in repeating document sections

Whether the group and detail sections repeat in a document affects how incremental fetch is applied to Grid/Graphs in that section, as described below:

- If all the elements of a grouping field are displayed simultaneously, the Group Header, Group Footer, Detail Header, and Detail Footer sections repeat, once for each element in the group. Only the first page of data from the Grid/Graph is displayed. Users cannot navigate to another page.

- If only one element is displayed at a time, these sections appear only once. A Grid/Graph placed in one of these document sections does not repeat, and users can navigate to other pages.

- If the document is not grouped, the Detail Header and Detail Footer sections appear only one time. A Grid/Graph placed in one of these document sections does not repeat, and users can navigate to other pages. If the document is not grouped, the Group Header and Group Footer are not displayed.

- Although the Detail section repeats, a Grid/Graph cannot be placed in it, so the Grid/Graph incremental fetch setting does not apply.

For background information on document sections, see Understanding and working with document sections, page 28. For steps to group the document, see Grouping records in a document, page 374. For steps to display individual grouping elements or all the elements, see Using page-by on a document, page 403 (page-by interactively displays groups on separate pages).

To apply incremental fetch to a Grid/Graph

1 In MicroStrategy Web, open a document in the Document Editor.

2 Right-click the Grid/Graph to apply incremental fetch to, and select Properties and Formatting. The Properties and Formatting dialog box opens.

3 On the left, under Properties, click Grid.

4 Select the Enable Incremental Fetch in Grid check box.
5 Select one of the following **Count By** options:

- To divide the Grid/Graph by rows, select **Individual rows**. In the **Maximum number of rows per page** field, type the maximum number of rows to include on each page.
- To divide the Grid/Graph by blocks, select **Blocks**. In the **Blocks per page** field, type the number of blocks to include on each page.

6 Click **OK** to return to the document.

### Caching documents

A cache is the stored results of a document query that has already been executed. When the document is executed again, the system can quickly access the cache to display the data, rather than putting a load on the system to re-run the request to the data source.

Enable document caching to generate the document only once—the first time that you execute a document in a specific mode (such as Express Mode or Interactive Mode) in MicroStrategy Web. Subsequent document executions in the same mode use the cache. Disable document caching to submit the document query to your data warehouse every time that you execute the document in a different mode.

You define the document caching options in Desktop, but documents are cached only when they are executed or exported in MicroStrategy Web. Desktop does not cache documents.

The benefits of document caching include:

- Faster single-user response times.
- The ability to support more concurrent users accessing complex documents.
- Lower total memory and CPU consumption for the same workload.

You can use the default project-level behavior instead, which is set in the Project Configuration Editor. For information and instructions, see the *Project Design Guide*.

You can select which formats to cache. Formats include:

- Excel (when the document is exported to Excel in MicroStrategy Web)
• HTML (when the document is exported to HTML View in MicroStrategy Web)
• PDF (when the document is exported to PDF in MicroStrategy Web)
• XML (when the document’s mode is changed, as from Express Mode to Interactive Mode, in MicroStrategy Web)

By default, a cache is not created for every page-by combination that can be run, since that can use much of the memory allocated to caches. For more information, see Caching and page-by, selectors, and widgets, page 503.

---

**To enable document caching**

1. Open the document in Design View in the Document Editor.
3. Select Caching.
4. Select Enable document caching.
5. Select the formats to cache.
6. Choose whether to Create cache when page-by selections are modified. If this check box is selected, a new cache is created each time a user selects a different page, chooses a different selector item, or interacts with a widget. For more details on this type of caching, see Caching and page-by, selectors, and widgets, page 503.
7. Click OK to save your changes.

---

**Caching and page-by, selectors, and widgets**

By default, a cache is not created for every page-by combination that can be run, since that can use much of the memory allocated to caches. For example, for a document paged by Region, a separate cache would be created for each region.

You may want to create a cache for the region that is used most frequently, or for the default region. The Create cache when page-by selections are modified setting allows you to do this. When this check box is selected,
Caches are also created when a different item is chosen in a selector or when a user interacts with a widget. For instructions to page a document, and the effects of paging a document, see *Using page-by on a document, page 403*. For general information about selectors and widgets, including instructions and examples, see the *Dashboards and Widgets Creation Guide*.

To use document caching in this way, you:

1. Enable page-by caching before executing the document.
2. Select the page, item, or widget view that you want to cache.
3. Disable page-by caching.

Detailed instructions follow.

---

**To enable document caching for page-by**

**Enable document caching**

1. Open the document in Design View in the Document Editor.
3. Select *Caching*.
4. Select *Enable document caching*.
5. Select the formats to cache.
6. Select the *Create cache when page-by selections are modified* check box.
7. Click *OK* to return to the document.
8. Save the document.

**Cache the information**

10. Select the page, item, or widget view that you want to cache.
11 Save the document.

**Disable page-by caching**

12 Open the document in Design View in the Document Editor.

13 From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.

14 Select **Caching**.

15 Clear the **Create cache when page-by selections are modified** check box.

16 Click **OK** to return to the document.

17 Save the document.

---

**Portable documents: Reusing documents across projects**

A portable document contains all the design of the document without the data, allowing you to copy documents between projects, even when the projects do not have the same metadata. When you import the document into the replacement project, you map the document to the new project (referred to as reconciling the document).

- A Report Services (RS) dashboard (a type of document optimized for viewing online and for user interactivity) can also be made portable; for simplicity, the term document is used throughout this section to refer to documents and RS dashboards. For instructions to create RS dashboards, see the Dashboards and Widgets Creation Guide.

Portable documents separate document definition from the dataset reports that provide the data, allowing:

- Documents to be reused across projects, creating a library of reusable documents.
- The document designer and the data architect to work simultaneously, rather than sequentially. That is, the document designer can work on polishing the design of a document (the layouts, panel stacks, and other non-data objects) at the same time that the data architect is preparing the
data (the metrics, reports, and other MicroStrategy objects) that will populate the document. When both are finished, the document is reconciled with the dataset reports.

- Out-of-the-box documents can be deployed to your project by reconciling the documents’ content to your own project objects. For example, you can use a document from the MicroStrategy Tutorial project or any of the Analytical Modules in your own project.

Use the Document Editor to create the document to be reused across projects. For instructions to create a document, see *Creating documents, page 17.*

### How the document reconciliation process works

All the parts of a document whose definition explicitly references a dataset report need reconciliation. These include the dataset reports and the dataset objects on those reports. Dataset objects include metrics, attributes, consolidations, and custom groups.

The original project is the project that you export the document from; the replacement project is the project that you import the document into.

Document reconciliation has the following stages:

- **Stage 1 reconciliation: dataset reports**
  You map each original dataset report to a replacement dataset report.

- **Stage 2 reconciliation: dataset objects**
  For each dataset report, you map each dataset object on the original report to a replacement dataset object on the replacement dataset report. An original dataset object that exists in the replacement report is automatically mapped, but you can select another replacement object. Objects are matched by GUID, then by name.

- **Stage 3 reconciliation: attribute forms**
  (Attribute form reconciliation occurs only in certain cases, depending on the document’s design.)
  For each attribute, you map each attribute form (such as Region Name and Region ID for the Region attribute) from the original dataset report to the attribute form on the replacement dataset report. An ID or DESC
attribute form in the original is automatically mapped to an ID or DESC form in the replacement, but you can select another replacement attribute form, as long as it is an ID or DESC form. A custom attribute form in the original can be mapped to any custom attribute form in the replacement.

**Reviewing after reconciliation**

After reconciliation, you should review the resulting document to ensure that it works as you expect it to. Potential additional work that you may need to perform includes:

- For Interactive Grid widgets and Time Series widgets for mobile devices, settings that refer to dataset objects in the underlying Grid/Graphs are not updated. An example is the interval settings of the Time Series widget.

- Images are not included in the portable document. You must copy any image files to the following folders:
  - Intelligence Server
  - Web ASPx\asp
  - Desktop

- The original attribute in attribute element qualifications in thresholds and view filters is replaced by the replacement attribute, but attribute elements are not updated. After reconciliation, edit the threshold or view filter to ensure that the correct attribute form is used.

**Copying documents between projects**

To copy a document between projects, follow the high-level steps below. See *To copy a document between projects, page 508* for a detailed procedure.

1. In the original project, create the document to be used as a portable document.

2. Export the document from the original project. Exporting creates a package file with the extension .pkg.
3 Import the document into the replacement project.

The document is automatically checked to see if it needs to be reconciled. If it does, you are guided through the reconciliation process.

**Prerequisites**

- You have created the document that will be used as the original document, following these requirements:
  - The document must be created in a project that was created with MicroStrategy version 8.0.1 or later.
  - The document cannot contain derived metrics, derived elements, or drill maps.

- To export the document, you must have browse and read access to the document.

- To import the document, you must have the Use Document Editor privilege, and browse and use access on all replacement objects.

**To copy a document between projects**

**Export the portable document from the original project**

1 In MicroStrategy Desktop, log in to the original project (the project that contains the document to export).

2 Select the document to use as the original document.

3 From the Tools menu, select Export Document Template. The Browse for Folder dialog box opens.

4 Navigate to the folder to save the file in, name the file, and then click OK. Integrity checks are run to ensure that the document meets the prerequisite requirements.

- If the integrity checks fail, a message appears. Click OK to return to Desktop. The document is not exported. Review the prerequisite requirements listed above and edit the document so that it meets those requirements.

- If the document passes the integrity checks, the document, named `document_name.pkg`, is saved in the selected folder.
5 Log out of the project.

**Import the portable document into the replacement project**

6 In MicroStrategy Desktop, log in to the replacement project (the project that you want to import the document to).

7 From the **Tools** menu, select **Import Document Template**. The Select a Package dialog box opens.

8 Navigate to and select the portable document to import.

9 Click **Open**.

10 The document is automatically reviewed to see if it needs reconciliation.

   • If the document needs reconciliation, the Document Reconciliation Editor opens. A status message indicating how many replacement reports or objects need to be reconciled is displayed. Follow the **Reconcile** steps on page 509.

   • If the document does not need reconciliation, the Document Reconciliation Editor opens with blank fields and a blank status message. One way that this can happen is if the document does not contain any dataset reports. Skip to the **Save** steps on page 511.

**Reconcile**

The Document Reconciliation Editor lists:

• The dataset reports in the original document

• The dataset objects on those reports

• How many replacement reports or objects need to be reconciled (the status message)

11 Map an original dataset report to a replacement dataset report by following these steps:

   a Click **Select** in the **Replacement Report** column of the original dataset report row. The Select a Report dialog box opens.

   b Navigate to and select the replacement dataset report.
c Click **Open**. If the replacement dataset report does not match the original dataset report (for example, the original report contains two attributes but the replacement has only one), a message is displayed. Click **OK**, and select a different report.

The **Replacement Report** column now displays the name of the replacement dataset report to map to, and the **Replacement Objects** column displays the objects on the replacement dataset report.

If a suitable replacement report does not exist, you can create a new report to use, without closing the Document Reconciliation Editor. If the Select a Report dialog box is open, click **Cancel** to close it. Return to Desktop without closing the editor (for example, you can use **ALT+TAB** to select Desktop), and then create the report and save the report. Return to the Document Reconciliation Editor (for example, using **ALT+TAB**), and then begin mapping the replacement report again, at this step.

12 If an original dataset object exists in the replacement report, it is automatically mapped to that object. Objects are matched by GUID, then by name. If you want to change an automatic mapping or an object is not mapped, follow the steps below:

a Select the replacement dataset object in the **Replacement Objects** column. Cells in the **Replace With** column that can be mapped to the replacement object are highlighted. (For example, if you select an attribute, all attribute cells are highlighted.)

b Drag the replacement dataset object to the matching **Replace With** cell. For example, if Employee in the original and EE in the replacement are equivalent, drag Employee to EE.

c Repeat these steps for each dataset object on the original dataset report.

13 ID and DESC attribute forms in the original are automatically mapped to ID or DESC forms in the replacement, but you can select another replacement attribute form, as long as it is an ID or DESC form. You can map a custom attribute form in the original to any custom attribute form in the replacement. If you want to change an automatic mapping or an attribute form is not mapped, follow the steps below:

a Select the replacement attribute form in the **Replacement Objects** column.

b Drag the replacement attribute to the matching **Replace With** cell. For example, if Employee Number in the original and EE# in the replacement are equivalent, drag Employee Number to EE#.
c Repeat these steps for each attribute form on the original dataset report.

Attribute form reconciliation occurs only in certain cases, depending on the document’s design, so this step may not be required.

14 Repeat these Reconcile steps until all original dataset reports, original dataset objects, and original attribute forms are mapped to the replacement. Once this is complete, the status message, which displays the number of reports or objects to be reconciled, disappears.

Save

15 Select Save from the File menu.

16 Navigate to the folder to save the document in, and then click OK. A message appears indicating the document was saved.

17 Click OK. The Document Reconciliation Editor closes, and you are returned to Desktop.

Review

18 After importing the document, review the resulting document to ensure that it works correctly. Follow the suggestions in Reviewing after reconciliation, page 507.

19 Save any changes to the document.
DOCUMENT INTERFACES IN MICROSTRATEGY

Introduction

If you are new to MicroStrategy Report Services, use this appendix to help you become familiar with the Document Editor interface. The Document Editor allows you to create, customize, and save documents to be used across the MicroStrategy platform. The Document Editor opens when you view a document in Design View.

If you are already familiar with MicroStrategy, use this appendix to identify icons and other features you can take advantage of for quicker access to your most commonly used functionality.

Document Editor layout

The following image shows the Document Editor in Desktop, with the sample Basic Report added as the dataset report. The image highlights the Document Editor’s main sections and toolbars. More information about the editor is available in the Desktop Help. To access the Desktop Help, press F1 or click Help when using the editor.
The Document Editor consists of the following sections, as shown above:

- Menu bar
- Toolbars (position varies according to which toolbars are currently enabled)
- Layout tabs (shaded area below the toolbars), which are displayed when the document contains multiple layouts
- Grouping panel (shaded area directly above the Layout area)
- Layout area (middle)
The accordion pane at the left of the interface displays the Datasets, the Property List, or Notes. Switch between them by clicking the appropriate name at the bottom of the pane.

- Datasets, which contains the datasets selected for the document
- Property List, which displays the formatting settings of the object selected on the layout
- Notes, which displays the notes or comments added to the document

Each of the major sections of the editor is discussed below. For details about the other sections, see the Desktop Help.

**Controls toolbar**

A control is any selectable item in the document’s Layout area. This can be a text field, line, rectangle, image, panel stack, selector, HTML container, or Grid/Graph object. For instance, dragging and dropping a dataset object onto the Layout area creates a control. If the dragged object is a dataset report, a Grid/Graph is created; otherwise, a text field is added to the Layout area.

Use the Controls toolbar to insert new controls into the document.

Use the **Lock** button to keep the currently selected control button turned on so that you can insert multiple controls until you unlock it. For example, you can insert three lines without needing to click the **Line** button three times. To do this, click the **Line** button, click **Lock**, then click in the Layout area three times to create three lines. To turn off the lock, click the **Lock** button again.

**Toolbar icons**

From the Document Editor toolbars, you can perform the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td><img src="image" alt="Save Icon" /></td>
<td>Saves the document.</td>
</tr>
<tr>
<td>Cut</td>
<td><img src="image" alt="Cut Icon" /></td>
<td>Cuts the currently selected objects. Use this to move or remove controls.</td>
</tr>
<tr>
<td>Name</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy</td>
<td><img src="image1.png" alt="Copy Icon" /></td>
<td>Copies the currently selected objects. Use this to duplicate controls.</td>
</tr>
<tr>
<td>Paste</td>
<td><img src="image2.png" alt="Paste Icon" /></td>
<td>Pastes whatever you have cut or copied. Use this to move or duplicate controls.</td>
</tr>
<tr>
<td>Delete</td>
<td><img src="image3.png" alt="Delete Icon" /></td>
<td>Deletes the currently selected object.</td>
</tr>
<tr>
<td>Undo</td>
<td><img src="image4.png" alt="Undo Icon" /></td>
<td>The last action performed is undone.</td>
</tr>
<tr>
<td>Redo</td>
<td><img src="image5.png" alt="Redo Icon" /></td>
<td>An action that was undone is redone.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td><img src="image6.png" alt="Zoom Out Icon" /></td>
<td>Zooms out the view to see more of the document.</td>
</tr>
<tr>
<td>Zoom Percentage</td>
<td><img src="image7.png" alt="Zoom Percentage Icon" /></td>
<td>Sets the zoom percentage.</td>
</tr>
<tr>
<td>Select Controls</td>
<td><img src="image8.png" alt="Select Controls Icon" /></td>
<td>Allows you to select existing controls rather than insert new controls. After you insert a new control, the Select Controls icon is enabled, unless Lock has been activated.</td>
</tr>
<tr>
<td>Lock</td>
<td><img src="image9.png" alt="Lock Icon" /></td>
<td>Allows you to add the same type of control repeatedly. It keeps the currently selected control button (Text Field, Image, and so on) turned on so you can insert multiple controls. Click Lock again to turn off this feature.</td>
</tr>
<tr>
<td>Text</td>
<td><img src="image10.png" alt="Text Icon" /></td>
<td>Inserts a text field into the document. Text fields displays text such as data from the dataset reports, static text for labels, and information about the document or dataset report. For more information, see Adding text and data to a document: Text fields, page 81.</td>
</tr>
<tr>
<td>Image</td>
<td><img src="image11.png" alt="Image Icon" /></td>
<td>Inserts an image into the document. You are prompted for the file location of the image. For requirements to ensure that the image is available when it is needed, see Inserting images in a document, page 151.</td>
</tr>
<tr>
<td>Line</td>
<td><img src="image12.png" alt="Line Icon" /></td>
<td>Inserts a line into the document. For information, see Adding shapes and lines to a document, page 149.</td>
</tr>
<tr>
<td>Name</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rectangle</td>
<td><img src="Rectangle.png" alt="Rectangle Icon" /></td>
<td>Inserts a rectangle into the document. Use the drop-down list to select either Rectangle (with square corners) or Rounded Rectangle (with round corners). Once you select either shape, if you click the icon again, that same shape is added to the document. For more information, see Adding shapes and lines to a document, page 149.</td>
</tr>
<tr>
<td>Report</td>
<td><img src="Report.png" alt="Report Icon" /></td>
<td>Adds a new dataset and a Grid/Graph to the document at the same time. A Grid/Graph acts as a standard MicroStrategy report. For more information, see Adding a Grid/Graph and a new dataset simultaneously, page 175.</td>
</tr>
<tr>
<td>Grid</td>
<td><img src="Grid.png" alt="Grid Icon" /></td>
<td>Inserts a Grid/Graph placeholder that displays as a grid. A Grid/Graph placeholder is an empty Grid/Graph, without a dataset to populate the Grid/Graph with data. For more information, see Adding an empty Grid/Graph, page 176.</td>
</tr>
<tr>
<td>Graph</td>
<td><img src="Graph.png" alt="Graph Icon" /></td>
<td>Inserts a Grid/Graph placeholder that displays as a graph. A Grid/Graph placeholder is an empty Grid/Graph, without a dataset to populate the Grid/Graph with data. Use the drop-down list to select the graph style. For more information, see Adding an empty Grid/Graph, page 176.</td>
</tr>
<tr>
<td>Panel Stack</td>
<td>![Panel Stack Icon](Panel Stack.png)</td>
<td>Inserts a panel stack, which is a collection of panels. Panels allow the user to see different predefined views of data in the same document. When you add a panel stack to a document, one panel is automatically added to the panel stack. For background information on panel stacks, including instructions and examples, see the Dashboards and Widgets Creation Guide.</td>
</tr>
<tr>
<td>HTML Container</td>
<td>![HTML Container Icon](HTML Container.png)</td>
<td>Inserts an empty HTML container, which is used to display Flash and AJAX content in the document. When viewed in MicroStrategy Web, this content displays as though it is in an HTML browser within the document. This allows a document to display Flash information when the document itself is not in Flash Mode. For more information, see Displaying real-time web and other HTML content: HTML containers, page 142.</td>
</tr>
<tr>
<td>Selector</td>
<td><img src="Selector.png" alt="Selector Icon" /></td>
<td>Inserts a selector, which allows a user, in Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web, to flip through the panels in a panel stack or display different attribute elements or metrics in a Grid/Graph. Use the drop-down list to select the type of selector. For background information on selectors, including instructions and examples, see the Dashboards and Widgets Creation Guide.</td>
</tr>
<tr>
<td>Design View</td>
<td>![Design View Icon](Design View.png)</td>
<td>Switches the document to Design View so you can edit the document. (Disabled in Design View)</td>
</tr>
<tr>
<td>PDF View</td>
<td>![PDF View Icon](PDF View.png)</td>
<td>Switches the document to PDF View, which displays the content of the document.</td>
</tr>
<tr>
<td>HTML View</td>
<td>![HTML View Icon](HTML View.png)</td>
<td>Switches to HTML View, which displays a preview of the document as it will appear in MicroStrategy Web. If the icon is disabled, HTML View is not available for the document. You can enable it; see Selecting available export formats, page 364.</td>
</tr>
</tbody>
</table>
If the document contains multiple layouts, a tab for each layout is displayed above the Grouping panel. Use the tabs to switch between layouts. Each layout functions as a separate document, with its own grouping, page setup, and so on, but the layouts are generated into a single PDF document. For more information, see *Creating multi-layout documents, page 476.*
Grouping panel

The Grouping panel lets you group information in the document in a hierarchical structure. To add a group, drag and drop any attribute, consolidation, or custom group from the Datasets pane onto the Grouping panel. This adds a corresponding pair of sections to the Layout area.

To display the Grouping panel, select Grouping from the View menu.

For more information about grouping documents, see Grouping records in a document, page 374.

Layout area

The Layout area provides the framework for precisely controlling the display section of the fields when the document is viewed as a PDF or in MicroStrategy Web. To add data, drag objects from the Datasets pane and drop them into this area. Depending on the document section that you place controls in, the controls print or display differently. For more information about each of these sections, see Understanding and working with document sections, page 28.

- Page Header/Footer: prints at the top and bottom of each page.
- Document Header/Footer: prints at the beginning/end of the document.
- Group Header/Footer: for each field in the Grouping panel, prints before and after the Detail Header/Footer.
- Detail Header/Footer: prints immediately before and after each group of Detail sections.
- Detail: repeats for each row in the dataset.

You can expand and collapse a section by clicking the plus and minus signs next to its name. Expanding and collapsing a section in this way does not affect the section size in the PDF or whether controls display when the document is viewed as a PDF. It only provides you with more room on the Layout area to design the document.

By default, all sections are displayed in all views (Design View, PDF View, and Express Mode in MicroStrategy Web). You can select which sections to hide or display in various views. For more information, see Hiding or displaying sections for a finished document, page 289.
Clicking and dragging the lower boundary of the section in the Layout area increases the size of the section in both the Design View and PDF View. For more information on changing the section size, see *Changing the size of a section*, page 296.

If your layout expands past the width of a single page, a dotted line is displayed to show the page break.

• The Layout area contains an alignment grid to help you control the placement and alignment of controls.

• You can align the controls automatically with reference to the grid.

• You can change the settings of the grid, including scale, density, and selection behavior (whether you need to fully enclose or only touch a control to include it in a selection box). For detailed instructions, see the Desktop Help.

Datasets pane

This section displays all of the datasets used in the document. It lists all attributes, metrics, custom groups, and consolidations in the existing MicroStrategy report, regardless of whether or not they are displayed on the report. For example, if the Report Objects contains a metric that is not displayed on the grid, that metric will be listed as a dataset object. For more information, see the *Advanced Reporting Guide*.

To place an object on a document, drag it from the Datasets pane and drop it onto the Layout area. This creates a text field on the Layout area. If you drag and drop a dataset name from the Datasets pane to the Layout area, you create a Grid/Graph. For more information on creating text fields, see *Adding text and data to a document: Text fields*, page 81. For more information on Grid/Graphs, see *Chapter 3, Displaying Reports in Documents: Grid/Graphs*.

To display the Datasets pane, click Datasets at the bottom of the accordion pane or press F8.

If there are multiple datasets in a document, the dataset that is displayed in bold is the grouping and sorting dataset. For more information about datasets in a document, see *Using prompts in documents*, page 488.
Property List

The Property List displays the settings of the object selected on the Layout area. The settings that are listed vary depending on the type of object (text field, image, line, section, and so on) selected. For more information about the settings in the Property List and how to use them, refer to the Desktop Help.

To display the Property List click Property List at the bottom of the accordion pane or press F9.

Controlling how the Property List displays

By default, a drop-down object list is displayed at the top of the Property List pane. It contains all the controls and sections in the document or, for multi-layout documents, the selected layout. The Property List, with the drop-down object list displayed, is shown below:

You can instead choose to display the objects as a hierarchical tree representing the document structure. You can choose whether to display the
When you choose an item from the list or the tree, the displayed settings change and the control/section becomes selected in the Layout area. Conversely, if you select an object in the Layout area, the Property List displays the settings for that object, and the object is selected in the tree.

You can also choose to hide the object list or document structure tree, to display the settings only. In this case, to choose a different object, select the object in the Layout area.

To switch between the various displays, click the appropriate button at the top of the Property List pane:

- Object list
- Document structure on left
- Document structure on top
- Properties only

**Sorting the Property List**

You can display the settings in the Property List sorted by category or alphabetically by option name. Click the **Sort by Category** or **Sort alphabetically** button at the top of the Property List pane.
Displaying information about settings

You can choose whether or not to display information about an option, by selecting an option and clicking the Help button at the top of the Property List pane. The information, which displays at the bottom of the Property List pane, provides more detail about the selected option.

Notes

The Notes pane displays the notes or comments added to the document, and allows you to add your own notes. Use this area to communicate with other users about the document. The notes can include details about the document, information on how it was created, reasons to use it, queries about the data displayed, a back-and-forth conversation about designing the document, or anything useful to you and other users. The document cache is not invalidated when notes are added or modified.

The Notes pane contains:

- A display of all the notes that have been added to the document. You must have the View Notes privilege to see any notes that have been added to the document.

- A text field to type new notes. Click Submit to add the new note. You must have the Add Notes privilege to add new notes, but you do not need write access control on the document.

  The Submit button becomes available once you type text.

You can type up to 1024 characters in each separate note, to a maximum of 65,535 characters for all the notes in the document.

If you have the Edit Notes privilege, you can change existing notes, as described below:

1. Click Edit. The text field for new notes closes, and all the existing notes become active.
2. Type over the existing text or add new text.
3. Click OK. The text field for new notes opens.

To display the Notes pane, click Notes at the bottom of the pane.
Introduction

This appendix walks you through the process of creating a sample invoice document.

Create a sample invoice document

This section contains step-by-step instructions to walk you through creating a simple invoice with data from the MicroStrategy Tutorial. Because the Tutorial does not contain the precise type of data needed for an invoice, such as Invoice Date and Due Date, we will use data from similar, related attributes as a replacement. You can use this section as a tutorial, bringing together the pieces described in the chapters of this book to create a document.

Dates in the MicroStrategy Tutorial project metadata are updated to reflect the current year. The sample documents and images in this section, as well as the procedures, were created with dates that may no longer be available in the Tutorial project. Replace them with the first year of data in your Tutorial project.
By following the instructions, you will create a document that provides a separate invoice for each customer. Each invoice will contain the following:

- Company logo
- Customer name, city, and state
- Invoice and due dates
- Purchase date, ID, description, and cost of each item
The completed invoice looks like the following:

![Customer Invoice](image)

This sample has been altered to fit within the space limitations of this manual.

It may be helpful to print the document and refer to it as you create your own invoice document.
The high-level steps for this procedure are outlined below. While each step is self-contained, they are meant to be completed in order.

1. Creating the report to use as the dataset, page 529
2. Creating the new document and selecting the dataset, page 530
3. Grouping the document by customer, page 531
4. Adding the logo image to the document, page 532
5. Resizing the image, page 533
6. Adding static text to the document, page 533
7. Formatting, aligning, and sizing the text field, page 534
8. Adding a rectangle to the document, page 534
9. Switching to PDF View, page 535
10. Adding an attribute to the Customer Header section, page 536
11. Combining text fields, page 538
12. Adding and formatting additional text fields in the Customer Header section, page 539
13. Adding a line to the Customer Header section, page 541
14. Creating the column headers in the Detail Header section, page 542
15. Ordering the controls, page 543
16. Creating the item detail in the Detail section, page 545
17. Formatting a text field as currency, page 546
18. Adding summary information to the Detail Footer section, page 547
19. Adding totals to a document, page 549
20. Saving the document, page 550
21. Creating the final PDF, page 551
Before beginning the instructions, review *Creating a document using another document as a template, page 20* to familiarize yourself with the various components of the Document Editor.

Measurements throughout this tutorial are given in inches.

**Creating the report to use as the dataset**

The data for a document is derived from a report, so the preliminary step for creating a document is to create a report. When the report is used in a document, it is referred to as a dataset. For more information on datasets, see *Using prompts in documents, page 488*.

The dataset report for the invoice document needs all of the data for the document, such as customer and order information. The attribute Ship Date will be used to simulate both the invoice and due dates. Only two customers and one quarter are included on the report, since this information is sufficient to demonstrate various document features without creating a large dataset.

Since this example is focused on creating a document, not a report, the following procedure assumes that you are familiar with the steps necessary to create a report. For details, refer to the *Desktop Help* or the *Basic Reporting Guide*.

---

**To create the report**

1. On the MicroStrategy Desktop, point to **New** from the File menu, and then select **Report**. The Report Editor opens.

   If the New Grid dialog box opens, select **Blank Report** as the report object template.

2. Add the following objects to the grid:
   - **Customer** (from the Customers hierarchy)
   - **Customer City** (from the Customers hierarchy)
   - **Customer State** (from the Customers hierarchy)
• **Ship Date** (from the Customers hierarchy)

  *Ship Date* stands in for the invoice and due dates on the document.

• **Item** (from the Products hierarchy)

• **Day** (from the Time hierarchy)

• **Cost** metric (from the Public Objects\Metrics\Sales Metrics folder)

3 Add a report filter for

• Quarter In List (Q1 05)

  AND

• Customer In List (Aaronson Maxwell, Ballin Stephen)

4 Save and close the report, naming it Invoice Dataset Report.

### Creating the new document and selecting the dataset

Next, create the shell of the new document and select as the dataset the report you just created. Again, the dataset provides the data fields for the document.

### To create the new document and select the dataset

1 On the MicroStrategy Desktop, point to **New** from the **File** menu, and then select **Document**. The New Document dialog box opens.

2 Select **Empty Document** and click **OK**. The Select a report dialog box opens.

3 Navigate to the Invoice Dataset Report and double-click it. The Document Editor opens.
The Document Editor contains the Datasets pane on the left, the Layout area in the middle, and the Property List on the right.

If the Datasets pane is not displayed, select **Datasets** from the **View** menu. Similarly, if the Property List is not displayed, select **Property List** from the **View** menu.

Notice that the Layout area is empty except for sections—no objects have been placed on the document yet. You can expand and collapse the sections by clicking the plus sign or double-clicking the grey button next to the section name. You can drag a section's top or bottom border to make the section larger or smaller. Expanding, collapsing, or resizing a section in this way does not affect its size or whether controls in it appear or are hidden when the document is viewed as a PDF.

The Datasets pane contains the Invoice Dataset Report and all the objects on that report. These objects are available for use on the document. The Property List displays the settings of the object selected on the Layout area. The settings vary depending on the type of object selected, but include font, size, alignment, position, and others. For more information, see *Creating a document using another document as a template, page 20* and the *Desktop Help*.

### Grouping the document by customer

Grouping by the Customer attribute allows you to create a separate invoice for each customer.

---

**To group the document by Customer**

Select **Customer** in the Datasets pane. Drag and drop it into the Grouping panel, which is labeled Drop Grouping Fields Here.

**Tip:** If the Grouping panel is not displayed, select **Grouping** from the **View** menu.

After you add Customer to the grouping, notice that two new sections are created on the Layout area. The new sections are grouping sections and are called Customer Header and Customer Footer. For more information on grouping, see *Grouping records in a document, page 374*; for information on the different sections, see *Understanding and working with document sections, page 28*. 
To print each Customer on a separate page

1 Right-click Customer in the Grouping panel and select Grouping Properties. The Grouping Properties dialog box opens.

2 Select the Page break between groups check box.

For information on the other settings in the dialog box, see Resetting page numbers for each group, page 397 and Keeping the data in a group together on a page, page 398.

3 Click OK to return to the Document Editor.

Until you create the PDF, you will not see any changes from the page break option.

Adding the logo image to the document

Adding a logo helps to identify the company sending the invoices. The logo must appear on every page, so the appropriate place to put it is in the Page Header section. You can use any image as a logo. The image type must be .bmp, .jpg, .jpeg, or .gif. For information on ensuring that the image is accessible, see Inserting images in a document, page 151.

To add the image to the document

1 On the Layout area, click the plus sign next to Page Header. This expands the section so that you can work in it.

2 Click Image on the toolbar. When you move the cursor to the Layout area, the pointer becomes crosshairs.

3 Click the top left corner of the Page Header section. The Image Source dialog box opens.

4 Navigate to an image file to use as the logo.

5 Select the file and click Open. The image appears in the document. You can drag and drop the image to reposition it or resize it using the red handles.
Resizing the image

The height of the image used in the sample invoice is .3 inches. If your image is larger, it will overlap the rectangle and the text below it. You can adjust the size of your image to fit the space available.

To resize an image

1. Click the image on the Layout area to select it.
2. In the Property List, set the Height to 0.3.
3. If the image is too distorted, you can also adjust the width. Enter the appropriate number in the Width option in the Property List.

Adding static text to the document

Data and text are displayed in documents in text fields. Static text does not change and serves as a label. For more information on static text and the different types of text fields, see Adding text and data to a document: Text fields, page 81.

On the invoice document, add the text field that displays next to the logo. This text field contains the phrase “Customer Invoice”. Again, since this is printed on each page, it should be added to the Page Header section.

To add a text field

1. Click Text Field on the toolbar. When you move the cursor to the Layout area, the pointer becomes crosshairs.
2. Click in the Page Header section, next to the logo. A box is placed in the section.
3. Type the following in the text field:
   Customer Invoice
The text appears in the box, although you will not see it all because the text box is too small. We will fix that problem in the next step, by setting the height and width of the text field.

**Formatting, aligning, and sizing the text field**

Once you add a text field to a document, you can change its appearance in a variety of ways. The procedure below changes the font of the text, aligns the text field, and resizes it. For more information on arranging and formatting text fields, see *Chapter 1, Designing and Creating Documents*.

---

**To format, align, and size the text field**

1. Click the text field on the Layout area to select it. Alternatively, you can select it from the drop-down list at the top of the Property List.

2. To format the text, click the **Bold** and **Italic** icons in the toolbar.

3. To change the font size, select **18** from the Font Size drop-down list on the toolbar.

4. To align the text field, drag and drop it in the correct position or set the **Left** and **Top** settings in the Property List. To re-create the sample invoice exactly, set Left to 4.34 and Top to .03.

5. To size the text field, you can drag the resizing handles or set the Height and Width settings in the Property List. To re-create the sample, set Height to .25 and Width to 2.4.

---

**Adding a rectangle to the document**

The final object in the Page Header section is a rectangle or box, which spans the page below the logo and its related text. This divider should be printed on each page, hence it is included in the Page Header.
To add a rectangle

1. Click the Rectangle icon on the toolbar. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click in the Page Header section to add the rectangle.

3. On the Property List, change the color of the rectangle to grey, by clicking Backcolor then the Browse button. The Color dialog box opens. Click the grey swatch, then click OK.

4. To set the rectangle to span the width of the entire page, change the Width mode option on the Property List to 100%.

5. While you can change the rectangle size using the resizing handles, set the Height and Top settings to the following using the Property List. This ensures that your document looks exactly like the sample.
   - Height: .06
   - Top: .34

For more information on formatting rectangles, see Formatting lines and rectangles, page 284.

Your Page Header section should now look like the following:

Switching to PDF View

It can be helpful to occasionally check your progress during the document creation process. Switch to PDF View to see what the document looks like after the PDF is generated.

To switch to PDF View

1. Click PDF View on the toolbar.
The PDF is generated and displays like the following:

![Customer Invoice]

Notice that the document has only one page, although the report contains two customers and the document is grouped by customer. However, the Customer attribute has not yet been placed on the document, so the document is not really grouping yet. Also, since the only controls on the document are static—a picture and the words “Customer Invoice”—the document in PDF View does not look much different from the document in Design View.

To continue working on the document, click **Design View** on the toolbar.

- If you frequently switch between Design View and PDF View, keep an instance of Acrobat Reader open on your machine. This helps speed up the process of switching to PDF View.

**Adding an attribute to the Customer Header section**

The next section on the Layout area is the Document Header. You can use the Document Header as a cover page, since this section prints once at the beginning of the document. Since this document does not contain anything like a cover page, move to the next document section, which is the Group Header, in this case, the Customer Header.

- If you do not need a section, it does not display in the PDF as empty space if controls have not been added to it, since by default the Can Shrink option is set to true. This setting automatically sets the height of an empty section to zero. If you have placed controls in the section, or the Can Shrink option has been changed, set the Visible option to false.

Recall that placing the Customer attribute in the Grouping panel created Customer Header and Customer Footer sections. We will add information specific to each customer to the Customer Header section. This data includes the customer name, address, and invoice information, and will print once for each customer.

First add the Customer attribute, to display the name of the customer being invoiced, and a text field to label and identify the attribute. An attribute on a document is referred to as a data field, which is another type of text field. For
more details on using data fields in documents, see *Adding dynamic data to a document, page 83.*

---

**To add an attribute and a corresponding label**

1. Click **Text Field** on the toolbar. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click at the top of the Customer Header section. A box is placed in the section.

3. Type the following in the text field:
   
   Bill To:

4. Set the following options in the Property List to position the text field as shown in the example invoices:
   
   - **Left**: .34
   - **Top**: .03

5. Format the text:
   
   - **Bold**
   - **Font size**: 10

6. Drag and drop **Customer** from the Datasets pane to the Customer Header. A text field containing the text {Customer} is placed on the Layout area. The text will be replaced with the customer name when the PDF is generated.

7. Set the following options in the Property List to position the data field as shown in the example invoices:
   
   - **Width**: 2.5
   - **Left**: .11
   - **Top**: .37
Combining text fields

You can combine different types of text fields, such as static text and data fields, in one text field. For example, to see the customer’s city and state separated by a comma, create a text field, insert the Customer City attribute, type a comma and space, and insert the Customer State attribute. For more information, see *Combining different types of text fields in a document*, page 86.

To combine text fields

1. Drag and drop **Customer City** from the Datasets pane to the Customer Header. A text field containing the text {{Customer City}} is placed on the Layout area. The text is replaced with the customer’s city when the PDF is generated.

2. Expand the size of the new text field using the resizing handles. This will allow you to more easily see what you are typing in the text field.

3. Select the new text field and press **F2** to edit it.

4. Type a comma.

5. Drag and drop **Customer State** from the Datasets pane into the new text field. Notice that a space is added automatically before Customer State. The text field should now contain the following:

   {{Customer City}}, {{Customer State}}

   When the outline of the text field becomes yellow, drop the object into it.

6. Press **ENTER** to exit edit mode.

7. Set the following options in the Property List to position the text field as shown in the example invoices:

   - **Width**: 2.5
   - **Left**: .11
   - **Top**: .54
Adding and formatting additional text fields in the Customer Header section

Now, add the remaining text fields to the Customer Header section—invoice number, invoice and due dates, and the remittance address. The invoice number is the Customer ID, which is not the default attribute form. The following procedure shows you how to access a particular attribute form, as well as copy a text field. It also demonstrates selecting, formatting, and aligning multiple fields in different ways. For more information, see *Arranging controls on a document, page 156* and *Formatting text fields, page 273*.

---

**To add and format additional text fields**

1. Add the following static text fields to the Customer Header, as shown on the sample invoice. The formatting and alignment will be described later.
   - Invoice #
   - Invoice Date
   - Due Date
   - Remit To:

2. Add the following lines as one static text field. To insert a break between the lines, press **CTRL+ENTER**.

   MicroStrategy, Inc.
   1861 International Drive
   McLean, VA 22102

3. Drag and drop *Ship Date* from the Datasets pane to the Customer Header. A text field containing the text {{Ship Date}} is placed on the Layout area.

   **To copy a control on the Layout area**

4. Right-click *Ship Date* on the Layout area and select **Copy**.

5. Right-click below Ship Date on the Layout area and select **Paste**. The document now contains two copies of the control, one for use as the Invoice Date and the other as the Due Date.
To display a particular attribute form

6 In the Datasets pane, expand Customer. From the list of Customer attribute forms, drag and drop ID to the Customer Header. A text field containing the text {Customer@ID} is placed on the Layout area.

To select, format, and align multiple controls

7 Hold down the CTRL key and click the static fields Invoice #, Invoice Date, and Due Date.

8 Click Bold in the Formatting toolbar.

9 Set the Left option in the Property List to 2.63 and press ENTER. This will left align the three controls.

10 Click anywhere in the Layout area to deselect the controls.

11 Hold down the CTRL key and click Customer@ID and the two copies of Ship Date.

12 Set Left in the Property List to 3.61, thereby placing the controls along the same line.

13 In the same manner, select Invoice # and Customer@ID. Set Top in the Property List to .2.

14 Select Invoice Date and the first Ship Date. Set Top in the Property List to .37.

15 Select Due Date and the second Ship Date. Set Top in the Property List to .54.

16 Select the static text fields Remit To: and the MicroStrategy address. Set Width to 1.65.

To align controls using the right-click menu

17 To align Remit To: with Customer@ID, which you have already set with the correct Top position, select Customer@ID and Remit To:.

Right-click, point to Align, and then select an option:

• If Customer@ID is higher than Remit To:, select Top.

• If Customer@ID is lower than Remit To:, select Bottom.
18 Repeat the process with the first Ship Date and the MicroStrategy address text field.

19 Select **Remit To:** and set Left to 5.32.

20 To align the MicroStrategy address text field with the Remit To: control, select both controls. Right-click, point to **Align**, and then select an option:

- If Remit To: is to the left of the address, select **Left**.
- If Remit To: is to the right of the address, select **Right**.

### Adding a line to the Customer Header section

The final piece of the Customer Header section is a double line at the bottom of the section, to separate the customer information from the invoice details.

---

**To add a line**

1. Click the **Line** icon in the toolbar. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click at the bottom of the Customer Header section to add the line.

3. Set the following in the Property List:

   - Line style: Double, to change it to a double line from the default of **Solid**
   - Line weight: 2
   - Top: 1, which moves the line to the bottom of the Customer Header section
   - Length mode: 100%, which stretches the line across the width of the page

If the line disappears off the Layout area, drag the Detail Header down to show more of the Customer Header section. This does not affect the size of the sections in the PDF, only in Design View.

For more information on formatting lines, see *Formatting lines and rectangles, page 284.*
Your Customer Header section should now look like the following:

<table>
<thead>
<tr>
<th>Bill To:</th>
<th>Invoice#</th>
<th>Remit To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Customer}</td>
<td>{Customer@ID}</td>
<td>MicroStrategy, Inc.</td>
</tr>
<tr>
<td>{{Customer City}}, {{Customer State}}</td>
<td>{{Ship Date}}</td>
<td>1861 International Drive</td>
</tr>
<tr>
<td></td>
<td>Invoice Date</td>
<td>McLean, VA 22102</td>
</tr>
<tr>
<td></td>
<td>Due Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2/16/2005</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2/16/2005</td>
<td></td>
</tr>
</tbody>
</table>

**Previewing the Customer Header**

Switch to PDF View, by clicking **PDF View** on the toolbar, to generate the PDF and check your progress. The document, in contrast to the first preview, now looks different in PDF View and Design View. This is because you added attributes to the document, which are replaced with the actual data when the PDF is generated. Notice that the document now contains two pages, grouped by Customer, as shown in the following sample.

To continue working on the document, click **Design View** on the toolbar.

**Creating the column headers in the Detail Header section**

The next section on the Layout area is the Detail Header, which prints immediately before each group of Detail sections. In our invoice document,
the Detail Header contains the column headers for the itemized lines of the invoice and prints once for each customer. The controls in this section are static text fields and a rectangle, used to make the text fields stand out.

Since you have added static text fields and a rectangle to the document already, the following procedure is a high-level process only.

---

### To add controls

1. Add the following static text fields to the Detail Header section and set the options as indicated:
   - Date: **Left** = .13, **Top** = .02
   - Item #: **Left** = 1.62, **Top** = .02
   - Item Description: **Left** = 3.05, **Top** = .02
   - Amount: **Left** = 5.69, **Top** = .02

2. Bold all four text fields and set their **Backcolor** to grey.

3. The default text field width is not long enough to display the item description without wrapping to a second line. To fix this, set the **Width for Item Description** to 1.25.

4. Add a rectangle to the Detail Header section and set the following options:
   - **Backcolor**: Grey
   - **Height**: .25
   - **Width mode**: 100%
   - **Top**: 0

The text fields disappear behind the rectangle, but we will fix that problem in the next section.

---

### Ordering the controls

If controls overlap in a document, as the rectangle and the text fields in the Detail Header do, you can change the order of the controls by moving them
forward or backward. This displays controls in front of or behind other controls.

**To order controls**

1. Select the rectangle, being sure not to select any of the text fields.
2. Right-click, point to **Order**, and then select **Send to Back**.

Your Detail Header section should now look like the following:

<table>
<thead>
<tr>
<th>Date</th>
<th>Item #</th>
<th>Item Description</th>
<th>Amount</th>
</tr>
</thead>
</table>

**Previewing the Detail Header**

Switch to PDF View, by clicking **PDF View** on the toolbar, to generate the PDF and check your progress. Now each of the invoices has the new column headings, as shown in the following sample:
Creating the item detail in the Detail section

The next section on the Layout area is the Detail section, which prints one row for each row of data in the document’s dataset. For the invoice, one row is printed for each item bought by the customer. Therefore, you will add the detailed item information to this section.

Since you have added attributes to the document already, the following procedure is a high-level process only.

To add and format attributes

1. Add the following to the Detail section:
   - Day
   - Item ID
   - Item
   - Cost

   Recall that to add a particular attribute form, you must expand the attribute in the Datasets pane and select the attribute form. The default attribute form for Item is Description, not ID.

2. Select Item and set the Width option to 2.25.

3. Select Day and set the Top option to .05.

4. Align the other controls to Day. To do this, select the controls, right-click, point to Align, and select Top.

5. Align Day with the Date text field in the Detail Header section. To do this, select the controls, right-click, point to Align, and select Left.

6. Similarly, align Item@ID with the Item # text field and Item with the Item Description text field.

7. To align Cost with Amount, select both fields. Right-click, point to Align, and then select an option:
   - If Cost is to the left of Amount, select Right.
   - If Cost is the right of Amount, select Left.
Formatting a text field as currency

Cost should be formatted as currency to accurately present the values.

To format a text field as currency

1. Right-click Cost and select Format. The Format Objects dialog box opens.

2. On the Number tab, select Currency from the Category list. The default settings use a dollar sign and two decimal places.

3. Click OK to return to the document.

Your Detail section should now look like the following:

<table>
<thead>
<tr>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Day}</td>
</tr>
<tr>
<td>{Item@ID}</td>
</tr>
<tr>
<td>{Item}</td>
</tr>
<tr>
<td>{Cost}</td>
</tr>
</tbody>
</table>
Previewing the Detail section

Switch to PDF View, by clicking PDF View on the toolbar, to generate the PDF and check your progress. Each invoice contains detail information on each item bought by the customer, as shown in the following sample:

![Customer Invoice]

<table>
<thead>
<tr>
<th>Date</th>
<th>Item #</th>
<th>Item Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/12/2005</td>
<td>15</td>
<td>Working With Emotional</td>
<td>14.38</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intelligence</td>
<td></td>
</tr>
<tr>
<td>2/12/2005</td>
<td>17</td>
<td>Attention to Detail</td>
<td>8.22</td>
</tr>
<tr>
<td>2/12/2005</td>
<td>18</td>
<td>The 48 Laws of Power</td>
<td>13.35</td>
</tr>
<tr>
<td>2/12/2005</td>
<td>21</td>
<td>Career Intelligence</td>
<td>10.27</td>
</tr>
<tr>
<td>2/12/2005</td>
<td>25</td>
<td>Don't Sweat the Small Stuff</td>
<td>7.19</td>
</tr>
<tr>
<td>2/12/2005</td>
<td>27</td>
<td>Smart Choices</td>
<td>12.32</td>
</tr>
<tr>
<td>2/12/2005</td>
<td>28</td>
<td>Day Job</td>
<td>13.35</td>
</tr>
<tr>
<td>2/12/2005</td>
<td>34</td>
<td>Lord of the Flies</td>
<td>4.11</td>
</tr>
</tbody>
</table>

Adding summary information to the Detail Footer section

The last part of the invoice contains totals and term information. Since this summary information should appear on each invoice, place it in the Detail
Footer section. The Detail Footer section prints immediately following the Detail section, and is typically used for totals.

Before creating the totals, add static text fields to label the amounts and lines to separate the sections. Again, since you have added static text fields and lines to the document, this is a high-level process, providing enough information to ensure that your invoices match the sample.

**To add summary information**

1. Add the following static text fields to the Detail Footer section and set the options as indicated:

   - Total Charge: **Left** = 3.51, **Top** = .1
   - Total Tax: **Left** = 3.51, **Top** = .32
   - Total Due: **Left** = 3.51, **Top** = .54

2. Add a double line at the top of the Detail Footer section. Set its options as listed below:

   - **Line style**: Double
   - **Line weight**: 2
   - **Top**: .03
   - **Length mode**: 100%

3. Add another line, between Total Tax and Total Due, and to the far right. Set its options as listed below:

   - **Line style**: Double
   - **Line weight**: 2
   - **Left**: 5.58
   - **Top**: .5
   - **Length**: 1.42

4. Add another line, underneath Total Due. Set its options as listed below:

   - **Left**: 3.45
   - **Top**: .71
• **Length:** 3.55

5  Add the following text field:

Terms: Net 30 Days, Plus 1.5% per month after 30 days

6  Set the following options for the Terms text field:

• **Font:** 8
• **Width:** 3
• **Left:** 2.06
• **Top:** .77

---

### Adding totals to a document

You may notice that all the dataset objects have been used, or placed onto the document. Where do the totals come from? Totals are calculated using metrics. Depending on where a metric is placed in a document, the metric is calculated differently.

In this invoice document, the Cost metric is in a text field in the Detail section, where it is calculated at the level returned by the dataset report. In this case, it is calculated at the item level. When the same metric is placed in the Detail Footer, it returns a subtotal for the Detail section. Here, it adds the values from each item to compute the invoice total.

For more information on totals, see *Working with metrics in documents*, page 114.

---

### To add totals

1  Right-click **Cost** in the Detail section and select **Copy**.

2  Right-click next to Total Charge in the Detail Footer section and select **Paste**. Although this field calculates a total, the information displayed on the Layout area is the same: {Cost}.

   Copying and pasting the metric from the Layout area also copies the metric’s formatting (currency with two decimal places in this case).
3 Bold the new Cost control.

4 Align it to the top with the Total Charge control.

5 Align it to the left with the Cost metric in the Detail section.

6 Drag and drop Cost from the Datasets pane to the Detail Footer, placing it to the right of Total Due.

![When you drag a metric from the Datasets pane, the control default formatting is used. You will see the difference when you create the PDF. For more information, see Defining default formatting for control types: control defaults, page 255.]

7 Bold this second Cost control.

8 Align it to the top with the Total Due control.

9 Align it to the left with the first Cost metric in the Detail Footer.

Your Detail Footer section should now look like the following:

<table>
<thead>
<tr>
<th>Detail Footer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Charge</td>
</tr>
<tr>
<td>Total Tax</td>
</tr>
<tr>
<td>Total Due</td>
</tr>
</tbody>
</table>

Terms: Net 30 Days, Plus 1.5% per month after 30 days

Saving the document

You should save your document, so that you can refer to it later.

---

**To save a document**

1 Click the **Save** icon on the toolbar. The Save Document As dialog box opens.

2 Navigate to a directory in which to save the document.

3 Enter a name for the document, such as **Sample Invoice**, in the Object name box.
4 Click **Save**.

**Creating the final PDF**

Now when you switch to PDF View, the completed invoices are created. They should look like the samples provided at the beginning of this tutorial section.
TROUBLESHOOTING DOCUMENTS

Introduction

This section provides explanations of some of the most common issues you may encounter when creating Report Services Documents, in a question and answer format. For more detailed discussions, refer to the relevant sections of this guide.

Troubleshooting during document creation

Troubleshooting Grid/Graphs

Can I save a Grid/Graph in a document as a standalone report?

No, Grid/Graphs are embedded objects within the document and they cannot be saved as a standalone report.
My document contains a Grid/Graph displayed as a graph. I set the Width Mode and Height Mode to Fit to contents. After I saved the document, both these options revert to the default setting of Fixed. Why?

Fit to contents is supported only when Grid/Graphs are displayed as grids.

My document contains a Grid/Graph with attributes but only one metric. The metric values do not display completely in PDF View in Desktop. How can I view the full column?

Before switching to PDF View, change the document layout to landscape. From the File menu, select Page Setup. On the Page tab, select Landscape as the Orientation.

When I try to create a view filter on a Grid/Graph, a message appears asking me to convert the shortcut to a local copy of the report. I do not want to convert it.

You cannot create a view filter on a Grid/Graph shortcut because the Grid/Graph is linked to the original report, allowing changes made to the original report to automatically update the Grid/Graph in the document. You have two options:

- If you want to create a view filter on the Grid/Graph, you must convert the Grid/Graph to a local copy. You can then create the view filter. Changes made to the original report will no longer be passed to the Grid/Graph in the document.

- If you want to allow changes to the original report to affect the Grid/Graph in the document, click Cancel. You cannot create a view filter.

For information on what actions are allowed in shortcuts, see Adding a Grid/Graph as a shortcut, page 191.

I want to format the “No Data Returned” message that appears on a Grid/Graph in MicroStrategy Web.

You can format the message using HTML tags, for display in all Web modes except Flash Mode.

1 In Desktop, right-click the project, and select Project Configuration. The Project Configuration Editor opens.
2 Expand the **Report Definition** category on the left, and select **Advanced**.

3 Type the message into the **No data returned** field, using HTML tags. To change the background color, put the message into a table and set the table’s background color.

4 Click **OK** to save the changes and return to Desktop.

If the formatted message does not appear, restart IIS or the web server.

**Miscellaneous document creation troubleshooting**

**If I have multiple datasets with the same attributes, what data is shown in the Grid/Graph and the Detail section?**

In general, the following is true:

- If the Grid/Graph uses a single dataset, only data from that dataset is displayed.
- If the Grid/Graph uses multiple datasets, data from the combined datasets is displayed.
- The Detail section displays a join between all the datasets and shows all the data.

Your final results also depend on what attribute elements are present in each dataset. For example, if each dataset contains different elements, some values will be missing in the Grid/Graph and the Detail section. If the datasets contain the same elements but different metrics, the Detail section will display the metrics for each element. The Grid/Graph will display the data from the dataset or datasets that it uses. For examples, see *Joining multiple datasets: Examples, page 65.*

For background information documents with multiple datasets, such as how datasets are joined, see *Working with multiple dataset reports, page 51.*

**The height of a document section is defined to grow, the height is set to 1.5 inches, and the maximum height is set to 10 inches, larger than the expected*
results. When I view the document in HTML View or export it to HTML, the document section is only 1.5 inches long, and therefore the data is cut off.

When exported to HTML or viewed in HTML, a document section uses the Height setting, regardless of the Height can grow or Maximum height settings, because the exact height cannot be determined during HTML rendering. To allow all the data to be displayed, specify a more accurate Height setting.

I placed a metric on a grid and in the Document Header. The values are different. Why?

A metric is calculated differently depending on its location in the document. In this case, the value of the metric on the grid depends on the attributes, consolidations, and custom groups in the grid. The metric in the Document Header is a grand total for the document.

For a complete list of how a metric is calculated in various locations within a document, see Using prompts in documents, page 488.

I cannot resize or move a control.

The control may be locked. A locked control cannot be resized or moved. You cannot modify the following settings when a control is locked:

- Height
- Left
- Top
- Width

To unlock the control, follow the steps below:

1. Right-click the control and select Properties and Formatting. The Properties and Formatting dialog box opens.
2. Select Layout from the left.
3. Clear the Locked check box.
4. Click OK to return to the document.
Troubleshooting during document execution

I cannot open a document.

If a document has embedded Transaction Services, the document does not open. Instead, a message is displayed, indicating that transaction-enabled documents are not supported in Desktop. Open the document in MicroStrategy Web.

I executed a document and received an error about an incomplete or inconsistent object definition.

The document uses a Freeform SQL report as a dataset. Save this kind of document before you execute it.

I have two lines with the same line weight, but they show different thicknesses in the PDF.

Typically, this viewing problem can be alleviated by using the Zoom In feature (increase the Zoom%) on the PDF. The lines display with the same thickness on the screen. This will not affect the printed output. All lines will print as defined, even if they display differently when viewing an Adobe PDF.

If I see an image in Design View, why doesn't it show up when I view the document as PDF?

Make sure the image is in .bmp, .jpg, .jpeg, or .gif format. It must be accessible by both the Intelligence Server machine that runs the document and the user who is designing the document.

For example, use a Web server machine to which designers have access and to which the Intelligence Server machine has access. For more information, see Inserting images in a document, page 151.

My PDF has an extra page, with a smudge on the left. What happened?

You moved your controls too far to the right. In Design View or Design Mode, move the controls to the left of the vertical page separator, which is represented by a dashed line.
My document contains a link to a prompted report. Answers to the prompts are passed using both the originMessageID and promptsAnswerXML parameters. When I drill on the link, I am prompted, even though the information should have been passed in the link parameters.

Your destination report must contain nested prompts, since the combination of prompt XML and message ID does not work in this case.

A nested prompt is where the definition of one prompt depends on the answer to another prompt. For example, the first prompt is for category, and the second is for subcategory. The list of subcategories for the second prompt depends on the answer to the category prompt. If you use both prompt XML and message ID in this case, when you click the link, the answer to the subcategory prompt is not passed to the destination. You are re-prompted for subcategory.

My document contains 10 reports, and the Jobs per user parameter in the Project Configuration Editor is set to 5. The document does not finish executing.

The second five reports on the document do not wait until the first five reports execute, so the document cannot finish executing. To execute a document with ten reports, set the Jobs per user and Jobs per user session parameters to at least ten. For more information on these Project Configuration Editor parameters, see the System Administration Guide.

Be cautious increasing these parameters, as you do not want to have multiple users running many jobs simultaneously, which can overwhelm Intelligence Server or your database.

An image does not display in PDF View, when exported to PDF, or in MicroStrategy Mobile.

Ensure that the image is saved in one of the image types listed below; other image types cannot be displayed in PDF View, when exported to PDF, or in MicroStrategy Mobile.

- bmp
- jpg
- jpeg
- gif
If the image file path is using an http reference to a central Web Server machine, such as http://microstrategy/Test/myimage.jpg, ensure that the URL does not contain any spaces. You can remove the space from the image name or replace the space with %20.

For more information about inserting images into documents, see Inserting images in a document, page 151.

Troubleshooting common Flash Mode issues

This section describes some common issues you may encounter as you use Flash Mode while viewing a document. The issues described in this section are not necessarily issues related to defects in the software itself, but rather notes about how Flash Mode is designed to work.

I cannot switch to Flash Mode in MicroStrategy Web; it is not an option in the View menu.

To display a document in Flash Mode in MicroStrategy Web, Flash Mode must be enabled for the document, the user, and the project, as described below.

- A user with the appropriate privileges can enable Flash Mode for a document using either MicroStrategy Web or Desktop. The steps below are for Web; for steps in Desktop, see the Desktop Help.

  a In MicroStrategy, Web, open the document in Design or Editable Mode.

  b From the Tools menu, select Document Properties. The Properties dialog box opens.

  c From the left, select Document.

  d In the Available Display Modes list, select the Flash check box.

  e You can specify that this document always opens in Flash Mode when it is initially opened in Web. To do this, select Flash from the Run by default as drop-down list.

  f Click OK to apply your changes and return to the document.
• Enable Flash Mode in your User Preferences in MicroStrategy Web.
  a Click the MicroStrategy icon at the top of any page and select Preferences.
  b On the left, click Report Services.
  c Select the Enable Flash Mode check box.
  d Click Apply.

• In MicroStrategy Web, a project administrator can enable Flash Mode for a project, using the project default preference. Contact your project administrator to enable it.

In MicroStrategy Web, a graph displays in Interactive Mode but does not display properly in Flash Mode.

Some graph styles are not supported in Flash Mode. You may also encounter issues with other aspects of graph formatting which are not supported in Flash Mode. If issues such as these occur, you must change the graph style of the report to a supported style.

The following graph styles are the graph styles supported in Flash Mode:

<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Graph Sub-type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Bar</td>
<td>• Clustered</td>
</tr>
<tr>
<td></td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Percent</td>
</tr>
<tr>
<td></td>
<td>• Stacked</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Clustered</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Absolute</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Stacked</td>
</tr>
<tr>
<td>Horizontal Bar</td>
<td>• Clustered</td>
</tr>
<tr>
<td></td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Percent</td>
</tr>
<tr>
<td></td>
<td>• Stacked</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Clustered</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Absolute</td>
</tr>
<tr>
<td>Vertical Line</td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Percent</td>
</tr>
<tr>
<td></td>
<td>• Stacked</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Absolute</td>
</tr>
<tr>
<td>Horizontal Line</td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Absolute</td>
</tr>
</tbody>
</table>
Other display issues include the following:

- Nested labels in graphs are not displayed in Flash Mode. If the graph currently uses nested labels, switch to another label type before opening the graph in Flash Mode.

- If a graph legend is positioned manually rather than automatically, the graph legend may not be displayed in exactly the same position in Flash Mode.

- Donut bevel effects for circular data markers in a graph may appear different in Flash mode. For a more consistent look across modes, consider using a different bevel effect, such as Sphere or Smooth Edge.

<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Graph Sub-type</th>
</tr>
</thead>
</table>
| Vertical Area     | • Absolute  
|                   | • Percent  
|                   | • Stacked  
|                   | • Dual-axis Absolute  
|                   | • Dual-axis Stacked  |
| Horizontal Area   | • Absolute  
|                   | • Dual-axis Absolute  |
| Pie               | • Pie  
|                   | • Ring Pie  
|                   | • Multiple Proportional Pies  
|                   | • Multiple Proportional Ring Pies  
|                   | **Note:** Pie graphs may appear slightly larger in Flash Mode than they do in other display modes. The Proportional styles are not displayed proportionally in Flash Mode.
| Stock             | • Hi-Low-Open-Close  |
| Scatter           | • X-Y Scatter  
|                   | • Dual-axis X-Y Scatter  |
| Bubble            | • Bubble  
|                   | • Dual-axis Bubble  
|                   | **Note:** The minimum, maximum, and interval settings for the Bubble graph may not be displayed in Flash Mode exactly as they do in other display modes.
| Combination graphs| • Bar Area  
| These graphs use a combination of two graph types | • Bar Line  
|                   | • Area Line  
|                   | • Dual-axis Bar Area  
|                   | • Dual-axis Bar Line  
|                   | • Dual-axis Area Line  
|                   | **Note:** The alignment of the Y-axis labels can appear differently in Flash Mode than they do in other display modes.
For complete details on working with graphs, see the Advanced Reporting Guide.

In MicroStrategy Web, an image displays in Interactive Mode but does not display in Flash Mode.

The image file path may be incorrect or unsupported in Flash Mode. The file location of the image must use an HTTP-based path, not a network or local image path. For information about adding images to documents and using the correct image path, see Inserting images in a document, page 151.
Introduction

This appendix lists the advanced functions that are supported for calculated expressions in documents. The syntax for each function is included because you must type the syntax into a text field to use an advanced function in a calculated expression.

For detailed information on function syntax and examples of each function, see the MicroStrategy Functions Reference. For more information on calculated expressions, see Creating calculated expressions, page 130.

Functions are grouped into the following:

- Internal functions, page 564
- Null/Zero functions, page 564
- Financial functions, page 564
- Math functions, page 566
- Statistical functions, page 567
## Internal functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banding</td>
<td>Banding(Argument, StartAt, StopAt, Size)</td>
</tr>
<tr>
<td>BandingC</td>
<td>BandingC(Argument, StartAt, StopAt, BandCount)</td>
</tr>
<tr>
<td>BandingP</td>
<td>BandingP (Argument, Boundary1, Boundary2, Boundary3...BoundaryN)</td>
</tr>
<tr>
<td>Case</td>
<td>Case (Condition1, ReturnValue1, Condition2, ReturnValue2, ..., DefaultValue)</td>
</tr>
<tr>
<td>CaseV</td>
<td>CaseV (Argument, Value1, Result1, Value2, Result2, ..., DefaultResult)</td>
</tr>
</tbody>
</table>

## Null/Zero functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>NullToZero</td>
<td>NullToZero(Argument)</td>
</tr>
<tr>
<td>ZeroToNull</td>
<td>ZeroToNull(Argument)</td>
</tr>
</tbody>
</table>

## Financial functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accrnt</td>
<td>Accrnt &lt;Par = 1000, Basis = 0&gt; (Issue, FirstInterest, Settlement, Rate, Frequency)</td>
</tr>
<tr>
<td>Accrntm</td>
<td>Accrntm &lt;Par = 1000, Basis =0 &gt; (Issue, Maturity, Rate)</td>
</tr>
<tr>
<td>Coupdaybs</td>
<td>Coupdaybs &lt;Basis = 0&gt; (Settlement, Maturity, Frequency)</td>
</tr>
<tr>
<td>Coupdays</td>
<td>Coupdays &lt;Basis = 0&gt; (Settlement, Maturity, Frequency)</td>
</tr>
<tr>
<td>Coupdaysnc</td>
<td>Coupdaysnc &lt;Basis = 0&gt; (Settlement, Maturity, Frequency)</td>
</tr>
<tr>
<td>Coupncd</td>
<td>Coupncd &lt;Basis = 0&gt; (Settlement, Maturity, Frequency)</td>
</tr>
<tr>
<td>Coupnum</td>
<td>Coupnum &lt;Basis = 0&gt; (Settlement, Maturity, Frequency)</td>
</tr>
<tr>
<td>Couppcd</td>
<td>Couppcd &lt;Basis = 0&gt; (Settlement, Maturity, Frequency)</td>
</tr>
<tr>
<td>Cumipmt</td>
<td>Cumipmt &lt;Type = 0&gt; (Rate, Nper, Pv, Start, End)</td>
</tr>
<tr>
<td>Cumprinc</td>
<td>Cumprinc &lt;Type = 0&gt; (Rate, Nper, Pv, Start, End)</td>
</tr>
<tr>
<td>Db</td>
<td>Db &lt;Month = 12&gt; (Cost, Salvage, Life, Period)</td>
</tr>
<tr>
<td>Function</td>
<td>Syntax</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ddb</td>
<td>Ddb &lt;Factor = 2&gt; (Cost, Salvage, Life, Period)</td>
</tr>
<tr>
<td>Disc</td>
<td>Disc &lt;Basis = 0&gt; (Settlement, Maturity, Price, Redemption)</td>
</tr>
<tr>
<td>Dollarde</td>
<td>Dollarde (FractionalDollar, Decimal)</td>
</tr>
<tr>
<td>Dollarfr</td>
<td>Dollarfr (DecimalDollar, Fraction)</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration &lt;Basis = 0&gt; (Settlement, Maturity, CouponRate, YieldRate, Frequency)</td>
</tr>
<tr>
<td>Effect</td>
<td>Effect(NominalRate, Npery)</td>
</tr>
<tr>
<td>Fv</td>
<td>Fv &lt;Type = 0&gt; (Rate, Nper, Pmt, Pm)</td>
</tr>
<tr>
<td>Intrate</td>
<td>Intrate &lt;Basis = 0&gt; (Settlement, Maturity, Investment, Redemption)</td>
</tr>
<tr>
<td>Ipmt</td>
<td>Ipmt &lt; FV = 0, Type = 0 &gt; (Rate, Period, Nperiod, PV)</td>
</tr>
<tr>
<td>Mduration</td>
<td>Mduration &lt;Basis = 0&gt; (Settlement, Maturity, CouponRate, YieldRate, Frequency)</td>
</tr>
<tr>
<td>Nominal</td>
<td>Nominal(EffectiveRate, Npery)</td>
</tr>
<tr>
<td>Nper</td>
<td>Nper &lt;Type = 0&gt; (Rate, Pmt, PV, FV)</td>
</tr>
<tr>
<td>Oddfprice</td>
<td>Oddfprice &lt;Basis = 0&gt; (Settlement, Maturity, Issue, FirstCoupon, CouponRate, YieldRate, Redemption, Frequency)</td>
</tr>
<tr>
<td>Oddfyield</td>
<td>Oddfyield &lt;Basis = 0&gt; (Settlement, Maturity, Issue, FirstCoupon, CouponRate, Price, Redemption, Frequency)</td>
</tr>
<tr>
<td>Oddlprice</td>
<td>Oddlprice &lt;Basis = 0&gt; (Settlement, Maturity, LastInterest, CouponRate, YieldRate, Redemption, Frequency)</td>
</tr>
<tr>
<td>Oddlyield</td>
<td>Oddlyield &lt;Basis = 0&gt; (Settlement, Maturity, LastInterest, CouponRate, Price, Redemption, Frequency)</td>
</tr>
<tr>
<td>Pmt</td>
<td>Pmt &lt;FV = 0, Type = 0&gt; (Rate, Nper, PV)</td>
</tr>
<tr>
<td>Ppmt</td>
<td>Ppmt &lt;Type = 0&gt; (Rate, Per, Nper, PV)</td>
</tr>
<tr>
<td>Price</td>
<td>Price &lt;Basis = 0&gt; (Settlement, Maturity, CouponRate, YieldRate, Redemption, Frequency)</td>
</tr>
<tr>
<td>Pricedisc</td>
<td>Pricedisc &lt;Basis = 0&gt; (Settlement, Maturity, DiscRate, Redemption)</td>
</tr>
<tr>
<td>Pricemat</td>
<td>Pricemat &lt;Basis = 0&gt; (Settlement, Maturity, Issue, CouponRate, YieldRate)</td>
</tr>
<tr>
<td>Pv</td>
<td>Pv &lt;Type = 0&gt; (Rate, Nper, Pmt, FV)</td>
</tr>
<tr>
<td>Rate</td>
<td>Rate &lt;FV = 0, Type = 0, Guess = 0 &gt; (Nperiod, Payment, PV)</td>
</tr>
<tr>
<td>Received</td>
<td>Received &lt;Basis = 0&gt; (Settlement, Maturity, Investment, Discount)</td>
</tr>
<tr>
<td>Sln</td>
<td>Sln(Cost, Salvage, Life)</td>
</tr>
</tbody>
</table>
## Math functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abs</td>
<td>Abs(Argument)</td>
</tr>
<tr>
<td>Acos</td>
<td>Acos(Argument)</td>
</tr>
<tr>
<td>Acosh</td>
<td>Acosh(Argument)</td>
</tr>
<tr>
<td>Asin</td>
<td>Asin(Argument)</td>
</tr>
<tr>
<td>Asinh</td>
<td>Asinh(Argument)</td>
</tr>
<tr>
<td>Atan</td>
<td>Atan(Number)</td>
</tr>
<tr>
<td>Atan2</td>
<td>Atan2(x_num, y_num)</td>
</tr>
<tr>
<td>Banding</td>
<td>Banding(Argument, StartAt, StopAt, Size)</td>
</tr>
<tr>
<td>BandingC</td>
<td>BandingC(Argument, StartAt, StopAt, BandCount)</td>
</tr>
<tr>
<td>BandingP</td>
<td>BandingP (Argument, Boundary1, Boundary2, Boundary3...BoundaryN)</td>
</tr>
<tr>
<td>Ceiling</td>
<td>Ceiling(Argument)</td>
</tr>
<tr>
<td>Combine</td>
<td>Combine(Number, Number_Chosen)</td>
</tr>
<tr>
<td>Cos</td>
<td>Cos(Argument)</td>
</tr>
<tr>
<td>Cosh</td>
<td>Cosh(Argument)</td>
</tr>
<tr>
<td>Cumipmt</td>
<td>Cumipmt &lt;Type = 0&gt; (Rate, NPer, Pv, Start, End)</td>
</tr>
<tr>
<td>Cumprinc</td>
<td>Cumprinc &lt;Type = 0&gt; (Rate, NPer, Pv, Start, End)</td>
</tr>
<tr>
<td>Db</td>
<td>Db &lt;Month = 12&gt; (Cost, Salvage, Life, Period)</td>
</tr>
<tr>
<td>Ddb</td>
<td>Ddb &lt;Factor = 2&gt; (Cost, Salvage, Life, Period)</td>
</tr>
</tbody>
</table>
### Statistical functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>BetaDistribution</td>
<td>BetaDistribution &lt; Lower Bound = 0, Upper Bound = 1 &gt; (x, alpha, beta)</td>
</tr>
<tr>
<td>BinomialDistribution</td>
<td>BinomialDistribution &lt;Cumulative = 0&gt; (x, n, p)</td>
</tr>
<tr>
<td>ChiSquareDistribution</td>
<td>ChiSquareDistribution(x, df)</td>
</tr>
<tr>
<td>Function</td>
<td>Syntax</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Confidence</td>
<td>Confidence(alpha, stdev, size)</td>
</tr>
<tr>
<td>CritBinomial</td>
<td>CritBinomial(trials, probability_s, alpha)</td>
</tr>
<tr>
<td>ExponentialDistribution</td>
<td>ExponentialDistribution &lt;Cumulative = 0&gt; (x, lambda)</td>
</tr>
<tr>
<td>FDistribution</td>
<td>FDistribution(x, df₁, df₂)</td>
</tr>
<tr>
<td>Fisher</td>
<td>Fisher (x)</td>
</tr>
<tr>
<td>GammaDistribution</td>
<td>GammaDistribution &lt;Cumulative = 0&gt; (x, alpha, beta)</td>
</tr>
<tr>
<td>HypergeometricDistribution</td>
<td>HypergeometricDistribution(x, n, M, N)</td>
</tr>
<tr>
<td>InverseBetaDistribution</td>
<td>InverseBetaDistribution &lt; Lower Bound = 0, Upper Bound = 1 &gt; (probability, x, alpha, beta)</td>
</tr>
<tr>
<td>InverseChiDistribution</td>
<td>InverseChiDistribution(x, df)</td>
</tr>
<tr>
<td>InverseFDistribution</td>
<td>InverseFDistribution (x, df₁, df₂)</td>
</tr>
<tr>
<td>InverseFisher</td>
<td>InverseFisher(x)</td>
</tr>
<tr>
<td>InverseGammaDistribution</td>
<td>InverseGammaDistribution (x, alpha, beta)</td>
</tr>
<tr>
<td>InverseLognormalDistribution</td>
<td>InverseLognormalDistribution(x, mean, stdev)</td>
</tr>
<tr>
<td>InverseNormDistribution</td>
<td>InverseNormDistribution(x, mean, stdev)</td>
</tr>
<tr>
<td>InverseNormSDistribution</td>
<td>InverseNormSDistribution(x)</td>
</tr>
<tr>
<td>InverseTDistribution</td>
<td>InverseTDistribution(probability, df)</td>
</tr>
<tr>
<td>LogNormalDistribution</td>
<td>LogNormalDistribution(x, mean, stdev)</td>
</tr>
<tr>
<td>NegativeBinomialDistribution</td>
<td>NegativeBinomialDistribution(f, s, p)</td>
</tr>
<tr>
<td>NormalDistribution</td>
<td>NormalDistribution &lt;Cumulative = 0&gt; (x, mean, stdev)</td>
</tr>
<tr>
<td>Permut</td>
<td>Permut(n, m)</td>
</tr>
<tr>
<td>PoissonDistribution</td>
<td>PoissonDistribution &lt;Cumulative=0&gt; (x, lambda)</td>
</tr>
<tr>
<td>Standardize</td>
<td>Standardize(x,mean,stdev)</td>
</tr>
<tr>
<td>StandardNormalDistribution</td>
<td>StandardNormalDistribution (Argument)</td>
</tr>
<tr>
<td>TDistribution</td>
<td>TDistribution(x, df)</td>
</tr>
<tr>
<td>WeibullDistribution</td>
<td>WeibullDistribution &lt;Cumulative = 0&gt; (x, alpha, beta)</td>
</tr>
</tbody>
</table>
Glossary

**Autostyle** A document that stores formatting settings for various control types.

**Auto text code** Dynamic text that is populated by the document or dataset, consisting of the document’s or dataset’s options rather than data from the data warehouse. Examples of auto text codes, which can be considered as a type of variable, are document name, page number, and execution time. Auto text codes are contained in text field controls on a document.

See also:

- Data field
- Text field

**Cache** A special data store holding recently accessed information for quick future access. Caching is normally done for frequently requested reports or documents so that they execute faster, because they need not run against the data warehouse. Results from the data warehouse are stored separately and can be used by new job requests that require the same data.

In the MicroStrategy environment, when a user runs a report for the first time, the job is submitted to the database for processing. If the results of that report are cached, the results can be returned immediately without having to wait for the database to process the job the next time the report is run.
Document caching generates the document only once—the first time that you execute a document in a specific mode (such as Express Mode or Interactive Mode) in MicroStrategy Web. Subsequent document executions in the same mode use the cache. If document caching is disabled, the document query is submitted to your data warehouse every time that you execute the document in a different mode.

**calculated expression**  A metric obtained dynamically, directly from metrics on a document dataset, by using at least one of the metrics in the document. Calculated expressions allow you to use simple arithmetic operators (+, -, *, /) to combine metrics from different datasets in the document.

See also:
- **Derived metric**

**compound join**  A way to join a document’s multiple datasets. It matches any common attributes, then creates a virtual dataset by sequentially proceeding through dataset rows to create a complete set of joined rows. A compound join saves memory space and processing time.

**conditional formatting**  Used to format specified controls in a document depending on predefined criteria. It allows certain settings of controls, including sections, to be controlled by data-driven conditions. Conditional formatting in documents is similar to thresholds in reports.

**control**  Any item in the document’s Layout area that you can select. This can be a text field, line, rectangle, image, panel stack, selector, Grid/Graph, or HTML container. These different kinds of controls are referred to as control types.
See also:

- Grid/Graph
- HTML container
- Panel stack
- Selector
- Text field

**control default** A set of options that can be set for each type of control and each section in a document. You can set the defaults according to the control that is currently selected; afterward, its format is applied to any object of the same type that you create in the document.

**dashboard** An interactive, visually intuitive display of data. A dashboard can summarize key business indicators (KPIs) to provide a status check. Users can change how they view the dashboard’s data using interactive features, such as selectors, grouping, widgets, and visualizations. Users can explore their data via multiple paths, using text, data filtering, and layers of organization.

MicroStrategy has two kinds of dashboards:

- **Visual Insight (VI) dashboard**: Simple visualizations and pre-defined, presentation-quality formatting allow you to quickly display your data in a visually-striking, interactive dashboard.

- **Report Services (RS) dashboard**: A broad selection of widgets and a wide variety of formatting options allow you to design a customized, interactive dashboard. RS dashboards provide the freedom to design a dashboard pixel-by-pixel in multiple editing and previewing modes. The abundant design options deliver full control over position, formatting, and interactivity.

**data field** Dynamic text that is populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache). A data field is only a reference to the metric, attribute,
consolidation, or custom group on a report. Data fields are contained in text field controls on a document.

See also:

• Auto text code
• Text field

dataset A MicroStrategy report that retrieves data from the data warehouse or cache. It is used to define the data available on a document.

Datasets 1. A pane in the Document Editor that shows all objects (grouped by datasets) that can be used in the document.

2. All objects that can be used in the document as supplied by the datasets. Dataset objects are attributes, consolidations, custom groups, and metrics.

data warehouse 1. A database, typically very large, containing the historical data of an enterprise. Used for decision support or business intelligence, it organizes data and allows coordinated updates and loads.

2. A copy of transaction data specifically structured for query, reporting, and analysis.

derived metric A metric based on data already available from metrics on a document dataset. It is calculated on the Intelligence Server, not in the database. Use a derived metric to perform calculations on other metrics (column math), on data after it has been returned from the database.

See also:

• Calculated expression

drill A link from one document to another document, report, or HTML document. Prompt answers for the destination can be included in the drill.
**document** 1. A container for objects representing data coming from one or more reports, as well as positioning and formatting information. A document is used to format data from multiple reports in a single display of presentation quality.

2. The MicroStrategy object that supports the functionality defined in (1).

**Grid/Graph** A control placed in a document that displays information in the same way a MicroStrategy report does.

**grouping** A way to create a hierarchical structure for a document.

**History List** A folder where users put report results for future reference.

**HTML container** A control that either displays real-time information from the web or displays formatted HTML.

**Layout area** The middle panel of the Document Editor in which you place data or other controls to determine the appearance of the document when it is viewed as a PDF.

**link** A connection from a document to another document or a report. A link lets an analyst execute another document or report (the target) from a document (the source), and to pass parameters to answer any prompts that are in the target.

**page-by** Interactively displaying groups on separate pages in PDF View. It allows the end user to dynamically select group elements as criteria for analysis. The PDF that results from this selection is called a page of the original document.

**panel** A way of grouping data in a document so that users can navigate subsets of data as if the subsets were pages in a smaller document. Each “page”, or layer of data, is a panel; a group of panels is called a panel stack.
**panel stack** The holder for a collection of panels, or layers of data, in a document. A user can navigate or flip through the panels in a panel stack; only one panel is displayed at a time.

**project**

1. The MicroStrategy object in which you define all of the schema and application objects, which together provide a flexible reporting environment. A project is the highest-level intersection of a data warehouse, metadata repository, and user community, containing reports, filters, metrics, and functions.

2. An object containing the definition of a project, as defined in (1). The project object is specified when requesting the establishment of a session.

**Property List** The list of settings used to specify the appearance or any other characteristic of a control on a document.

**report instance** A container for all objects and information needed and produced during report execution including templates, filters, prompt answers, generated SQL, report results, and so on. It is the only object that is referenced when executing a report, being passed from one special server to another as execution progresses.

**scheduling** A MicroStrategy Intelligence Server feature that is used to automate specific tasks.

**selector** A type of control in a document that allows a user to:

- Flip through the panels in a panel stack, to see different predefined layers of data, or “pages”, in the same document

- Display different attribute elements or metrics in a Grid/Graph

**summary metric** A shortcut to a subtotal, or a subtotal metric allowing explicit aggregation in documents. A summary metric allows you to select the function to use to calculate the subtotal (that is, a summary).
**text field**  A type of control in a document that displays text in the document. These different types of text content are:

- Static text, which does not change and serves as a label
- Dynamic text, which is populated by the document or dataset. There are two types of dynamic text:
  - Data field, which is populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache). A data field is only a reference to an object on a report.
  - Auto text code, which is populated by the document or dataset, consisting of their settings rather than data from the data warehouse
- A combination of any or all of the above types in one text field

See also:

- **Data field**
- **Auto text code**

**virtual dataset**  A dataset held in memory that is the result of a compound join between multiple datasets in a document.

**widget**  A type of control that presents data in a visual and interactive way; an interactive Flash-only graph that dynamically updates when a new set of data is selected. Some types include Gauge, Heat Map, and Stacked Area widgets.
INDEX

Numerics
3D effect 263

A
accessing an image
on a shared network drive 153
on the Web server machine 153
partial path 153
adding
auto text code 89
data field. See also adding a data field. 83
data to a document 81
dataset 48
document section 39
line 150
object to a Grid/Graph 202
page break. See also adding a page break. 343
page numbers 344
rectangle 149
rounded rectangle 150
section 39
shape 149
static text 82
text 81
adding a data field 83
attribute form 85
by typing 85
using the Dataset Objects pane 85
adding a page break 343
after a section 344
at a new section 343
before a section 344
before and after a section 344
for a group 396
aggregation
dynamic 124
explicit 139
alerting. See conditional formatting. 307
aligning controls
by selecting and setting options 160
alignment grid 520
anti-alias
embedding a font for displaying in Flash Mode 341
applying an autostyle 259
arranging controls 156
attribute 81
attribute element prompt in a link 431

© 2013 MicroStrategy, Inc.
attribute form
  in a data field 84
  in a group 379

audience
  for document creation 11
  for manual  xx

auto text code defined on 82, 88
  adding 89
  attribute form and set qualification filter example 111
  combining with another text field 86
  configuring content of 94
  current user 90
  dataset filter details 92
  dataset prompt details 93
  dataset report description 92
  dataset report details 92
  dataset report execution time 93
  dataset report filter details 93
  dataset report information 91
  dataset report limit details 93
  dataset report template details 93
  date and time 90
  date and time vs. document execution time 91
  delimiter example 95
  document description 90
  document execution time 91
  document execution time vs. date and time 91
  document inbox title 90
  document information 90
  document name 90
  document notes 90
  drilling filter example 108
  dynamic date filter example 112
  filter example 112, 113
  in a blank text field 89

levels of configuration 94
  MicroStrategy Web Server name 91
  object name delimiters 95
  page number 90
  project name 90
  prompt 91
  prompt answers example 104
  prompt details 91
  prompt details example 103
  prompt titles and index example 103
  shortcut filter example 108
  time and date 90
  total number of pages 90

automatic resizing of a pages 90

AutoStyle defined on 258
  applying to a document 259
  creating 259
  document template vs. layout 481
  multi-layout document 481

B
  background
    backstyle 261
    color 267
    document 325
    document section 293
    layout 325
  backstyle 261
  best practices
    document 10

bitmap graph 355
Blank Dashboard template 290
Blank Document template 21
bookmarks 356
  clearing 356
  hiding 356
showing 356

border
document 325
layout 325

C
cache defined on 502
   enabling 503
   page-by and 503
   calculated expression 129, defined on 130
   creating 133
   function in 130
   functions supported 563
   calculating metric 114
totals 125, 139

changing
document section height 296
document section size 296
document section size (horizontal section) 300
document section width 299
   grouping order 377
collapsing a document section 37, 519
color picker 269
compound join defined on 52
compound metric, dynamic aggregation in 124
conditional formatting
   attribute 311
   control type formatting 307
deleting 324
derived metric and 310
displaying 323
displaying example 309
hiding 323
layout and 481
   multi-layout document and 481
   multiple datasets and 313
   multiple metrics or attributes 319
   selector totals 312
   single expression and metric 316
   configuring the content of an auto text code 94
   consolidation 81
   control defined on 7
       arranging 156
can not be moved 556
can not be resized 556
distributing 160, 161
   formatting 253, 255
   hiding 272
   locking 162
   moving. See moving a control.
   ordering 163
   selecting multiple controls 157
   sizing 161
   snapping to grid 158
types of 7
   unlocking 162
control default defined on 255
   Grid/Graph 207
control styles for a transaction-enabled document 457
control type 7
controlling horizontal overflow 350
Controls toolbar 515
   Lock button 515
copying a document to another project 505
copying and pasting formatting 254
creating
   Autostyle 259
calculated expression 133
derived metric 137
document watermark 333

document. See also creating a document. 17

metric. See also creating a metric. 129

creating a document 17

audience and 11

best practices 10

data source and 11

Document Editor 18

document template 22

effective design of 14

Excel exporting and 15

from a report 25

introduction 6

methods of 17

multiple reports 19, 22

multiple simultaneously 18

overview 6

project and 12

saving time and 13

template 22

using a template 20

creating a metric 129

calculated expression 130

derived 134

summary 139

custom color 269

custom group 81

data, adding to a document 81

dataset 6, 45

adding 48

changing for a Grid/Graph 195

displaying missing objects 54

for a document 57

for a project 58

Grid/Graph and 170

Grid/Graph link to 229

grouping and sorting 51, 74

Intelligent Cube 74

join 60, 75, 79

layout and 480

MicroStrategy OLAP Services report as 74

missing object display 54

multi-layout document and 480

multiple 52

primary 60

removing 48

missing object from 54

removing missing objects 54

for a document 57

for a project 58

secondary

multiple datasets

primary and secondary datasets 60

sorting and grouping 51

subset report as 74

virtual 52

dataset object 9

Dataset Objects pane

adding data to a document 85

dragging and dropping 85

dataset report information 88

Datasets pane, displaying 520

date 90

default

grid autostyle 256

data field defined on 82

adding to a document 83

attribute form 84

combining with another text field 86

hyperlink and 440

spaces in 85

special character in 85

data source and document creation 11

D
prompt order 491
deleting
  grouping field 378
  layout 485
delivery options for a document
  subscription 493
deploying out-of-the-box documents to
  your project 506
derived metric 129, defined on 134
  conditional formatting 310
  creating 137
  summary metric and 310
Design View 5
designing a document
  effective design 14
  introduction 6
  overview 6
Detail Footer section 35
  metric calculation and 118
Detail Header section 34
  metric calculation and 118
Detail section 34
  horizontal 293
  horizontally displayed example 293
  metric calculation and 115
display mode for MicroStrategy Web
  default 337
  selecting 337
displaying
  Datasets pane 520
document section 38, 289
  HTML 144
  section of a document 289
  website 146
distributing controls
  horizontally 160, 161
  relative to layout 161
  vertically 160, 161
document defined on 1
  concepts. See document - concepts.
  creating. See also creating a
document. 17
data set 6
  does not open 557
  execution does not finish 558
  resizing automatically 494
  sample 525
  section 28
  section. See also document section. 28
tasks. See document - tasks.
template. See also document
template. 20
transaction-enabled. See also transac-
tion-enabled document. 449
tutorial 525
  watermark. See also document
  watermark. 328
document - concepts
  best practices 10
data set 45
design xx, 1
FAQs 553
multi-layout 476
out-of-the-box deployment 506
portable 505
section. See also document section. 28
template. See also document
template. 20
  watermark. See also document
  watermark. 328
document - tasks
  caching 502
  creating. See also creating a
document. 17
  formatting 251
  grouping 374
  paging 403
<table>
<thead>
<tr>
<th>Index</th>
<th>Report Services Document Creation Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>previewing for printing</td>
<td>4</td>
</tr>
<tr>
<td>sorting</td>
<td>409</td>
</tr>
<tr>
<td>document description auto text code</td>
<td>90</td>
</tr>
<tr>
<td>Document Editor</td>
<td></td>
</tr>
<tr>
<td>accordion pane</td>
<td>515</td>
</tr>
<tr>
<td>alignment grid</td>
<td>520</td>
</tr>
<tr>
<td>Controls toolbar</td>
<td>515</td>
</tr>
<tr>
<td>creating a document</td>
<td>18</td>
</tr>
<tr>
<td>Datasets pane</td>
<td>520</td>
</tr>
<tr>
<td>Grouping panel</td>
<td>519</td>
</tr>
<tr>
<td>layout</td>
<td>513</td>
</tr>
<tr>
<td>Layout area</td>
<td>519</td>
</tr>
<tr>
<td>layout tab</td>
<td>518</td>
</tr>
<tr>
<td>Notes pane</td>
<td>523</td>
</tr>
<tr>
<td>Property List</td>
<td>521</td>
</tr>
<tr>
<td>toolbar icons</td>
<td>515</td>
</tr>
<tr>
<td>Document Footer section</td>
<td>36</td>
</tr>
<tr>
<td>layout and</td>
<td>478</td>
</tr>
<tr>
<td>metric calculation and</td>
<td>118</td>
</tr>
<tr>
<td>multi-layout document</td>
<td>36</td>
</tr>
<tr>
<td>multi-layout document and</td>
<td>478</td>
</tr>
<tr>
<td>Document Header section</td>
<td>32</td>
</tr>
<tr>
<td>layout and</td>
<td>478</td>
</tr>
<tr>
<td>metric calculation and</td>
<td>118</td>
</tr>
<tr>
<td>multi-layout document</td>
<td>32</td>
</tr>
<tr>
<td>multi-layout document and</td>
<td>478</td>
</tr>
<tr>
<td>document inbox title</td>
<td>90</td>
</tr>
<tr>
<td>document information</td>
<td>88</td>
</tr>
<tr>
<td>document name</td>
<td>90</td>
</tr>
<tr>
<td>document section</td>
<td>31</td>
</tr>
<tr>
<td>concepts. See document section - concepts.</td>
<td></td>
</tr>
<tr>
<td>names. See document section - names.</td>
<td></td>
</tr>
<tr>
<td>size. See also document section sizing.</td>
<td>296</td>
</tr>
<tr>
<td>tasks. See document section - tasks.</td>
<td></td>
</tr>
<tr>
<td>document section - concepts</td>
<td></td>
</tr>
<tr>
<td>Excel row height</td>
<td>370</td>
</tr>
<tr>
<td>horizontal</td>
<td>293</td>
</tr>
<tr>
<td>horizontal sizing example</td>
<td>299</td>
</tr>
<tr>
<td>layout and</td>
<td>31</td>
</tr>
<tr>
<td>metric calculation and</td>
<td>120</td>
</tr>
<tr>
<td>row height in Excel</td>
<td>370</td>
</tr>
<tr>
<td>size. See also document section sizing.</td>
<td>296</td>
</tr>
<tr>
<td>document section - names</td>
<td>28, 478</td>
</tr>
<tr>
<td>Detail</td>
<td>34</td>
</tr>
<tr>
<td>Detail Footer</td>
<td>35</td>
</tr>
<tr>
<td>Detail Header</td>
<td>34</td>
</tr>
<tr>
<td>Document Footer</td>
<td>36</td>
</tr>
<tr>
<td>Document Header</td>
<td>32</td>
</tr>
<tr>
<td>Document Header and Footer in a layout</td>
<td>478</td>
</tr>
<tr>
<td>Group Footer</td>
<td>35</td>
</tr>
<tr>
<td>Group Header</td>
<td>33</td>
</tr>
<tr>
<td>Layout Footer</td>
<td>36</td>
</tr>
<tr>
<td>Layout Header</td>
<td>32</td>
</tr>
<tr>
<td>Page Footer</td>
<td>36</td>
</tr>
<tr>
<td>Page Header</td>
<td>31</td>
</tr>
<tr>
<td>Page Header and Footer in a layout</td>
<td>484</td>
</tr>
<tr>
<td>document section - tasks</td>
<td></td>
</tr>
<tr>
<td>adding in a horizontally displayed section</td>
<td>41</td>
</tr>
<tr>
<td>collapsing</td>
<td>37, 519</td>
</tr>
<tr>
<td>displaying</td>
<td>38</td>
</tr>
<tr>
<td>expanding</td>
<td>37, 519</td>
</tr>
<tr>
<td>formatting</td>
<td>288</td>
</tr>
<tr>
<td>formatting background color</td>
<td>293</td>
</tr>
<tr>
<td>height</td>
<td>296</td>
</tr>
<tr>
<td>hiding</td>
<td>38</td>
</tr>
<tr>
<td>inserting a horizontally displayed section</td>
<td>41</td>
</tr>
<tr>
<td>inserting additional</td>
<td>39</td>
</tr>
<tr>
<td>keeping contents together</td>
<td>306</td>
</tr>
<tr>
<td>printing horizontally</td>
<td>293</td>
</tr>
<tr>
<td>repeating information</td>
<td></td>
</tr>
</tbody>
</table>
horizontally 302
repeating information on each page 303
document section display 289
  horizontal 293
  PDF only 291
document section sizing
  horizontal section 300
  horizontal sizing example 299
  set size 296
  variable size 296
  width 299
document template 20
  Autostyle vs. 21
  Blank Document 21
  creating 24
  creating a document with 20
  displaying Object Templates folder 24
  exporting to another project 24
  importing from another project 24
  predefined 21
document watermark 328
  blank 332
  creating 333
  disabling 336
  overwriting the project watermark 336
draft resolution graph 355
drill link
  prompt and 558
drilling
  Grid/Graph 238
  join type 241
  link and 446
  linking to documents and reports 418
  parent attribute 240
  selector and 446
  subtotals 241
  thresholds 240
  within the dataset report 239
drop shadow formatting 265
dynamic
  aggregation 124
  aggregation function 124
  image 151
  text 82
  text in a link 417

E
embedding
  bitmap in Excel 369
  font for Flash Mode 341
  font in a PDF 353
  font in a PDF and Windows default font 354
  image in Excel 368
enabling
  document caching 503
example
  3D effect 263
  advanced function in calculated expression 132
  background 261
  backstyle 261
  bookmarks in a PDF 356
  calculated expression 131
  calculating totals 125
  clipped text field 276
  conditional formatting 309
  conditional formatting and derived metric 310
  control default formatting 255
  data field in a hyperlink 440
  derived metric 135
  displaying a document section in PDF only 291
document border 325
document section sizing 296
drilling using links 418
drop shadow 265
dynamic image 151
formatting an HTML container 282, 283
gradient color 267
Grid/Graph. See also example - Grid/Graph. 169
group total 380
grouping 374
hiding a document section in MicroStrategy Web display modes 291
horizontal
detail section 293
group 390
overflow 352
sizing 299
HTML container 147
formatting 282, 283
MicroStrategy Web 144
hyperlink with a data field 440
invoice 525
line 149
linking to a web page 416
metric calculation. See example - metric calculation.
mirror gradient 267
number formatting in a text field 277
padding in a text field 280
page-by 403
prompt answer for any other prompts not listed 436
rectangle 149
rectangle vs. rounded rectangle 150
repeating a document section horizontally 302
repeating a document section on each page 304
report details auto text code 97, 98
rounded corners rectangle 285
scroll bar in text field 276
sizing a document section 296
summary metric 139
table of contents
grouped document 359
grouped multi-layout document 361
multi-layout document 360
text field 83
text field number formatting 277
three-way gradient 267
tooltip 270
transparent title bar 214
view filter on a Grid/Graph 217
watermark 327
example - auto text code
delimiter 95
filter details 108, 111, 112, 113
prompt answers 104
prompt details 103
prompt titles and index 103
example - Grid/Graph 168
background of selected item 210
incremental fetch 500
example - link
answering a hierarchy prompt 432
answering a target prompt with source prompt answers 428
attribute in a Grid/Graph as the source 422
button as the source 421
Grid/Graph dataset report as target 229
ignoring a target prompt 429
selector values 421
text field as the source 419
web page as the target 415
example - metric calculation
  Detail Header section 118
  Detail section 115
  Document Header section 118
  Grid/Graph 120
  Grid/Graph in a Group Header section 122
  Group Header or Footer section 116
  Page Header section 118
execution time
dataset report 93
document 91
expanding a document section 37, 519
exporting
  available export formats 364
  best practices for designing for Kindle and Nook 16
default export options 365
document as a template to another project 24
formats 364
formatting for 342, 363
grouped document layout 486
multi-layout document 486
page-by and 364
template to another project 24
exporting to Excel
  best practices 15
colors 15
document creation and 15
embedded bitmap 369
embedded image 368
graph styles 15
group to a separate worksheet 401
image display 368
layout to a separate worksheet 486
line 16
line breaks in a text field 16
live graph 369
multi-layout document 486
multiple worksheets for a group 401
multiple worksheets for a multi-layout document 486
object type display 15
rectangle 16
row height 370
troubleshooting 15
word-wrapping 16
worksheet for each layout 486
worksheet for each page 401
exporting to PDF
  missing image 558
multi-layout document 486
Express Mode (MicroStrategy Web)
  context menu in 245
  refreshing document automatically 340
expression, calculated 130
F
field group 450
filter details auto text code
  configuring 105
  configuring alias display 113
  configuring the display of an attribute element list qualification 110
  configuring the display of attribute form and set qualifications 111
  configuring the display of logical operators 112
defining content of 107
filter, view 217
Flash Mode (MicroStrategy Web)
  embedding a font for 341
enabling 559
floating toolbar in 245
font embedding 341
graph not displaying in 560
graph styles supported in 560
grid toolbar 339
Grid/Graph manipulations 247
image displayed in 153
image not displaying in 562
rounded rectangle 285
switching to 559
troubleshooting 559
Flash View 5
floating toolbar for a Grid/Graph 245
font embedding
  Flash Mode 341
  PDF 353
  PDF and Windows default font 354
footer section and multi-layout document 484
formatting
  3D effect 263
  Autostyle 258
  backstyle 261
  conditional 307
  control 253, 255
  control default 255
  copying and pasting a format 254
  custom color 269
  default 255
  document 251
  document border and background 325
  document for exporting or printing 342
  drop shadow 265
  gradient color 267
  Grid/Graph 207
  hiding a control 272
horizontal text 279
HTML container 282
image 287
interfaces 285
layout border and background 325
line 284
padding in a text field 280
rectangle 284
rounded rectangle 286
section 288
  background color 293
shape 284
table of contents 359
text field 273
text position in a text field 278
tooltip 270
useful suggestions 252
using a view filter 217
vertical text 279
Formatting toolbar 254
function
  calculated expression and document 130
  supported in a calculated expression 563
G
  gradient color 267
    mirror 267
    three-way 267
graph
  displaying a Grid/Graph as 198
  not displaying in Flash Mode 560
  resolution 355
Graph mode for a Grid/Graph 198
graph resolution 355
Graph view for Grid/Graph 198
Grid mode
Grid/Graph 197
grid toolbar in Flash Mode 339
Grid view for Grid/Graph 197
grid, displaying a Grid/Graph as 197
Grid/Graph defined on 167
adding 170
   as a shortcut 191
object to 202
automatic target maintenance for selectors and 171
changing dataset of 195
converting a shortcut 554
custom sorting 217
custom subtotals 218
data manipulations in Flash Mode 247
dataset report 170
disabling sorting and pivoting in for MicroStrategy Web 246
displaying 167
   as a graph 198
   as a grid 197
   as a grid and a graph 198
drilling on 238
editing 197
   when displayed as a graph 205
   when displayed as a grid 203
   when displayed as a grid and a graph 207
example 168
formatting. See also Grid/Graph formatting. 207
Graph mode 198
Grid mode 197
in header/footer 168
incremental fetch 499
link to dataset report 229
linking as a shortcut 195
linking to a dataset shortcut 191, 195
metric calculation and 120, 122
metric not displayed completely 554
multiple datasets in a single 58
multiple datasets in. See also Grid/Graph with multiple datasets. 178
no data returned message 554
overlapping 42
pivoting in Express Mode 245
placeholder. See also Grid/Graph placeholder. 176
Quick Switch between grid and graph 338
saving 553
selecting 196
shortcut 191
sorting
   Express Mode 245
   Flash Mode 245
title bar 211
toolbar 339
unlinking
   dataset report 194
   shortcut 194
view filter 217
view filter on a shortcut 554
viewing
   as a graph 198
   as a grid 197
   as a grid and a graph 198
Width Mode Fit to contents 554
Grid/Graph formatting 207
background of selected items in 208
control default 207, 256
custom formatting 217
default grid autostyle 256
example 210
graph formatting 205
grid formatting 203
Height Mode Fit to contents 554
initial format 207
layout when displayed as a grid and a graph 199
resizing 197
Grid/Graph placeholder 176
adding a dataset to 177
adding existing dataset to 177
adding new dataset to 178
formatting 176, 177
Grid/Graph with multiple datasets 178
adding 190
joining 180
primary dataset 181
resolving metrics 183
secondary dataset 182
view filter 219
Group Footer section 35
hiding 395
horizontal 389
metric calculation and 116, 122
Group Header section 33
hiding 395
horizontal 389
metric calculation and 116, 122
repeating 398
group totals 380
disabling page-by and 381
example 380
Grid/Graph metric calculation and 384
metric calculations in Grid/Graphs and 384
metrics and 387
showing 382
sorting and 383
grouping 374
applying to the current layout or all layouts 399
bookmarks and 376
displaying grouping elements containing null values 75
example 374
exporting and 364
exporting to separate Excel worksheets 401
field 375
deleting 378
moving 377
form display 379
Grid/Graph and 168
Group Header section 33
hiding Group Footer section 395
hiding Group Header section 395
horizontal sections 389
incremental fetch and 497
keeping data together 398
layout and 478
multi-layout document and 478
order 376
changing 377
horizontally displayed group and 393
page break 396
page-by and 376
repeating a Group Header section 398
resetting page numbers for 397
restarting page numbering 397
sorting 409
table of contents and 359, 376
totals. See also group totals. 380
Grouping panel
changing grouping order 377
deleting grouping field 378
header section and multi-layout document 484
hiding
document section 289
Group Header section 395
project watermark for a document section 332
hiding a document section 38, 289
empty document section 298
from all users and designers 290
in all views 290
in MicroStrategy Web 291
hierarchy prompt in a link 431
horizontal
fit 350
overflow 350
size 299
horizontal alignment in a text field 278
horizontally displayed group 389
adding a grouping field to 392
changing the grouping order of 393
horizontally displayed section 293
inserting a section into 41
width 299
horizontally printing
grouping section 389
section 293
HTML
document section height 556
HTML container 142, defined on 143
displayed in MicroStrategy Web 144
formatting 282
HTML tags supported in Flash Mode 144
in Excel 145, 147
in MicroStrategy Web 147
in PDF 145, 147
inserting (HTML tags) 146
inserting (iFrame) 148
inserting (URL) 148
using a URL 146
using an iFrame 146
using HTML tags 144
HTML content 142
HTML View 5
hyperlink 439
data field 440
example with a data field 440
image 439
pop-up text 439
text field 439
tooltip 439
iFrame 146
image
accessing on shared network drive 153
accessing on Web server machine 153
attribute in the file name 151
dynamic 151
formatting 287
inserting 151
metric in the file name 151
missing in MicroStrategy Mobile 558
missing in PDF View 558
missing when exported to PDF 558
not displaying 557
not displaying in Flash Mode 562
PDF View and supported image types 155
used in Flash Mode 153
watermark 326
importing
document as template from another project 24
layout into a document 483
template from another project 24
importing data 47
as a dataset 49
including a table of contents in a PDF 358
incomplete or inconsistent object definition error 557
incremental fetch 496
Grid/Graph 499
grouping and 497
information
keeping together 306
repeating horizontally 302
repeating on each page 303
input object control 457
Calendar 459
formatting 457
List 461
Signature Capture 464
Slider 464
Switch 467
Text Area 468
Text Field 469
Time Picker 472
Toggle 472
inserting
image 151
line 150
rectangle 149
rounded rectangle 150
shape 149
Intelligent Cube 74
international support xxxi

K
Keep together property 306
Kindle
best practices for exporting a document to 16

L
landscape orientation 346
layout
applying grouping selections to the current layout or all layouts 399
Autostyle 481
changing the order of 483
conditional formatting in 481
creating 482
dataset 480
deleting 485
Document Header and Footer 478
document properties for 480
exporting 486
footer 478
formatting border and background 325
header 478
horizontal overflow 350
importing 483
Layout Header and Footer 478
layout properties for 478
layout tab 484
Page Footer section 481
Page Header and Footer 484
Page Header section 481
PDF properties 480
properties for 478
renaming 485
sections in 31
separate Page Header and Footer for each 484

J
Jobs per user parameter 558
Jobs per user session parameter 558
join, compound 52
joining multiple datasets 52
tab 477
watermark 481
Layout area defined on 519
controls in 7
Layout Footer section 36
metric calculation and 118
Layout Header and Footer in a layout 478
Layout Header section 32
metric calculation and 118
layout tab 477, 478, 484
changing the background color 485
changing the order of 483
renaming 485
line
adding 150
formatting 284
inserting 150
line weight issues 557
link defined on 411
any other prompts 436
attribute element prompt 431
attribute in a Grid/Graph 422
button 421
drilling 418
drilling and 446
drilling using 418
dynamic text in 417
example 429, 432, 436
example of drilling using links 418
example of linking from a button 421
example of linking from a text field 419
example of linking from an attribute in a Grid/Graph 422
example of linking to a web page 415, 416
example of linking with selector values 421
Grid/Graph to dataset report 229

hyperlink 439
multiple links on the same object 417
selector and 446
selector values 421
text field 419
tooltip and 416
web page as the target 415, 417
linking a Grid/Graph as a shortcut 191, 195
unlinking 194
linking documents and reports
  drilling 418
live Excel graph 369
Lock button on the Controls toolbar 515
locking a control 162

M
margins 347
metric 81
calculated expression 129, 130
calculating a Grid/Graph at the group level 122
calculating as a grand total 118
calculating at the dataset level 115
calculating at the Grid/Graph level 120
calculating at the group level 116
calculation depending on location 114
calculation of 125, 556
comparison of metrics created in documents 129
compound 124
constant in 130
creating 129
derived 129, 134
document location and 114
dynamic aggregation 124
from dataset report 128
from multiple datasets 130
in Detail Footer section 118
in Detail Header section 118
in Detail section 115
in Document Footer section 118
in Document Header section 118
in Grid/Graph 120
in Grid/Graph in Group Header or Footer section 122
in Group Footer section 116
in Group Header section 116
in Layout Footer section 118
in Layout Header section 118
in Page Footer section 118
in Page Header section 118
operator in 130
reusing in multiple places 134
summary 129, 139
total 125
MicroStrategy Mobile
image missing 558
transaction-enabled document 449
MicroStrategy Transaction Services 449
creating a transaction-enabled document 450
input object controls that support transactions 457
MicroStrategy Web
display mode 337
drilling 240
hiding a document section in 291
improving document performance in 494
selecting available display modes 337
selecting default display mode 337
transaction-enabled document 449
MicroStrategy Web Server name 91
mirror gradient color 267
moving a control
by alignment 157
multi-layout document 476
Autostyle 481
changing the order of the layouts 483
conditional formatting in 481
creating 482
dataset 480
deleting a layout 485
Document Footer section 36
Document Header and Footer 478
Document Header section 32
document properties for 480
exporting 486
formatting border and background 325
grouping and 478
horizontal overflow 350
importing a layout 483
Layout Footer section 36
Layout Header and Footer 478
Layout Header section 32
layout properties for 478
layout tab 484
layout tab background color 485
layout tab in 477
Page Footer section 37, 481
Page Header section 32, 481
PDF properties 480
properties for 478
renaming layout 485
sections in 31
sorting and 478
table of contents in 360
table of contents in grouped 361
watermark 327, 481
multiple datasets
calculated expression and 130
conditional formatting and 313
derived metric and 134
effects of removing a dataset 48
effects of replacing a dataset 48
grouping and replacing dataset 51
in a single Grid/Graph 58, 178
Intelligent Cubes as 74
join behavior 52
examples 65
page-by and 406
view filter and 219

N

nested
  prompts in a drill link 558
Nook
  best practices for exporting a document to 16
notes 523
  adding 523
  auto text code 90
  editing 523
  length of 523
  submitting 523
  viewing 523
Notes pane 523
null value 75
number formatting in a text field 277
number of pages, total 90
numbering pages 343

O

object name delimiters for an auto text code 95
object on a report. See data field.
object template 21
opaque background 261
opening a document

Design View 5
PDF View 6
ordering
  controls 163
orientation 346
out-of-the-box document, deploying to your project 506
overflow, controlling 350

P

padding in a text field 280
page break
  adding 343
  keep together 306
  preventing within a group 398
Page Footer section 36
  layout 481
  metric calculation and 118
  multi-layout document 37, 481
  multi-layout document and 484
  separate footer for a layout 484
  shared among layouts 484
Page Header section 31
  layout 481
  metric calculation and 118
  multi-layout document 32, 481
  multi-layout document and 484
  separate header for a layout 484
  shared among layouts 484
page margins 347
page number 90
page numbers 344
page setup options 346
page-by defined on 403
  caching and 503
  disabling 408
  enabling 407
  example 403
<table>
<thead>
<tr>
<th>Exporting and Group Totals</th>
<th>Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>364</td>
<td>346</td>
</tr>
<tr>
<td>Group Totals And Disabling</td>
<td>Scaling</td>
</tr>
<tr>
<td>380</td>
<td>347</td>
</tr>
<tr>
<td>Multiple Datasets And</td>
<td></td>
</tr>
<tr>
<td>406</td>
<td></td>
</tr>
<tr>
<td>Pages, Numbering</td>
<td></td>
</tr>
<tr>
<td>343</td>
<td></td>
</tr>
<tr>
<td>Paper orientation</td>
<td></td>
</tr>
<tr>
<td>346</td>
<td></td>
</tr>
<tr>
<td>PDF</td>
<td></td>
</tr>
<tr>
<td>Bookmarks In</td>
<td></td>
</tr>
<tr>
<td>356</td>
<td></td>
</tr>
<tr>
<td>Embedding Font In</td>
<td></td>
</tr>
<tr>
<td>353, 354</td>
<td></td>
</tr>
<tr>
<td>Extra Pages In</td>
<td></td>
</tr>
<tr>
<td>557</td>
<td></td>
</tr>
<tr>
<td>Graph Resolution</td>
<td></td>
</tr>
<tr>
<td>355</td>
<td></td>
</tr>
<tr>
<td>Including An Interactive Table Of Contents</td>
<td>Including An Interactive Table Of Contents</td>
</tr>
<tr>
<td>358</td>
<td>358</td>
</tr>
<tr>
<td>Page Setup Options</td>
<td></td>
</tr>
<tr>
<td>346</td>
<td></td>
</tr>
<tr>
<td>Table Of Contents</td>
<td></td>
</tr>
<tr>
<td>358</td>
<td></td>
</tr>
<tr>
<td>PDF Properties</td>
<td></td>
</tr>
<tr>
<td>Layout And</td>
<td></td>
</tr>
<tr>
<td>480</td>
<td></td>
</tr>
<tr>
<td>Multi-Layout Document And</td>
<td></td>
</tr>
<tr>
<td>480</td>
<td></td>
</tr>
<tr>
<td>PDF View</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Image Missing</td>
<td></td>
</tr>
<tr>
<td>558</td>
<td></td>
</tr>
<tr>
<td>Opening A Document In</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Pivoting A Grid/Graph In</td>
<td></td>
</tr>
<tr>
<td>Express Mode</td>
<td></td>
</tr>
<tr>
<td>245</td>
<td></td>
</tr>
<tr>
<td>Pivoting A Grid/Graph In</td>
<td></td>
</tr>
<tr>
<td>Flash Mode</td>
<td></td>
</tr>
<tr>
<td>Disabling</td>
<td></td>
</tr>
<tr>
<td>246</td>
<td></td>
</tr>
<tr>
<td>Pop-Up Tooltip</td>
<td></td>
</tr>
<tr>
<td>270</td>
<td></td>
</tr>
<tr>
<td>Portable Document</td>
<td></td>
</tr>
<tr>
<td>505</td>
<td></td>
</tr>
<tr>
<td>Reconciliation</td>
<td></td>
</tr>
<tr>
<td>506</td>
<td></td>
</tr>
<tr>
<td>Portal</td>
<td></td>
</tr>
<tr>
<td>212</td>
<td></td>
</tr>
<tr>
<td>Portlet</td>
<td></td>
</tr>
<tr>
<td>212</td>
<td></td>
</tr>
<tr>
<td>Portrait Orientation</td>
<td></td>
</tr>
<tr>
<td>346</td>
<td></td>
</tr>
<tr>
<td>Predefined Format</td>
<td></td>
</tr>
<tr>
<td>258</td>
<td></td>
</tr>
<tr>
<td>Printing</td>
<td></td>
</tr>
<tr>
<td>Documents On A Single Page</td>
<td></td>
</tr>
<tr>
<td>348</td>
<td></td>
</tr>
<tr>
<td>Formatting For</td>
<td></td>
</tr>
<tr>
<td>342</td>
<td></td>
</tr>
<tr>
<td>Groups On A Single Page</td>
<td></td>
</tr>
<tr>
<td>348</td>
<td></td>
</tr>
<tr>
<td>Landscape</td>
<td></td>
</tr>
<tr>
<td>346</td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td></td>
</tr>
<tr>
<td>347</td>
<td></td>
</tr>
</tbody>
</table>

**Project**

- Copying A Document Between 505
- Document Creation And 12

**Project Name** 90

**Project Watermark** 328

- Creating 330
- Hiding 332
- Overwriting document watermark 336

**Prompt** 91

- Adding To A Document 489
- Default Answer 489
- Default Prompt Order 491
- Document And 488
- Order Of 491

**Prompt Answer Method**

- All Valid Units 432
- Answer With The Same Prompt 427
- Current Unit 431
- Default Answer 431
- Dynamic 431
- For Any Other Prompts 435
- Prompt User 428

**Prompt Details** 91

- Prompt Details Auto Text Code 93
- Configuring 102

**Prompt In A Link**

- Any Other Prompts 436

**Prompt Order** 491

- Changing 492
- Default 491

**Properties And Formatting Dialog Box** 253, 254

**Property List** Defined on 521

- Controlling The Display Of 521
- Displaying 521
- Help Button 523
| Q | Quick Switch between grid and graph 338 |
| R | reconciling a document 505 |
|   | reconciling an imported document 506 |
|   | rectangle |
|   | adding 149 |
|   | formatting 284 |
|   | refreshing a document automatically in Express Mode 340 |
|   | renaming |
|   | layout 485 |
|   | layout tab 485 |
|   | Repeat horizontally property 302 |
|   | Repeat on each page property 303 |
|   | repeat section setting 398 |
|   | repeating information |
|   | horizontally 302 |
|   | on each page 303 |
|   | report |
|   | creating a document from 25 |
|   | execution in a document 558 |
|   | report description auto text code 92 |
|   | report details auto text code 92 |
|   | configuring 97 |
|   | configuring, sample 97, 98 |
|   | report filter auto text code 92 |
|   | report filter details auto text code 93 |
|   | report limit details auto text code 93 |
|   | Report Services document 1 |
|   | See also document. report. See Grid/Graph. |
|   | resetting page numbers for a group 397 |
|   | resizing a document automatically 494 |
|   | restarting page numbering for a group 397 |
|   | rounded rectangle |
|   | adding 150 |
|   | formatting 286 |
| S | scaling 347 |
|   | section |
|   | formatting 288 |
|   | horizontal 293 |
|   | security requirements 11 |
|   | selecting multiple controls 157 |
|   | selector |
|   | drilling and 446 |
|   | link and 446 |
|   | totals and conditional formatting 312 |
|   | shape |
|   | adding 149 |
|   | formatting 284 |
|   | shortcut |
|   | Grid/Graph 191 |
|   | linking a Grid/Graph as 195 |
|   | unlinking a Grid/Graph 194 |
|   | sizing a control 161 |
|   | dragging sizing handles 161 |
|   | using the Properties and Formatting dialog box 161 |
|   | snapping to grid 158 |
|   | sorting |
|   | document 409 |
|   | group totals and 383 |
|   | grouping item 409 |
|   | layout and 478 |
|   | multi-layout document and 478 |
using a view filter 217
sorting a Grid/Graph in Express Mode 245
sorting a Grid/Graph in Flash Mode
disabling 246
static text 81
adding to a document 82
combining with another text field 86
subscription delivery options 493
subset report as dataset 74
subtotals
calculating 125
group 380
shortcut to subtotals 139
summary metric 139
using a view filter 218
summary metric 129, defined on 139
conditional formatting 310
creating 141
renaming 141
support
international xxxi
support. See technical support.

T

table of contents 358
changing location of 362
formatting 359
grouping and 359
multi-layout document and 360
technical support xxxi
template
Blank Dashboard 290
creating a document with 20
creating document template 24
displaying Object Templates folder 24
exporting to another project 24
importing from another project 24
predefined document template 21
template details auto text code 93
configuring 100
text direction in a text field 279
text field defined on 81
clipped 276
combining 86
display properties 278
editing 87
formatting 273
hyperlink 275
number formatting 277
options 274
padding 280
padding and vertical text 280
scroll bar 276
size 275
text display properties 278
vertical text 279
vertical text and padding 281
text, adding to a document 81
three-dimensional effect 263
three-way gradient color 267
threshold. See conditional formatting. 307
time 90
title bar
Grid/Graph 211
tooltip 270
hyperlink and 439
link and 416
totals
calculating automatically 125
using summary metric 139
Transaction Services 557
transaction-enabled document 449
creating 450
field group 450
input object controls that support transactions 457
transparent background 261
troubleshooting 553
   Excel exporting 15
   Flash Mode 559
True Type font on UNIX 1
tutorial
document 525
typing a data field 85

U
UNIX, True Type font on 1
unlinking a Grid/Graph shortcut 194
unlocking a control 162
user auto text code 90

V
variable. See auto text code.
vector graph 355
vertical text 279
   embedding a font for displaying in Flash Mode 341
   padding and 281
view filter 217
   custom formatting 217
   custom sorting 217
   custom subtotals 218
view mode for a Grid/Graph
   Graph 198
   Grid 197
viewing a document
   Flash View 5
   HTML View 5
   PDF View 4

virtual dataset defined on 52
visualization in a Visual Insight (VI) dashboard, multiple datasets in 58

W
watermark 326
   disabling 336
   disabling document watermark 336
document 328
   layout and 481
   multi-layout document and 481
   project 328, 330
   washout 327
web content 142
word wrap in a text field 279
write-back functionality 449